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Getting Started 

  

Welcome to Catalyst Manufacturing®, a manufacturing planning and execution 

system that is both highly functional and easy to use. You can use the online help manual 

to refer to throughout the application for reference and instruction. The categories below 

will help you install Catalyst and start populating the system with your company data. 

  

1. System Requirements 

2. Installation 

3. SQL Server Setup 

4. Establish DSN Connection 

5. Select Company Data File 

6. Product Registration 

7. Populating Data 

8. Catalyst Data Import 

9. Troubleshooting Installation Problems 

10. Create / Modify Program Shortcut 

11. Favorites 

 

System Requirements 

  

The system requirements for Catalyst Manufacturing® are similar to those for 

Microsoft Access® and SQL Server®.  Catalyst consists of two databases – one that 

resides on the client PC and a back-end database that resides on the server machine. The 

system requirements for each are provided below. 

  

Client PC 

  

• Computer: A 64-bit personal computer that meets Microsoft Access® minimum 

hardware requirements 

• Memory: 8 GB RAM or higher 

• Operating System: Windows 11, Windows 10, Windows 8.1, Windows 8, 

Windows 7 

• Software: Microsoft Access® 2016, 2019, 365 (64-bit version). Microsoft 

Excel® is required for use of import and export worksheets and pivot table 

templates. Microsoft Outlook® or comparable email client required for 

notification functionality.  

o Note: The 64-bit Access Runtime can be used on machines without an 

Access license.  A licensed version of Access is required to make 

modifications to the Full or Pharmaceutical Edition.  The Basic Edition is 

distributed in accde file format and cannot be modified. 
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• Hard Disk: 3.0 GB available disk space for both Microsoft Office® and the 

Catalyst application files.   

Server 

  

• Computer and Processor: A 64-bit server that meets Microsoft SQL Server® 

minimum hardware requirements  

• Operating System: Windows Server 2008, 2012, 2016, or 2019 

• Software: SQL Server 2014, 2016, 2017, or 2019 (64-bit version, Express 

Editions acceptable) with client tools to perform database administration 

functions. 

• Hard Disk: At least 5.0 GB for company back-end database files and backup 

storage. 

Installation 

Unless Catalyst is hosted on a cloud platform, each client machine must either 

have a 64-bit version of Microsoft Access or the Access Runtime installed on each client 

machine.  For network environments, the back-end database must also be placed on a 

server machine so it can be shared by all users. 

1. If upgrading to a new version, uninstall any previous version of Catalyst using the 

Add and Remove Programs utility in the Windows® Control Panel. 

2. Download and run the Catalyst installation package as an administrator. 

3. Proceed through the installation steps provided in the setup package to install 

Catalyst on the local machine.  

• During installation, do not change the default installation location and 

install for all users.  

• After installation, a program shortcut is placed on the desktop and in the 

Programs group.  

• Establish the Catalyst folder and subfolders on the client machine as 

Trusted Locations in Microsoft Access. If using the Access Runtime, 

please refer to the help topic to Establish Trusted Locations when using 

the Access Runtime. 

4. Repeat the steps above for each client PC installation.  

5. Move the Catalyst back-end database files with a mdf and ldf file extension from 

the Catalyst folder on the client machine to the Data folder under the SQL Server 

instance on the server.  Refer to the SQL Server Setup help topic for instructions 

on how to attach the database files to SQL Server and other configuration details.  

https://catalystmfg.zendesk.com/hc/en-us/articles/207988616-How-do-I-setup-Trusted-Locations-in-Microsoft-Access-2010-and-2013-
https://catalystmfg.zendesk.com/hc/en-us/articles/207988666-How-do-I-setup-Trusted-Locations-if-I-m-using-the-Access-Runtime-
https://catalystmfg.zendesk.com/hc/en-us/articles/207988666-How-do-I-setup-Trusted-Locations-if-I-m-using-the-Access-Runtime-
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6. On a client machine, create a System DSN as described in the Establish DSN 

Connection help topic. 

7. On the same client machine, open Catalyst using the desktop shortcut and select 

Relink Company Database from the Tools tab.  On the Select Company Data 

File screen, select the DSN name and click the Refresh Links button.  

8. Repeat steps 6-7 on each client machine. 

9. To enable user-level security so that each user logs into Catalyst with their own 

user name and password, refer to the instructions provided in the Enable User-

Level Security help topic.  

10. To activate the product, submit your registration information as described in the 

Product Registration help topic. 

 

SQL Server Setup 

  

The Catalyst SQL Server back-end database files are installed in the Catalyst 

application path during program installation. In a multi-user network environment, the 

back-end database files need to be moved to a shared folder on the server machine. If you 

do not already have SQL Server® installed on the server machine, you will need to do so 

before continuing with the setup. The sections below provide instructions on how to 

attach the Catalyst database files to SQL Server and establish the necessary SQL Server 

security and protocols. Prior to linking to the SQL Server database from a client PC, you 

will also need to create a DSN connection to SQL Server as described in the Establish 

DSN Connection help topic. 

Select Server Authentication Mode 

Catalyst can use either Windows authentication or SQL Server authentication. It 

is highly recommended you use Windows authentication unless you are not using domain 

controllers. To allow either connection option, ensure the Server authentication setting 

for your SQL Server instance specifies mixed mode (SQL Server and Windows 

Authentication mode) on the Security page of the Server properties. 

Attach SQL Server Database Files 

1.      Open SQL Server Management Studio by right-clicking the shortcut and 

selecting 'Run as administrator'. 

2.      In the Console Root, expand your SQL Server group, right-click the Databases 

folder, and select Attach from the shortcut menu. On the Attach Databases 

screen, select the Add button to search for the Catalyst .mdf file on your server. 

Select the file and click the OK button to return to the Attach Databases screen. 
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3.      Click the OK button to attach the selected database. If an error occurs, verify you 

have the appropriate SQL Server permissions to perform administrative functions. 

After the database has been attached to SQL Server, you can now link to it from 

within Catalyst using the Relink Company Database screen. 

Create SQL Server Logins 

1.      In SQL Server Management Studio, open Object Explorer and expand the folder 

of the server instance in which to create the new login. 

2.      Expand the Security folder and the Logins folder to view the current logins. 

3.      Either open the properties for an existing user or create a new user login by right-

clicking the Logins folder and selecting New Login. 

4.      For a new login, if using Windows authentication, enter the name of a Windows 

user or group in the Login name field.  If using SQL Server authentication, enter 

a login name and password. 

5.      On the Server Roles page, select the 'sysadmin' server role. 

6.      On the User Mapping page, select the Map checkbox adjacent to the Catalyst 

database. In the 'Database role membership' frame, select the 'db_owner' and 

''public' roles. 

7.      Click OK. 

Verify SQL Server Protocols 

1.      Open SQL Server Configuration Manager. 

2.      In the SQL Server Services folder, verify that the SQL Server Browser service is 

running and set to start automatically. 

3.      In the SQL Server Network Configuration folder, select the SQL Server protocol 

used by Catalyst and verify that Shared Memory and TCP/IP protocols are 

enabled. 

4.      In the SQL Native Client Configuration folder, select Client Protocols and verify 

that Shared Memory and TCP/IP are enabled. 
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Establish DSN Connection 

  

To establish a Data Source Name (DSN) connection to Microsoft SQL Server, 

please refer to the steps below.  Catalyst is a 64-bit Microsoft Access application so the 

DSN must be created using the 64-bit ODBC Data Source Administrator.  You have the 

option to connect to SQL Server using either Windows Authentication or SQL Server 

Authentication if you are not using domain controllers. Please refer to the SQL Server 

Setup help topic for the appropriate permissions and settings. 

  

1.      On the client PC, open the ODBC Data Source Administrator (64-bit). 

2.      On the ODBC Data Source Administrator screen, select the System DSN tab 

and click the Add button. 

3.      On the Create New Data Source window, select the SQL Server driver 

compatible with the SQL Server instance running on the server. Click the 

Finish button. 

4.      On the Create a New Data Source to SQL Server window, in the Name field, 

type ‘Catalyst MFG v5.x’ or similar to distinguish the DSN database to which 

you will be connecting. In the Server field, select the network server you 

previously attached the Catalyst back-end database files. Click the Next 

button. 

5.      On the Microsoft SQL Server DSN Configuration window, select either ‘With 

Integrated Windows authentication’ or ‘With SQL Server 

authentication’.  When using SQL Server authentication, you will need to 

enter a login name and password. Click the Next button. 

6.      On the Microsoft SQL Server DSN Configuration window, mark the check 

box ‘Change the default database to:’ and select the current version of the 

Catalyst back-end database. Leave the check boxes marked to use ANSI 

identifiers and settings. Click the Next button. 

  

7.      On the last Microsoft SQL Server DSN Configuration window, leave all 

default settings and click the Finish button. 

  

8.      On the ODBC Microsoft SQL Server Setup dialog, verify the connection by 

clicking the Test Data Source button. If the test does not complete 

successfully, modify SQL Server permissions and settings and/or use the 

Back button to modify the DSN configuration as required. 

  

9.      Close the ODBC Data Source Administrator and open Catalyst on the client 

PC using the desktop shortcut. When prompted, select ‘Yes’ to establish a 

new connection or select Relink Company Database from the Tools tab. 
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10.  On the Select Company Data File screen, select the DSN name specified in 

step 4. The Database name should default to the database selected in step 6. 

If it does not, reopen the ODBC Data Source Administrator and use the 

Configure button to select the correct default database. 

11.   If using Windows authentication, leave the checkbox marked to Use Trusted 

Connection. If using SQL Server authentication, uncheck Use Trusted 

Connection and enter the login name and password entered in step 5 when 

creating the DSN. 

12.  Click the Refresh Links button to reset the connection to the specified 

Catalyst back-end database. 

Select Company Data File 

  

To link to the back-end database or company data file, select Relink Company 

Database from the Tools tab. The Select Company Data File screen is used during 

initial setup and as needed to switch back and forth between companies. The currently 

selected company is referenced in the Current Company field.  The steps to relink to a 

new company data file are provided below. 

  

1.      On the Select Company Data File screen, select a DSN name from the drop-

down list. The Database name should populate automatically based on the 

default database selected when the DSN was created. If it does not, reopen the 64-

bit ODBC Data Source Administrator and use the ‘Configure’ button to assign the 

correct default database. 

2.      If using Windows authentication, keep the Use Trusted Connection field 

checked. If using SQL Server authentication, unselect the Use Trusted 

Connection checkbox and enter the SQL Server login name and password for the 

database.  

3.      Click the Refresh Links button to connect to the selected company database file. 

Product Registration 

  

The Pharmaceutical Editions must be obtained from either the Catalyst 

Manufacturing web site or an authorized reseller and activated within thirty (30) days of 

installation. To activate the Pharmaceutical Edition, install and register the product using 

the steps below.  

  

Initial Registration 

1. The activation code is based on the server information. Prior to registering the 

product, ensure that the back-end database has been moved to the server and that 

the Catalyst client has been relinked to the back-end database that resides on the 
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server. If the registration is submitted while the client is connected to a back-end 

database that resides on the local client, the activation code will only be valid for 

that client. Note: a product registration cannot be submitted for the sample 

StoreMore back-end database.  

2. After opening or relinking to an unregistered Catalyst back-end database, the 

Product Registration wizard should open automatically. If not, select Product 

Registration from the Help tab. 

3. If the Evaluation Version screen is displayed, click the Next button. 

4. On the Software License Agreement page, read and select ‘I agree’ to the license 

agreement and click the Next button. 

5. On the company information page, complete all fields and click the Next button. 

6. Prior to submitting the registration, verify the displayed Server Name, select a 

Registration Send Method and click the Next button. 

7. Please allow up to 1 business day to receive a new activation code. The typical 

response time, however, is within a few hours. 

Resubmit Registration 

1. If the back-end database is moved to a different server or the registration 

information changes in any way, the registration information will need to be 

resubmitted to obtain a new activation code. 

2. To resubmit the registration with new information, perform steps 2-4 above to 

advance to the activation page. Click the Change Registration Information 

button. 

3. On the company information page, re-enter or verify the company information 

fields and click the Next button. 

4. Prior to submitting the registration, verify the displayed Server Name, select a 

Registration Send Method and click the Next button.  

5. Please allow up to 1 business day to receive a new activation code.  The typical 

response time, however, is within a few hours. 

Activation 

1. After receiving the product activation code, re-open the Catalyst database.  

2. The Product Registration wizard should open automatically. If not, select 

Product Registration from the Help tab. 

3. On the Software License Agreement page, read and select 'I agree' to the license 

agreement and click the Next button. 
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4. On the activation page, carefully enter the activation code into the product 

registration key fields and click the Finish button.  

5. A message will confirm whether or not the activation code was entered 

successfully.  The product only needs to be activated from one client machine.  If 

the activation code is not valid, verify and re-enter. If still unsuccessful, contact 

Catalyst Support. 

 

Populating Data 

  

The two main methods to populate Catalyst Manufacturing® with your company 

data are importing data from an external source and keying the data in manually. A pre-

formatted spreadsheet is available to help you import data from another data source. 

When using the QuickBooks Link, you can use the information already populated in 

QuickBooks to import customer, vendor, and other data supported by the interface. To 

enter the data manually, please refer to the Data Management page of the Process Flow 

Charts (Help > Process Flow Charts) for a guide on the order in which the data needs to 

be loaded. To upgrade from a previous version of Catalyst, you can import your data into 

the current version using the Catalyst Upgrade Wizard. 

              

The entering of customer orders, purchase orders, and shop orders will depend on 

how you want to initialize the system. Generally, you will want to load open customer 

orders and purchase orders and any shop orders needed to cover work-in-progress at the 

time of implementation cutover. You may also want to release some shop orders in 

anticipation of what you will need during the initial production period. It is recommended 

that you conduct a physical inventory using the Physical Inventory Control Board to enter 

opening balance transactions for all inventory items just prior to the implementation 

cutover date.  

 

Catalyst Data Import 

  

To facilitate the population of foundation data in Catalyst, a pre-formatted Microsoft 

Excel® spreadsheet has been provided to import items, unit of measures, product classes, 

product codes, customers, vendors, vendor items, warehouses, locations, carriers, 

countries, states, product configurations (routes/BOMs), and work centers. The 

spreadsheet file name is CatalystImport.xls and is located in the Catalyst directory. The 

spreadsheet can be opened by selecting Import Data > View Spreadsheet Data from the 

External Data group on the Tools tab. After populating the spreadsheet, the data can be 

imported using the Catalyst Data Import screen which is opened by selecting Import 

Data > Import Spreadsheet Data on the Tools tab. 

  

When viewing the spreadsheet, the first row (blue background) of each worksheet 

contains the labels for the equivalent table columns in Catalyst. The required fields are 

indicated with bold text. Each column has data validation rules to ensure that the data 
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entered into each cell is the correct data type and length. For columns that depend on data 

from another source, a drop-down box has been provided on the spreadsheet to add 

values from another worksheet range. For example, the Vendor column on the Items 

worksheet references the Vendors worksheet. The vendor names entered on the Items 

page need to either already exist in Catalyst or be included as part of the import. 

Otherwise, the item record that references the vendor will not be imported. These 

dependent relationships are indicated on the various worksheet cells with a drop-down 

combo box that lists the records in the corresponding reference range. 

After loading the required data into the spreadsheet, you can import the records 

directly into Catalyst as described below. 

  

1.      Save and close the CatalystImport.xls spreadsheet. 

2.      Open the Catalyst Data Import screen by selecting Import Data > Import 

Spreadsheet Data on the Tools tab. 

3.      Select the data you would like to import using the radio button options. 

Specify the Import Path, if required, using the browse button. The selection 

of some data groups will automatically require that you include data from 

related sources even if you have not populated those worksheets. For instance, 

to import item data, you must also import data for product classes, product 

codes, warehouses, locations, unit of measures, and vendors. However, it’s not 

necessary to populate the spreadsheet with data if it already exists in Catalyst. 

For instance, if the location A0023 already exists in Catalyst, it can be added 

to the Items and Work Centers worksheets, but does not need to be added to 

the Locations worksheet.  

4.      To import the data from the spreadsheet, click the Import Data button. After 

the data has been imported, you can view the imported records for each data 

group by clicking the adjacent edit button . To view an imported quote 

configuration, select the Build Config. button on the Quote page of the 

Customer Order Entry screen. 

  

Since duplicate records are not added during the import process, the spreadsheet can be 

used to load additional records at any time. 

 

Troubleshooting Installation Problems 

  

Some of the more common installation problems and resolutions have been 

included in this section. If you are unable to find a satisfactory resolution to your 

problem, please submit a help ticket to Catalyst Manufacturing® support for assistance. 

  

Improperly Registered ActiveX Control 

Missing Object or Library 

Missing or Incorrect Activation Code 
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Improperly Registered ActiveX Control 

An ActiveX control may not have been properly registered during setup or might 

have been unregistered accidentally through another program installation. The error 

message generated in Catalyst will be “object or control not found”, "object not loaded", 

or "load library failed" when trying to open the form containing the unregistered control. 

This error can often be resolved by reinstalling or repairing the Catalyst installation 

  

 Missing Object or Library 

Catalyst Manufacturing contains references to objects and libraries that Catalyst 

needs to function properly. When the user opens the Catalyst database, the program 

checks for missing references and prompts the user if any files are missing. In most cases, 

re-installing Catalyst or Microsoft Access® will correct the problem. However, a missing 

reference error may also indicate that more than one version of Access is installed on the 

machine, an outdated version of Access is installed, or a control or driver did not properly 

register or became unregistered for some reason.  A reinstallation of Catalyst only 

addresses broken or missing references when a control needs to be installed and re-

registered.  Any other root causes would need to be addressed prior to re-installing the 

software. 

  

In versions of the software that are distributed with an accdb extension (Full and 

Pharma Editions), missing or broken references can be checked using the Visual Basic® 

Editor as described in the steps below.  

  

1.      In the Full Edition, open the Catalyst front-end database by holding down the 

shift key at the same time you press OK on the login dialog box.  

  

2.      Open the VB Editor by either selecting View > Code from the Microsoft 

Access® menu or pressing Alt-F11. 

  

3.      From the VB Editor, select Tools > References from the menu bar. Missing 

references will be identified with a “MISSING” tag beside the reference 

checkbox. 
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4.      If the Catalyst Agent reference is missing, it probably means that it is located in a 

different path than specified in the reference. To correct, uncheck the checkbox 

for the Catalyst Agent, click OK to close the Reference dialog, reopen by 

selecting Tools > References and browse and select the Catalyst Agent.accde file 

from the correct path.  

  

5.      Close the References screen. Select Debug > Compile Catalyst Manufacturing 

from the VB Editor menu. After the project finishes compiling, close the VB 

Editor. 

  

6.      From the Microsoft Access ribbon menu, select Database Tools > Compact and 

Repair Database. Close Catalyst when the process completes. 

  

Missing or Incorrect Activation Code 

To verify if the activation code is missing, select Help > Product Registration 

and proceed through the Registration Wizard to verify the missing activation code. Re-

enter the activation code if required. 

  

The activation code is based on the server address that the back-end database 

resides at the time of registration. If the activation code is incorrect, it could be caused by 

one of the following reasons: 

•        the back-end database has moved to a different server, 

•        the server network address has changed, or 
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•        the company name and address has changed from the original 

registration. 

  

The previous activation code will still work if the registration information or 

server can be changed back to its original state. If not, it will be necessary to submit a 

new product registration to Catalyst Manufacturing Support and request a new activation 

code.  

  

Catalyst Manufacturing is licensed to a business entity by physical site location on 

a server basis. Additional fees apply for activation codes needed to operate on more than 

one server at the same time. In addition, a new license is required to operate separate 

back-end databases independently at more than one site location. 

  

Create / Modify Program Shortcut 

  

During installation, program shortcuts are automatically created on the desktop 

and Windows® Programs menu. This section describes how to modify the default 

shortcut properties due to a revised file name or path of the client database. You will need 

to modify the workgroup switch, for instance, if you have moved the workgroup file from 

the local hard drive to a server location. 

   

Create a new program shortcut from scratch 

  

1. Using Windows Explorer®, navigate to the Catalyst front-end database in the 

Catalyst program folder. 

  

2. Right-click on the file and select the Send To > Desktop (create shortcut) option 

to send a copy of the database to your desktop. 

  

3. Refer to the instructions below on modifying an existing program shortcut to add 

a workgroup switch to the shortcut. 

 

Modify an existing program shortcut 

  

1. Locate and select the existing Catalyst MFG program shortcut on the Windows® 

desktop. 

  

2. Right-click the shortcut and select the Properties option from the shortcut menu. 
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3. To compel the user to login to the system with their user name, include a 

workgroup switch by adding the following text to the end of the Target field. In a 

network environment, move the workgroup file to a shared network folder and 

modify the directory path below accordingly. Please refer to the help topic, 

Enabling User-Level Security, for more information.  

 /WRKGRP "C:\Program Files\Catalyst\Catalyst.mdw" 

  

4. To activate the logon screen, the target path must also include the path and file 

name of the Microsoft Access application (MSACCESS.EXE). The Access path 

will vary depending on the Microsoft Office version or Access Runtime installed 

on the machine.  

 

"C:\Program Files\Microsoft Office\root\Office16\MSACCESS.EXE" 

“C:\Program Files\Catalyst\Catalyst v5.15.accdb” /WRKGRP "C:\Program 

Files\Catalyst\Catalyst.mdw" 

  

5. To default the user name from Windows in the logon screen, you can also add a 

user switch as follows: 

 

     /user %username% 
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6. Click OK on the Properties window to save the new shortcut properties. 

 

  

Favorites 

The Favorites tab can be customized to store the most commonly used screens 

and reports for each user. To add a button to the Favorites tab, open a frequently used 

form and click the Toggle Favorites button located in the Quick Access Toolbar 

above the Catalyst ribbon. The report filter screens in Catalyst can be added to the 

Reports button on the Favorites tab in the same manner.  

            To remove an item from the Favorites tab, open the form and click the Toggle 

Favorites button. To clear all items from the Favorites tab, click the Clear Favorites 

button  located in the Quick Access Toolbar. 
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Overview 

Catalyst Manufacturing® was designed to meet the planning, scheduling, and 

inventory needs of the small manufacturer in make-to-order, assemble-to-order, make-to-

stock, and engineer-to-order environments. Catalyst contains many of the features found 

in higher-end MRP II (Manufacturing Resource Planning) and ERP (Enterprise Resource 

Planning) systems, but without the complexity and at a price the small manufacturer can 

afford. In many ways, however, Catalyst is much better, providing features and 

functionality that can truly “accelerate the way you do business™” including: 

•       Dynamic lead times 

•       Streamlined shop order creation and release 

•       Purchase order consolidation 

•       Graphical views of route and bill-of-materials product configurations 

•       Graphical shop order views with linked sub-assemblies 

•       Finite capacity scheduling 

•       Gantt-chart production schedule board 

•       Dimensional inventory  

•       Material and labor backflush with backflush confirmation at receipt 

•       Cycle count process tools 

•       Physical inventory tools  

Catalyst organizes information and provides functionality for the basic order cycle 

processing of a typical small manufacturing enterprise including Sales, Customer Service, 

Engineering, Product Data Maintenance, Planning, Production, Purchasing, Inventory 

Control, and Shipping. On the financial side, Catalyst enables you to leverage your 

existing capabilities and expertise with a standard interface to QuickBooks Pro®, 

Premier®, and Enterprise® Editions. For more information on the different processes 

within Catalyst, refer to the following links: 

  

•       Sales and Shipping Process Overview 

  

•       Planning and Scheduling Process Overview (Streamlined) 
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•       Planning and Scheduling Process Overview (Detailed) 

  

•       Purchasing Process Overview 

 

Sales and Shipping Process Overview 

  

The process for creating customer orders and shipping to customers in Catalyst can be 

summarized in the following steps: 

  

1. Create Customer Order 

  

2. Release and Pick Customer Orders 

  

3. Prepare Shipment Paperwork 

  

4. Enter Shipment Confirmation 

  

5. Email Invoice/Advance Ship Notice 

6. Export Invoice to QuickBooks (see QuickBooks Link help reference if applicable) 

  

Planning and Scheduling Process Overview (Streamlined) 

  

Catalyst offers a streamlined approach to plan and schedule production according to the 

steps provided below. 

  

1. Run MRP 

  

2. Mass Release Shop Orders 

  

3. Run Finite Scheduler 

  

4. Create Shop Packets  

  

5. Report Labor (optional) 

  

6. Enter Shop Order Receipts  

7. Sample, Test, Release 
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Planning and Scheduling Process Overview (Detailed) 

  

The detailed planning and scheduling process includes more analysis of material and 

capacity availability and adjustments to either the schedule or capacity to balance supply 

and demand. The general steps in this process are below.  

  

1. Run MRP 

2. Review MRP Action Messages 

   

3. Review Material Availability 

4. Review Capacity Availability 

5. Mass Release Shop Orders 

6. Run Finite Scheduler 

7. Review Work Center Dispatch Reports 

  

8. Review Production Schedule Board 

  

9. Create Shop Order Packets  

10. Report Labor (optional) 

11. Issue Materials 

12. Enter Shop Order Receipts 

13. Sample, Test, Release 

14. Review Shop Order Variances 

15. Close Shop Orders (optional) 

  

The Catalyst online help documentation includes more detailed information; however, for 

a more in-depth review of the subject, please refer to MRP II: Making It Happen by 

Thomas Wallace or ERP: Making It Happen by Wallace and Kremzar. The Association 

for Supply Chain Management (www.ascm.org) is another excellent resource for 

reference materials on the subject. 

 

  

http://www.ascm.org/
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Purchasing Process Overview 

  

The general process to create and process purchase orders can be accomplished in the 

following steps. 

  

1. Create Purchase Order or Consolidate Purchase Orders 

  

2. Email Purchase Order 

  

3. Enter P.O. Receipt 

4. Sample, Test, Release 

5. Export Item Receipts (see QuickBooks Link help reference if applicable) 

6. Enter Vendor Invoice 

7. Export Vendor Bill (see QuickBooks Link help reference if applicable) 
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Data Maintenance 

The Data Maintenance tab provides options to create and maintain much of the 

foundation data for Catalyst. Refer to the Populate Data section for more information on 

initializing Catalyst with your company data. The Data Maintenance tab options are 

summarized below. 

Item Master 

Product Configuration Master 

Engineering Master 

Parametric Item Master 

 

Mass Update Orders 

Mass Update BOM/Route 

Mass Update Item Master 

Mass Update Lead Times 

 

Product Code Master 

Product Family Master 

Planning Type Code Master 

Mfg. Type Code Master 

QC Type Code Master 

QA Type Code Master 

 

Company Master 

Department Master 

Employee Master 

Event Notification 

 

Unit of Measure Master 

State/Province Master 

Country Master 
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Create / Maintain Item Master 

  

The Item Master is opened from the Data Maintenance tab and is used to store 

all part information related to inventory, planning, cost, orders, supply, product, 

specifications, and shipping data. The Item Master is used to create and maintain item 

data for inventory and non-inventory parts and form the basis of what is bought, sold, 

planned, scheduled, and transacted throughout the system. The Item Master stores default 

values, parameters, attributes and specifications related to an item.  

  

Display Item 

An item can be displayed by selecting a record from the Item No. drop-down list, 

browsing the list using the navigation buttons on the bottom of the screen, or by using 

defined search criteria to filter from a list. To search for an item, click on the search 

 button adjacent to the Item No. field. On the Advanced Item Search screen, you can 

enter filter criteria for the item number, description, status, or any combination of product 

type, product code, or product class.  

  

The search screen can be used to open discontinued or inactive items that no 

longer appear in the active Item No. drop-down list. The Description field can be used to 

enter words or phrases contained in the Short Description field e.g. “lumber” to display 

all items containing lumber in the description. To select an item from the filtered list, 

select the record and click the Select button or double-click the Item No. field. 

  

Add New Item  

            To add a new item to the Item Master, click the New button and enter a unique 

item number in the Item No. field. Proceed through the other pages of the Item Master 

and populate the fields as defined in the sections below. 

  

Copy Item 

           To copy existing items in the Item Master to a new item, click the Copy button. A 

dialog window opens that prompts you for the item to copy from and a new item number 

to copy the existing record. All item information is transferred to the new item except for 

item costs, customer and vendor parts, by-products, and dimensions/revisions, if 

applicable.  

 

Item Notes 

           To add general notes about an item, select the Notes button at the bottom of the 

screen. The comments entered for the item are used for reference only and are not copied 

to orders, product structures or any other data records. 

  

Inventory 

The Inventory page on the Item Master stores inventory-related information for 

the item. The Item Master can be used to obtain a quick look at inventory availability and 

location versus the Inventory Inquiry reports. The inventory fields are described in more 

detail by the following field definitions. 
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Long Description: contains a longer part description for the item (100 characters). 

  

Shipping Description: alternate item description used on shipping document. 

  

Lot Control?: this option specifies whether or not the item requires a lot number to be 

entered for all inventory transactions from initial receipt to final shipment. The lot 

number can be tracked using the Lot Tracking Report and Transaction History screen. 

  

Stock U/M: the unit of measure in which the item will be stocked. The units of measure 

for the application are created and maintained in the Unit of Measure Master. 

  

Purchase U/M: the unit of measure in which the item will be purchased. The conversion 

from purchase unit of measure to stock unit of measure is performed during the purchase 

order receipt process according to the conversion factor specified in either the Purchase 

U/M Conv. or Unit of Measure Master. 

   

Alternate U/M: an alternate unit of measure applicable for all item types to view 

inventory in a unit of measure other than the stock unit of measure. The conversion from 

alternate unit of measure to stock unit of measure is based on the conversion factor 

specified in either the Alternate U/M Conv. field or the Unit of Measure Master. 

   

Purchase U/M Conv.: if the item type is purchased or outside process, a conversion 

value to convert from the purchase unit of measure to the stock unit of measure during 

purchase order receipts. In addition, the inventory basis for the item can be alternated 

between the stock unit of measure and the purchase unit of measure using the Inventory 

By Location screen. The conversion value on the Item Master has precedence over any 

global conversion values maintained in the Unit of Measure Master. 

  

Alternate U/M Conv.: a conversion value to convert the inventory quantity from the 

stock unit of measure to the alternate unit of measure. The inventory can be viewed in 

either unit of measure using the Inventory By Location screen. The conversion value on 

the Item Master has precedence over any global conversion values maintained in the Unit 

of Measure Master. 

  

Cycle Count: a flag to indicate whether or not the item should be included in the cycle 

count program. To edit the cycle count properties for an item, click the adjacent edit 

button. 

  

Dimensional/Rev. Control: the item attribute setting on the Inventory page of the 

Company Master determines whether an item can be setup with dimensional inventory or 

revision control. If the item attribute setting is dimensional inventory at the company 

level, an item can be marked as dimensional. Dimensional inventory records (i.e. the 

thickness, width, and length) can then be entered for the item by clicking the edit button 

adjacent to the Dimensional field. If the item attribute setting is revision control at the 

company level, an item can be marked as revision control. Revision control records (i.e. 
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revision numbers) can then be entered for the item by clicking the edit button adjacent to 

the Rev. Control field. Dimensional inventory items cannot be saleable, serial number 

controlled, or a by-product. Revision control items cannot be serial number controlled or 

a by-product. 

  

Backflush: the Backflush flag designates that the item will be automatically issued to a 

shop order at the time of shop order receipt. The issue quantity is based on the standard 

quantity required in the bill-of-material. The Backflush flag can be changed on the 

product configuration and/or the shop order to allow for exceptions at either level. When 

backflushing lot-controlled items, the backflush consumes inventory on a FIFO basis 

using an ascending sort on the lot number. 

  

Default Warehouse: the default warehouse used for purchase order receipts and 

inventory adjustment transactions. 

  

Default Location: the default location used for purchase order receipts and inventory 

adjustment transactions. 

  

Item Status: the status of the item indicating whether the item is active, discontinued, or 

inactive. When changing the status of an item to inactive, the associated vendor part 

numbers also become inactive. If the item is subsequently reactivated, the status of the 

associated vendor part numbers must also be reactivated. 

 

Item Substitutes: the acceptable item substitutes for an item can be maintained in this 

section to replace saleable items on customer orders and bill-of-material components on 

product configurations and shop orders. The conversion factor field is used to convert the 

quantity required when making an item substitution. For example, if a substitute item 

requires 1.5 times the material of the standard item, the conversion factor value is 1.5 and 

would be multiplied by the quantity required on a product configuration or shop order 

when the item is substituted for the standard item on the bill-of-material. The effective 

start and stop dates are considered in the MRP and product costing functions and can be 

used to manage inventory obsolescence by introducing new items as old ones are 

discontinued or phased-out.  

  

To substitute an item in either the product configuration or shop order bill-of-material, 

right-click over the bill-of-material item and select the Substitute Item option from the 

shortcut menu. After selecting an item from the substitute list, click the Replace button to 

remove the current item from the bill-of-material and replace it with the substitute item. 

     

Planning 

The Planning page on the Item Master stores planning-related information 

regarding the item. The planning fields are described in more detail with the following 

field definitions. 
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Item Type: indicates whether the item is manufactured, purchased, or is an outside 

process. Shop orders and purchase orders can be entered for outside process items to 

allow linking a shop order to a purchase order line and tracking material and labor.  

  

Planner/Buyer: refers to the planner for manufactured items or buyer for purchased 

items. The planner/buyer drop-down list is populated by adding employees to the 

Employee Master. 

  

Product Family: refers to the product family for manufactured items. The product 

family is used by the Catalyst Scheduler to apply campaign rules in the sequencing of 

shop order operations based on the setup hours entered in the Product Family Setup 

Matrix. 

  

Order Policy: the order policy the system uses for calculating planned orders for an item 

during MRP. The safety stock and minimum order quantity are also considered in the 

MRP calculation, if applicable. The order policy options are as follows: 

• Discrete – calculates planned orders in quantities to meet the net requirements 

for each period. Using a discrete order policy, the planned order quantity will 

vary based on demand. 

• Fixed – calculates planned orders in fixed increments of the lot size.  

• Period – calculates planned orders by summing the net requirements over a 

specified time interval. The period order policy can be used to manage the 

number of order transactions for an item. 

• Multiple – calculates planned orders in multiples of the lot size. 

• EOQ – calculates the economic order quantity for an item. The economic 

order quantity (EOQ) is the replenishment quantity that minimizes the annual 

cost of holding inventory and the annual order costs.   

  

Lot Size: a numeric field specifying the preferred quantity to be produced or ordered for 

each shop order or purchase order, respectively. The lot size is required for MRP items 

using the fixed order policy. The lot size is also used to calculate kanban reorder 

quantities for kanban items. 

  

Min. Order Qty:  the minimum order quantity as calculated by MRP for planned orders. 

MRP will increase the planned order quantity to the minimum order quantity for any 

demand requirement below the minimum. 

  

Period Days: the number of calendar days in a time interval for items using a Period 

order policy. 

  

Safety Lead Time: the number of additional calendar days needed to buffer for 

variations in timing such as late supplier shipments and process variations.  MRP will 

offset the need date for a planned order by the safety lead time so that the planned release 

for the order is scheduled earlier by an amount equal to the safety lead time. 
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Plan Horizon: the planning horizon for the item in calendar days used to indicate the 

greater of the cumulative lead time for the item or the time required to make capacity 

adjustments for suppliers or work centers. The cumulative lead time calculation is based 

on the primary product configuration for the item and all lower-level assemblies. To 

calculate the cumulative lead time for the item, click the adjacent  button. 

Alternatively, the planning horizon for all dynamic lead time items can be updated using 

the Mass Update Lead Times option in the Data Maintenance menu. 

 

Annual Usage: the annual usage or demand in units per year. This quantity should reflect 

anticipated future demand when possible. To calculate annual demand based on MRP 

demand requirements, click the adjacent  button. 

  

Order Cost: the transaction cost for each order placed and received (excludes the cost of 

the item).  These costs include ordering, receiving, freight, inspection, sampling, testing 

and any other costs required from the time the order is placed until the material is 

released for use and the supplier is paid. 

  

Holding Cost: the annual holding cost per unit. The cost of holding or carrying inventory 

includes obsolescence, insurance, storage, material handling and any other costs 

associated with holding and preserving the safety and integrity of the material until it is 

either consumed in production or discarded. 

  

EOQ: the economic order quantity calculated using the formula 

•      where, 

D = annual usage or demand in units per year 

CT = transaction cost for each order placed and received 

CI = annual holding cost of one unit  

  

Safety Stock: the amount of additional inventory carried to cover quantity variances due 

to demand fluctuations, yield and scrap losses, or supplier defects and shortages. MRP 

generates a planned order to replenish the safety stock whenever gross requirements 

cause the projected inventory to fall below the safety stock.  

•        Type: the safety stock quantity can be either fixed or dynamic. For dynamic 

safety stock, the user must specify a minimum safety stock and days of 

inventory. The dynamic safety stock is calculated as follows: 

SS = ADR x DOI 

where,  

SS = dynamic safety stock 

ADR = average daily requirements 

DOI = days of inventory 

 

and ADR is calculated by dividing the total lead time demand by the lead 

time days for the item. To calculate the dynamic safety stock based on the 

most recent MRP run, click the Update button. 

•        Quantity: refers to either the fixed or dynamic safety stock quantity. 
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•        Minimum: the minimum safety stock. MRP uses the minimum safety stock if 

it is greater than the dynamic safety stock for the item. 

•        Days of Inventory: the number of days the dynamic safety stock is projected 

to last based on current demand. 

  

Lead Time: the lead time for an item in calendar days specified using a combination of 

fixed and variable components. The variable lead time component indicates how lead 

time varies with quantity. The lead time components are used by MRP to calculate 

release dates for planned orders. The release dates are calculated by subtracting the 

planned order due date by the lead time. The total lead time for an item equals the fixed 

lead time plus the variable lead time multiplied by the order quantity. The safety lead 

time creates an additional offset if applicable. 

•        Dynamic: if the dynamic flag is set, the fixed and variable lead times can be 

reset using the Mass Update Item Master utility or during MRP by selecting 

the ‘Update lead times’ MRP option. The fixed and variable lead times are 

calculated based on the standard times specified in the primary product 

configuration for the item. 

•        Fixed: the fixed portion of the lead time component. If the item is dynamic, 

the fixed lead time is calculated from the setup hours of the primary product 

configuration for the item. 

•        Variable: the variable portion of the lead time component. If the item is 

dynamic, the variable lead time is calculated from the run hours of the primary 

product configuration for the item. 

     

Phantom: indicates whether or not the item should be treated as a phantom bill-of-

material. A phantom item is used in the bill-of-material to indicate that MRP should 

“blowthrough” the phantom level to its child components. A phantom bill-of-material 

represents an item that is physically built, but rarely stocked, before being used in the 

next step or level of manufacturing (APICS Dictionary). The phantom level allows for 

the use of a common bill-of-material structure that can be reused on other product 

configurations. A phantom item must have a discrete order policy and cannot be a master 

scheduled or make-to-order item. In addition, neither shop orders nor inventory 

transactions are allowed for phantom items. 

  

Kanban:  a flag to indicate whether to plan replenishments based on demand pull signals 

instead of MRP results. Replenishments for kanban items are signaled when the projected 

inventory balance falls below the reorder point level. Orders for items that meet this 

condition can be automatically released using either the Mass Release Control Board or 

P.O. Consolidation screen. The kanban items are also summarized on the Kanban 

Reorder Point Report. The lot size serves as the default order multiple for kanban items. 

  

Make-To-Order: a flag used to designate whether or not a manufactured item is make-

to-order. A make-to-order item must always have a shop order linked to the customer 

order line. The make-to-order setting should only be used if the entire order quantity for 

the item must always be made and a one-to-one relationship between the order line and 
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shop order exists. A shop order receipt transaction must be entered prior to shipment 

unless the item is non-inventory. 

  

Non-Inventory: a flag used to designate whether or not a purchased item is a service or 

non-inventory item. If the flag is set, then inventory will not be updated for the item 

during a purchase order receipt. 

  

Master Schedule: a flag to indicate whether the item is master scheduled. Only 

manufactured and outside process items can be master scheduled. 

  

Pick List: a flag to indicate whether to include the item on the shop order pick list. This 

allows items to be listed on the bill-of-material, but excluded from the pick list, for 

instance, if the item is already stocked in the work center location 

  

Auto-create SO: a flag to designate whether an outside process shop order is 

automatically created and linked to the PO line when a purchase order is created for an 

outside process item. A linked outside process shop order on the PO line enables the 

creation of a pick list for materials to be sent to the outside contractor and the backflush 

of those materials at the time of the PO receipt. 

 

Planning Notes: item-specific planning notes that are maintained for the planner or 

buyer for material planning purposes.  The notes could include obsolescence or depletion 

plans, minimum order rules, container sizes, or other material planning or purchasing 

information.  The planning notes are displayed as a reference on various material 

planning screens such as Material Planning, Master Scheduling, Mass Release Control 

Board, and Purchase Order Consolidation screens. 

    

Cost 

The Cost page contains product class, general ledger reference accounts, and unit 

cost information for the item. The assignment of a product class to an item automatically 

associates the general ledger revenue, inventory, cost of goods sold (COGS)/expense, and 

inventory adjustment accounts. The account references are maintained on the Costing 

page of the Company Master. 

  

The Unit Cost frame stores the average cost and standard costs for material, 

labor, overhead, and shipping. Refer to the Costing Methods help topic for more 

information on the use of average and standard costs within Catalyst. For dimensional 

inventory or revision control items, the Unit Cost frame displays the unit costs for each 

dimensional inventory or revision number record. For outside process items, the material 

cost includes the outside process cost which is referenced on the Unit Cost frame. The 

average cost value is updated automatically as receipts are entered for the item. The 

standard cost values are populated using the Update Raw Material Standard Costs and 

Perform Product Cost Rollup functions located in the Financial menu. The Frozen flag 

can be selected for an item to prevent the automatic update of standard costs during a 

product cost rollup. 
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The product cost rollup function updates material, labor, and factory overhead 

costs for items with a production configuration. The administrative overhead (selling, 

general, and administrative) and shipping costs are assigned manually. The shipping cost 

represents a unit freight cost for the item or an allocated landed cost for imported items. 

For more information on landed cost allocations, please refer to the Allocate Landed 

Costs section of the Enter P.O. Receipts help topic.  

 

Orders 

           The Orders page contains sales order information for an item. The page content is 

summarized below.  

    

Default Sales Price: the default sales price method is used to determine a default sales 

price when the item is added to a customer order. The default sales price is based on one 

of the following options: 

•        Fixed: a fixed unit sales price based on the list price for the item. 

•        Vary by customer price level: the default sales price derived from either 

the item price assigned to the customer’s price level or a fixed discount or 

markup percentage for the customer’s price level. Price levels are created 

and maintained in the Sales Price Level Maintenance screen. 

•        Vary by quantity: the default sales price is based on the quantity ordered 

as maintained on the Sales Price Quantity Breaks screen.  

•        Vary by customer item: the default sales price is determined by the price 

of the customer item as maintained in the Customer Items section. 

  

List Price: the list unit sales price for the item. The list price is expressed in terms of the 

domestic (home) currency and stock unit of measure. The list price is used as the basis 

when determining the default sales price by either the fixed sales price or customer price 

level methods as described below. 

  

Product Code: indicates the sales category or product grouping for the item to be used 

for organizing and presenting information for items. 

  

Saleable Item?: indicates whether or not the item can be sold. If the flag is set, the item 

can be added to an order line during Customer Order Entry. 

  

Taxable?: indicates whether or not sales tax applies to the item when calculating the 

sales tax amount on a customer or vendor purchase order.  

  

Sales Forecast Consumption: if a forecast is maintained for saleable items, the forecast 

is consumed in either monthly buckets or by a date range determined by the forecast 

consumption days.  When using forecast consumption days, the sales order quantity 

consumes the forecast around the requirements date by the specified number of days 

before and after the requirements date.  If forecast consumption days are not specified for 

an item, the forecast is consumed in monthly buckets.  If the sales order quantity exceeds 

the forecast quantity in the forecast consumption date range, it continues to consume the 
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forecast specified in later periods until the order quantity has been fully consumed.  For 

more information on forecast consumption, refer to the Forecast Master help topic.   

  

Customer Items: the customer items section supports the ‘Vary by customer item’ sales 

price method and includes fields to store customer-specific part number, NDC number, 

and pricing information. During Customer Order Entry, the customer part number and 

price are included when adding a line item to the order. The default price is stated in 

terms of the stock unit of measure and the customer’s currency basis.  

  

Open Sales Orders: list displays open customer orders for the item. To open a specific 

order, double-click the order in the Sales Order field.  To view the sales order history for 

an item, click the Order History toggle button. The adjacent Print button can be used to 

print either open orders or order history depending on the current state of the toggle 

button.   

 

Supply 

The Supply page on the Item Master contains information to view and manage 

replenishment orders for manufactured and purchased items. The Under Recpt. Tol. 

refers to the percentage a shop order or purchase order can be under-received. Similarly, 

the Over Recpt. Tol. refers to the percentage a shop order or purchase order can be over-

received. When entering a shop order or purchase receipt transaction, a hard stop is 

applied to quantities entered greater than the over-receipt tolerance and a soft warning for 

any under-receipts. To allow an over-receipt transaction to be processed, either the order 

quantity or over receipt tolerance must be revised.  For example, if the over-receipt 

tolerance for an item is 10% and the order quantity is 200 units, a shop order receipt 

quantity would be permitted up to a quantity of 220 units.  If the actual quantity produced 

against a shop order exceeds 220 units, either the shop order quantity or over-receipt 

tolerance for the item would need to be increased to allow the full quantity to be 

received.  The under and over receipt tolerances are guides intended reduce entry 

errors.  The allowable range, therefore, should be set to accommodate the typical receipt 

variance for an item and only warn the user when the quantity falls outside the normal 

range.  

  

The Issue Tolerance specifies the percentage of the batch that must be consumed 

before the associated shop order automatically changes to a ‘Complete’ status.  The Issue 

Tolerance is used in conjunction with the Completion % to allow partial balances of a 

shop order to continue to net against upper-level demand and prevent the creation of 

unnecessary planned orders due to yield losses. The Issue Tolerance only applies when 

both the item and its parent use a ‘Fixed’ order policy. 

  

The Completion % indicates the percentage at which a shop order, customer 

order line, or purchase order line changes to ‘Complete’ based on a receipt or shipment 

transaction. For instance, for a purchase order with multiple line items, the receipt of a 

single line item at the stated completion percentage changes the order line status to 

‘Complete’ and the PO status to ‘Partial’. The PO status only changes to ‘Complete’ 
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when all order lines have been completed. The completion percentage is calculated by 

dividing the total quantity received or shipped by the order quantity. 

   

For purchased and outside process items, the Supply page displays vendor and 

manufacturer sections. The Primary Vendor is used as a default when purchase orders 

are generated on the Material Planning and Purchase Order Consolidation screens. While 

there can only be one primary vendor, you can select an unlimited number of alternate 

vendors in the Vendor Items section.  

  

The Default Purchase Price assigned to a purchase order is based on one of the 

price options described below. The purchase price is based on the purchase unit of 

measure and the vendor’s currency for all default purchase price options except for Fixed.  

•         Fixed: a fixed unit purchase price stated in terms of the company currency 

and stock unit of measure. For dimensional inventory or revision control 

items, the fixed price is maintained on the dimensional inventory or 

revision number record. 

•         Use last P.O. price: price is based on the last purchase order price. The 

last purchase order price is vendor-specific so the default price is based on 

the last time the item was ordered from a specified vendor. 

•         Vary by quantity: price is based on the quantity ordered as maintained on 

the Purchase Price Quantity Breaks screen.  

•         Vary by vendor item: the purchase price is assigned based on the price of 

the vendor item as maintained in the Vendor Items section.   

  

The Vendor Items section is used to enter vendor part number, NDC number, 

audit rating, primary manufacturer, and default price information for the item as it relates 

to a specific vendor. The vendor price and part number are assigned to a PO line when a 

vendor item is selected during Purchase Order Entry. The Purchase Order Entry screen 

includes a Filter button in the detail section which is used to display vendor items for the 

vendor assigned to the purchase order. The Vendor Items section includes three buttons 

with the following actions: 

•         Print: opens the Vendors by Item Report for the currently selected item. 

•         Documents: opens a window to assign a document, such as an item 

specification or routing, to the vendor item. The vendor document is 

assigned to a PO line when the vendor item is added to the purchase order. 

•         Purchase: creates a purchase order for the currently selected vendor item. 

This button gives the buyer a mechanism to place an immediate order for a 

specific vendor item instead of using the PO Consolidation or Purchase 

Order Entry screens. 

  

The Manufacturers section is used to enter manufacturer part numbers and notes 

that can then be assigned to vendors listed for that item. Only approved manufacturers 

can be assigned to vendors items in the Vendor Items section.  

  

Open Supply Orders: list displays open shop orders or purchase orders for the item. To 

drill-down and view the order detail, double-click on the Source field for an order in the 
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list. For outside process items, only the purchase order appears in the list of supply 

orders. Any outside process shop orders can be viewed from the Purchase Order Entry 

screen by drilling-down on linked shop orders. To view the order history for an item, 

click the Order History toggle button. The adjacent Print button can be used to print 

either open orders or order history depending on the current state of the toggle button. 

 

Engineering 

The Engineering page stores revision and master data related information for the 

item. These fields in in this category are described below. 

   

Revision No.:  the current revision number for the item. The revision number can be 

maintained through Engineering Change Orders by clicking the adjacent edit button. 

When a revision number is selected from the drop-down list, the drawing/specification 

file associated with the revision is loaded automatically into the Specification File field. 

  

Specification File:  the path and file name for the specification file associated with an 

item.  The Browse button is aused to add a file path and file name by searching local or 

network drives.  The supported file types include Microsoft Word® (.doc, .rtf, .htm, 

.html), Adobe Acrobat® (.pdf), AutoCAD® (.dwg, .dwf, .dxf), and common graphic files 

(.jpg, .gif). For graphic file types, a thumbnail image of the file is displayed adjacent to 

the path. The specification file can be opened by clicking the open folder image beside 

the Browse button.   

  

Include file on:  the specification file specified on the Item Master can be automatically 

added to a purchase order or product configuration as indicated below.  

•         Purchase order line? check box to automatically include the specification file 

when the item is added to a purchase order line.  If the specification file is 

changed on the Item Master and the change is effective immediately, any open 

purchase orders for the item must also be updated. 

•         Product configuration? check box to automatically add the specification file to 

a product configuration.  If a specification file is assigned to the product 

configuration, it is copied to any new shop orders when the shop order is 

created.  If the specification file is changed on the Item Master, it must be updated 

on the product configuration for the item.  If the change is effective immediately, 

any open shop orders for the item must also be updated. 

  

File Listing: the file list for an item includes the first 20 files stored in the Specification 

File for the item. The file list provides a quick reference to view and open any files that 

have been saved in the same folder as the master drawing or specification file.  

  

Part Notes: memo field for item-specific notes and comments. 

  

Plan Type Code: a product type used by the Planning department to categorize and sort 

material codes. 

  



Catalyst Manufacturing User Manual

 

31 

Mfg. Type Code: a product type used by the Manufacturing department to categorize 

and sort material codes. 

  

QC Type Code: a product type used by the Quality Control department to categorize and 

sort material codes. 

  

QA Type Code: a product type used by the Quality Assurance department to categorize 

and sort material codes. 

 

Testing 

The Testing page on the Item Master stores product-specific information relevant 

to the pharmaceutical industry. The field definitions are included below. 

  

Retest Date Offset: the number of days or months, depending on the specified units, 

from the last test date that retesting is required.  When using daily units, the retest date is 

calculated based on the specified number of days from the last test date.  When using 

monthly units, the retest date is calculated as the month ending date prior to the 

calculated retest date.  If a retest is not required for the item, then select ‘None Required’. 

  

Expiration Date Offset: the number of days or months, depending on the specified units, 

from the manufacturing date that the batch expires.  When using daily units, the 

expiration date is calculated based on the specified number of days from the 

manufacturing date. When using monthly units, the expiration date is calculated as the 

month ending date prior to the calculated expiration date.  If lot expiration does not apply 

for an item, then select ‘None Required’. 

  

Release Required? this option specifies whether or not a batch must be released prior to 

use in production. If release is required, the batch is received into inventory in 

‘Quarantine’ status. If release is not required, the batch is received into inventory in 

‘Approved’ status. 

  

Testing Required? this option specifies whether or not a batch must be tested prior to 

being dispositioned.  

  

Contains API? this option specifies whether or not the item contains API (active 

pharmaceutical ingredient). During batch record review, the reviewer is required to enter 

an active added date for items that contain active material. 

  

Test Specifications: the test specifications for an item are entered and maintained by test 

category as described in the steps below.  The test specifications are added to the Batch 

Tracking Log when a new batch record is created for the posting of test results for a 

batch. 

  

1.      Enter a Test Category name.  To add a new category, click the  button.  To 

move between existing test categories, use the navigation buttons 
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.  To delete a category, click the  button.  Deleting a 

test category also deletes the test specifications added to that category. 

  

2.      To enter a specification, move to the Test Specifications section below the test 

category and enter a Test Name, Test Method and Specification.  Add new 

specifications to the category by using the Tab or Enter key to move to a new 

record . 

  

3.      Repeat the steps above to populate all test specifications for each category. 

  

Shipping 

The Shipping page contains fields to store information used on the shipping 

documents, namely the packing list and bill of lading. 

  

Ship Description: shipping commodity description that defaults on customer shipment 

documentation. If the ship description is not populated, the short description is used as 

the default item description for the shipping documentation. 

  

Hazardous Mat’l: a flag used to indicate if the item is considered a hazardous material 

during shipment. Hazardous materials are identified on the bill of lading. 

  

DEA Registration Req’d: a flag used to indicate whether or not DEA registration is 

required for an item when it is ordered by a customer or from a vendor.  If DEA 

registration is required, the item can be added to an order line only if the customer or 

vendor has a valid, unexpired DEA license number. 

  

NMFC Item No.: the National Motor Freight Classification item number used to classify 

your goods. 

 

Freight Class: The freight class of the commodity as classified by the National Motor 

Freight Classification (NMFC). The freight class appears on the bill of lading. 

  

Unit Weight: the weight in pounds or kilograms of one unit per stock unit of measure. 

The unit weight is used to provide a default shipping weight when the item is added to a 

shipping document. 

  

Package Type: the type of package i.e. cartons, bundles, rolls, or drums. The package 

type appears on the bill of lading. 

  

Package Quantity: the standard quantity of a product (expressed in the stock unit of 

measure) packed into a package or shipping container. 

  

Package Weight: the weight of a standard packaged product (expressed in the shipping 

weight unit of measure). 
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Pallet Quantity: the number of stock units included in a standard unit pallet load. The 

pallet quantity is used to calculate a default number of pallets when adding the item to a 

ship appointment or shipment document.  

  

Pallet Load Wgt: the net weight (excluding pallet weight) of a standard unit pallet load. 

The pallet load weight is expressed in the shipping weight unit of measure and is used to 

calculate the net weight of a pallet load when adding the item to a shipment. 

  

Pallet Weight: the weight of the actual pallet used to stack the item. The pallet weight is 

expressed in the shipping weight unit of measure and is used to calculate the gross (total) 

weight of a shipment. 

  

Value Field: a user-defined numeric value. 

  

Text Field 1: user-defined text field (maximum 50 characters) 

  

Text Field 2: user-defined text field (maximum 50 characters) 

 

Change History 

The Change History page displays information on the user who created and 

changed the item record and the date and time the change was made. The change 

information includes updates made to subsections of the item record including customer 

items, vendor items, manufacturer items, by-products, item substitutes, and item costs.  

The Change History page also includes the audit trail for changes made to the item 

master record. 

      

Audit Notes 

The Audit Notes page provides an audit trail of changes made to the item costs, 

test specifications, customer items, and vendor items.   

 

Create / Maintain Product Configuration Master 

 

The Product Configuration Master is opened from the Data Maintenance tab 

and is used to build and maintain the route and bill-of-material (BOM) for a 

manufactured or outside process item. The operations and materials are entered on the 

Bill of Resources page and displayed graphically on the Indented View page. The multi-

level bill-of-material structure can also be printed by clicking the Print button at the 

bottom of the screen. 

  

The parent-child relationship in the primary product configuration is the basis for 

the material requirements planning (MRP) BOM explosion. The product route of the 

primary product configuration is used to calculate work center capacity requirements and 

standard material, labor, and overhead costs. The product configuration is also used as a 

basis for creating shop orders for the parent item.  A copy of the product configuration is 

made each time a shop order is created for a parent item. 
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 When viewing the indented product structure, the View Filter allows you to 

change the graphical display to the bill-of-material, route, or a combination with the 

materials listed below their assigned operation sequence. The Item Filter allows you to 

filter the graphical display to view the bill-of-material components by operation sequence 

number. The Indented View page also contains the fields to calculate the cumulative lead 

time for the product configuration or perform a product cost rollup. These two features 

are described in more detail below. 

   

• Define Product Configuration 

o Header 

o Product Route 

o Bill-of-Material  

• Create Product Configuration 

• Copy Product Configuration 

• Create/Maintain Product Route 

o Substitute Alternate Work Centers 

• Create/Maintain Bill-of-Material 

o Create Linked Sub-Assemblies 

o Substitute Alternate Materials  

o Drill-Down Bill-of-Material  

o View BOM Revisions 

o Update matching BOM items 

• Enter Operation Notes 

• Enter Bill-of-Material Notes 

• Enter Engineering Notes 

• Enter Revision Notes 

• Attach Drawing/Spec File 

• Review Indented BOM Report 

• Perform Cost Rollup 

• Calculate Cumulative Lead Time 

• Review Audit Notes 

  

Define Product Configuration 
Header 

Parent: refers to the parent item number for which the product structure is being built. 

  

Description: a description of the parent item from the short description field in the Item 

Master. 

  

Dimension/Revision No.: the dimension code for the item if the parent item is identified 

as dimensional in the Item Master or the revision number if the parent item is identified 

as revision controlled in the Item Master. The item attribute setting on the Inventory page 

of the Company Master determines whether an item can be setup with dimensional 

inventory or revision control. 
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Eng. ID: the engineering identification number (integer) to distinguish between product 

configurations for the same parent item. The Engineering ID field would be used to refer 

to primary and alternate configurations.  The default Eng. ID is equal to 1 and refers to 

the primary product configuration for the item. 

  

Primary: specifies whether the configuration serves as the primary or alternate 

configuration for the item. The Eng. ID will always be equal to 1 for a primary 

configuration and greater than 1 for an alternate configuration. To change an item from a 

primary to an alternate configuration and vice versa, you can either check or uncheck the 

Primary field or manually change the Eng. ID values. 

   

Quantity: the quantity of the parent item for which the configuration refers. This value is 

typically equal to one, but could be greater than one when specifying the configuration of 

a batch or multiple.  When the quantity is greater than one the quantity required on the 

bill-of-material should be based on the batch quantity.  Material requirements will be 

based on the parent order quantity divided by the batch quantity multiplied by the 

quantity per on the bill-of-material. 

  

Yield: the process yield for the parent item expressed as the final amount completed 

during production divided by the initial amount. A lower process yield will result in 

higher planned order quantities for the parent item on the product configuration. For 

example, using the formula OrderQty = QtyReq / Yield, if 100 units if an item are 

required, but the process yield is 90%, 111 units would need to be started in production to 

yield 100 final units. The process yield for the parent and the scrap percentage for a 

component item are independent. Therefore, the gross requirements for a component item 

are affected by both the scrap rate of the component and process yield of the parent. The 

scrap calculation for a component item is QtyReq = FormulaQty * (1+Scrap%). For 

example, if 2 stock units are needed of a particular component material to build a single 

parent item, then, using a 5% scrap factor for the component and a process yield of 90% 

for the parent, the demand requirement for the component would be 2.10 units 2 * (1 + 

.05) to account for the scrap divided by .90 for the yield loss to equal a total of 2.33 units 

for each parent item produced. 

  

Revision: the revision field is used to store a revision number or reference for the product 

configuration. The revision number can be assigned from a list of revisions maintained in 

the Engineering Change Control Master or entered without a change control reference. If 

the item is revision controlled, the revision field is replaced by the Revision No. field 

defined above.  

   

Product Route 

The Operations section lists the sequence of operations required to produce the 

item. The sequence of operations defines the route for an item. The operations can be 

selected from a drop-down list for standard operations or entered directly into a line. An 

operation can also be edited once it has been added to the route. The Operations section 

contains the following fields: 

  



Catalyst Manufacturing User Manual

 

36 

Seq.: the sequence number for the operation. Typically, these are specified in increments 

of 10 to allow for later insertions or modifications. 

  

Opn: the operation identification number from the Operations Master. 

  

Operation Description: a brief description of the operation. 

  

Work Center: the name of the work center. 

 

Tooling: the default tool assigned to the operation. The tool list is maintained in the 

Tooling Master. 

  

Setup (hrs): the setup hours for the operation. 

  

Run Rate: the run rate for the operation, which defaults to the rate setup for the standard 

operation, but can be revised for each product configuration.  The units are based on the 

Run Units field. 

  

Run Units: the unit of measure for the run rate, which can be expressed as Units/Hr, 

Hrs/Unit, or Hrs/Batch. The hours per batch setting allows entering a fixed run time that 

applies to the batch parent quantity on the product configuration. When using units per 

hour or hours per unit, the total operation run hours is divided by the parent quantity to 

determine the required hours per unit. 

  

Queue (hrs): the queue time expressed in hours for an operation. The queue time occurs 

before an operation starts and represents the time spent waiting before the operation can 

enter the work center resource. The queue time represents a component of fixed lead time 

for an item. The queue time is also used by the finite capacity scheduler to offset the 

scheduled start time for an operation. The finite scheduler assumes queue hours transpire 

during both work and non-work periods. If queue hours occur only during work periods, 

you will need to create a separate operation and load the queue hours as setup hours or 

simply add the queue hours to the setup time of the preceding operation. 

  

Move (hrs): the move time expressed in hours for an operation. The move time occurs 

after the operation is completed and represents the time spent in-transit to the next 

operation. The move time represents a component of fixed lead time for an item. The 

move time is used by the finite capacity scheduler to offset the scheduled start time for 

the next operation. The finite scheduler assumes move hours are performed during both 

work and non-work periods. If move hours occur only during work periods, you will need 

to create a separate operation and load the move hours as setup hours or simply add the 

move hours to the setup time of the next operation. 

  

Min. Move: the minimum percentage completion of the current operation before it can 

proceed to the next downstream operation for processing. The default percentage of 

100% means that the operation must complete all units before the next operation can 
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start. A lower minimum move percentage reduces the cycle time for an item and results 

in a more compressed schedule. 

  

Operators: the number of operators required to perform operation. 

  

Backflush: a flag used to indicate whether the standard setup and labor quantities for the 

operation should be backflushed at the time of shop order receipt. 

  

Campaign: a flag used to indicate whether or not to apply campaign rules to the 

operation when generating a finite capacity schedule. If campaign rules are used, the 

setup hours for the operation will be reduced or eliminated when the operation is 

sequenced after the same item or product family. 

   

Bill-of-Material  

The Materials section lists the child items or components required to produce the 

parent item. Each child item is assigned a sequence number from the route to indicate the 

operation the material is required. The child items are selected from a drop-down list of 

items in the Item Master. The Materials section contains the following fields: 

  

Seq.: the sequence number from the above routing where the materials need to be issued. 

This allows the need date for materials to be based on the scheduled start time of the 

operation. 

  

Item No.: the item number for the component material. Double-clicking the field drills 

down the bill-of-material to find the primary product configuration for the item. 

  

Description: the short description of the item from the Item Master. 

  

Setup Qty: a fixed quantity of material required to clean, changeover, or perform some 

other setup activity. The setup quantity does not vary based on the parent build quantity.  

  

Qty Per: the quantity of the material required to produce the configuration quantity for 

the parent item. The quantity required should be based on the stock unit of measure in the 

Item Master. 

  

U/M: the stock unit of measure for the child item quantity. 

  

Scrap%: the scrap percentage incurred during the production process. The gross 

requirements for an item will be increased by its scrap factor. For example, if 10 units of 

a component are required to build a single parent item, but the component has a 10% 

scrap rate, approximately 11 units 10*(1 + .10) of the component need to be planned in 

production. 

  

Dimension/Revision No.: the dimension code for the item if the child item is identified 

as dimensional in the Item Master or the revision number if the child item is identified as 

revision controlled in the Item Master. The item attribute setting on the Inventory page of 
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the Company Master determines whether an item can be setup with dimensional 

inventory or revision control. 

  

Eff. Start: the effective start date of the child item on the current bill-of-material. The 

effective start and stop dates are considered in the MRP and product costing functions 

and can be used to manage inventory obsolescence by introducing new items as old ones 

are discontinued or phased-out. 

  

Eff. Stop: the effective stop date of the child item on the current bill-of-material. The 

effective start and stop dates are considered in the MRP and product costing functions 

and can be used to manage inventory obsolescence by introducing new items as old ones 

are discontinued or phased-out. 

   

Backflush: the backflush flag that determines whether the child item will be 

automatically issued when a shop order receipt transaction is entered.  If the backflush 

flag is set, the child item is issued from inventory to the shop order based on the standard 

usage including scrap. The backflush flag can be changed on individual shop orders if 

desired. 

  

Link Sub: a flag to indicate whether to link the item as a sub-assembly to the parent item 

when shop orders are created for the parent item. A linked sub-assembly cannot be 

specified for phantom items. 

  

Phantom: indicates whether or not the bill-of-material item is a phantom. The Phantom 

flag is set on the Item Master and indicates whether or not the item should appear on the 

Shop Order Traveler. For phantom items, the lower-level components on the phantom’s 

bill-of-material appear on the Shop Order Traveler instead of the phantom item itself. 

Accordingly, material issue transactions are entered for the phantom bill-of-material 

components instead of the phantom item itself. The inventory for phantom items is 

typically not tracked or controlled. 

    

Create Product Configuration 
            To create a new product configuration for a parent item, click the New button at 

the bottom of the screen. A screen appears that prompts you for the basic information 

required to create a new product configuration. The drop-down list for the Parent 

contains all of the manufactured and outside process items. Select an item from this list to 

create a new product configuration. The parent quantity can be changed from its default 

of 1 to indicate a batch or production lot size. If no other product configuration exists for 

the item, then the Eng. ID will default to 1 to indicate that it is the primary configuration. 

The Eng. ID can be edited as long as it does not conflict with an existing configuration 

for the same item. Any Eng. ID greater than one refers to alternate configurations for an 

item. Click the Save button to create the product configuration and begin entering the 

route and bill-of-material information. 

  

           If the parent is a dimensional inventory item, a dimension code must be selected 

for the product configuration. The configuration is subsequently referenced by a 
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combination of the item number and its dimensions for the purpose of uniquely 

identifying the item. Likewise, if the parent item is a revision controlled item, a revision 

number must be selected for the product configuration. The configuration is subsequently 

referenced by a combination of the item number and its revision number for the purpose 

of uniquely identifying the item. 

  

           The route and bill-of-material for a new product configuration is built by adding 

operations and materials, respectively. Typically the route is created first by selecting a 

standard operation from the Opn drop down list or by entering non-standard operations 

directly. The Seq number identifies the order in which the operations are performed on 

the shop floor. Next, materials are added by selecting items from the Item No. drop-

down list. Each child item must reference an operation sequence number in the product 

route for it to be displayed in the indented view. The Run Rate for a product 

configuration is always based on the Run Units, either “Hrs/Unit”, “Units/Hr”, or 

“Hrs/Batch”. The batch quantity refers to the parent quantity entered for the product 

configuration. The Qty Per for the materials should always be based on the quantity 

required to build the parent quantity. The parent quantity can be a single unit or batch 

quantity. When a shop order is created, the shop order quantity is divided by the product 

configuration quantity to determine the operation hours and material requirements for the 

shop order. 

  

Copy Product Configuration 
For items with similar product structures, an existing product configuration can be 

copied to a new configuration to save time and effort. A product configuration template 

can be created for certain product types or models to be used as a starting point for new 

configurations. Another application is in the creation of alternate bills and routes that may 

vary only slightly from the primary configuration. To copy an existing product 

configuration, click the Copy button located at the bottom of the screen. Enter a Base 

Config. product configuration master and a Copy To Item using the respective drop-

down lists. The Eng. ID for the new configuration automatically increments if a 

configuration already exists for the item. Click the OK button to copy and display the 

new configuration in the Product Configuration Master. 

   

Create/Maintain Product Route 
            Operations can be added to a product configuration route in one of several ways. 

If the operation is unique and will not be replicated, the operation can be added by 

entering a sequence number, operation description, work center, setup, run rate, and run 

units manually. This is the most time-consuming method and does not allow the 

operation to be automatically updated when bulk changes are made through the Operation 

Master, but it may be appropriate for non-standard or infrequent production runs.  

  

A more efficient method involves selecting a standard operation from the Opn 

drop-down list to automatically populate the required fields. The operations in the drop-

down list are populated from the standard operations entered in the Operation Master. 

While some initial effort is required to establish the standard operations, the process of 

building the route can occur much more rapidly. A standard operation can be edited after 
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adding it to a route to reflect variations from standard or alternate route considerations. 

The required run hours for the operation are obtained from either the default run hours in 

the Operation Master or the Operation Time Scale depending on whether or not the 

operation times vary non-linearly with the parent quantity. The run hours for the 

operation also depends on the parent build quantity for the configuration. 

  

A still more productive method to build the product route involves loading 

standard operations from a list using the Load Operations screen. The Load Operations 

screen can be opened by right-clicking an operation record and selecting ‘Load standard 

operations’ from the shortcut menu. The Load Operations screen lists all available 

standard operations in the Available list. Standard operations can be moved to the 

Selected list by double-clicking an operation or selecting multiple operations and 

clicking the right arrow button. Click the OK button to load the selected operations into 

the current route. The sequence numbers are automatically generated beginning with the 

last existing operation sequence number and incrementing by 10 for each operation. The 

sequence of operations can be changed after they are loaded into the route by revising the 

Seq field manually. As before, the required run hours for the operations are obtained 

from either the default run hours in the Operation Master or the Operation Time Scale 

depending on whether or not the operation times vary non-linearly with the parent 

quantity. 

  

Substitute Alternate Work Centers 

           To substitute a work center on a route operation with an alternate work center, at 

least one alternate work center must be specified on the Alternates page of the Work 

Center Master. To substitute a target work center for an approved alternate work center, 

right-click over the work center on the route and select the Alternate Work Center 

option from the shortcut menu. A dialog box opens which displays the alternate work 

centers for the selected record. Select a work center from the list and click the Replace 

button to remove the current work center and replace it with the alternate. 

   

Create/Maintain Bill-of-Material 
            Materials are added to existing product configurations by selecting an item from 

the Item No. drop-down list. After a selection is made, the item is loaded with the default 

values from the Item Master. Enter a Qty Per to indicate the child item quantity required 

to build the parent quantity. Enter values in the remaining fields based on the field 

definitions provided above. Each material must have a sequence number that relates to an 

operation in the route. The sequence number assigned to the child item defaults to the 

currently selected operation.  

 

Create Linked Sub-Assemblies 

            When adding or editing materials, the Link Sub field can be used to indicate that 

the child item should be planned and scheduled as a sub-assembly to the parent. When 

the Link Sub field is checked, a shop order for the child item will be created at the same 

time as the shop order for the parent. The shop orders will be linked so that they can be 

planned and scheduled together. The Shop Order Master displays both the parent and 

sub-assembly shop order simultaneously. 
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Substitute Alternate Materials 

           To replace a bill-of-material component with an alternate item, the item must have 

at least one alternate item specified on the Engineering page of the Item Master. To 

substitute a target bill-of-material component for an approved substitute from the Item 

Master, right-click over the bill-of-material item and select the Substitute Item option 

from the shortcut menu. A screen appears which displays the current substitutes for the 

item and the conversion values necessary for the substitution. Select an item from the 

substitute list and click the Replace button to remove the current item from the bill-of-

material and replace it with the substitute item. The Qty Per amount on the BOM record 

is adjusted by the conversion factor of the substitute item. 

   

Drill-Down Bill-of-Material 

            To view upper or lower levels in the bill-of-material, click the Up  or Down 

 icons next to the Item No. label in the Materials section. The Product Configuration 

Master will be updated with the parent or child configuration for the currently selected 

child item record. The drill-down also occurs when double-clicking the child item 

number directly. 

 

View BOM Revisions 

            To view the current engineering revision for a BOM component, right-click over 

the bill-of-material item and select the View BOM Revisions option from the shortcut 

menu. The Engineering Change Control Master opens for the item with references to the 

current revision and change control history. 

 

Update Matching BOM Items 

            To apply bill-of-material changes on a component to other product configurations 

or shop orders, right-click over the bill-of-material item and select the Update Matching 

BOM Items option from the shortcut menu. The Mass BOM Update screen opens with 

options for you to update the same BOM component listed on other product 

configurations and shop orders with the changes made to the currently selected BOM 

record. To apply the changes to all matching BOM items regardless of sequence number, 

uncheck the Seq. No. checkbox.   

 

Enter Operation Notes 
            The Operation Notes button allows adding or editing operation notes for each 

step in the product routing. The operation notes are copied to the shop order route when a 

new shop order is created. The shop order operation notes are also printed on the Shop 

Order Traveler that is sent to the shop floor. 

   

Enter Bill-of-Material Notes 
            The BOM Notes button allows adding or editing notes for each bill-of-material 

component. The bill-of-material notes are copied to the shop order when a new shop 

order is created. The shop order bill-of-material notes are also printed on the Shop Order 

Traveler sent to the shop floor. The bill-of-material notes can be used to store information 

specific to an item on the product configuration such as part placement or location. 
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Enter Engineering Notes 
            The Engineering Notes button displays a memo field for storing notes specific to 

the parent item's product configuration. The engineering notes are copied to the shop 

order when a new shop order is created. The shop order notes also print on the Shop 

Order Traveler. 

 

Enter Revision Notes 
            To track changes made to a product configuration, revision notes can be entered 

by selecting the Admin tab and adding a new record in the Revisions section. Although 

product configuration changes can be tracked through the Engineering Change Control 

Master, the revision history offers a more immediate reference of changes and can be 

used to document changes that are not tracked in a formal engineering change control. 

 

Attach Drawing/Spec File 

         The Drawing File button opens a dialog box for you to select and attach a drawing 

or specification file to the product configuration.  If a drawing file is assigned to the 

product configuration, it is copied to any new shop orders when the shop order is 

created.  The drawing file can be updated if required for any changes or revisions.  If the 

change is effective immediately, any open shop orders for the item must also be updated 

with the new drawing file.  The supported drawing file types include Microsoft Word® 

(.doc, .rtf, .htm, .html), Adobe Acrobat® (.pdf), AutoCAD® (.dwg, .dwf, .dxf), and 

common graphic files (.jpg, .gif).  The drawing/specification file can be opened by 

clicking the open folder image beside the Browse button on the dialog box.  It can also be 

printed from the Shop Packet Toolbar on the Shop Order Traveler or when generating 

Shop Order Packets.  

 

Review Indented BOM Report 
           The bill-of-materials for the product configurations can be printed in indented 

format by clicking the Print button at the bottom of the screen. A Where-Used Report is 

also available under Reports on the Data Maintenance tab. 

     

Perform Cost Rollup 
A product cost rollup for the selected product configuration can be performed in 

the Cost Rollup section on the Indented View page by clicking the Run Rollup button. 

The Cost Basis and the number of BOM Levels to include in the rollup can be specified 

prior to rollup. The Cost Basis indicates whether the material cost is based on the average 

or standard item cost. The BOM Levels indicate whether to refer to the next level to 

obtain lower-level costs or refresh all costs with a multi-level rollup. For a lengthy bill-

of-material, the multi-level rollup option may take a significant amount time to complete. 

  

The lot size used to unitize setup costs in the cost rollup is based on the lot size 

specified in the Item Master for items with a ‘Fixed’ order policy. For other order 

policies, the average lot size or parent build quantity is used in the cost rollup. The labor 

and overhead costs of the parent are based on the operation setup and run hours in the 
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product route and the setup, labor, and overhead rates in the work center (see Product 

Route Cost Calculations). To view a printed copy of the product configuration costs, 

refer to the costed route and BOM reports on the Financial tab. 

 

Calculate Cumulative Lead Time 
To automatically calculate the cumulative lead time for a product configuration, 

click the arrow image underneath the Cum. Lead Time label on the Indented View 

page. The cumulative lead time, or longest lead time path in a product configuration, is 

used in material planning to indicate the planning horizon for which changes in demand 

may affect lower-level component availability. To update the Planning Horizon value for 

an item, click the Update Plan Horiz. button after calculating the cumulative lead time. 

The planning horizons can also be recalculated for all items using the Mass Update Item 

Master utility on the Data Maintenance tab. 

 

Review Audit Notes 
The Audit Notes page displays an audit trail of any changes or additions made to 

the product configuration header, operations, or materials.  The Admin page includes 

information on who created or last changed the record and when, but the audit notes 

provide a much more detailed description of actual changes.  The Admin page also 

provides for the entry of revision notes to manually track the reasons for a change. 

 

Create/Maintain Engineering Changes 

 

The Engineering Change Control Master can be opened either from the 

Engineering page of the Item Master or by selecting Engineering Master from the Data 

Maintenance tab. The Engineering Change Control Master is used to track the status and 

history of engineering change orders associated with an item.  

  

The engineering change history is displayed and viewed by revision number. The 

records are sorted by descending Create Date and can be viewed by using the navigation 

buttons at the bottom of the screen. To add a new engineering change order, select an 

item number from the drop-down list and click the new record button  located beside 

the navigation buttons. To complete the ECO record, complete the remaining fields as 

defined below. 

  

Revision No.: the version number assigned to the change order for the item. The revision 

number is an alpha-numeric field that can be updated manually for non-revision-

controlled items or selected from a drop-down list if revision control has been activated 

for the item. For revision-control items, the revision numbers are maintained by clicking 

the edit button adjacent to the Rev. Control field on the Inventory page of the Item 

Master. 

  

ECO Status: the engineering change order status for the revision. The default status 

values include Specification, Design, Test, Prototype, Approval, Production, and 
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Superseded. The status values can be changed to meet internal requirements by editing 

the ECO status table. 

  

Last Rev. No.: a reference to the superseded revision number for the item. 

  

Engineer: the person responsible for documenting the change control process for the 

item. To add or edit this list, click the adjacent edit button. 

  

Create Date: the date the engineering change order was created. 

  

Approved By: the person who approved the final drawing and/or specifications for the 

item. To add or edit this list, click the adjacent edit button. 

  

Approval Date: the date the engineering change order was approved for production. 

  

Effective Date: the date the new revision can be used in production. This field is used for 

reference only. The actual effective start and stop dates used by MRP and costing should 

be maintained in the bill-of-material section of the product configuration for the item. 

  

Drawing/Spec File:  the path and file name for the drawing or specification file 

associated with an item. The Browse button can be used to search local or mapped drives 

for the path and file name. Catalyst supports Microsoft Word®, Adobe Acrobat®, and 

AutoCAD® files (.doc, .rtf, .pdf, .jpg, .gif, .htm, .html, .dwg, .dwf, and .dxf file 

extensions). The drawing/specification file can be opened by clicking the open folder 

image beside the Browse button.  

  

Change Summary: a summary description of the changes including in the change 

control. 

  

Change Justification: an explanation of the reasons and benefits for the change. 

  

Mass Update Orders 

  

           The Mass Update Orders utility is located on the Data Maintenance tab and is 

used to perform mass updates of line items listed on open customer orders and purchase 

orders. The updates can be used to either replace or remove line items that have not been 

shipped or received.   

  

To replace a line item with another item, select the ‘Replace’ or ‘Remove’ option, the 

current item and replacement item, and mark the appropriate check boxes to update open 

customer orders and/or open purchase orders. To process the update, select the Update 

button. After the update has completed, the updated records can be reviewed by selecting 

the Print Log button. 
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Mass Update BOM/Route 

  

The Mass Update BOM/Route utility is located on the Data Maintenance tab 

and is used to perform mass updates of bill-of-material components or operations listed 

on product configurations and open and released shop orders. The updates can be used to 

replace, remove, or append components and operations as described below. 

  

BOM Updates 

To replace a bill-of-material component with another item:   

1. Select the ‘Replace’ action on the BOM page. 

2. Select ‘this child item’ and ‘with this child item’ to specify the current and 

replacement item. 

3. Select a filter in the ‘for parent items with…’ section to indicate which parent 

product configurations and shop orders will be updated. 

4. Select the ‘on the following BOMs’ to specify the parent types to be updated. 

5. Click the Update BOMs button to process the update. After the update has 

completed, the updated records can be reviewed by selecting the Print BOM Log 

button. 

  

To remove a bill-of-material component:   

1. Select the ‘Remove’ action on the BOM page. 

2. Select ‘this child item’ to specify the component item to remove. 

3. Select a filter in the ‘for parent items with…’ section to indicate which parent 

product configurations and shop orders will be updated. 

4. Select the ‘on the following BOMs’ to specify the parent types to be updated. 

5. Click the Update BOMs button to process the update. After the update has 

completed, the updated records can be reviewed by selecting the Print BOM Log 

button. 

  

To append a new bill-of-material component:   

1. Select the ‘Append’ action on the BOM page. 

2. Select ‘this child item’ to specify the component item to add and ‘with this 

quantity’ to specify the standard quantity required on the primary product 

configuration.  

3. Select a filter in the ‘for parent items with…’ section to indicate which parent 

product configurations and shop orders will be updated. 

4. Select the ‘on the following BOMs’ to specify the parent types to be updated. 

5. Click the Update BOMs button to process the update. After the update has 

completed, the updated records can be reviewed by selecting the Print BOM Log 

button. 

  

Route Updates 

To replace an operation with another operation:   

1. Select the ‘Replace’ action on the Route page. 
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2. Select ‘this operation’ and ‘with this operation’ to specify the current and 

replacement operation. 

3. Select a filter in the ‘for parent items with…’ section to indicate which parent 

product configurations and shop orders will be updated. 

4. Select the ‘on the following routes’ to specify the parent types to be updated. 

5. Click the Update Routes button to process the update. After the update has 

completed, the updated records can be reviewed by selecting the Print Route Log 

button. 

  

To remove an operation from product routes:   

1. Select the ‘Remove’ action on the Route page. 

2. Select ‘this operation’ to specify the operation to remove. 

3. Select a filter in the ‘for parent items with…’ section to indicate which parent 

product configurations and shop orders will be updated. 

4. Select the ‘on the following routes’ to specify the parent types to be updated. 

5. Click the Update Routes button to process the update. After the update has 

completed, the updated records can be reviewed by selecting the Print Route Log 

button. 

  

To append a standard operation to product routes:   

1. Select the ‘Append’ action on the Route page. 

2. Select ‘this operation’ to specify the standard operation to add. 

3. Select a filter in the ‘for parent items with…’ section to indicate which parent 

product configurations and shop orders will be updated. 

4. Select the ‘on the following routes’ to specify the parent types to be updated. 

5. Click the Update Routes button to process the update. After the update has 

completed, the updated records can be reviewed by selecting the Print Route Log 

button. 

 

Mass Update Item Master 

  

           The Mass Update Item Master utility is located on the Data Maintenance tab 

and is used to perform mass updates of the following item master fields: 

  

Completion%: the completion percentage indicates the percentage at which a shop 

order, customer order line, or purchase order line changes to ‘Complete’ based on a 

receipt or shipment transaction. The mass update for the completion percentage can be 

processed by item type, product code, or product family. For more information on this 

field, please refer to the definition provided in the Item Master help topic. 

  

Under-receipt Tolerance: the under-receipt tolerance refers to the percentage a shop 

order or purchase order can be under-received. The mass update for the under-receipt 

tolerance can be processed by item type, product code, or product family. For more 

information on this field, please refer to the definition provided in the Item Master help 

topic. 



Catalyst Manufacturing User Manual

 

47 

  

Over-receipt Tolerance: the over-receipt tolerance refers to the percentage a shop order 

or purchase order can be over-received. The mass update for the over-receipt tolerance 

can be processed by item type, product code, or product family. For more information on 

this field, please refer to the definition provided in the Item Master help topic. 

  

Cycle Count: the cycle count indicator for the item indicates whether it should be 

included in the cycle count program. If an item is marked for cycle counting, the cycle 

count properties can be set for the item (e.g. ABC code, cycle count tolerance, schedule, 

etc.). The mass update for the cycle count setting can be processed by item type, product 

code, or product family. For more information on this field, please refer to the definition 

provided in the Item Master help topic. 

  

ABC Code: the ABC classification of the item based on the item’s usage and value. The 

mass update for the ABC code can be processed by item type, product code, or product 

family. For more information on this field, please refer to the cycle count properties for 

the item. 

  

Cycle Count Tolerance: the percentage tolerance allowed during inventory cycle counts 

for the item. The mass update for the cycle count tolerance can be processed by item 

type, product code, or product family. For more information on this field, please refer to 

the cycle count properties for the item. 

  

Sales List Price: the list price functions as the default unit price for saleable items when 

an alternative price method is not specified. The current list price can be increased or 

decreased by a specified percentage from either the current list price or standard cost for 

the item. The mass update for the list price can be processed for all saleable items, or by 

product code or product family. For more information on this field, please refer to the 

definition provided in the Item Master help topic. 

  

Purchase Unit Price: the fixed purchase price is used as the default unit price on a 

purchase order when the fixed price method is specified. The fixed unit price can be 

updated to either the last purchase price or standard material cost for the item. The mass 

update for the fixed purchase unit price can be processed for all purchased items or by 

product code or product family. For more information on this field, please refer to the 

definition provided in the Item Master help topic. 

  

Warehouse/Location: the default warehouse and location specified on the Item Master 

is used as the default when entering purchase order receipts and inventory adjustment 

transactions for the item. The mass update for the default warehouse and location can be 

processed by item type, product code, or product family. For more information on this 

field, please refer to the definition provided in the Item Master help topic. 
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Mass Update Lead Times 

 

 The Mass Update Lead Time utility is located on the Data Maintenance tab and 

is used to perform mass updates of lead times for items marked as ‘Dynamic’ on the 

Planning page of the Item Master.  The update can be run for either all dynamic lead time 

items or a specified item using the Item Filter option. 

  

Update fixed and variable lead time?  mark checkbox to update of the fixed and 

variable components of dynamic lead time items based on the standard times maintained 

in the item’s product route. 

  

Update planning horizon with cumulative lead time? mark checkbox to update the 

planning horizon with the revised lead times. The planning horizon for dynamic lead 

items will be updated with the cumulative lead time using the primary product 

configuration for the item and all lower-level assemblies.  

  

For more information on item lead times, please refer to the definitions provided in the 

Item Master help topic. 

 

Create / Maintain Product Codes 

The Product Code Master is located on the Data Maintenance tab and is used 

to create and maintain the product codes assigned to items in the Item Master. The 

product code indicates the sales category or product grouping for the item and can be 

used for organizing and presenting information by product line or category. For instance, 

the product code is used to filter items when performing advanced searches and inventory 

inquiries. The product code can also be used as a commodity code for purchased items to 

filter planned orders in the P.O. Consolidation screen. 

To maintain the product codes in datasheet view, click the table image  button. 

In datasheet view, you can scroll down the list of existing records and add, delete, or edit 

without the use of command buttons. To return to form view, double-click the gray bar to 

the left of the datasheet or right-click anywhere in the datasheet and select the View 

Form option from the shortcut menu. 

Create / Maintain Product Families 

The Product Family Master is located on the Data Maintenance tab and is used 

to create and maintain product families that are assigned to items in the Item Master. The 

product families are used by the Catalyst Scheduler to apply campaign rules in the 

sequencing of shop order operations based on the setup hours entered in the Product 

Family Setup Matrix. 
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To maintain the product families in datasheet view, click the table image 

 button. In datasheet view, you can scroll down the list of existing records and add, 

delete, or edit without the use of command buttons. To return to form view, double-click 

the gray bar to the left of the datasheet or right-click anywhere in the datasheet and select 

the View Form option from the shortcut menu. 

Create / Maintain Planning Type Code 

The Planning Type Code Master stores product types used by the Planning 

department to categorize and sort material codes. The screen is opened by selecting 

Planning Type Code under Product Type Masters on the Data Maintenance tab. The 

Planning Product Type is assigned to items using the Plan Type Code field on the 

Product page of the Item Master.  

To maintain the type codes in datasheet view, click the table image  button. In 

datasheet view, you can scroll down the list of existing records and add, delete, or edit 

without the use of command buttons. To return to form view, double-click the gray bar to 

the left of the datasheet or right-click anywhere in the datasheet and select the View 

Form option from the shortcut menu. 

Create / Maintain Mfg. Type Code 

The Mfg. Type Code Master stores product types used by the Manufacturing 

department to categorize and sort material codes. The screen is opened by selecting Mfg. 

Type Code under Product Type Masters on the Data Maintenance tab. The Mfg. 

Product Type is assigned to items using the Mfg. Type Code field on the Product page of 

the Item Master.  

To maintain the type codes in datasheet view, click the table image  button. In 

datasheet view, you can scroll down the list of existing records and add, delete, or edit 

without the use of command buttons. To return to form view, double-click the gray bar to 

the left of the datasheet or right-click anywhere in the datasheet and select the View 

Form option from the shortcut menu. 

Create / Maintain QC Type Code 

The QC Type Code Master stores product types used by the Quality Control 

department to categorize and sort material codes. The screen is opened by selecting QC 

Type Code under Product Type Masters on the Data Maintenance tab. The QC 

Product Type is assigned to items using the QC Type Code field on the Product page of 

the Item Master.  
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To maintain the type codes in datasheet view, click the table image  button. In 

datasheet view, you can scroll down the list of existing records and add, delete, or edit 

without the use of command buttons. To return to form view, double-click the gray bar to 

the left of the datasheet or right-click anywhere in the datasheet and select the View 

Form option from the shortcut menu. 

Create / Maintain QA Type Code 

The QA Type Code Master stores product types used by the Quality Assurance 

department to categorize and sort material codes. The screen is opened by selecting QA 

Type Code under Product Type Masters on the Data Maintenance tab. The QA 

Product Type is assigned to items using the QA Type Code field on the Product page of 

the Item Master.  

To maintain the type codes in datasheet view, click the table image  button. In 

datasheet view, you can scroll down the list of existing records and add, delete, or edit 

without the use of command buttons. To return to form view, double-click the gray bar to 

the left of the datasheet or right-click anywhere in the datasheet and select the View 

Form option from the shortcut menu. 

Create / Maintain Company 

  

The Company Master is opened from the Data Maintenance tab and is used to 

store the default settings for the company. The Company Name field is populated during 

registration and cannot be edited except by submitting a revised product registration 

(Help > Product Registration). The Company Master consists of tabbed pages for 

Address, Accounts, Costing, Manufacturing, Inventory, Shipping, Profile, and System 

information as reviewed below.  

  

Address 

            The Address page contains fields to store the company street address, phone and 

fax numbers, and email and web addresses. The company address is used on the customer 

order invoice as the remit address.  

  

Accounts 

The default Accounts Payable, Freight Expense, Sales Tax Expense, Accounts 

Receivable, Freight Income, and Sales Tax Payable account codes are established and 

maintained on the Accounts page of the Company Master. The account codes are used to 

export customer and vendor invoices to QuickBooks® based on customer shipments and 

vendor invoice receipts.  

  

The Chart of Accounts is provided for reference below the account codes. The 

chart of accounts can be imported from QuickBooks® using the QuickBooks® Link and 

should only be updated manually when using Catalyst in stand-alone mode.  
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Costing 

The Costing page of the Company Master is used to create and maintain cost 

classifications for items in the Item Master and maintain default settings for updating 

standard raw material costs. Product classes are created to identify the main types of 

product accounting classifications such as finished goods, spare parts, sub-assemblies, 

raw materials, and non-inventory items. The product classes in the sample company 

database are an example of what might be appropriate in a typical manufacturing 

company. 

  

Each product class is assigned the appropriate Revenue, Inventory, 

COGS/Expense, and/or Adjustment Accounts from the drop-down list of account 

codes. In general, revenue, inventory, and COGS/Expense accounts need to be assigned 

to any product class that will be assigned to a purchased or saleable item. This applies to 

finished goods, raw materials, and spare parts items. To update inventory in QuickBooks, 

each product class also needs an adjustment account.  

  

The average cost of an item is updated at the time of receipt. For manufactured 

items, this occurs during the shop order receipt. The Update shop order average cost 

section is used to determine whether the average cost is updated based on the standard 

cost of the item or the rollup cost. The rollup cost is based on the usage of materials and 

labor on the shop order. For bill-of-material items, the usage can be based on either the 

average or standard cost of the component. In addition, the rollup can be based on either 

standard hours and quantities specified on the shop order or the actual hours and 

quantities reported by labor and material issue transactions entered against the shop 

order. When using actual hours and quantities, the costing reverts to standard in the 

following instances: 

•        if the total received against the shop order is less than the receipt tolerance for 

the item 

•        for each operation on the product route, if no labor transactions have been 

reported for the operation 

•        for each component on the bill-of-material, if no material issue transactions 

have been entered for the component. 

  

The Update raw material standard cost section is used to maintain the standard 

cost for raw material items. The manual method indicates that standard costs will only be 

updated when edited directly in the Item Master or running the Update Standard Raw 

Material Costs utility on the Financial tab. When selecting one of the automatic options, 

the raw material standard costs are updated using last purchase order price, average 

purchase order price, or FIFO weighted-average purchase order price if the standard costs 

for the item are not frozen. The standard material cost is updated when saving a new or 

existing PO line. For the FIFO method, the update also occurs when entering or editing a 

PO receipt transaction. When using the Average PO price method, the number of days to 

apply the average must be entered. The average PO price method uses a simple average 

over the specified number of days to reset the standard material cost. The FIFO 
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weighted-average price method calculates the weighted average price of current 

inventory based on the purchase order price and most recent receipt transactions. FIFO 

costing assumes inventory is consumed based on the first-in, first-out principle.  

   

Manufacturing 

The Manufacturing page of the Company Master is used to set production-related 

defaults for planning, scheduling, and shop floor control. The field definitions are as 

follows. 

  

Freeze Started Operations?:  indicates that shop order operations will be frozen when 

labor is reported. The Finite Scheduler will not attempt to schedule any shop order 

operations that have been frozen. This prevents moving the scheduled start date for an 

operation if it has already begun. The flag can be cleared for each started operation using 

the Shop Order Master. A frozen operation can still be rescheduled manually using the 

Production Schedule Board. 

  

Backflush Operation Materials?: indicates that any backflush materials associated with 

a shop order operation should be backflushed based on the good and scrap quantity 

reported for the operation. Note: Setting this flag will disable the backflush confirmation 

screen that displays when a shop order receipt is entered. This is in an effort to avoid 

duplicate material issue transactions. The operation backflush default should only be set 

if the company prefers to process backflush transactions at the time of labor entry rather 

than shop order receipt. The default setting can be overridden for specific shop orders on 

the Labor Entry screen. 

  

Planning Warehouse:  the default planning warehouse to be used for MRP 

generation.  Material Requirements Planning summarizes available inventory only in 

nettable inventory locations in the planning warehouse.  Select “All” for MRP to consider 

the on-hand inventory for all warehouses when determining net requirements. 

 

Schedule Direction: specifies the default finite-capacity schedule direction of either 

forward or backward. The default schedule direction can be overridden on the Catalyst 

Scheduler, but not when a shop order is scheduled without user intervention. 

 

Track Schedule Delays?: indicates that the schedule delay tracking feature is enabled. 

When enabled, the Track Schedule Delays group is displayed on the Production tab and 

the planner/scheduler is prompted to enter a delay code whenever the finish date on a 

shop order operation is rescheduled to a later date. The Schedule Delays Report, in the 

Reports menu of the Production tab, presents a detailed or summarized report of 

production delays which can be filtered by work center, reason code and date range. 

   

MRP Options: to select the desired default settings on the Catalyst MRP screen for the 

following options: 

Demand Source 

•         Independent demand 

•         Master production schedule 
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Options 

•       Include safety stock? 

•       Use time fences? 

•       Ignore remaining quantity? 

•       Update CRP? 

     

Show Barcodes?: the barcodes on the Shop Order Traveler and Shop Order Pick List 

reports can be turned on or off using the checkbox beside each report. 

 

Default Shop Schedule: the default shop schedule which can be used to update work 

center schedules that have been marked to use the default shop schedule in the Work 

Center Master. 

 

Inventory 

The Inventory page of the Company Master is used to set inventory control 

defaults. The field definitions are as follows. 

  

Lot No. Default: for lot controlled items, indicates whether a default lot number is 

generated by the system at the time of purchase order receipt or shop order creation. The 

default lot number consists of 10 digits and an optional prefix up to 3 characters. 

  

Receipt Allocations: if PO receipts are configured to auto-allocate, the quantity received 

on the PO will be allocated to the allocation shop order specified on the PO line at the 

time of receipt. Similarly, if shop order receipts are configured to auto-allocate, the shop 

order receipt quantity will be allocated to the customer order line that the shop order has 

been linked. In each case, the shop order must be linked to the order line for the 

automatic allocation to occur. The linkage on the customer order is through the Linked 

S.O. field on the customer order line. The linkage on the purchase order is through the 

Allocation S.O. field on the purchase order line. The receipt quantity is allocated up to 

the required quantity of the linked order. Any quantity in excess of the required quantity 

remains available for allocation to other orders. 

  

Item Attribute: The item attribute setting determines whether an item can be setup with 

dimensional inventory or revision control to extend the part definition of an item. The 

item attribute setting cannot be changed after inventory transactions have been entered 

for either dimensional inventory or revision control items. 

  

Shipping 

           The Shipping page contains information used in the shipping process and includes 

the following fields: 

  

Default Ship Whse: the default warehouse for customer shipments when shipping goods 

from a specified warehouse location. 
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Default Ship Location: the default location for customer shipments when shipping 

goods from a specified warehouse location. 

  

UCC Company Prefix: the number assigned to a company by either the UCC or an 

EAN International Member Organization. The UCC Prefix provides a globally unique 

number that is used in the bill of lading number.  

  

Ship Weight U/M: the unit of measure for unit package weights and overall shipment 

weights. The weight unit of measure is displayed on the packing list and bill of lading. 

Ship Early Days: the number of calendar days prior to the due date or promise date that 

the shipment is allowed to ship to the customer and still be considered on-time. The ship 

early days tolerance is used to determine on-time performance for customer shipments on 

the Shipment On-Time Performance Report. 

  

Ship Late Days: the number of calendar days after the due date or promise date that the 

shipment is allowed to ship to the customer and still be considered on-time. The ship late 

days tolerance is used to determine on-time performance for customer shipments on the 

Shipment On-Time Performance Report. 

 

Shipping Line No.: the basis for the shipping line number on the packing list and bill of 

lading – either a sequential number based on the number of shipping lines or a reference 

to the customer order line number. Note: For the order line number option, all shipment 

lines against the same customer order line number will reference the same line number.  

  

Ship-to Locations: the ship-to address locations for vendor purchase orders. The Copy 

Company Address button can be used to create a ship-to location record based on the 

company’s default address. 

  

Ship-from Locations: alternate ship-from locations that can be added for customer 

shipments to specify a different ship-from address on the packing list than the present 

company address. The ship-from address can be used to conceal the physical ship-from 

address in instances where the company desires to remain anonymous e.g. private label 

manufacture.  

   

Profile 

The Profile page contains additional parameters and reference fields for the 

company including: 

Account No.: the registration or entity identification number used for governmental, 

regulatory, trade, or associational purposes. The account number appears on sales orders, 

invoices, and various external reports that include the company address information. 

  

VAT Number: the value-added tax identification number for the company. The VAT 

number appears on sales orders, invoices, and various external reports that include the 

company address information. 
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Domestic Currency: the default currency used by the company. The default currency 

code is used to determine the basis for making currency conversions on customer orders, 

purchase orders, invoices and other transactions involving the use of foreign currencies. 

The conversion values are stored and maintained in the Currency Master.  

  

Inventory Precision: the number of decimals displayed for inventory quantity fields 

within the system. Also applies to quantity fields that may be used to process inventory 

receipt, material issue, adjustment and transfer transactions. 

  

PO Price Precision: the number of decimals displayed and default rounding for the 

purchase order unit price. 

  

Sales Price Precision: the number of decimals displayed and default rounding for the 

sales order unit price.  

     

DEA Reg. No.: the company’s DEA registration number for controlled substances. 

  

Expiration Date: the company’s DEA license expiration date. 

  

QuickBooks 

The QuickBooks page is visible when using the Catalyst Manufacturing with 

QuickBooks Link version. The QuickBooks page contains settings to determine how 

QuickBooks is updated.  

  

The QuickBooks Export Mode indicates whether or not updates are exported to 

QuickBooks in batch mode or automatically when the record or transaction is saved in 

Catalyst. In batch mode, the transactions (e.g. customer invoices, vendor bills) and list 

updates (e.g. customers, vendors) are exported only through the QuickBooks export 

menu. In automatic mode, the update is exported to QuickBooks at the time the 

transaction or update is entered in Catalyst (if the QuickBooks company file is open on 

the same computer). The QuickBooks Export Mode field is only visible when using the 

QuickBooks® Link. 

  

            The QuickBooks Inventory field indicates how inventory is updated in 

QuickBooks. An inventory adjustment typically consists of both a quantity and value 

adjustment in QuickBooks to adjust both the quantity on-hand and the average cost for an 

item. The ‘Update quantity only’ option, however, performs only quantity adjustments 

without updating the current average cost stored in QuickBooks. 

  

The QuickBooks Cost Basis field indicates the item cost basis used to update the 

QuickBooks average cost when updating the QuickBooks inventory from Catalyst. The 

QuickBooks inventory valuation can be based on either the standard or average unit cost 

of an item. The standard and average costs are stored on the Cost page of the Item 

Master. 
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System 

The System page includes fields to maintain security and email settings for 

outgoing messages. Examples of outgoing messages include order acknowledgements, 

advance ship notices (ASNs), and purchase orders. To populate the email settings section, 

please refer to the settings you received from your Internet service provider (ISP) or 

administrator.  To prevent unauthorized access to these settings, the System page can be 

restricted to users in the Admins users group by enabling user level security. Please refer 

to the Assign Users to Groups section for more information. 

  

Security Settings  

• Require user login?: indicates whether a user name is required to login to 

Catalyst. If a user login is required, the system must be setup to enable user-level 

security. 

• Require login password?: indicates whether passwords are required for login to 

Catalyst. If a password is required, users with a blank password from initial setup 

or password reset will be required to enter a valid password to open Catalyst. 

• Minimum password length: when password entry is required, the minimum 

acceptable password length. 

• Apply object-level security?: when checked, object-level security is applied when 

a user opens a secure form, report, or menu. 

• Password Expiration: the number of calendar days before a password expires and 

the user is required to enter a new password. 

• Session Timeout: the length of time (in minutes) before the current session times 

out and requires password re-entry to resume session. 

• Maximum Idle Time: the maximum number of inactive minutes before the session 

ends and the application automatically closes. 

  

Email Settings 

• Outgoing mail server (SMTP): outgoing server name (e.g. smtp.gmail.com). 

• Server requires encrypted connection: indicates whether the email server requires 

encrypted (SSL enabled) connection. 

• Outgoing server port (SMTP): outgoing server port number. 

• Server requires authentication: indicates whether the email server requires login 

authentication. If the email server requires authentication, the logon email address 

and password must be entered. 

• Logon user name: email address entered for logon. Since this email address will 

be used for outgoing messages, consider specifying a noreply or info email 

address account for this purpose. 

• Logon password: email password entered for logon. 

 

System Environment: the environment specified in this field is included in the 

application title to make it easier for users to distinguish between different environments. 

The default system environments are Production, Sandbox, Training, and Validation. For 

example, if ‘Sandbox’ is selected, the phrase “Catalyst Manufacturing – Sandbox 

Environment” will appear on the application title. For information on how to create a 
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sandbox environment, please refer to the help article in the Catalyst Forum entitled How 

do I create a "sandbox" environment to use for test and training purposes? 

  

Catalyst Help File Path: the path to the Catalyst Help file. This field is required if 

Catalyst was not installed in the default directory or if the help file has been moved to the 

server to avoid maintaining a copy on each client machine. 

  

Create / Maintain Departments 

  

The Department Master is found on the Data Maintenance tab and is used to 

create and maintain departments in the company. Employees can be assigned to different 

departments to evaluate staffing needs and generate assignment reports. Work centers can 

also be assigned to a department so that organizational groups may be defined and 

department supervisors can print employee lists for employees qualified and available to 

staff the work centers in their department. 

  

            An employee can be a member of more than one department. For example, if an 

employee is cross-trained and qualified to work in two departments, that individual can 

be added to each department. The Dept. Filter can be used to filter the Available list 

with employees in a particular department. The filter may be helpful when searching for 

employees already assigned to another department. 

Employees can be assigned to a department by selecting them from the Available 

list and moving them to the Selected list. Multiple selections can be made from either list 

by holding down the Shift or Ctrl keys and left-clicking with the mouse or by typing Ctrl-

A to select all employees. Movements between the lists can be accomplished by double-

clicking an employee name or selecting an employee and clicking the Add>> or 

<<Remove buttons. 

Create / Maintain Employees 

  

The Employee Master is located in the Company Data Setup group on the Data 

Maintenance tab and is used to create and maintain general employee information such 

as name, title, department, employee type (e.g. operator, sales rep, planner/buyer, or 

indirect), phone number, email address, hire date, job code, labor grade, and job grade. If 

an employee is classified as either a production operator or sales rep, additional 

information can be maintained on the Production or Sales pages, respectively. 

  

For employees classified as production operators, the operator may be assigned to 

scheduled work center operations. To classify an employee as an operator, select the 

‘Operator’ category from the employee Type field and assign a shift in the Shift No. 

field. On the Production page, assign a department in the Department Assignment 

frame and work center skill level for the operator in the Work Center Skill Level frame. 

An operator can only be assigned to scheduled operations on a work center if they have 

https://catalystmfg.zendesk.com/entries/26608617-How-do-I-create-a-sandbox-environment-to-use-for-test-and-training-purposes-
https://catalystmfg.zendesk.com/entries/26608617-How-do-I-create-a-sandbox-environment-to-use-for-test-and-training-purposes-
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been assigned to the work center department. To automatically schedule operators during 

the finite scheduling process, the available hours for the operator must be created on the 

Operator Calendar. The Operator Calendar can be updated or viewed by selecting the 

Update Calendar or View Calendar buttons at the bottom of the screen.  

  

For employees classified as sales reps, the employee can be assigned to customer 

orders and invoices to track sales commissions. To classify an employee as a sales rep, 

select the ‘Sales Rep’ category from the employee Type field. On the Sales page, assign 

a sales Commission % and Territory. The sales rep sales and commissions can be 

displayed using the Sales Commission Report located in the Financial menu. 

  

If user-level security is enabled, the form can be protected using object-level 

security to prevent unauthorized users from accessing or updating the information. The 

Employee No. is referenced in planner / buyer codes, salesperson codes, and department 

staffing lists. To remove employees from active reference lists, select the Inactive check 

box. 

  

To maintain employees in datasheet view, click the table image  button. In 

datasheet view, you can scroll down the list of existing records and add, delete, or edit 

without the use of command buttons. To return to form view, double-click the gray bar to 

the left of the datasheet or right-click anywhere in the datasheet and select the View 

Form option from the shortcut menu. 

 

Setup Event Notification 

  

The Event Notification screen is used to establish email distribution lists for 

specified system events. Typically, these notices would be directed internally, but could, 

on occasion, be used for external correspondence. The Event Type indicates the system 

transaction that causes an email to be sent to the distribution list. The Event Notification 

screen can be found in the Company Data Setup group on the Data Maintenance tab. 

  

An order priority of 10 or less is required on a customer order before an event 

notification is sent for a new customer order or shipment. For instance, if a customer 

order has been created with a priority of 10 or less, an email is sent to all addresses in the 

distribution list when the customer order is initially saved and again when it ships to the 

customer. The event notification works equivalently for P.O. Receipts for expedited 

purchase orders.  

  

Separately, an advance ship notice can be sent to a customer contact by clicking 

the Email ASN button on the Customer Shipment Confirmation screen and purchase 

orders can be emailed to a vendor contact by clicking the Email P.O. button on the 

Purchase Order Entry screen. 
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Create / Maintain Units of Measure 

  

The Unit of Measure Master is found on the Data Maintenance tab and is used 

to create and maintain unit of measure codes and conversion factors. Catalyst currently 

supports both a stock unit of measure for inventory and a purchase unit of measure for 

purchased items. The unit of measure codes are assigned to items in the Item Master and 

used throughout Catalyst.  

  

A unit of measure conversion factor is required for each purchase unit of measure 

so that purchase order receipt quantities can be converted to their stock unit of measure 

equivalent. If a conversion value is not entered in the Unit of Measure Master, it must be 

entered in either the Item Master or Vendor Price/Quantity Discounts screen. All 

inventory transactions are based on the stock unit of measure. 

  

To maintain the unit of measure records in datasheet view, click the table image 

 button. In datasheet view, the unit of measure records are displayed in the main 

datasheet and the conversion values are displayed in a subdatasheet below each unit of 

measure. To expand a subdatasheet and add, delete, or edit conversion values, click the 

plus symbol in the expansion column to the left of the unit of measure. 

 

Create / Maintain States / Provinces 

  

The State/Province Master is found on the Data Maintenance tab and is used to 

create and maintain a list of states and provinces for countries. The records in the 

State/Province Master are referenced in the Catalyst forms and reports containing this 

field. 

  

To maintain states in datasheet view, click the table image  button. In 

datasheet view, you can scroll down the list of existing records and add, delete, or edit 

without the use of command buttons. To return to form view, double-click the gray bar to 

the left of the datasheet or right-click anywhere in the datasheet and select the View 

Form option from the shortcut menu. 

 

Create / Maintain Countries 

  

The Country Master is found on the Data Maintenance tab and is used to create 

and maintain a list of countries used in Catalyst. The records in the Country Master are 

referenced in the forms and reports containing this field. 

  

To maintain countries in datasheet view, click the table image  button. In 

datasheet view, you can scroll down the list of existing records and add, delete, or edit 

without the use of command buttons. To return to form view, double-click the gray bar to 
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the left of the datasheet or right-click anywhere in the datasheet and select the View 

Form option from the shortcut menu. 
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Sales 

 

The Sales tab contains the options required to enter and maintain customer orders through 

the customer order process cycle. The available tab options are listed below. 

Quote Entry 

 

Customer Order Entry 

Customer Order Allocation 

 

Forecast Master 

 

Prospect Master 

Customer Master 

 

Customer Type Master 

Contact Management 

Territory Master 

 

Sales Price Level Maintenance  

Sales Price Quantity Breaks 
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Quote Entry 

 

The Quote Entry screen is used to create quotes for prospects or customers. To 

open the screen, select Quote Entry from the Sales tab. On the Quote Entry screen, 

open an existing quote by selecting it from the Quote No. drop-down list or by clicking 

the adjacent search  button to perform a more advanced search. The advanced search 

screen is required to open accepted or declined quotes.  

  

The Quote Entry screen consists of a quote header, line detail, and quote footer 

section. When entering a new quote, the RFQ No., Req. Ship Date, and Prospect or 

Customer Name must be saved before adding quote lines. A quote can refer to either a 

Prospect Name or Customer Name. The Prospect Name does not need to be saved in 

the prospect list to be added to a quote. In this case, the prospect name and address reside 

only on the quote itself. To switch between prospects and customers, simply press the 

toggle button adjacent to the name field. This will allow you to select a previously saved 

prospect or customer to the quote and populate the quote with the prospect or customer 

defaults.  

  

For more details on the quote entry process, please refer to the topics listed below. 

  

• Create New Quote 

• Enter Quote Lines 

• Enter Quote Notes 

• Attach Documents 

• Check Item Availability 

• Email Sales Quotation         

• Convert Quote 

• Add New Prospect 

• Copy Quote 

• Review Audit Notes 

  

Create New Quote 

To create a new quote, click the New button located at the bottom of the screen. A 

new quote is created with a default Quote No., Status, RFQ Number, Quote Date, and 

Follow-up Date.  Please refer to the sections below for field definitions of these fields 

plus others located in the quote header and footer sections.  

  

Header  

Sales Rep.: the sales representative responsible for obtaining and following-up on the 

quote. 

  

Status: the quote status defaults to “Draft” for new quotes. When the quote is submitted 

to the prospect or customer, the status can be changed to ‘Bid’. When the quote is 

converted to a customer order, it automatically updates to an ‘Accepted’ status. If the 

quote is not accepted, it can be changed to a ‘Declined’ status. 
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Sales Order: A quote is assigned an ‘Accepted’ status when it is converted to a customer 

order. 

  

RFQ Number: the Request for Quotation number. The default RFQ number can be 

replaced by one provided by the prospect company if applicable. 

  

Quote Date: the date the quotation is created. The quote date can be changed to the date 

the quote is sent to the prospect company if the quote is not sent the same day it is 

created. 

  

Follow-up Date: the internal date set to follow-up on the quote with the prospect 

company. The Quote Summary Report can be filtered by follow-up date for this purpose. 

  

Req. Ship Date: the requested ship date of the quoted line items if the prospect company 

accepts the quote. When the quote is converted to an order, the requested ship date 

becomes the order due date.  

  

Ship Via: the designated carrier for the quote in the event it is converted to a customer 

order. The adjacent edit button  can be used to add new records or edit the Ship Via 

Master. 

  

Freight Terms: the freight terms for the quote in the event it is converted to a customer 

order. The adjacent edit button  can be used to add new records or edit the Freight 

Term Master. 

  

FOB Point: the free-on-board point which designates where liability transfers for the 

shipment in the event the quote is converted to a customer order. The adjacent edit button 

 can be used to add new records or edit the FOB Point Master. 

  

Payment Terms: the payment terms for the quote in the event it is converted to a 

customer order. The adjacent edit button  can be used to add new records or edit the 

Payment Terms. 

  

Footer  

Prospect Name: the name of the prospect or customer depending on the setting of the 

toggle button for this field. If the toggle is Prospect Name, the name field refers to either 

a previously saved prospect or a prospect that resides only on the current quote. If the 

prospect has been saved to the Prospect list, it can be selected on future quotes without 

having to re-enter the prospect address and other default information. If the toggle is 

Customer Name, the name field refers to a current customer and as such, will populate 

the customer’s default information on the quote after it is selected. To switch between 

prospects and customers, simply press the toggle button adjacent to the name field. 

   

Quote Subtotal: the sum of the extended amounts from the quote lines. 
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Freight Charge: the anticipated freight charge for the quote. The freight charge can be 

calculated for common package and freight carriers using the adjacent shipping cost 

 button. 

  

Sales Tax Rate: the sales tax rate that will apply in the event the quote is converted to a 

customer order. The sales tax codes are maintained in the Tax Code Master. 

  

Sales Tax Amount: the sales tax amount calculated by multiplying the sales tax rate by 

the taxable portion of the quote subtotal.  

  

VAT Rate: the VAT rate applies to either the Goods and Services Tax for Canadian-

based companies or the Value Added Tax for companies doing business in the European 

Union. The VAT tax codes are maintained in the Tax Code Master. 

  

VAT Amount: the VAT amount calculated by multiplying the VAT rate by the quote 

subtotal and freight charge amounts. 

  

Quote Total: the sum of the quote subtotal, freight charge, and sales tax and VAT 

amounts. The prices and line totals for the quote lines are expressed in terms of the 

currency code selected for the quote. If the currency code is changed on the quote, the 

user is prompted to convert the unit prices on the quote lines. The currency conversion 

values are determined from the exchange rates maintained in the Currency Master.  

   

Enter Quote Lines 

To enter a new quote line, select an item from the Item No. drop-down list. The 

default Item No. list is populated with active saleable items as defined in the Item 

Master. After selecting an item from the drop-down list, the unit price on the quote line 

defaults based on the Default Sales Price method selected for the item on the Item 

Master. The ship date on the quote line defaults to the estimated ship date of the quote. 

The Customer Part No. can be populated for the quote line if applicable. A linked shop 

order can be created and attached to a quote line by double-clicking on the Linked S.O. 

field.  

  

To copy an existing quote line, select the quote line and press the Copy button 

located below the order lines. Note: The Copy button below the quote lines copies quote 

lines and the Copy button at the bottom of the screen copies the entire quote. 

  

Enter Quote Notes 

Quote notes can be entered by clicking the Quote Notes button at the bottom of 

the screen. To add notes to quote lines, click the Line Notes button. The notes appear on 

the Sales Quotation report. 

  

The Comments section on the Admin tab can be used to maintain internal notes 

related to the quote. Comments are intended for internal use only – they are not included 

on the sales quotation report. 
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Attach Documents 

The file path to item specifications, drawings and other documents can be 

maintained for each quote line by clicking the Line Docs button at the bottom of the 

screen.  

   

Check Item Availability 

To check the availability of an item (referred to as available-to-promise or ATP), 

click the Check ATP at the bottom of the screen. The available-to-promise screen 

displays the on-hand inventory for each line item and can be used to determine the 

quantity that can ship directly from stock. The Supply field refers to the total quantity on-

order for the item. To open the Material On-Order Report for an item, double-click on 

the Supply field. To open the Demand Planning Report and view the demand for an 

item, double–click on the Demand field. The Material On-Order and Demand 

Planning Report can also be opened from the Planning menu. 

   

Email Sales Quotation 

To send a sales quotation to a prospect or customer contact, select the Email 

Quote button. The Email Quote screen will open with either a field to enter the email 

address for a prospect that does not have any saved contacts or a list of saved prospect or 

customer contacts. 

   

Convert Quote 

            A quote can be converted to a customer order by either clicking the Convert 

Quote button at the bottom of the screen or clicking the wand button  adjacent to the 

Sales Order field. When a quote is converted to a customer order, the quote is converted 

to an ‘Accepted’ status and all of the quote information is transferred to a new customer 

order. The reference to the new customer order is displayed in the Sales Order field.  

  

            If the prospect for the quote has not been added to the prospect list, it is added 

when the quote is converted to an order. If the prospect is a new customer and has not 

previously been added to the customer list, it is added during the quote conversion. The 

prospect and customer can subsequently be referenced on the Prospect Master and 

Customer Master, respectively. 

   

Add New Prospect 

            When adding a prospect name to a quote, if the prospect is not currently stored in 

the prospect list, the user is prompted to add the prospect to the list. If the new prospect is 

not added at this time, the prospect can be added at a later time by clicking the Add 

Prospect button. If the prospect is not added to the prospect list when the quote is 

converted to an order, the prospect is added to the prospect list as part of the quote 

conversion. 

 

Copy Quote 

To copy a quote, open an existing quote and press the Copy button. On the Copy 

Quote screen, enter a New RFQ No. and Req. Ship Date  for the new quote and press 

the OK button.  
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Review Audit Notes 

The Audit Notes page displays an audit trail of any changes or additions made to 

the quote header, footer, or quote lines. 

 

Customer Order Entry 

   

The Customer Order Entry screen is used to create and maintain customer 

orders. To open the screen, select Customer Order Entry from the Sales tab. On the 

Customer Order Entry screen, open an existing customer order by selecting it from the 

Sales Order drop-down list or by clicking the adjacent search  button to perform a 

more advanced search. The search screen is required to open complete, closed, or 

cancelled orders. On the search screen, enter filter values to locate the desired order and 

press the Select button to display the selected order on the Customer Order Entry 

screen.  

  

The Customer Order Entry screen consists of a customer order header, line detail, 

and order footer section. When entering a new customer order, proceed through each of 

these sections from the top of the screen to the bottom. Shop orders can be created and 

linked to customer order lines to fulfill make-to-order requirements. For more details, 

please refer to the topics listed below. 

  

• Create Customer Order 

• Enter Order Lines 

• Enter Order Notes 

• Attach Documents 

• Check Item Availability 

• Email Order Acknowledgement 

• Allocate Inventory 

• Copy Customer Order 

• Maintain Revision Notes 

• Review Order Status 

• Review Shipment/Invoice History 

• Review Audit Notes 

 

Create Customer Order 

To create a new customer order, click the New button located at the bottom of the 

screen. A new customer order is created with a default Sales Order, Order No., and 

Status. The customer Order No. is based on an eight-digit code with the first two digits 

based on the year, the next two digits the month, and the last four digits an order 

sequence number that increments for each new order in a month. For example, the 999th 

order in October of 2010 would have an order number of 10100999. The four-digit 

sequence number automatically resets to 0001 at the start of a new month.  
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The order Status defaults to ‘Open’ for new orders. A shipment against an order 

line creates a customer invoice and automatically updates the customer order status and 

the completion status of the affected order line.  

  

When selecting a customer from the drop-down list, the Sales Rep., Order 

Priority, Payment Terms, Third-Party Bill-To, Ship Via, Freight Terms, FOB Point, 

Ship-To Location, Sales Tax Rate, currency code, and customer Notes from the 

Customer Master are loaded as defaults onto the customer order. The edit button 

 located adjacent to the customer field opens the Customer Master so that changes 

and/or additions can be made during the customer order entry process. 

  

Please refer to the field definitions below for the other fields that comprise the 

Customer Order Entry screen. 

  

P.O. Number: the customer purchase order number. The customer purchase order 

number must be entered prior to entering customer order lines or quote lines. 

  

Order Date: the date the customer order is received from the customer. 

  

Order Fulfillment Dates  

• Due Date: the earliest required ship date of the customer order to meet the 

requested delivery date.  Since a customer order may consist of multiple order 

lines with different due dates, the due date of the overall order represents the first 

or earliest due date for all order lines. The order due date must be entered prior to 

entering customer order lines or quote lines. The order line and quote line due 

date defaults to the due date on the customer order. MRP uses the due date for 

each order line as the demand need date so the order line due date serves as the 

end point of all production and purchasing activity required to ship the order line 

by the due date. 

  

• Req. Deliv. Date: the requested delivery date field accounts for the transit time of 

the shipment from the ship-from location to the ship-to location.  The delivery 

days to the ship-to location can be maintained in the customer ship-to location 

record on the Shipping page of the Customer Master.  If no delivery days are 

specified in the ship-to location, the delivery days defaults to one business day.   

  

• Promise Date: the customer order promise date. The promise date records the 

original promised ship date of the order. 

  

• Ship Date: displays the last ship date against the customer order. The ship date at 

the line detail level refers to the last ship date for that line item. The edit button 

 adjacent to the ship date field can be used to review the invoice/shipment 

history for the customer order. 

   

Sales Rep.: the sales representative responsible for or credited with the customer order. 

  

file:///C:/Users/Greg/Documents/Catalyst/User%20Manuals/Temp/Customers.htm
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Order Priority: used to add a job priority to shop orders linked to the customer order 

lines. The order priority ranges from 1 to 50 with higher priority orders being assigned 

lower numbers. The Catalyst finite-capacity scheduling engine uses job priority as a 

selection rule option. 

  

Payment Terms: the payment terms for customer order invoices. The adjacent edit 

button  can be used to add new records or edit the Payment Terms. 

  

Third-Party Bill-To: if the third-party bill-to address is populated on the customer order, 

it appears in the bill-to section on the invoice instead of the customer’s billing address. 

The adjacent edit button  can be used to add new addresses or edit the currently 

selected third-party bill-to address for the customer. The third-party bill-to addresses are 

also maintained on the Invoice page of the Customer Master. 

  

Ship Via: the preferred carrier for shipments against the customer order. The adjacent 

edit button  can be used to add new records or edit the Ship Via Master. 

  

Freight Terms: the freight terms for shipments against the customer order. The adjacent 

edit button  can be used to add new records or edit the Freight Term Master. 

  

FOB Point: the free-on-board point to designate when liability transfer for shipments 

against the customer order. The adjacent edit button  can be used to add new records or 

edit the FOB Point Master. 

  

Ship-To Location: the ship-to address location can be entered either from the drop-down 

list with the default customer ship-to locations or entered manually by clicking the 

adjacent edit button . Creating a new ship-to address in this manner updates the 

customer order and automatically adds the customer ship-to address to the Customer 

Master. 

  

Order Subtotal: the sum of the line totals from the order lines that have been converted 

to an ‘Order’ status. 

  

Freight Charge: the freight charge for shipments against the customer order. The freight 

charge amount will default on the Customer Shipment Confirmation page when 

processing the customer shipment. 

  

Sales Tax Rate: the sales tax rate defaults from the Sales Tax Code entered for the 

customer on the Orders page of the Customer Master and applies to the customer’s state, 

local or provincial sales tax as applicable. The sales tax codes maintained in the Tax 

Code Master. 

  

Sales Tax Amount: the sales tax amount is calculated by multiplying the sales tax rate 

by the taxable portion of the order subtotal.  
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VAT Rate: the VAT rate applies to either the Goods and Services Tax for Canadian-

based companies or the Value Added Tax for companies doing business in the European 

Union. The VAT tax codes are maintained in the Tax Code Master. 

  

VAT Amount: the VAT amount is calculated by multiplying the VAT rate by the order 

subtotal and freight charge amounts. 

  

Order Total: the sum of the order subtotal, freight charge, and sales tax and VAT 

amounts. The currency code defaults from the Customer Master and serves as the 

currency basis for the sales order. The prices and line totals for order lines and quote lines 

are expressed in terms of the currency referenced on the order. If the currency code is 

changed on the order, the user is prompted to convert the unit prices in the order detail 

section. The currency conversion values are determined from the exchange rates 

maintained in the Currency Master. The sales order will also be invoiced in the currency 

units stated on the order. The invoice amounts are converted to domestic units when the 

invoice is exported to an external accounting package. The receipt of the payment from 

the customer must first be converted by a third-party institution before being deposited to 

your account in domestic currency units. 

   

Enter Order Lines 

           To enter a new order line into the Order Lines page, select an item from the Item 

No. drop-down list. The default Item No. list is populated with active saleable items as 

defined in the Item Master. If customer items have been populated in the Item Master, the 

Filter toggle switch below the order lines is automatically toggled on to include only 

those items that have been assigned to the selected customer. The filter can be toggled on 

and off by clicking the button. 

  

After selecting an item from the drop-down list, the unit price defaults based on 

the Default Sales Price method selected for the item on the Item Master.  

  

The due date on the order line defaults to the customer order due date. A linked 

shop order can be created and attached to a customer order line by double-clicking on the 

Lot No. field. A linked shop order can also be selected from the drop-down list if the 

shop order has already been created. When a receipt transaction is entered for a linked 

shop order, the receipt quantity is automatically allocated to the customer order if the 

‘Auto-allocate SO receipts’ option is selected on the Inventory page of the Company 

Master. 

  

To perform an advanced search for a saleable item, select the Search button 

below the Item No. field. On the Customer Order Item Search screen, search for an 

item by description, customer, customer part number, or product code and add it to the 

order by selecting the desired item and clicking the Select button. An item can also be 

added to the order by double-clicking the desired Item No. from the filtered list.  
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To copy an existing order line, select the order line and press the Copy button located 

below the order lines. Note: The Copy button below the order lines copies order lines 

and the Copy button at the bottom of the screen copies the entire order. 

  

To view several other order-entry functions, right-click on the order line to open 

the shortcut menu and select from one of the following available options:  

•        Edit Item 

o To view or edit the Item Master for the selected item, select the Edit Item 

option from the shortcut menu. If user-level security is enabled, the ability 

to open or edit the Item Master may be limited depending on the user’s 

permission level. 

•        Search Item 

o To search the list of saleable items by attribute, select the Search Item 

option from the shortcut menu. The search screen contains fields to search 

for items based on description, customer, customer part number, or 

product code. To add a search item to the current customer order, select 

the desired record and click the Select button or double-click the desired 

Item No. from the filtered list. 

•        Substitute Item 

o To view a list of acceptable substitutes for a saleable item, select the 

Substitute Item option from the shortcut menu. The selected order line 

item can be replaced by highlighting a substitute item and clicking the 

Replace button. To add substitutes to the list of available items, open the 

Item Master and add other saleable items to the Item Substitutes section 

located on the Inventory page. 

•        Open drawing file 

o If applicable, opens the drawing or specification file for the item. 

  

When adding line items to a customer order, the sales forecast for the item is 

consumed as described in the Forecast Master help topic. 

  

A credit item, a line item that appears on the customer invoice as a credit, can be 

added to the sales order with a negative price.  Credit items are typically setup as non-

inventory items and must be processed on the shipment to be included on the customer 

invoice and exported to QuickBooks®. 

 

For partially completed orders, it may be desirable to hide complete order lines. 

To do this, select the Hide Complete toggle button to view only open line items. To view 

all order lines again, select the Show All toggle button. 

 

Enter Order Notes 

Customer order notes can be entered by clicking the Order Notes button at the 

bottom of the screen. To add notes and comments to order lines, click the Line Notes 

button. The notes appear on the Order Acknowledgement, Sales Quotation, and Customer 

Invoice reports. 

 



Catalyst Manufacturing User Manual

 

71 

Attach Documents 

The file path to item specifications, drawings and other documents can be 

maintained at either order level or line item level. To link a document to the customer 

order, click the Order Doc button at the bottom of the screen. The order document can be 

used to store the file path to an order acknowledgement or customer purchase order. To 

link a document to an order line, click the Line Docs button. The line documents can be 

used to store a drawing or specification file for each order line. If an order line item is 

added when the Filter button is toggled on and a document path has already been stored 

for the customer item using either the Item Master or Customer Master, the document 

will automatically be linked to the order line when the item is added to the customer 

order.  

      

Check Item Availability 

When entering line items for a customer, you can determine the available-to-

promise (ATP) and capable-to-promise (CTP) for the order line items by clicking the 

Check ATP or Check CTP buttons, respectively, at the bottom of the screen. The 

available-to-promise screen presents a summary of the inventory availability for each 

order line item. The screen can be used to determine the quantity of an order line that can 

ship directly from stock. The Supply field refers to the total quantity on-order for that 

item. To open the Material On-Order Report for an item, double-click on the Supply 

field. To open the Demand Planning Report and view the demand for an item, double–

click on the Demand field. The Material On-Order and Demand Planning Report can 

also be opened from the Planning menu. 

  

When the quantity ordered for an item exceeds the quantity on-hand, the item 

must be produced. For these make-to-order situations, a capable-to-promise date is much 

more reliable than using the standard lead time to determine a ship date because the 

actual time to make the product will depend on current material and capacity availability. 

The Check CTP button opens a dialog box to determine a capable-to-promise date for 

the order using the Catalyst Finite Scheduler. You can add new linked shop orders to line 

items using the Add S.O.? option. Click the Run button to calculate the scheduled start 

and finish dates for all linked shop orders on the customer order. To freeze the scheduled 

dates for a customer order line, click the Freeze? button for that line item. The resulting 

schedule dates can be used to populate the customer order due date and/or promise dates. 

 

Email Order Acknowledgement 

To send an order acknowledgement to a customer contact, select the Email Order 

button. The Email Order Acknowledgement screen will open with a list of customer 

contacts you can select to send an acknowledgement of the order. 

   

Allocate Inventory 

To allocate inventory to the customer order, select the Allocate Inventory button 

to open the Customer Order Allocation screen. The inventory allocation process can be 

used in conjunction with ATP (Available-To-Promise) to determine if inventory or 

scheduled receipts exist to ship the order. 
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Copy Customer Order 

To copy a customer order, select an existing order and press the Copy button. On 

the Copy Customer Order screen, enter a Customer PO number and Due Date for the 

new order and press the OK button. 

 

Maintain Revision Notes 

To track the changes made to a customer order, revision notes can be entered by 

selecting the Admin tab and adding a new record in the Revisions section. The revision 

history can be used to document changes made to the due date, price, quantity, or other 

changes on the order. The revision notes print on the customer order and order 

acknowledgement reports to serve as a reference of changes agreed to with the customer.  

  

The Comments section on the Admin tab can be used to maintain internal notes 

related to the order. Comments are intended for internal use only – they are not included 

on any sales order reports.  

   

Review Order Status 

To view the status of linked shop orders and purchase orders for the customer 

order, select the Order Status button. The Customer Order Status Report displays 

shop orders and purchase orders assigned to the customer order with their respective 

order quantity and due dates. A purchase order can be linked to an order line through the 

Drop Shipment process. 

  

Review Shipment/Invoice History 

To review invoices for the selected customer order, select the Invoice Summary 

button located adjacent to the Ship Date field.  Customer invoices can also be reviewed 

and printed by selecting Reports > Customer Invoice Report under the Shipping 

tab.  Shipment history can be reviewed by selecting Reports > Shipment History 

Report under the Shipping tab or Financial Reports > Sales By Customer Detail 

Report under the Financial tab. 

  

Review Audit Notes 

The Audit Notes page displays an audit trail of any changes or additions made to 

the customer order header, footer, or order lines. 

  

Allocate Customer Orders 

The Customer Order Allocation screen is used to make material reservations for 

a customer order. The available inventory is calculated as the on-hand quantity less the 

allocated quantity in a specific location (Available Quantity = On-Hand – Allocated 

Quantity). The available inventory is used by warehouse personnel to determine whether 

or not sufficient inventory is available to release the order for shipment. The allocation 

process also facilitates the shipment of inventory on a first-in, first-out (FIFO) basis when 

allocating lot or serial controlled inventory items. 
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An inventory allocation does not directly affect the on-hand balance for an item. 

The allocation quantity is subtracted from the on-hand inventory to determine the 

available inventory balance, but it does not affect material requirements planning (MRP) 

calculations. MRP nets against the on-hand quantity, not the available quantity. The 

inventory allocation is an optional step to help warehouse personnel more clearly identify 

the inventory available for orders released for shipment. When the shipment confirmation 

is entered (see Shipping Entry), inventory is relieved from the shipment location (i.e. 

deducted from inventory on-hand) and with it, the inventory allocation.  

To allocate materials from inventory to a customer order, follow the steps 

outlined below: 

  

1.      Select Customer Order Allocation from the Sales tab. 

2.      On the Customer Order Allocation screen, select a customer order from the 

Sales Order drop-down list. To select customer orders based on other criteria, 

click the search  button and perform an advanced search. After selecting a 

customer order, the Order Lines and corresponding Available Inventory 

sections are populated. 

  

3.      Select an order line by clicking the record selector for the desired row. The 

Available Inventory section includes all inventory locations with a positive 

on-hand balance in nettable, pickable inventory locations for the currently 

selected line item. The Allocation Location option can be used to filter the 

available inventory to a specific warehouse or location.  

  

4.      To allocate inventory for an order line, select the Allocate flag on the desired 

inventory location record. The Quantity field is automatically populated 

based on the smaller of the quantity required for the line item and the 

Available inventory. If necessary, edit the default allocation quantity. 

Continue to select additional inventory records until the allocation quantity 

equals the order quantity for the line item. The total allocated quantity for an 

inventory location record can never exceed the on-hand quantity in that 

location. To decrease an allocation quantity, enter a negative amount in the 

Quantity field.  

5.      Click the Save button to allocate the designated inventory to the line items on 

the currently selected customer order. In the Order Lines section, the 

Allocated Qty and Alloc % columns are updated based on the saved 

allocations. The Available column in the Available Inventory section is also 

updated accordingly. 

6.      Repeat the previous three steps for each customer order line. The inventory 

allocation can be saved either before moving to another order line or after 

entering allocations for all order line items.  
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7.      As an alternative to entering allocations for each order line one at a time, the 

inventory allocations for a customer order can be automatically generated 

based on last receipt date (FIFO) by selecting the Allocate All button at the 

bottom of the screen. Similarly, inventory records can be unallocated from a 

customer order by selecting the Unallocate All button. 

After inventory has been allocated to a customer order, click the Allocation 

Report button at the bottom of the screen to open the Inventory Allocations by 

Customer Order report. To view the allocations for a customer order, allocated item 

number, or allocated lot number, select Inventory Allocation Reports from the Reports 

button on the Inventory tab. To release the order for shipment and create the shipment 

documents based on the allocations, select Review Shipment Capability by Allocation 

from the Shipping tab. 

 

Forecast Master 

A forecast can be imported into Catalyst from the forecast spreadsheet or entered 

directly into the Forecast Master. The analysis and development of the forecast typically 

occurs in an offline system or spreadsheet. To enter the forecast directly into the 

Forecast Master, follow the steps described below: 

1.      Select Forecast Master from the Sales tab. 

2.      Select a saleable Item No. from the drop-down list. 

3.      Add the item forecast records by effective date into the lower screen. Catalyst 

needs the forecasted item, effective date, and forecast quantity to create an 

item forecast. The customer orders for the item during the forecast period are 

summarized in the Orders field as orders are received. The Remaining field 

is determined by subtracting the forecast quantity by customer orders 

received. The remaining forecast represents the unconsumed forecast quantity 

and will be considered when running MRP with the forecast included option. 

The forecast can also be populated in datasheet view by clicking the table image 

  button. In datasheet view, the forecast items are displayed in the main datasheet with 

the forecast records displayed in a subdatasheet below each item. To expand a 

subdatasheet and add, delete, or edit forecast records, click the plus symbol in the 

expansion column to the left of the item. 

The forecast variance can be reviewed using the Sales Forecast By Item, Sales 

History By Item, and Customer Order Bookings reports located in the Reports list on 

the Sales tab. 
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Forecast Consumption 

If a forecast is maintained for saleable items, the forecast is consumed in either 

monthly buckets or by a date range determined by the forecast consumption days 

specified for an item on the Orders page of the Item Master.  When using forecast 

consumption days, the sales order quantity consumes the forecast around the 

requirements date by the specified number of days before and after the requirements 

date.  If forecast consumption days are not specified for an item, the forecast is consumed 

in monthly buckets.  If the sales order quantity exceeds the forecast quantity in the 

forecast consumption date range, it continues to consume the forecast specified in later 

periods until the order quantity has been fully consumed. 

  

MRP considers customer orders and remaining forecast when calculating demand 

requirements.  If there is no remaining forecast i.e. the forecast has been fully consumed, 

only customer orders will be considered for that period.  The forecast remaining from 

prior periods may create past due demand requirements so the forecast should be 

regularly maintained to remove past due unconsumed forecast if the demand is no longer 

expected. 

  

Forecast Import 

The forecast can also be imported from a pre-formatted forecast spreadsheet as 

described in the steps below. 

   

1.     Select Forecast Import from the Sales tab or click the Import button on the 

Forecast Master. 

2.     On the Import Forecast Data screen, select the Export Items button to 

export saleable items to the forecast spreadsheet specified in the Export 

Path.  This step will allow selection of forecast items from a drop-down list 

when populating the forecast in the next step. 

3.     On the Import Forecast Data screen, open the forecast spreadsheet by 

selecting the Open button. To populate the forecast on the spreadsheet, enter 

the forecast item, effective date, and quantity on the Forecast worksheet for 

each forecast line. When the forecast is complete, save and close the 

spreadsheet. 

4.    On the Import Forecast Data screen, click the Import button. This will 

import the forecast populated in the previous step into Catalyst.  

Prospect Master 

  

The Prospect Master stores information on sales prospects that may not have 

converted a sales quote to a customer order and been migrated to the Customer Master. A 

prospect can be displayed by selecting a record from the Prospect No. drop-down list, 

browsing the list using the navigation buttons on the bottom of the screen, or by using 

defined search criteria to filter from a list. To search for a prospect, click on the search 
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 button adjacent to the Prospect No. field. On the Advanced Prospect Search screen, 

you can enter filter criteria for the prospect name, billing, city, billing state, sales rep or 

prospect status. The search screen must be used to open inactive prospects that no longer 

appear in the active Prospect No. drop-down list. The screen consists of tabbed sections 

for Address, Contacts, Quotes, and Profile information as described below. 

  

Add New Prospect 

A new prospect can be added by clicking the New button at the bottom of the 

screen and entering the required information into each section. The prospect number, 

name and payment terms are required fields. The prospect number defaults to a unique 

index, but can be changed if desired to any other unique prospect number.  

  

Copy Prospect 

To create a new prospect based on an existing record, open the prospect in the 

Prospect Master and select the Copy button. In the Copy Prospect dialog box, select 

the ‘Prospect name’ option under Copy To and enter the new prospect name. Click OK 

to create the new prospect record. To copy an existing prospect to the customer list, select 

the ‘Customer name’ option under Copy To. The new customer name defaults to the 

currently selected prospect name. Click OK to create the new customer record. 

  

Address 

The Address page contains the billing and shipping address for the prospect. The 

Use Billing Address? flag can be used to copy the billing address fields to the ship 

address fields. There are additional fields to store the prospect’s sales territory, phone 

number, fax number, web address, and email address.  

   

Contacts 

            The Contacts page is used to enter prospect contact information. Each contact 

record includes fields for first name, last name, title, email, phone number, extension, fax, 

mobile, location, address, city, state, zip code, and comments. 

   

Quotes 

            The Quotes page contains default fields used for the Quote Entry process as well 

as a summary of the quote history for the prospect. Double-clicking the Quote No. in the 

Quote History opens the quote on the Quote Entry screen. The additional fields on this 

page include: 

  

Sales Rep.: the default sales representative for the prospect.  

  

Payment Terms: the payment terms default on a new quote for the prospect, but are also 

carried over to the customer order if the quote is converted to a sales order. 

  

Price Level: a price level may be assigned to the prospect and used to determine the 

default quote price for an item when added to a quote line. The default quote price could 

be based on a different method depending on the option selected on the Orders page of 

the Item Master. A price level can be based on either an item price or a fixed discount or 
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markup percentage. Price levels are created and maintained in the Sales Price Level 

Maintenance screen.  

  

Sales Tax Code: the default sales tax code for the prospect. The sales tax codes are 

maintained in the Tax Code Master and can be imported from QuickBooks® if 

applicable. 

  

VAT Code: the default value-added tax code for the prospect. The value-added tax codes 

are maintained in the Tax Code Master. 

     

Currency Code: the currency basis for the quote. The default currency is the domestic 

currency specified in the Company Master. 

  

Profile 

The Profile page contains fields to store additional default information for the 

prospect as defined below. 

  

FOB Point: designates where legal liability, and typically shipping costs, transfers from 

the shipper to the receiver. 

Ship Via: specifies the preferred courier or common carrier to use for shipping. 

Freight Terms: indicates which party is responsible for shipping costs. 

Language: if translations are maintained for the report labels in the Translation Manager, 

the language default on the Prospect Master indicates the language used on sales quotes 

printed for the prospect.  

 

VAT Number: indicates the value-added tax identification number for the prospect.  

 

Inactive: flag used to indicate whether the prospect should appear in active prospect lists. 

Notes: used to store prospect-specific notes and comments. 

   

Admin 

The Admin page displays information on the user who created and changed the 

prospect record and the date and time the change was made. The change information 

includes changes made to prospect contacts. 

 

Audit Notes 

The Audit Notes page displays an audit trail of any changes or additions made to 

the prospect record. 
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Customer Master 

  

The Customer Master consists of tabbed pages for Address, Contacts, Items, 

Orders, Invoice, Shipping, and Profile information. A customer can be displayed by 

selecting a record from the Customer No. drop-down list, browsing the list using the 

navigation buttons on the bottom of the screen, or by using defined search criteria to filter 

from a list. To search for a customer, click on the search  button adjacent to the 

Customer No. field. On the Advanced Customer Search screen, you can enter filter 

criteria for the customer name, billing city, billing state, sales rep, customer type, or 

customer status. The search screen can be used to open inactive customers that no longer 

appear in the active Customer No. drop-down list. 

  

Add New Customer 

A new customer can be added by clicking the New button at the bottom of the 

screen and entering the customer information into each section. The customer number, 

name, and payment terms are required fields. The customer number defaults to a unique 

index but can be changed if desired to any other unique customer number.  

  

Copy Customer 

To create a new customer based on an existing record, open the customer in the 

Customer Master and select the Copy button. In the Copy Customer dialog box, enter 

the New Customer name and click the OK button. It will be necessary to enter new 

contacts, items, and ship-to locations for the new customer record and modify other fields 

as required to reflect differences. 

  

Address 

The Address page contains fields for entering the billing and physical street 

address for a customer. The Use Billing Address? flag can be used to copy the billing 

address fields to the street address fields. There are additional fields to store the 

customer’s sales territory, phone number, fax number, web address, and email address. 

   

Contacts 

            The Contacts page is used to enter customer contact information. Each contact 

record includes fields for first name, last name, title, phone number, extension, fax, email, 

mobile, location, address, city, state, zip code, and comments. Contact events can be 

created and maintained using Customer Contact Management, opened by double-clicking 

on a contact’s first name. 

  

Items 

The Items page contains a Part No. Cross Reference screen displaying items that 

are ordered from the currently selected customer. The part number cross reference screen 

allows the entry of a customer-specific part number and default price for the customer 

item. The default price should be stated in terms of the stock unit of measure and 

customer currency. The screen also presents the date the item was last ordered from the 
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customer. The cross-reference information can also be maintained in the Customer 

Items section on the Orders page of the Item Master. 

   

Orders 

           The Orders page contains default fields that populate a customer order when the 

customer is selected. The Order page also contains an ‘Open Orders’ list for the 

customer. The open orders list can be changed to display a list of previous orders by 

clicking the ‘Order History’ button. For both lists, any of the orders can be opened by 

double-clicking the Sales Order field. 

  

Priority: the priority field is a value between 1 and 50 used to prioritize customer orders 

and shop orders. A lower value indicates higher priority so orders with a priority of 1 will 

be scheduled before orders with a priority of 10, for instance. The priority can be changed 

on the customer order and/or shop order. 

  

Price Level: a price level may be assigned to the customer and used to determine the 

default sales price for an item when added to an order line. The default sales price could 

be based on a different method depending on the option selected on the Orders page of 

the Item Master. A price level can be based on either an item price or a fixed discount or 

markup percentage. Price levels are created and maintained in the Sales Price Level 

Maintenance screen.   

  

Sales Tax Code: the default sales tax code for the customer used on the customer order. 

The sales tax codes are maintained in the Tax Code Master and can be optionally 

populated using the standard interface to QuickBooks®. 

  

VAT Code: the default value-added tax code for the customer used on the customer 

order. The value-added tax codes are maintained in the Tax Code Master. 

     

Sales Rep.: the default sales representative for the customer. 

   

Invoice 

           The Invoice page contains financial and accounting fields related to customer 

invoicing. The standard field definitions are as follows: 

  

Payment Terms: the payment terms are included on the customer invoice and indicate 

the discount and net terms for the customer.  

  

Revenue Acct.: the general ledger revenue account used to post revenue for the 

customer. The QuickBooks® Link uses the revenue account assigned to the product class 

for the item so the revenue account assigned to the customer is for reference only. 

 

Accounting ID: When using the QuickBooks® Link, the Accounting ID displays the list 

reference for the customer maintained in the accounting package. 
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Currency Code: the currency code is referenced on the customer order and indicates the 

currency used on the customer invoice.  

 

Credit Limit: the customer’s credit limit. During customer order entry, the customer’s 

open order amount is compared to their credit limit. If the open order amount exceeds the 

credit limit, the order-entry operator receives a warning message and prompt to place the 

order on Credit Hold. A credit hold order deducts the sales forecast but is not processed 

as demand until being removed from credit hold.  

  

Balance: When using the QuickBooks Link, the customer’s open balance represents 

unpaid invoices in QuickBooks. During customer order entry, the customer’s open order 

amount in Catalyst and balance in QuickBooks is compared to the credit limit to 

determine if the order should be placed on credit hold.  

  

Default Third-Party Bill-To: the default third-party bill-to address that initially 

populates on all new customer orders for the customer.  The default third-party bill-to can 

either be removed or changed to a different third-party bill-to address during customer 

order entry.  If a third-party bill-to address is populated on the customer order, it appears 

in the bill-to section on the invoice instead of the customer’s billing address. 

  

Third-Party Bill-To Addresses: a list of addresses that may be used to specify a 

different bill-to address than the customer’s billing address. A third-party bill-to address 

can be assigned to the customer order to replace the customer’s billing address on the 

customer invoice.  

    

Shipping 

           The Shipping page contains fields to store the default FOB point, preferred carrier, 

freight terms, and ship-to locations for the customer. The FOB Point field designates 

where legal liability, and typically shipping costs, transfers from the shipper to the 

receiver. The Ship Via field specifies the preferred courier or common carrier to use for 

shipping. The Freight Terms indicate when ownership and title transfers between seller 

and buyer and which party is responsible for shipping costs.  

  

The Ship-To Locations section stores multiple ship-to addresses for a customer 

and are referenced on customer orders and shipping documents. The Copy Street 

Address button can be used to create a ship-to location record based on the customer’s 

physical street address. If a new customer ship-to location is added during Customer 

Order Entry, it is automatically added to the list of available ship-to locations on the 

Customer Master. To specify a preferred ship-to location for customer orders, select the 

Default check box for the desired location. The ship-to location is then automatically 

added to the customer order when the customer is selected. The information maintained 

in the Notes field is transferred to the customer’s packing list when the shipping 

document is created. The Warehouse and Location values are used during ship 

confirmation when shipping goods to a customer’s consignment location. The Del. Days 

field stores the delivery days from the ship-from location to the ship-to location and is 



Catalyst Manufacturing User Manual

 

81 

used to calculate the delivery date of a customer order given the due date or, conversely, 

the due date of a customer order given its requested delivery date. 

   

Profile 

The Profile page contains fields to store general information about the customer 

including customer type, default language, account number, value-added tax number, 

active status, and customer notes. 

  

Cust. Type: used to classify the customer for reporting purposes. 

Language: if translations are maintained for the report labels in the Translation Manager, 

the language default on the Customer Master indicates the language used on sales orders, 

invoices, packing lists and other reports printed for the customer. 

Account No. refers to the customer account number or name. 

 

VAT Number: indicates the value-added tax identification number for the customer.  

Inactive: flag used to indicate whether the customer should appear in active customer 

lists. 

 

Notes: used to store customer-specific notes and comments for customer invoices, 

packing lists, and bills of lading. 

  

DEA Reg. No.: Drug Enforcement Agency registration number. The DEA registration 

and license expiration date for the customer are verified when an item requiring DEA 

registration is entered on a customer order or shipping document. 

  

DEA License Exp.: DEA license expiration date. The DEA registration and license 

expiration date for the customer are verified when an item requiring DEA registration is 

entered on a customer order or shipping document.  

   

Admin 

The Admin page displays information on the user who created and changed the 

customer record and the date and time the change was made. The change information 

includes changes made to customer contacts, customer items, and ship-to locations. 

 

Audit Notes 

The Audit Notes page displays an audit trail of any changes or additions made to 

the customer or customer items on the Items page. 
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Customer Contact Management 

The Customer Contact Management screen can be used to enter and track 

contact events for customer contacts maintained in the Customer Master.  To enter a new 

contact event, click the New button and select a customer and contact from the Customer 

and Last Name drop-down lists.  After entering the relevant information for the contact 

event, click the Save button.  To view previously entered events for a contact, select the 

customer contact and click the View Events button. 

The fields on the Customer Contact Management screen include: 

Customer: the company name of the customer contact 

Last Name: the last name of the customer contact 

First Name: the first name of the customer contact 

Phone: the phone number for the customer contact 

Fax: the fax number for the customer contact 

Email: the email address for the customer contact 

Order No.: the customer order number for reference purposes. 

Type: the type of contact such as meeting, phone, fax, email, or page. 

Employee: the employee making the customer contact. 

Date: the date of the customer contact. 

Document No.: a document reference field. 

Comments: a comment field for notes and memos. 

Create / Maintain Customer Types 

  

           The customer types are used to organize and group customers for reporting and 

analysis purposes. The Customer Type Master screen can be opened from the Sales tab 

or by clicking the edit  button beside the Cust. Type field on the Profile page of the 

Customer Master. 

  

            To maintain the customer types in datasheet view, click the table image 

 button. In datasheet view, you can scroll down the list of existing records and add, 
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delete, or edit without the use of command buttons. To return to form view, double-click 

the gray bar to the left of the datasheet or right-click anywhere in the datasheet and select 

the View Form option from the shortcut menu. 

 

Create / Maintain Sales Territories 

  

           The Territory Master is found on the Sales tab and is used to create and maintain 

sales territories for salespersons. Territories are assigned to customers in the Customer 

Master. The territory field can be used to generate regional sales reports and customer 

listings within a designated territory. 

  

            To maintain sales territories in datasheet view, click the table image  button. 

In datasheet view, you can scroll down the list of existing records and add, delete, or edit 

without the use of command buttons. To return to form view, double-click the gray bar to 

the left of the datasheet or right-click anywhere in the datasheet and select the View 

Form option from the shortcut menu. 

 

Maintain Sales Price Levels 

  

The Sales Price Level Maintenance screen is used to create and maintain price 

levels. To open, select the Sales Price Level Maintenance button on the Sales tab or use 

the link on the Orders page of the Item Master. Price levels can be used to determine the 

default sales price for an item on a customer order. To apply price levels, the default sales 

price method, ‘Vary by customer price level’, must be assigned to an item on the Orders 

page of the Item Master. In addition, a price level needs to be assigned to any customer 

that may order items using the price level sales price method. The combination of the two 

settings allows the default sales price to be calculated using price levels at the time of 

customer order entry. 

  

Add new price level 

           To add a new price level, open the Sales Price Level Maintenance screen and 

select the New button. Assign a Level Type to the new price level and select the Save 

button. For the ‘Item Price by Level’ option, add item price records by selecting an item 

number and assigning a custom price for the price level.  

Once a price level is created it can be assigned to a customer on the Orders page 

of the Customer Master. To view a list of customers assigned to a price level, select the 

Where-Used button to open the Price Level Where-Used by Customer report. 

Price level types 

A price level can be based on either an item price or a fixed discount or markup 

percentage. On the Sales Price Level Maintenance screen, the two price level types are 

defined as follows: 

•        Item Price by Level 
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o       The default sales price is based on the custom price assigned to the 

customer’s price level when the item is added to a customer order. 

•        Fixed % by Level: 

o       The default sales price is calculated as a fixed discount or markup 

percentage of the item’s list price. The List Price is maintained on 

the Orders page of the Item Master. 

  

Maintain item prices by price level 

For the ‘Item Price by Level’ option, the custom prices for an item can be updated 

on the Sales Price Level Maintenance screen using the steps described below. 

1.      Select a price level from the Price Level drop-down list. 

2.      Enter a price adjustment percentage and select whether the adjustment is 

higher or lower than the item’s current custom price, standard cost or 

average cost. 

3.      To apply rounding, select the desired number of decimal places. 

4.      Select the ‘Adjust’ button to apply the specified price adjustment to the 

selected price level. 

  

Maintain item prices by item 

 For the ‘Item Price by Level’ option, the custom prices can be adjusted for all 

price levels assigned to an item by double-clicking the item number field on the Sales 

Price Level Maintenance screen. This opens the Item Price Levels screen with a list of 

all price levels and prices for an item. 

 

Enter Sales Price Quantity Breaks 

  

The Sales Price Quantity Breaks screen is used to store sales price quantity 

breaks for saleable items. The Sales Price Quantity Breaks screen can be opened from 

the Sales tab or the Orders page of the Item Master. When adding an item to an order 

line, a price quantity break is applied if ‘vary by quantity’ has been selected as the default 

sales price option in the Item Master. When entering an order line quantity, the price set 

is identified by comparing the order line due date to the effective date and expiration date 

of the item price sets. The price break is applied to order quantities at or above the 

quantity break. A zero price is returned if a price set or break quantity cannot be found 

for the item. 

  

Multiple price sets consisting of price quantity break information can be 

maintained for each saleable item. The record selectors in the Price Sets frame can be 

used to navigate between different price sets. To create a new price set, click the 

 button. To delete an existing price set, click the  button. Each price set 

includes the following fields: 
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Effective Date: the effective date of the price set 

Expiration Date: the expiration date of the price set 

Set Description: a description of the price set 

Price Quantity Breaks: the price for each quantity level. The price should be 

based on the stock unit of measure for the item and stated in terms of the company 

currency. 
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Planning 

The Planning tab contains the options required to conduct the material and capacity 

planning reviews and create and maintain a production schedule. The tab options 

available from this menu are listed below. 

Master Production Schedule 

Review Material Availability 

Review Capacity Availability 

 

Mass Release Shop Orders 

Consolidate Purchase Orders 

 

Generate Finite Schedule 

Review Work Center Dispatch 

Review Production Schedule Board 

 

Run MRP 

Review MRP Action Messages 
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Master Production Schedule 

 

The two sources of independent demand are customer orders and forecast. MRP is 

used to drive independent demand to the master schedule items and generate planned 

orders. The process of firming these planned orders is referred to as master production 

scheduling (MPS). The purpose of master scheduling is to balance demand requirements 

with supply, namely materials and capacity. The MPS offers a higher degree of stability 

for the production schedule caused by the variation inherent in customer orders and 

forecast. With the MPS, changes in demand are reviewed at the master schedule level to 

determine if the schedule can be changed without adversely affecting the current 

production schedule and material and capacity constraints. The Master Production 

Schedule (MPS) is validated by Rough-Cut Capacity Planning (RCCP).  

  

The master schedule is maintained using the Master Scheduling screen which 

can be opened by selecting Master Production Schedule on the Planning tab. The 

process and tools for establishing the master production schedule are similar to the 

material and capacity planning process with a few notable exceptions, namely: 

  

•       Firm planned orders 

•       Review lead-time violations for lower-level components 

•       Conduct rough-cut capacity planning 

•       Adjust the capacity and/or the production plan to balance supply and 

demand 

  

Firm Planned Orders 

           The master schedule is created by firming system generated planned orders. When 

using the master production schedule as the basis for MRP, only firm planned orders and 

scheduled receipts (shop orders and purchase orders) are used to drive lower-level 

demand. MRP does not consider requirements for planned orders that have not been 

firmed if the Master Production Schedule is selected as the MRP demand source.  

  

            The Planned Order Maintenance screen is opened by clicking the Firm Orders 

button or double-clicking the Supply source on the Material Planning and Master 

Scheduling screens. To firm a planned order simply check the Firmed box in the Planned 

Order Maintenance or use the Firm All button. Planned order quantities can be changed 

or deleted as a part of the firm planning process. The MRP lines on the Material Planning 

and Master Scheduling screens are updated with firm planned order changes the next 

time MRP runs. By default, the primary product configuration (Eng. ID = 1) is used to 

calculate lower-level MRP demand requirements. To specify an alternate configuration 

for firm planned orders, select the desired alternate configuration in the Eng. ID drop-

down list. The Comments field can be used to store notes related to the firm planned 

order such as the reason for changing the firm plan date or quantity. 

  

Although only the planned orders for master scheduled items need to be firmed 

when using the MPS demand source, it is possible and sometimes appropriate to firm 
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planned orders for non-master scheduled items. For example, if manufacturing expresses 

a capability to produce at a different quantity or date than recommended by a system 

generated planned order, the planned order can be overridden by making the necessary 

changes to the planned order and firming the order. For non-master schedule items, MRP 

will use both firm and non-firm planned orders to generate lower-level demand. 

  

Since MRP does not delete firm planned orders, they must be removed manually 

by unselecting the Firmed checkbox or converted to either a shop order or purchase 

order using the Mass Release Control Board or PO Consolidation screen, respectively. A 

shop order or purchase order can also be converted by right-clicking the firm planned 

order line on the Material Planning or Master Scheduling screen and selecting the 

‘Release Planned Order’ option from the shortcut menu. If a shop order or purchase order 

is created by clicking the ‘New’ button on the Shop Order Master or Purchase Order 

Entry screen, the firm planned order must be deleted manually in the Planned Order 

Maintenance screen.  

   

Catalyst creates a “Firm” action message to identify the master schedule items which fall 

within the planning horizon. To review a list of MRP lines that need to be firmed, click 

the Action Messages button at the bottom of the screen to open the MRP Action 

Messages dialog window. Select the Firm action type and click OK to preview a report 

listing the MRP lines with a “Firm” action message.  

     

Review Lead-Time Violations 

            After firming planned orders and running MRP, any lead-time violations for 

lower-level components caused by the new firm planned orders will be indicated by a 

“LT Viol” action message. These action messages can be reviewed by clicking the 

Action Messages button at the bottom of the screen to open the MRP Action Messages 

dialog window. Select the LT Viol action type and click OK to preview a report listing 

the MRP lines with a “LT Viol” status. These conflicts need to be resolved with the 

appropriate production and/or purchasing contacts to ensure that the master production 

schedule is realistic from a material availability standpoint. 

   

Conduct Rough-Cut Capacity Planning 

           After resolving material conflicts, the master scheduler must also validate the firm 

planned orders for the rate-determining work centers using a process called rough-cut 

capacity planning. RCCP involves reviewing capacity requirements in bottleneck work 

centers against available capacity over a given time period. Any excess required capacity 

over planned capacity needs to be resolved by adjusting either the schedule or capacity as 

described in the next section. Planned capacity is reflected in the Shop Calendar. 

Required capacity is based on the setup and run hours for shop orders and firm planned 

orders. 

  

           In Catalyst, RCCP can be performed by selecting Review Capacity Availability 

from the Planning tab. Select the bottleneck work center from the drop-down list and 

adjust the dates to reflect the planning horizon. To determine the impact of firm planned 

orders, select the Firm Planned Orders option from the Order Types option group.  
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The available capacity for the chosen period is summarized in the Planned Capacity 

field. The total hours required for selected orders is summarized in the Required Hours 

field. Any remaining capacity is displayed in the Remaining Cap. field in green. When 

the work center is overcapacity, the remaining capacity will be negative and displayed in 

red. In this situation, either the capacity or the schedule needs to be adjusted for the 

master production schedule to be valid. 

   

Adjust Schedule and/or Capacity 

            For work centers where the required capacity exceeds the available capacity, the 

master production schedule or capacity must be adjusted to balance supply and demand 

requirements. After reviewing options with production management, revised capacity in 

the form of overtime, extra shifts, resources, etc. can be reflected using the Shop 

Calendar. If capacity cannot be adjusted to meet the demand requirements, then the 

master production schedule must be changed. In Catalyst, this is accomplished using the 

Planned Order Maintenance screen to change the firm planned order need and release 

dates. The difficult part of the task involves informing sales representatives and customer 

contacts that their orders will be delayed. However, customers obviously would much 

rather learn of the delay early on than be surprised when the shipment does not arrive as 

originally promised.  

  

Changes to the master production schedule made within the planning horizon 

need to be subjected to a review and approval process to ensure schedule stability. A 

production schedule that changes whenever demand changes is much harder to meet than 

one that remains stable. For instance, changes to the production schedule within the 

releasable period for an item results in higher setups, waste, and shop floor disruptions. 

The MPS can be used to manage demand changes by reviewing planned orders at the 

master schedule level prior to releasing shop orders into the production schedule. 

 

Review Material Availability 

  

The Material Planning screen, opened by selecting Review Material 

Availability on the Planning tab, is used to evaluate time-phased supply and demand 

requirements for an item. In conjunction with MRP Action Messages and material 

shortages reports, the Material Planning screen is a critical tool in the review and 

evaluation of the material requirements for an item. The Material Planning screen 

presents summarized demand and supply information by item to assess whether on order 

needs to be released to meet independent[1] or dependent[2] demand requirements. The 

release process involves converting planned orders to shop orders and purchase orders 

using the Material Planning screen, Mass Release Control Board, or Purchase Order 

Consolidation screen. 

  

The Material Planning screen presents a snapshot of the time-phased supply and 

demand requirements from the last material requirements planning (MRP) run. As orders 

are released and changes are made in the system that affect the demand and supply 
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picture, the MRP screen remains the same until updated either by the next full MRP run 

or by clicking the Refresh button at the bottom of the screen. The Refresh button 

updates the gross requirements for the current item and recalculates the supply based on 

newly released orders or changes to open orders and inventory. To regenerate MRP 

results for all item levels, however, a full MRP run needs to be launched from the 

Catalyst MRP screen. The Catalyst MRP screen can be opened by clicking the Run MRP 

button. 

  

The source of gross requirements from upper-level demand can be identified in 

the Source field. If the source demand originates from a customer order, purchase order, 

or shop order, the order can be opened by double-clicking the Source field. If the source 

demand originates from a planned or firm planned order, double-clicking the Source 

field opens the Demand Pegging screen. The Demand Pegging screen identifies the 

source of upper-level demand for the currently selected MRP line. To peg the demand 

further, double-click the Item No. field on the Demand Pegging screen to display the 

MRP requirements for the parent item. For a multi-level summary of the MRP Pegging 

Requirements for an item, select the Pegging Report button at the bottom of the 

Material Planning screen.  

  

Although the Mass Release Control Board and Purchase Order Consolidation 

screens offers a more efficient way to release multiple planned orders, a planned order 

can also be converted to a shop order or purchase order directly from the Material 

Planning screen. When right-clicking an MRP line, a shortcut menu is displayed with 

options to edit or release the planned order, shop order, or purchase order for an item. 

The edit option allows you to edit the existing planned order, firm planned order, shop 

order, or purchase order for the line item. The release order option converts existing shop 

orders to a ‘Released’ status or creates a shop order or purchase order based on a planned 

or firm planned order. When releasing planned or firm planned orders, the planned order 

is deleted from the planned order table. 

  

The demand due date for dependent demand items is based on the release date for 

the parent item. The supply need date for dependent demand items will be equivalent to 

the demand due date since it’s based on the release date for the upper-level demand. The 

supply quantity depends on the demand requirement and other system settings including 

the order policy, lot size, minimum order quantity, and safety stock for the item. The 

Action field is a system-generated MRP action message for an MRP line item. The field 

definitions for the upper portion of the Material Planning window are reviewed below. 

   

Item No.: the item number selected for material planning review. 

  

Item Description: the description of the item as specified on the Item Master. 

   

Planner/Buyer: the planner or buyer initials for the item as specified on the Planning 

page of the Item Master. 
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Planning Whse: the planning warehouse as set in the Company Master. During MRP, 

only inventory in the planning warehouse will be netted against demand requirements 

unless “All” has been selected. The planning warehouse can also be changed from the 

Material Planning screen. 

  

Safety Stock: the safety stock specified for the item in the Item Master. MRP will 

attempt to replenish the safety stock whenever gross requirements cause the projected 

inventory to fall below the safety stock. For kanban items, this field is referred to as the 

“Reorder Point”. 

  

Total On-Hand: the total non-reject quantity on-hand in nettable inventory locations at 

the time MRP was last run. 

  

Order Policy:  the order policy specified for the item on the Planning page of the Item 

Master. The order policy determines how MRP calculates planned orders.  

  

Lot Size: the lot size specified for the item on the Planning page of the Item Master. 

  

Min. Order Qty: the minimum order quantity for the item. The minimum order quantity 

is factored into MRP planned order calculations. 

  

Yield: the product or process yield specified for the primary product configuration. The 

supply quantities that appear in the Supply section represent the projected receipt 

quantities after the expected yield loss. To determine the release quantities prior to any 

yield loss, refer to either the quantity ordered field on the shop order or the planned order 

release quantity which can be obtained by clicking the Firm Orders button. 

  

Current Date: today's date 

  

Planning Horiz.: the planning horizon expressed in days normally calculated as the 

greater of either the cumulative lead time or the time required to make capacity 

adjustments for an item. The Planning Horizon indicates the demand fence within which 

items are firm planned and/or released as scheduled receipts (i.e. shop orders or purchase 

orders). When running MRP using the time fence option, MRP uses the Planning Horizon 

as the demand time fence within which the system does not generate planned orders. 

  

Horizon Fence: the demand time fence which is equal to the current date plus the 

planning horizon days. The Horizon Fence is used to define the period over which a 

master schedule item should be firm planned since changes to the schedule within the 

planning horizon could have an adverse impact on material availability for lower-level 

items. 

  

Product Code: the product code for the item. 

  

Product Class: the product classification of the item. 
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Item Type: the product type of the item whether manufactured, purchased, or outside 

process. 

  

Period Days: the number of days in a time interval for items using a Period order policy. 

  

Fixed Lead Time: the fixed lead-time component in days to make or procure an item. 

  

Var. Lead Time: the variable lead-time component in days to make or procure an item. 

  

Safety LT: the safety lead-time specified for the item on the Planning page of the Item 

Master. MRP will offset the need date for a planned order by the safety lead time so that 

the planned release for the order is scheduled earlier by an amount equal to the safety 

lead time. 

 

Planning Notes: item-specific planning notes that are maintained as a reference for the 

planner or buyer for material planning purposes. 

 
[1] Independent demand refers to demand that is not dependent on another item i.e. forecast and customer 

orders. 
[2] Dependent demand refers to demand that is dependent on another item i.e. demand from a parent 

established through a bill-of-material relationship. 

   

Review Capacity Availability 

  

The Work Center Capacity Load Profile can be opened by selecting Review 

Capacity Availability from the Planning tab. The Work Center Capacity Load Profile 

graphically depicts the load on a work center to indicate which periods are over or under 

capacity. The load is defined as the percentage of available capacity consumed on a work 

center during any given time period. The buckets adjust in size and color based on the 

load percentage, which is displayed at the top of each bucket. The available capacity is 

based on the work center schedules in the shop calendar.  

  

The Capacity Load Profile allows you to view production requirements by 

specified time period or bucket. The default bucket sizes are daily, weekly, and monthly. 

The load profile will display up to 12 buckets of demand. The demand requirements 

included in the load profile can be changed to include a combination of shop orders and 

MRP-generated planned orders. To view a summary of the weekly or daily buckets, 

including operator requirements, select the Print button to open the Capacity Load 

Profile Report. To view or reschedule a specific shop order, drill-down further by double-

clicking on the shop order number. To view the operation detail that comprises the 

demand in a period, double-click the bucket to open the Work Center Load Detail. The 

load detail lists the work center operations that comprise the bucket demand.  

  

The schedule for any individual shop order can be adjusted in the Shop Order 

Master or Work Center Dispatch screen. Click the Schedule button to reschedule all shop 

orders using the finite capacity scheduling engine. The detailed Capacity Requirements 
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Plan (CRP) is generated based on the current shop schedule during MRP. If the 

scheduling engine is run after MRP, it may be necessary to rerun CRP using the Refresh 

CRP button. The work center capacity is based on the shop calendar. The capacity for a 

specific work center can be adjusted using a combination of the Work Center Master and 

Shop Calendar. 

  

The Capacity Load Profile displays all demand having due dates or schedule dates 

between the Period Start and Period End dates. The Period End date is calculated 

automatically based on the Period Start and Bucket Size. To review past-due demand, 

change the Period Start to an earlier date. The capacity load profile also contains 

calculated fields that summarize the load and capacity for the work center between the 

selected start and end dates. These fields are all expressed in hours and are defined as 

follows: 

Required Hrs: the total remaining hours for operations in the work center between the 

period start and end dates. 

Scheduled Hrs: the total hours scheduled for operations in the work center between the 

period start and end dates. 

Unsched. Hrs: the difference between the required hours and the scheduled hours fields 

indicating the remaining operation hours that still need to be scheduled. 

Planned Cap.: total available hours planned on the shop calendar between the period 

start and end dates. 

Available Cap.: the difference between the planned capacity and required hours 

indicating the available hours in the work center between the period start and end dates. 

  

The Capacity Load Profile indicates whether or not demand needs to be 

rescheduled to meet capacity constraints. Alternatively, capacity can be adjusted by 

adding shifts, overtime, or resources although this option typically has direct labor 

variance implications. When the required hours exceeds scheduled hours or planned 

capacity for a period, the unscheduled hours and available capacity fields are displayed in 

red.  

 

Capacity Load Detail 

  

The Work Center Load Detail is opened from the Work Center Capacity Load 

Profile and lists the work center operations in a specified bucket period. To view or 

reschedule a specific shop order in the list, open the Shop Order Master by double-

clicking on the shop order number. 

  

The Work Center Load Detail can also be used to sequence the shop orders in a 

work center. The Finite Scheduler generates an initial schedule sequenced according to 
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due date or priority. The sequence of the shop orders scheduled across a work center can 

be adjusted by changing the priority of the shop order and running the Finite Scheduler 

using the Priority job selection rule. The priority for a shop order can be changed by 

editing the Priority field directly or by double-clicking the shop order and changing the 

priority on the Shop Order Master. Note, however, that the Finite Scheduler produces a 

schedule subject to the capacity constraints in a work center so higher priority jobs may 

not necessarily be scheduled first if there is not enough capacity at any of the work 

centers the shop order is routed. The Work Center Load Detail fields are defined in more 

detail below. 

Sched. Date: scheduled operation date for either planned or shop order sequence number. 

Order No.: the planned order or shop order reference number. 

Status: shop order or planned order status. 

Priority: the job priority between 1 (highest) and 50 (lowest). The priority can be edited 

if the order types displayed include only open and released shop orders. 

Item No.: the parent item number 

Description: the parent item description. 

Seq.: the operation sequence number. 

Opn Description: the operation description. 

Load Hrs: the scheduled operation hours on the schedule date. 

Total Load Hrs: the sum of the load hours on the work center between the bucket start 

and end dates. 

Mass Release Control Board 

  

The Mass Release Control Board, opened by selecting Mass Release Shop 

Orders from the Planning tab, is used to mass release open shop orders, firm planned 

orders, and planned orders. The Mass Release Control Board offers a fast, effective 

method of releasing open shop orders and creating shop orders from MRP planned 

orders.  

  

The releasable orders for MRP items can be filtered by release date, MRP action 

message, item filters, or order type. The Release Date filter is used to display shop orders 

and planned orders having a release date on or before the specified date. The Item Filter 

can be used to display, MRP items, kanban items, saleable items, items with a specified 

planner, items with a specified product code, or specified item numbers. For kanban 
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items, a demand signal is generated when net requirements from actual demand exceeds 

the fixed safety stock level for the item. Finally, the Order Type filter can be used to 

specify the release of either shop orders or planned orders.  

  

The orders to be released are selected by checking the Release box for records in 

the Releasable Orders list or by using the Select All and Unselect All buttons below the 

list. To exclude an order from the release process, uncheck the Release box for that order 

line. The Releasable Orders List can be sorted by Item No., Release Date, or Need Date 

by clicking the indicator arrows on the respective fields. The Material Planning screen for 

an item can be opened by double-clicking the item number.  

  

The release cycle consists of the five steps described below and are executed 

using the hyperlinks in the lower-left portion of the Mass Release Control Board.  

   

1.      Check material shortages: Opens the Material Shortage Report that 

summarizes the available quantity for all bill-of-material components. The 

report identifies orders with material shortages and allows for the selective 

inclusion or exclusion of orders for release based on available materials. It 

also can serve as a prompt to follow-up on outstanding open orders to ensure 

receipt prior to the start of production. 

   

-        The Material Shortage Report calculates the Quantity Available from 

the Quantity Required, Other Release Requirements, and 

Warehouse On-Hand columns. The Other Release Requirements 

are obtained from shop orders that have either already been released or 

are selected for release in the current session. The Warehouse On-

Hand is based on the selected warehouse. The Quantity On Order 

field is for reference only and sums open shop orders for manufactured 

items and purchase orders for purchased items. This report can be 

misleading if materials are not issued to shop orders in a timely 

manner or if shop orders are released to the shop floor before their 

actual start date in production. 

-        To place a purchase order for material shortages at the same time the 

shop order is released, select the Purchase Shortages button at the 

bottom of the screen. This will open the Purchase Order Consolidation 

screen and populate the list with shortages for any selected line items. 

To create the purchase order, select the Combine box for items with 

the same vendor and click the Auto-create PO button. Alternatively, 

purchase orders can be created from planned orders generated after 

running MRP. 

  

2.      Mass release shop orders: Releases only those orders in the Releasable 

Orders list with the Release flag checked. If the selected Order Type is 

‘Open Shop Orders’, the status of open shop orders is changed to ‘Released’. 

If the Order Type is ‘Firm Planned Orders’ and/or ‘Planned Orders’, the 

planned orders are converted to shop orders in a ‘Released’ status. Any items 
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with linked sub-assemblies are also released as a part of this process. Planned 

and firm planned orders are automatically deleted during the release process 

with the results reflected in the next MRP run. 

  

-        To assign a lot number to a shop order during the release process, 

manually add the lot number to the release line before clicking the 

‘Mass Release’ button. Alternatively, to have the system generate a 

default lot number, specify a lot number default for shop orders on the 

Profile page of the Company Master.  

-        To link a shop order to a customer order line at the time of release, 

assign a customer order to the release line in the Cust. PO drop-down 

list. 

  

3.      Mass allocate shop orders: Allocates material to the shop orders released in 

the previous step. The allocation of material to shop orders is not required, but 

it does allow for enhanced visibility of the material that remains available for 

other orders. For lot-controlled items, the material allocation is performed 

using oldest materials first. To unallocate materials performed in this step, 

click the Reverse Allocations button located in the bottom portion of the 

screen. 

  

4.      Schedule shop orders: Opens the Catalyst Scheduler to generate a finite 

capacity schedule. The schedule can be reviewed in the Capacity Planning 

window or the Production Schedule Board prior to being printed and sent to 

the shop floor. It is recommended that the system-generated schedule be 

validated prior to dispatch to the shop floor. 

  

5.      Print shop order packets: Opens a screen to print the shop order documents 

such as the Shop Order Traveler and Pick List for the orders released in step 2. 

  

The releasable orders list updates automatically for any changes made on the 

screen; however, the Update List button can also be used to refresh the releasable order 

list after running MRP or to reflect changes made by other users.  

 

Consolidate Purchase Orders 

  

The Purchase Order Consolidation screen, opened by selecting Consolidate 

Purchase Orders from the Planning tab, converts planned orders to purchase orders for 

MRP and kanban items. The purchase requirements list can be updated by selecting a 

Source, Purchase Filter, Item Filter, and/or Vendor Filter at the top of the screen. The 

Item Filter can be used to change the releasable order list to include only MRP items, 

kanban items, or a specific item. For kanban items, a demand signal is generated when 

net requirements from actual demand exceeds the fixed safety stock level for the item. 
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The Purchase Order Consolidation screen is used in conjunction with MRP 

Action Messages and associated planning reports to review planned orders and convert to 

purchase orders. Prior to converting a planned order, the buyer can edit purchase 

quantities and need dates or change the vendor to take advantage of quantity breaks, 

consider item availability, expedite requirements, and any other factors. The Material 

Planning screen for an item can be opened by double-clicking the item number. Catalyst 

automatically deletes planned orders after converting them to purchase orders. The new 

purchase orders are displayed on the Material Planning screen after the next MRP run or 

screen refresh.  

  
The planned orders or kanban signals to be consolidated are selected by checking 

the Combine box for each line to include on a purchase order. The planned order list can 

be sorted by Item No., Release Date, or Need Date by clicking the indicator arrows on 

the respective fields. When clicking the Auto-create P.O. button, a purchase order is 

automatically created for the selected lines. If multiple planned orders for an item are 

combined on a purchase order, planned orders with the same due date are combined into 

a single line while those with a different due date are added on separate lines.  

  

The default vendor on each planned order line is the primary vendor assigned to 

the item on the Supply page of the Item Master. The default vendor can be changed to 

an alternate vendor that appears in the Vendors list on the Supply page of the Item 

Master. When creating a purchase order with multiple line items having different 

vendors, the purchase order is created using the vendor from the first selected line item.  

 

Generate Finite Schedule 

  

The Catalyst Scheduler, launched by selecting Generate Finite Schedule from 

the Planning tab, is a finite scheduling engine that creates a finite capacity schedule 

based on the available capacity reflected in the shop calendar for each work center. The 

scheduling options on the Options page can be used to configure the way the scheduler 

runs. The Statistics page indicates when the scheduler last ran and the total elapsed time. 

In addition, a summary is provided of the total number of late and unscheduled 

operations in the current schedule. A report of late and unscheduled operations can be 

opened by clicking the adjacent View buttons. 

  

On the Options page, the Schedule Direction indicates whether the scheduler 

forward schedules from the shop order release date or backward schedules from the due 

date. When backward scheduling, the scheduler first attempts to schedule a shop order 

using backward sequencing. If the resulting scheduled start date is before the current 

date, the shop order is rescheduled using forward sequencing. For bottleneck scheduling, 

schedule the bottleneck operation manually using the Shop Order Master and select the 

Frozen flag. Then select either the ‘Backward’ or ‘Forward’ schedule direction to fill-in 

schedule dates and times for the unfrozen operations.  
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The finite scheduling engine run options allow scheduling of work center 

resources, operators, or both. The default run option is ‘Schedule work centers only’ 

which generates a schedule without assigning operators to each scheduled operation. To 

assign operators based on the current schedule, select the ‘Schedule operators against 

existing schedule only’ run option. To schedule work center resources and then assign 

operators to the new schedule, select the ‘Schedule both work centers and operators’ run 

option. The last two run options require setting up operators in the Employee Master and 

specifying available operator hours in the Operator Calendar. When tooling is assigned to 

an operation, the scheduler will check to prevent the same tool from being used at the 

same time. 

  

The shop orders are loaded into the schedule according to job selection rules. The 

shop orders can be sorted according to Due Date, Critical Ratio, or Priority job selection 

rules. These three job selection rules are defined below. 

Due Date: shop orders are loaded onto the Production Scheduling Board 

beginning with the earliest shop order due date. The shop order number is used as 

secondary sort criteria in the event of a tie. 

Critical Ratio: shop orders are loaded onto the Production Scheduling Board 

beginning with highest critical ratio. The critical ratio is calculated by dividing the 

hours remaining to be completed on the shop order operations by the shift hours 

remaining on the shop calendar before the due date. The due date and shop order 

number are used as secondary sort criteria in the event of a tie. 

Priority: shop order priorities range from 1 to 50 with 1 being the highest priority 

and 50 the lowest priority. Shop orders are loaded onto the Production Scheduling 

Board beginning with highest priority (1) and ending with the lowest priority (50). 

The shop order priority defaults to 50 and can be changed either on the Shop 

Order Master or the Capacity Planning window. The due date and shop order 

number are used as secondary sort criteria in the event of a tie. 

To apply campaign rules to the scheduling process, select the appropriate option 

under the Campaign Rules group. The application of campaign rules allows the 

scheduler to consider efficiencies in sequencing operations to minimize setup time and 

maximize resource capacity. The campaign rules are applied when sequencing operations 

of the same item or product family. The Catalyst Scheduler will apply campaign rules 

only to operations with the Campaign flag marked on the shop order route. When the 

‘Apply to same product only’ option is selected, the setup hours for a shop order 

operation is assumed to be zero when the prior operation on the work center resource is 

the same item. When the ‘Use product family setup matrix’ option is selected, the setup 

hours for a shop order operation is obtained from the Product Family Setup Matrix. The 

setup hours used for the operation is based on the product family of the previously 

scheduled item and the product family of the current item.  
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You can select whether to include only released shop orders or both open and 

released shop orders in the production schedule by marking the appropriate check box in 

the Order Status section. To calculate the scheduled start and finish dates for an 

individual shop order, select the shop order from the drop-down list in the CTP 

Calculation section. After the schedule is generated, the scheduled start and finish dates 

are displayed for review. The shop order start and finish dates can be frozen by clicking 

the Freeze button located in the section. 

The Catalyst Scheduler only schedules unfrozen shop order operations. Prior to 

generating a new production schedule, the operations in the current schedule can be 

frozen to prevent them from being changed after they are released to the shop floor for 

production. The options in the Schedule Control section allow the scheduler to freeze all 

operations, scheduled operations, or started operations for both open and released shop 

orders operations. The same options are provided for unfreezing any frozen operations. 

To leave the frozen status of operations unchanged, use the default No Action option.  

Review Work Center Dispatch 

  

The Work Center Dispatch Report is used to not only generate dispatch reports 

for the various work centers, but also to make changes to the scheduled operations 

quickly and easily. The Work Center and Shop Order filters can be used to limit the 

operations displayed in the Scheduled Operations section. Any of the enabled scheduled 

operation fields can be modified including the work center resource, shop order due date, 

shop order priority, operation description, setup hours, run hours, operation notes, and 

scheduled start and finish times. To modify a date field, double-click the field and select 

a date/time from the calendar. Click the Save button to save your schedule changes and 

the Print Preview button to generate Work Center Dispatch Reports for the filtered 

operations. 

 

Review Production Schedule Board 

  

The Production Schedule Board, located on the Planning tab, is useful for 

quickly assessing the performance of the production schedule and making fine-tune 

schedule adjustments prior to releasing shop orders to production. The Production 

Schedule Board displays the finite capacity schedule in Gantt chart view with each row 

containing scheduled shop order operations for a work center resource across time.  

  

The Production Schedule Board displays work non-work periods in a yellow 

background based on the planned capacity in the Shop Calendar. The shop order 

operations appear as red (late) or blue (on-time) bars with each one labeled with the shop 

order number and sequence number. The length of the operation bar represents its 

duration with the beginning and end of the bar representing the schedule start and finish 

times. An operation that must span over non-work periods will appear longer than the 

actual operation hours required. 
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The Production Schedule Board can be used an effective tool to quickly 

reschedule shop order operations and obtain a frozen schedule that will not be changed by 

the addition of new orders into the system. An operation can be rescheduled by dragging 

an operation bar to another work period on the same resource. Rescheduling operations 

on the scheduling board changes the schedule start and end dates and times for the 

operation and freezes the operation so that it will not be rescheduled the next time the 

scheduler runs. To allow the scheduler to make adjustments to the overlap between 

operations, the rescheduling of one operation on a shop order will not automatically move 

other operations on the same shop order. To move multiple operations on the same shop 

order, drag and drop each individual operation. To highlight all operations on a shop 

order, click the Select S.O. toggle button. To remove the highlight from a shop order, 

turn off the toggle button. 

  

An individual operation can be frozen and unfrozen by opening the Operation 

Detail screen using the right-click button. To freeze or unfreeze the entire schedule, open 

the Schedule Control screen by clicking the button at the bottom of the screen. The 

Schedule Control screen allows the scheduler to freeze or unfreeze all operations, 

scheduled operations, or started operations for both open and released shop orders. These 

options are also available in the Catalyst Scheduler to apply before the schedule is 

generated. 

  

An operation cannot be moved into another row to be rescheduled on another 

work center or resource. The operation work center must be changed in the Shop Order 

Master to move the operation to an alternate work center. To open the Shop Order 

Master, double-click an operation bar. Any changes made on the Shop Order Master are 

not reflected on the schedule board until the next time the schedule is generated. The 

operation must be unfrozen if it is to be rescheduled automatically by the Catalyst 

Scheduler.  

    

To add a single shop order to the schedule, click the Add Shop Order button at 

the bottom of the screen and select a shop order from the drop-down list. After clicking 

the Schedule button, the shop order is added to the existing production schedule. The 

shop order scheduled start and finish dates are displayed in the screen for easy reference. 

The Freeze button can be used to freeze the scheduled start and finish dates so they will 

not be changed during the next schedule run. The linked shop orders on a customer order 

can similarly be added to the schedule to determine a capable-to-promise (CTP) date for 

the customer order. 

  

To change the work periods, click the Shop Calendar button and update the shop 

calendar over a date range or specific date using additional shifts, overtime, or other 

capacity adjustments. When changing the shop calendar, click the Refresh button to 

update the schedule board with the revised work periods. Alternatively, rerun the Catalyst 

Scheduler to recognize the new capacity constraints.  
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The production schedule view can be adjusted using the zoom buttons and schedule start 

and end dates on the lower part of the screen. A summary of the operations scheduled on 

a work center resource can also be viewed using the Work Center Dispatch Report 

(Planning > Review Work Center Dispatch). 

  

Run Material Requirements Planning (MRP) 

  

Material Requirements Planning (MRP) is the calculation of material 

requirements from independent (customer orders and forecast) and dependent (bill-of-

material) demand sources netted against open orders and inventory at each level in the 

bill-of-material. MRP levels are determined by the bill-of-material structure specified on 

the primary product configuration. A product configuration is the build recipe for an item 

and includes the raw materials, sub-assemblies, and components required to make the 

item.  

  

MRP can be based on either the master production schedule (MPS) or 

independent demand sources (customer orders and forecast). When basing MRP on the 

master production schedule, dependent demand is based on firm planned orders. When 

basing MRP on independent demand, customer orders and forecast serve as the end item 

demand source. When master scheduling, Catalyst MRP accepts firm planned orders 

established at multiple levels in the bill-of-material. 

  

MRP calculates net material requirements for purchased and manufactured items 

through a bill-of-material (BOM) explosion. MRP uses the standard quantities and scrap 

factors specified on the bill-of-material to determine the dependent demand for the next 

BOM level. When there is not sufficient supply (open orders and inventory) to cover 

demand, MRP generates planned orders. The planned order quantity is determined by the 

order policy, lot size, minimum order quantity and safety stock quantity for the item. The 

planned order due date is based on the demand need date. The planned order release date 

is calculated by subtracting the planned order due date by the lead time.   

  

Planned orders are converted into purchase orders and shop orders through the 

planning process. Purchase orders are created using the Purchase Order Consolidation 

screen and sent to vendors for execution. Shop orders are created using the Mass Release 

Control Board which includes a checklist to check material availability and run a finite-

capacity scheduler prior to releasing the orders to production. 

  

The Catalyst MRP screen launches a complete regeneration of demand and supply 

requirements for all inventory levels. To avoid record conflicts, MRP should be run when 

no other material and capacity planning functions are occurring. To verify other users 

have exited the system, check the User Roster on the Tools tab. To launch MRP, select 

Run MRP on the Planning tab. MRP can also be setup to run automatically as described 

in the Scheduled Task Setup help topic. 
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MRP can be configured by modifying the run options on the Options page. The 

default settings for some MRP options can be set on the Manufacturing page of the 

Company Master. The Statistics page indicates when MRP last ran and the total elapsed 

time. The definitions for each of the MRP options are as follows: 

  

Include safety stock?  With this option checked, MRP considers the safety stock for an 

item and generates a planned order whenever the projected available balance is less than 

the safety stock.  

  

Include forecast?  When this option is checked, MRP includes the sales forecast entered 

for an item as an independent demand source. 

  

Update CRP?  When this option is checked, Capacity Requirements Planning (CRP) 

runs after MRP completes. In situations where infinite capacity load results are not 

needed, MRP can be run without CRP by unchecking this option. 

  

Ignore remaining quantity?  In batch production environments, yield losses for lower-

level items often result in smaller batch sizes for upper-level items. These shop orders 

can be closed so MRP will not consider the remaining quantity, but MRP will still 

generate planned orders for the remaining quantity unless upper-level demand is also 

adjusted for the yield loss. This represents a potentially time-consuming task especially 

for deep bill-of-material structures. By selecting the ‘Ignore remaining quantity?’ option, 

Catalyst MRP will ignore the remaining quantity on partially received shop orders so that 

planned orders are not generated for the remaining quantity and passed down as 

dependent demand.  

  

Update lead times? To ensure item lead times reflect the most recent standard times 

entered on the product route, this option can be checked to update dynamic lead times 

prior to running MRP. 

  

Use time fences?  The time fence used by Catalyst MRP is based on the fixed and 

variable lead time components for the item. The time fence represents the period during 

which changes to the schedule could adversely affect meeting required due dates. By 

electing to use time fences, MRP does not generate a planned order within the item’s 

stated lead time. This prevents generating planned orders which will cause lead-time 

violations or that could be met by expediting current scheduled receipts. 

  

Use effective dates?  When this option is selected, MRP will consider the effective start 

and stop dates entered for bill-of-material components when generating dependent 

demand. This feature allows planners to effectively manage inventory obsolescence by 

introducing new items as old ones are discontinued or phased-out. 

  

Use schedule dates?  If this option is selected, MRP will use the shop order scheduled 

start date to determine the need dates for lower-level materials. If this option is not 

selected, MRP will use the shop order release date. The shop order release date is 

calculated by MRP based on the item lead-time and may be significantly different than 
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the actual start date due to material and capacity constraints. Therefore, allowing MRP to 

use the shop order scheduled start date typically results in a more accurate reflection of 

lower-level demand requirements. In addition, it avoids the need to manually adjust the 

shop order release dates to reflect actual start dates. Regardless, it is also important to 

note that frequently changing the production schedule will introduce “nervousness” into 

the system and make it difficult to meet demand requirements. 

  

Use sequence position?  When this option is selected, MRP will determine the need date 

for bill-of-material components based on the sequence position it has been assigned in the 

route. This feature allows planners to delay releasing orders for items until they are 

actually needed in the production process. If this option is not selected, then the need date 

for all bill-of-material components will be based on the release date of the parent item. 

This feature is more applicable for processes with multiple operations and long lead 

times. 

  

Use planning horizon?  The planning horizon refers to the period in which demand is to 

be considered for MRP items. The planning horizon for each item is typically based on 

the cumulative lead time. The MRP planning horizon indicates the maximum number of 

days that independent demand will be included in the MRP calculation. 

 

Review MRP Action Messages 

  

MRP generates action messages to recommend certain actions on behalf of the 

planner for planned and firm planned orders. The action messages are intended as a guide 

in the planning process - the planner may decide to ignore or override any of the system-

generated messages. The action messages are displayed on the Material Planning window 

and can be printed by clicking the Action Messages button at the bottom of the screen or 

by selecting Review MRP Action Messages on the Planning tab.  

  

The MRP Action Messages Report can be filtered by action type, planner/buyer 

code, horizon days, or horizon date. In general, the following actions need to be 

performed as part of the post-MRP review process: 

  

•       Evaluate past due open orders 

•        Expedite orders to meet demand requirements 

•       Review unreleased orders that will cause lead time violations 

•       Release firm planned, planned, and open shop orders 

•       Schedule out orders resulting in excessive inventory 

•       Firm planned orders 

  

Evaluate past due open orders 

Open shop orders and purchase orders with a ‘Past Due’ message need to be 

evaluated to determine whether the demand requirement is still valid. Past due orders 

may need to be cancelled, scheduled out to a later period, or scheduled in to an earlier 

period depending on the situation.  
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Expedite orders to meet demand requirements 

Catalyst assigns a ‘Schedule in’ action message to orders that need to be 

expedited to an earlier time period. For example, if you have a purchase order where net 

requirements in the previous period are negative, Catalyst will recommend that you 

attempt to schedule in the order by contacting the vendor and expediting it to an earlier 

time period. 

  

Review lead time violations 

            Catalyst will flag planned orders having release dates greater than the current date 

with a “LT Viol” action message. If the planner or buyer decides to release the order 

without changing the due date, then the due date may not be attainable based on the 

stated lead-time for the item. The planner or buyer must make the final decision on 

revising the due date for the order when it is released. This decision is normally 

coordinated with the respective production supervisor or vendor since the order may need 

to be expedited to meet the planned due date. 

   

Release firm planned, planned, and open shop orders 

            The release date for an order is the due date minus the lead-time days for an item. 

When the current date equals an order’s release date, the order needs to either be released 

to the shop floor for manufactured items or released to the vendor in the form of a 

purchase order for purchased and outside process items. The release process is performed 

using either the Mass Release Control Board for manufactured items or the Purchase 

Order Consolidation screen for purchased items. 

  

Schedule out orders 

           Firm planned orders, open shop orders, and purchase orders with a ‘Schedule out’ 

message need to be evaluated to determine whether the demand requirement is still valid. 

For instance, if a shop order was created for a customer order that was later postponed, 

the shop order will also need to be scheduled out. Similarly, lower-level shop orders and 

purchase orders may need to be scheduled out because upper-level shop orders have been 

rescheduled. Due to demand variability, scheduled receipts may no longer be required in 

the same quantity or timing as originally planned. It may be necessary to cancel, 

reschedule, or change the quantities for these orders to avoid creating excess inventory 

and unnecessarily consuming materials and capacity that are needed for valid demand 

requirements. 

  

Firm Planned Orders  

            For master scheduled items, planned orders that fall within the planning horizon 

for the item are indicated with the “Firm” message. The master scheduler should, in such 

cases, review the requirement and convert the planned order to a firm planned order using 

the Planned Order Maintenance screen which can be opened from the Master Scheduling 

window. It is recommended that the Mass Release Control Board be used to release firm 

planned orders so that they are deleted automatically. Firm planned orders will need to be 

deleted manually when creating shop orders using Shop Order Entry. A planned order 
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that has not been firmed can be released with either method since they are deleted during 

each MRP run. 
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Production 

  

The Production tab contains the options required to execute and control the production 

schedule. The available menu options are listed below. 

Maintain Shop Orders 

Create Shop Orders 

Allocate Shop Orders 

 

Create Shop Order Packets 

Print Shop Order Documents 

 

Report Labor by Operation 

Report Labor by Shop Order 

 

Analyze Shop Order Variance 

Track Schedule Delays 

Close Shop Orders 

 

Tooling Master  

Operation Master 

Work Center Master 

 

Shop Calendar 

Operator Calendar 

 

Product Family Setup 

Labor Reason Codes  
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Maintain Shop Orders 

  

The Shop Order Master provides a quick overview of the status of all operations 

and materials required on a shop order. The operations and materials are maintained on 

the Bill of Resources page and displayed graphically on the Indented View page with 

any linked sub-assembly shop orders. The Shop Order Master is used to maintain existing 

shop orders and make changes to the order quantity, due date, status, priority, route, and 

bill-of-material. The sections below explain how to navigate and use the Shop Order 

Master. 

  

• Display Shop Orders 

o Based On Parent Item 

o Advanced Search 

• Create Shop Order 

• Copy Shop Order 

• Revise Shop Order Route 

o Change Work Center 

o Change Operation 

• Schedule Operations 

• View Linked Sub-Assemblies 

• Review Material Shortages 

• View Open Purchase Orders 

• Substitute Materials 

• Enter Operation Notes 

• Enter Bill-of-Material Notes 

• Enter Shop Order Notes 

• Enter Revision Notes 

• Postread Master Data 

• Attach Drawing/Spec File 

• Allocate Inventory 

• Print Shop Order Documents 

• Track Schedule Delays 

• View Transaction History 

• Review Costs 

• Close Shop Orders 

• Shop Order Master Definitions 

o Header 

o Operations 

o Materials 

• Review Audit Notes 
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Display Shop Orders 

To display a shop order, enter the shop order number directly into the Shop 

Order field or select it from the drop-down list.  

  

The initial shop order list only includes open and released shop orders. To open a 

shop order with a different status or search for a shop order using other criteria, click the 

search  button adjacent to the Shop Order field. The Advanced Shop Order Search 

screen allows searching for shop orders based on item number, shop order status, due 

date, lot number, or serial number. The search results are displayed in the lower screen 

and can be loaded into the Shop Order Master by selecting a record and either clicking 

the Select button or double-clicking the S.O.# field. 

   

Create Shop Order 

A new shop order can be created by clicking the New button and following the 

procedures described in the Shop Order Entry section.  

   

Copy Shop Order 

The Copy button on the Shop Order Master will either copy the selected shop 

order or split the shop order into a sublot depending on the specified Action. For the 

‘Copy shop order’ option, the selected shop order is duplicated in all respects except for 

the Lot No., Release Date, and Due Date which can be entered under the Copy To 

section. For the ‘Split shop order into sublot’ option, the selected shop order is split into a 

sublot with the remaining order quantity transferring from the split lot to the sublot. In 

addition, the order quantity on the original shop order is reduced to the quantity received 

and the shop order status is changed to ‘Complete’. The default lot number for the sublot 

shop order is based on the original lot number with an appended suffix. To create the 

copy or sublot shop order, press the OK button. 

 

Revise Shop Order Route 

Change Work Center 

To change the work center on an existing shop order operation, move to the 

Work Center field of an existing operation and select a new work center from the drop-

down list. If the shop order was previously scheduled, ensure that the Frozen flag is not 

checked on the operation so that the revised route is reflected in the schedule the next 

time the Catalyst Scheduler runs. 

  

To substitute a work center on a route operation with an alternate work center, at 

least one alternate work center must be specified on the Alternates page of the Work 

Center Master. To substitute a target work center for an approved alternate work center, 

right-click over the work center on the route and select the Alternate Work Center 

option from the shortcut menu. A dialog box opens which displays the alternate work 

centers for the selected record. Select a work center from the list and click the Replace 

button to remove the current work center and replace it with the alternate. 

  

  



Catalyst Manufacturing User Manual

 

109 

Change Operation 

A shop order operation can be replaced with an alternate operation by clicking the 

Opn field in the Operations section and selecting a new operation from the drop-down 

list. If labor has already been reported against the original operation, then leave the 

original operation line and add a new line for the alternate operation. An example of this 

situation is when a machine goes down after partially completing the shop order and must 

be moved to another machine to complete the operation. For illustration purposes, assume 

each machine is in a different work center. In this case, use the hours remaining from the 

original operation for the run hours in the new operation and change the hours remaining 

in the original operation to zero so that the shop order only generates capacity 

requirements for the remaining hours. 

 

Schedule Operations 

            The operations for the currently selected shop order can be scheduled by selecting 

the Sched. Opns button at the bottom of the screen. When scheduling a single shop order 

in this manner, the shop order operations are added to the existing schedule. To load shop 

order operations into the schedule based on job selection rules for all open and/or 

released shop orders, use the Catalyst Finite Scheduler. The finite scheduler calculates 

start and finish dates and times for each shop order operation based on the available hours 

for each work center in the Shop Calendar. 

 

View Linked Sub-Assemblies 

To view a linked sub-assembly shop order either double-click the Item No. field 

of the linked sub-assembly component or select the child item record and click the Down 

 icon next to the Item No. label. The Shop Order Master will display the linked sub-

assembly shop order. 

  

To add a linked sub-assembly shop order to a child item record, you can either 

select a previously created shop order from the Linked Sub. drop-down list or double-

click the Linked Sub. field to add a new shop order. 

 

Review Material Shortages 

The Material Shortages button at the bottom of the screen opens a report that 

calculates the availability of each bill-of-material item based on requirements and on-

hand inventory for the item. The report can be used to determine if sufficient materials 

are available to complete the shop order or if the shop order must wait on materials to be 

received from open purchase orders. 

  

View Open Purchase Orders 

The Open POs button opens a report to view the open purchase orders for each 

purchased component on the shop order. The report can be used to determine when the 

shop order can be started based on anticipated PO receipt dates. The report is also 

accessible from the Purchasing > Open Purchase Orders Report menu using the shop 

order report option. 
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Substitute Materials 

To replace a shop order bill-of-material component with an alternate item, the 

item must first have at least one alternate item specified on the Engineering page of the 

Item Master. To substitute a target bill-of-material component for an approved substitute 

from the Item Master, right-click over the bill-of-material item and select the Substitute 

Item option from the shortcut menu. A dialog box opens which displays the current 

substitutes for the item and the conversion values necessary for the substitution. Select an 

item from the substitute list, and click the Replace button to remove the current item 

from the bill-of-material and replace it with the item substitute. The Qty Req. amount on 

the BOM record is adjusted by the conversion factor of the substitute item. 

For item substitutions not referenced as alternates, simply replace the existing 

item by selecting a new item from the drop-down list.  If the item already has been issued 

to the shop order, but not actually consumed then perform a negative single-issue 

transaction before making the material substitution. If the item has already been 

consumed before the substitution is made, then leave the original material line and add a 

new line for the substitute material. The quantity required for the new material should be 

for the balance remaining on the original line item. After adding the substitute material, 

change the quantity required on the original line item to equal the quantity issued so that 

the shop order will not generate material requirements for the original line item.  

 

Enter Operation Notes 

The Operation Notes button allows adding or editing the operation notes for each 

step in the shop routing.  The operation notes print on the Shop Order Traveler sent to the 

shop floor. 

   

Enter Bill-of-Material Notes 

The BOM Notes button allows adding or editing notes for each bill-of-material 

component. The bill-of-material notes print on the Shop Order Traveler sent to the shop 

floor. The bill-of-material notes can be used to store information specific to an item on 

the shop order such as part placement or location. 

   

Enter Shop Order Notes 

The Shop Notes button displays a memo field for storing notes specific to the 

shop order. The shop order notes are displayed on the Shop Order Traveler sent to the 

shop floor. 

 

Enter Revision Notes 

         To track changes made to a shop order, revision notes can be entered by selecting 

the Admin page and adding a new record in the Revisions section. The revision history 

can be used to document moving a job to another work center or resource due to 

unplanned maintenance, substituting an item due to a material shortage, changing the 

scheduled start or finish times, or any number of changes that may occur in the midst of 

production.   
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Postread Master Data 

To revert the shop order back to its original state and delete all open allocations, 

the shop order can be overwritten with the Product Configuration Master data by clicking 

the Postread master data button located on the Admin page. The postread function can 

be used to quickly revert the shop order operations and bill-of-material back to their 

original state. The shop order cannot be postread if any inventory or labor transactions 

have already been entered against the shop order.  

 

Attach Drawing/Spec File 

The Drawing File button opens a dialog box for you to select and attach a 

drawing or specification file to the shop order.  If a drawing file is assigned to the product 

configuration, it is copied to the shop order when the shop order is created.  The 

supported drawing file types include Microsoft Word® (.doc, .rtf, .htm, .html), Adobe 

Acrobat® (.pdf), AutoCAD® (.dwg, .dwf, .dxf), and common graphic files (.jpg, 

.gif).  The drawing/specification file can be opened by clicking the open folder image 

beside the Browse button on the dialog box.  It can also be printed from the Shop Packet 

Toolbar on the Shop Order Traveler or when generating Shop Order Packets. 

 

Allocate Inventory 

To allocate inventory to a shop order and view shop order allocation reports, click 

the Allocate Inventory button at the bottom of the screen. For details on the shop order 

allocation process, refer to the Shop Order Allocation help topic. 

 

Print Shop Order Documents 

          The Record Requisition Report, Shop Order Traveler, Allocation/Dispensing 

Sheet, Pick List, and Operation Reporting Sheet can be printed by clicking the Print 

Documents button at the bottom of the screen. The Record Requisition Report is used to 

request a physical copy of the master batch record for execution. The Shop Order 

Traveler displays the operations and materials needed for each production step.  The 

Allocation/Dispensing Sheet lists the batch allocations for each bill-of-material item with 

space to enter the actual quantities dispensed.  The Pick List lists the materials needed 

and includes lot number and location if the material has been allocated. The Operation 

Reporting Sheet is used to capture operator labor hours for each shop order operation. 

 

Track Schedule Delays 

          If the track schedule delays feature is enabled, the user is prompted to enter a 

delay code whenever the finish date on a shop order operation is rescheduled to a later 

date. All schedule delays posted against the shop order can be viewed by clicking the 

Schedule Delays button at the bottom of the screen. The Schedule Delays Report, in the 

Reports menu of the Production tab, presents a detailed or summarized report of 

production delays which can be filtered by work center, reason code and date range. 

 

View Transaction History 

To view the inventory and labor transactions reported against the currently 

selected shop order, select the Transaction History button at the bottom of the screen. 
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For more information on how to enter a customized search on transaction history, refer to 

the View Transaction History help topic. To view the material and labor cost variances 

on a shop order, select Cost Variance Reports from the Production tab. 

  

Review Costs 

To analyze the variance between actual and standard costs on a shop order, select 

the Review Costs button at the bottom of the screen. The Shop Order Cost Summary 

screen opens to display the standard and actual costs incurred for each material and 

operation on the shop order. On this screen, the standard material costs are derived from 

the standard unit cost for the item and the standard labor and factory overhead costs are 

based on the standard setup and run times for the operation and the rates specified on the 

Cost page of the work center (see Product Route Cost Calculations).   

  

To override the standard unit costs for a material or operation, edit the standard 

unit cost fields directly. The changes will be applied to the current shop order only – the 

standard rates for the item remain unchanged. To restore the standard unit costs with their 

default values, select the Refresh button. To display the shop order cost variance report, 

select the Cost Variance button at the bottom of the Shop Order Cost Summary 

screen.  

  

Note, the costs presented on the Shop Order Cost Summary screen are used for 

shop order variance analysis only. The cost rollup to update the average cost of the parent 

item at the time of receipt may be different than the actual or standard costs used in the 

cost rollup depending on average cost update method specified on the Costing page of the 

Company Master. To identify the rollup cost for the shop order, click the  arrow beside 

the Rollup Cost label on the Indented View page. If the cost rollup is performed before 

any labor or material issue transactions have been entered against the shop order, the cost 

rollup will reflect standard costs and quantities.  

 

Close Shop Orders 

The status of a shop order is automatically updated to ‘Complete’ when shop 

order receipts are entered that meet or exceed the receipt tolerance for the shop order 

parent item. The shop orders are changed to a ‘Closed’ status using the Close Shop Order 

process. During the shop order close process, the material and labor variances on a shop 

order are reviewed and analyzed. The close process can be performed on a daily or 

monthly basis as part of the month-end close, but is more useful when performed soon 

after production completes on an order to facilitate root-cause variance analysis. The 

shop order status can also be changed manually on the Shop Order Master. 

  

The shop order must be in an ‘Open’ or ‘Released’ status to enter labor and 

inventory transactions. To enter transactions for completed or closed shop orders, you 

must use the search button  and select the desired shop order from the Advanced 

Search screen. 
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Shop Order Master Definitions 

Header 

The fields on the main screen of the Shop Order Master include: 

  

Shop Order: the shop order number. Selecting the shop order automatically populates 

the tree view and material and operation screens. 

  

Item No.: the shop order parent item number. 

  

Description: the shop order parent item description. 

 

Lot No.: the lot number for the shop order item. 

Dimension/Revision No.: the dimension code for the item if the parent item is identified 

as dimensional in the Item Master or the revision number if the parent item is identified 

as revision controlled in the Item Master. The item attribute setting on the Inventory page 

of the Company Master determines whether an item can be setup with dimensional 

inventory or revision control. 

  

Release Date: the date the shop order needs to be released to meet the due date. 

  

Due Date: the shop order due date. 

   

Sched. Start: the scheduled start date/time for the shop order. The scheduled start date is 

calculated by the Catalyst Finite Scheduler and is based on the start date/time for the first 

operation. 

  

Sched. Finish: the scheduled finish date/time for the shop order. The scheduled finish 

date is calculated by the Catalyst Finite Scheduler and is based on the finish date/time for 

the last operation. 

  

Status: the shop order status options and definitions are as follows: 

• Open – indicates the shop order has been created, but pending release to 

production until confirmation of material and capacity availability. Open shop 

orders are considered for MRP, CRP, and scheduling purposes. 

• Released – indicates the shop order has been released to production. Released 

shop orders are considered for MRP, CRP, and scheduling purposes. 

• Complete – indicates the shop order has been completed, but is still pending 

review of material variances for shop order closure. 

• Cancelled – indicates the shop order has been cancelled and no longer needed for 

production. 

• Closed – indicates that the shop order labor and material variances have been 

reviewed and the shop order is closed to further transactions. 
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• Quote – the quote status indicates the shop order is linked to a quote line or a 

customer order in a quote status. A quote shop order will not be considered for 

MRP, CRP, or scheduling purposes until the quote is converted to an order. 

  

Priority: the job priority which determines the order in which shop orders are loaded 

onto the Production Schedule Board by the Catalyst finite capacity scheduling engine. 

The priority defaults from the customer order if the shop order was created during 

Customer Order Entry. Otherwise, the priority defaults to the lowest priority of 50. 

   

Quantity Ordered: the shop order quantity ordered. 

  

Quantity Received: the shop order quantity received to date. 

  

Quantity Remaining: the shop order quantity remaining calculated as the difference 

between the quantity ordered and quantity received. 

  

Sales Order No.: the customer order number assigned when creating linked shop orders 

from the Customer Order Entry screen.  The field can also be used to store a user-defined 

job number. 

  

Outside Process PO: a read-only reference to the purchase order number linked to the 

shop order for the outside process item. For outside process items, a purchase order is 

created for the item and linked to a shop order. The linked shop order provides a means to 

consume any materials located at the outside process supplier location, among other 

things. 

  

Operations 

The Operations screen on the Shop Order Master represents the shop order route 

and includes the following fields: 

  

Seq.: the sequence number for the operation. 

  

Opn: the shop order operation number. 

  

Operation Description: the operation description. 

  

Work Center: the work center the operation will be performed. 

 

Resource: the work center resource the operation has been scheduled to run. 

 

Tooling: the default tool assigned to the operation. 

  

Setup: the setup hours for the operation. 

  

Run Hrs: the run hours required for the operation. 
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Total Hrs: the total setup and run hours required for the operation. 

  

Hrs Comp.: the setup and run hours reported complete for the operation. 

  

Hrs Rem.: the total setup and run hours remaining to be completed for the operation. The 

hours remaining can be adjusted without changing the setup or run hours to reflect 1) the 

completion of an operation before all standard setup and run hours have been fully 

consumed, or 2) additional capacity requirements when the standard setup and run hours 

has been exceeded, but more operation time is required. 

  

% Comp.: the completion percentage of the operation calculated by dividing the total 

hours required into the hours reported complete for the operation.  The completion 

percentage is also displayed in the tree view with the operation description. 

  

Schedule Start: the scheduled start date and time for the shop order operation. The 

scheduled start date and time is calculated by the Finite Scheduler and can be changed 

manually by double-clicking the field to open the Date/Time Calendar. 

  

Schedule Finish: the scheduled finish date and time for the shop order operation. The 

scheduled finish date and time is calculated by the Finite Scheduler and can be changed 

manually by double-clicking the field to open the Date/Time Calendar. 

   

Queue (hrs): the queue time expressed in hours for an operation. The queue time occurs 

before an operation starts and represents the time spent waiting before the operation can 

enter the work center resource. The queue time represents a component of fixed lead time 

for an item. The queue time is also used by the finite capacity scheduler to offset the 

scheduled start time for an operation. The finite scheduler assumes queue hours transpire 

during both work and non-work periods. If queue hours occur only during work periods, 

you will need to create a separate operation and load the queue hours as setup hours or 

simply add the queue hours to the setup time of the preceding operation. 

  

Move (hrs): the move time expressed in hours for an operation. The move time occurs 

after the operation is completed and represents the time spent in-transit to the next 

operation. The move time represents a component of fixed lead time for an item. The 

move time is also used by the finite capacity scheduler to offset the scheduled start time 

for the next operation. The finite scheduler assumes move hours are performed during 

both work and non-work periods. If move hours occur only during work periods, you will 

need to create a separate operation and load the move hours as setup hours or simply add 

the move hours to the setup time of the next operation. 

  

Min. Move: the minimum percentage completion of the current operation before it can 

proceed to the next downstream operation for processing. The default percentage of 

100% means that the operation must complete all units before the next operation can 

start. A lower minimum move percentage reduces the cycle time for an item and results 

in a more compressed schedule. 
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Operators: the number of operators required to perform the shop order operation. The 

number of operators is used as a default when reporting labor for the operation. The 

number of operators is applied to the run hours reported for the operation. 

  

Frozen: a flag to indicate that the scheduled start and finish dates for the operation will 

not change because it has already started or has been manually rescheduled on the 

Production Schedule Board.  The frozen flag can be manually reset, but will occur 

automatically if the Freeze Started Operations flag is set on the Manufacturing page of 

the Company Master. 

  

Backflush: a flag used to indicate whether the standard setup and labor amounts for the 

operation should be backflushed at the time of shop order receipt. 

  

Campaign: a flag used to indicate whether or not to apply campaign rules to the 

operation when generating a finite capacity schedule. If campaign rules are used, the 

setup hours for the operation will be reduced or eliminated when the operation is 

sequenced after the same item or product family. 

   

Materials 

The Materials screen on the Shop Order Master represents the shop order bill-of-

material and contains the following fields: 

  

Seq.: the operation sequence number indicating when the material is needed. 

  

Item No.: the item number for the material.  If the item has a linked shop order, it can be 

displayed as the current shop order by double-clicking the field or the down arrow image 

 next to the field label. 

  

Description: the item number description. 

  

Qty Req.: the quantity of material required, including setup quantity, to produce the 

quantity ordered on the shop order. 

  

Qty Issued: the quantity of the material issued to the shop order. 

  

Qty Rem.: the quantity of the material remaining to be issued to the shop order. 

  

U/M: the stock unit of measure for the material. 

  

Scrap%: the material scrap percentage. The quantity required for an item is increased by 

its scrap factor. For example, if 100 units of a component are required to build a single 

parent item, but the component has a 10% scrap rate, approximately 110 units 100*(1 + 

.10) of the component will be required in production. 

  

Dimension/Revision No.: the dimension code for the item if the child item is identified 

as dimensional in the Item Master or the revision number if the child item is identified as 
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revision controlled in the Item Master. The item attribute setting on the Inventory page of 

the Company Master determines whether an item can be setup with dimensional 

inventory or revision control. 

 

Linked Sub.: the linked sub-assembly shop order for the bill-of-material item.  

 

Backflush: the backflush flag that determines whether the child item will be 

automatically issued when a shop order receipt transaction is entered. If the backflush 

flag is set, the child item is issued from inventory to the shop order based on the standard 

usage including scrap. The backflush flag can be changed for each shop order component 

if desired. Please refer to the Material Backflush section for more information about the 

backflush process. 

   

Review Audit Notes 
The Audit Notes page displays an audit trail of any changes or additions made to 

the shop order header, operations, or materials.  The Admin page includes information on 

who created or last changed the record and when, but the audit notes provide a much 

more detailed description of actual changes.  The Admin page also indicates the product 

configuration used to create the shop order and provides for the entry of revision notes to 

manually track the reasons for a change.  

 

Create Shop Orders 

The Create Shop Order window creates shop orders by copying the bill of 

material and route information for a parent item from the Product Configuration Master. 

To create a new shop order, select either an item number from the drop-down list, 

populate the remaining fields as described below, and click the Create button. A dialog 

box will appear after the shop order has been created displaying the new shop order 

number. 

Description: the short description of the shop order parent item. 

Dimension/Revision No: the dimension code for the item if the parent item is identified 

as dimensional in the Item Master or the revision number if the parent item is identified 

as revision controlled in the Item Master. The item attribute setting on the Inventory page 

of the Company Master determines whether an item can be setup with dimensional 

inventory or revision control 

Eng. ID: the engineering identification number from the Product Configuration Master. 

Quantity: the shop order quantity. 

Status: the status defaults to open for new shop orders. The status can be changed to 

‘Released’ using either the Shop Order Master or Mass Release Control Board. 
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Priority: the shop order priority ranging from 1 (high priority) to 50 (low priority). 

Order No.: this field can be used to refer to either the customer order number or an 

internal job number. 

Lot No.: the lot number for the shop order item. To have the system generate a default lot 

number, specify a lot number default for shop orders on the Profile page of the Company 

Master. 

Release Date: the release date for the shop order set as either the current date or the shop 

order due date if the current date already exceeds the established due date for the shop 

order. 

Due Date: the due date for the shop order set automatically as the current date plus the 

lead time days, but can be manually overridden. 

 

Allocate Shop Orders 

The Shop Order Allocation screen is used to make material reservations for bill-

of-material components. The available inventory for a component is calculated as the on-

hand quantity less the allocated quantity in a specific location. The available inventory is 

used by a planner during the shop order release process to determine whether or not 

sufficient materials are available to release the order. A component does not need to be 

released or moved into a release location to be allocated to a shop order. The allocation 

process facilitates the usage of material on a first-in, first-out (FIFO) basis to comply 

with cGMP requirements. 

An inventory allocation does not directly affect the on-hand balance for an item. 

The allocation quantity is subtracted from the on-hand inventory to determine the 

available inventory balance, but it does not affect material requirements planning (MRP) 

calculations. The quantity required on the bill-of-material component creates a net 

requirement for MRP, but the inventory allocation does not. The inventory allocation is 

an optional step to help material planners more clearly identify the inventory available for 

orders released to the shop floor. 

The Shop Order Allocation screen is similar to the Mass Issue screen in that 

materials are allocated to a shop order in the same manner as they are issued. The 

primary difference between a material issue and a material allocation is that the issue 

transaction deducts the issue quantity from inventory on-hand (On-Hand = On-Hand – 

Issue Quantity). The allocation quantity, however, does not affect the on-hand balance for 

an item, only the available balance (Available Quantity = On-Hand – Allocated 

Quantity). To allocate materials from inventory, follow the steps outlined below: 

  

1.      Select Allocate Shop Orders from the Production tab. 
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2.      On the Shop Order Allocation screen, select a shop order from the Shop 

Order drop-down list. To select shop orders based on other criteria, click the 

search  button and perform an advanced search. After selecting a shop 

order, the Bill-of-Material Components and corresponding Inventory Batch 

Records sections are populated. 

  

3.      Select a bill-of-material (BOM) component by clicking the record selector for 

the desired row. The Available Inventory section includes all non-rejected 

inventory in nettable, pickable inventory locations for the currently selected 

BOM item. The Allocation Location option can be used to filter the available 

inventory to a specific warehouse or location. 

  

4.      To allocate inventory for a bill-of-material item, select the Allocate flag on 

the desired inventory location record. The Quantity field is automatically 

populated based on the smaller of the quantity required for the bill-of-material 

component and the Available inventory. If necessary, edit the default 

allocation quantity. Continue to select additional inventory batch records until 

the allocation quantity meets or marginally exceeds the quantity required for 

the bill-of-material component. The total allocated quantity for an inventory 

location record can never exceed the on-hand quantity in that location. To 

decrease an allocation quantity, enter a negative amount in the Quantity field.  

5.      Click the Save button to allocate the designated inventory to the BOM items 

on the currently selected shop order. In the Bill-of-Material Components 

section, the Allocated Qty and Alloc % columns are updated based on the 

saved allocations. The Available column in the Inventory Batch Records 

section is also updated accordingly. 

6.      Repeat the previous three steps for each bill-of-material component used on 

the shop order. The material allocation can be saved either before moving to 

another bill-of-material component or after entering allocations for all bill-of-

material items.  

7.      As an alternative to entering allocations for each BOM item one at a time, the 

inventory allocations for a shop order can be automatically generated based on 

expiration and receipt date (FIFO) by selecting the Allocate All button at the 

bottom of the screen. Similarly, inventory records can be unallocated from a 

shop order by selecting the Unallocate All button. 

To use the inventory allocations as a basis for the materials that are picked for the 

shop order, select the Allocated Pick List button to display the Shop Order Pick List by 

Allocation report. The Shop Order Pick List by Allocation report specifies the material 

that needs to be pulled from a warehouse or stockroom location prior to the start of 

production. To transfer the materials from the allocated locations to a shop floor location, 

click the Transfer Allocations button. This will open the Inventory Transfers screen and 

populate the from locations and quantities based on the shop order allocations. To 

complete the transfer, enter the transfer to locations and click the Save button.  
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After the material allocations have been entered for a shop order, click the 

Allocation Report button at the bottom of the screen to open the Shop Order Allocation 

Report. Select the Alloc./Disp. Sheet button at the bottom of the screen to open the 

Material Allocation/Dispensing Sheet. The Material Allocation/Dispensing Sheet 

specifies the batch quantities that need to be dispensed for production. To view the 

allocations for a shop order, allocated item number, or allocated lot number, select 

Reports > Inventory Allocation Reports from the Inventory tab. 

 

Create Shop Order Packets 

The Create Shop Order Packets screen allows you to select multiple shop orders 

and print various production reports for the selected shop orders, including batch record 

requests, pick lists, shop order travelers, dispensing sheets, and drawing/specification 

files attached to the shop orders, if applicable. The Available shop order list can be 

filtered by Release Date, Shop Order, or Shop Order Status. In addition, the Include 

picked? and Include Printed? check boxes can be used to exclude shop orders where 

either the Shop Order Pick List or Shop Order Traveler has already printed. 

           For instructions and a brief description of each report, refer to the steps below. 

1.      Select Create Shop Order Packets from the Production tab. 

2.      Use the fields at the top of the screen to filter the Available list of shop 

orders. To add any of the available shop orders to the Selected list, highlight 

the shop order and click the down arrow button. The shop orders can also be 

selected by double-clicking the shop order record in the Available list.  

3.      After selecting all desired shop orders, use the buttons at the bottom of the 

screen to print one of the following reports: 

• Record Requisition: lists all the shop orders and lot numbers to 

request a physical batch record for processing 

• Shop Order Traveler: lists the operations and materials required on 

the shop order  

• Pick List: a consolidated pick list of materials required to process all 

of the selected shop orders 

• Allocation/Dispensing List: a list of required materials on a shop 

order with the allocated lot numbers for each material and a section 

for the operator to manually enter the dispensed quantities 

• Operation Reporting Sheet: used to capture setup and operation start 

and finish times for reporting of labor hours against the shop order 
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• Drawing: a reference to open and print the drawing/specification file 

for each shop order 

• Work Center Dispatch Report: if start and finish dates and times 

have been created for the shop orders, the dispatch report lists all 

scheduled operations for each work center resource (see Work Center 

Dispatch Report)..   

Enter Labor Hours by Operation 

  

The Operation Reporting screen is opened by selecting By Operation in the 

Report Labor section of the Production tab. Operation Reporting is used to capture 

and enter the operation time and quantity completed on a shop order operation.  The steps 

to accomplish this are as follows: 

  

1.      On the Operation Reporting screen, enter or scan the Shop Order number.   

• If the shop order has more than one operation, enter or scan the 

Sequence number.   

• If the current operation is not ‘Run’, select the Operation Code to 

indicate setup or downtime.  If selecting downtime, enter the 

appropriate Reason Code. 

• Enter the Operator Name if reporting by operator is desired.  Update 

the No. Operators if more than one operator working on the 

operation. 

• Update the Shift No. if not working on first shift. 

• If the operation is using a specific resource, enter the Resource name. 

  

2.      Press the Start button to start the clock. 

  

3.      Press the Pause button to either temporarily pause the clock or report 

completion of work. 

• If work needs to pause for break, press the Resume button when work 

has restarted. 

• If work on the operation has been completed, enter the quantity 

completed and press the Save button.  

  

The labor hours and quantity are posted to the operation when the transaction is 

saved.  The labor transaction updates the hours remaining for the shop order operation 

and adjusts the outstanding capacity load on the work center. The hours completed and 

percentage completion of each operation is displayed in the Shop Order Master. When 

the Freeze Started Operations flag is set on the Company Master, the shop order 

operation is frozen when a labor transaction is saved. If an operator is selected, the 

operator labor hours are also captured and summarized on the Operator Hours Labor 

Report. 
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The fields on the Operation Reporting fields accept barcode entry. The clock will 

start automatically after scanning the shop order and sequence number.  For shop orders 

with only one operation, the clock starts after scanning only the shop order. To stop the 

clock, the operator can either rescan the shop order or press the Stop button. 

  

If the Backflush Operation Materials flag is set on the Company Master and a 

quantity is reported for the session, any backflush components are issued to the shop 

order when the labor transaction is saved. If a non-defective quantity is reported on the 

last operation, a shop order receipt transaction is entered using the operation quantity 

reported. A shop order receipt transaction cannot be processed for serial number 

controlled items on this screen. The actual hours reported can be compared to standard 

hours by viewing the labor variances summarized on the Shop Order Cost Variance 

Report located on the Production tab.  

  

The Operation Reporting screen is shown below followed by field definitions for 

each section. 

  

 
  

Operation/Job 

Shop Order: the shop order number. 

  

Sequence No.: the operation sequence number. 

   

Operation Code: the category of work performed – setup, run, or downtime. 

  

Reason Code: shop order operation reason code.  The reason code applies 

primarily to downtime.  The list of Labor Reporting Reason Codes can be 

maintained by selecting Labor Reason Codes from the Production tab. 

  

Operator Name: the name of the operator or work group performing the work on 

the shop order operation.  
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Shift No.: the current shift number being reported. 

  

Resource: the work center resource, if applicable, that the operator or work group 

is performing the work. 

  

No. Operators: the number of operators required to perform the operation during 

the reported hours. The number of operators applies to run hours only. 

   

Quantity/Hours Completed 

Good Quantity: the quantity of conforming units produced during the hours 

reported. 

  

Scrap Quantity: the quantity of reject or nonconforming units produced during 

the hours reported. 

  

Operation Time: the accumulated time worked on the shop order operation 

expressed in hh:mm:ss format.  The accumulated time does not include any time 

where the operation clock may have been paused for breaks or other reasons.  

  

Operation Hours: the accumulated time worked on the shop order operation 

expressed in decimal hours format.   

  

Operation Summary 

User Name: the current system user.  The system user cannot be edited. 

  

Quantity: the total quantity of conforming units reported for the current session. 

  

Scrap/Waste: the total quantity of reject or nonconforming units reported for the 

current session. 

  

Total Quantity: the total quantity of conforming and nonconforming units 

reported for the current session. 

  

Clock   

Clock Start: the date and time the clock was started or, if there was a pause in 

work, the clock start time is reset to the date and time the clock was resumed. 

  

Clock Stop: the date and time the clock was last paused to reflect a work 

stoppage for break or other reason. 

  

Elapsed Time: the elapsed time since the clock was started or resumed from a 

pause in work. 

  

Start/Pause/Resume: the start button is used for the initial clock start.  The pause 

button is used to temporarily pause the clock.  The resume button is used to restart 

the clock and resume the accumulation of operation time. 
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Enter Labor Hours by Shop Order 

             

The Labor Entry screen is opened by selecting Report Labor by Shop Order 

from the Production tab and is used to report the quantity and hours completed for all 

operations on a shop order. It is designed to capture the reporting of labor hours on a shop 

order either by operator or in summary format. To capture labor hours directly by an 

operator on the shop floor, report labor by operator using the Operation Reporting screen. 

The Labor Entry screen includes the following fields: 

  

Shop Order: the shop order number. Selecting a shop order automatically populates the 

other reference fields in the form header. 

   

Lot No.:  the lot number associated with the shop order. 

   

Item No.: the parent item produced on the shop order. 

  

Description: a description of the parent item on the shop order. 

  

S.O. Status: the status of the shop order. The status can be revised during labor entry. 

  

Due Date: the due date of the shop order. 

  

Quantity Ordered: the shop order quantity ordered. 

  

Quantity Received: the total shop order quantity received to date. 

  

Quantity Remaining: the difference between the shop order quantity ordered and 

received. 

  

Total Reported Hours: the total hours reported for all operations of the currently 

selected shop order. 

  

Total Non-defective: the total conforming quantity reported for all operations of the 

currently selected shop order. 

  

Total Defective: the total reject quantity reported for all operations of the currently 

selected shop order. 

  

Freeze Started Operations?:  a flag which defaults from the Company Master to 

indicate whether or not shop order operations should be frozen after labor is reported.  

  

Backflush Operation Materials?: a flag which defaults from the Company Master to 

indicate whether or not the backflush materials associated with a shop order operation 

should be backflushed based on the good and scrap quantity reported for the operation. 
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Note: When using this option, the shop order receipt must be entered from the Labor 

Entry screen at the final operation to avoid processing duplicate backflush transactions. If 

the receipt is entered on the Inventory Transaction Reporting screen, duplicate material 

issue transactions will be processed for backflush components on reported operations. 

  

Enter S.O. Receipt Last Operation?: a flag to indicate whether or not to process a shop 

order receipt for the good quantity reported at the last operation. 

  

The lower section lists all shop order operations and includes fields to report the hours 

and quantity completed for each operation. The field definitions are as follows: 

  

Seq.: the operation sequence number. 

   

Operation: the operation description. 

  

Work Center: the work center the operation is performed. 

  

Standard Hours: the total setup and run hours required for the shop order operation. 

  

Hours Completed: the total setup and run hours previously reported for the shop order 

operation. 

  

Hours Downtime: the total downtime hours previously reported for the shop order 

operation. 

  

Hours Remaining: the total setup and run hours remaining for the shop order operation. 

The hours remaining for an operation can be changed to reflect an operation is complete 

(i.e. zero hours remaining) or that more hours remain to finish processing regardless of 

the reported operation quantity or hours. 

  

% Compl.: the percentage complete based on the total hours required and total hours 

reported against the shop order operation. 

  

Total Quantity: the total non-defective quantity reported for the shop order operation. 

  

Total Scrap: the total defective quantity reported for the shop order operation. 

   

Quantity Completed: the quantity of conforming units produced during the hours 

reported. The operation quantity is used to calculate the default setup and run hours based 

on either the shop order quantity or the number of units reported against the previous 

operation. The operation quantity is also used to process shop order receipt and issue 

transactions depending on the Backflush Operation Materials and Enter S.O. Receipt 

Last Operation settings on the main screen.  

  

Defect Quantity: the quantity of reject units produced during the hours reported. If 

the Backflush Operation Materials flag is set, the defect quantity is added to the non-
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defect quantity to calculate the backflush quantity for backflush materials attached to the 

operation. 

  

Setup Hours: the setup hours incurred for the shop order operation. The setup hours 

default from the operation quantity entered, but can be changed to reflect a difference 

from the standard hours required. 

  

Run Hours: the run hours incurred for the shop order operation. The run hours default 

from the operation quantity entered, but can be changed to reflect a difference from the 

standard hours required.  

  

Downtime Hours: the downtime hours incurred for the shop order operation. If 

downtime is entered for the operation, assign a reason code to assist with the problem 

solving effort. 

  

Reason Code: the primary reason for the downtime hours reported on the shop order 

operation. If an applicable reason code does not appear in the drop-down list, double-

click the Reason Code field to open the Labor Reporting Reason Codes and enter a new 

reason code.  

 

Operation Date: the actual production date for the hours reported.   

 

No. Operators: the number of operators required to perform the operation. The number 

of operators is applied to the run hours reported for an operation.  

  

Start and End Date/Time: the operation start and end date and time reported for the 

current labor transaction. If start and end times are entered for the operation, default 

values for the Setup Hours and Run Hours are calculated based on the elapsed time. 

The operation start and end times are optional and are more appropriate for operations 

subject to few disruptions to avoid having to enter a separate labor transaction for each 

interval.  

  

Operator Hours: To post operator hours against the shop order, enter the setup hours, 

run hours, and downtime hours for each operator that worked on the operation. The shift 

number, shift date, and work center resource may also be entered for each operator. The 

Operation Reporting Sheet is used to capture the actual operation times by shop floor 

operators and submitted to the production office for data-entry. To view a summary of 

the operator hours posted over a specified date range, select the Operator Hours button 

located at the bottom of the screen. 

 

Analyze Shop Order Variance 

  

Several reports have been provided to analyze the difference between standard and 

actual costs on a shop order after production.  The analysis of material and labor 

variances on a shop order serves the following important purposes: 
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o   identify potential missing or incomplete transactions prior to officially closing the 

shop order to signal that all inventory and labor entries have been reviewed and 

verified. 

  

o   identify process inefficiencies early so corrective actions can be applied to 

eliminate costly labor and material overruns on later jobs.  

In general, shop order variances may exist between standard and actual labor hours, 

standard and actual material required, and theoretical and actual receipt quantities. The 

reports listed below address one or more of these variance types.  To display the reports, 

select the relevant option from the Analyze Shop Order Variance group on the 

Production tab and enter the desired selection criteria.  

o   Shop Order Transaction Detail – summarizes shop order receipts, material 

issues, and labor transactions by shop order or by item number. When 

summarized by item number, the results can be used to compare average yields 

with theoretical yields, actual material usage with estimated scrap percentages, 

and standard labor hours with actual labor and setup hours. 

  

o   Shop Order Quantity Variance Report – these reports identify missing or 

incomplete shop order receipts when one or more components have been issued 

(shop order issues / missing receipts) and components with missing or incomplete 

material issue transactions based on the shop order quantity received (shop order 

receipts / missing issues). These reports should be run on a daily basis to identify 

missing, incomplete, or erroneous transactions.  

  

o   Shop Order Cost Variance Report – summarizes material and labor variances for 

a shop order.  The material variances are derived from the difference between the 

standard quantity required and the actual quantity issued to a shop order. Labor 

variances are derived from the difference between the standard required hours and 

the actual hours reported against a shop order.  A favorable variance is indicated 

by a positive quantity and is a result of actual costs below standard costs.  An 

unfavorable variance is indicated by a negative quantity and is a result of actual 

costs exceeding standard costs.  A screen version of this report is also available by 

clicking the Review Costs button on the Shop Order Master.   

 

Shop order material variances may indicate that the standard material quantities 

and scrap rates are incorrect and need to be adjusted in the Product Configuration 

Master. The variance could also be the result of an assignable cause such as 

defective material from a supplier or an out-of-control process with lower than 

expected yields. The material variance could also be caused by a missing or 

incorrect shop order receipt or material issue. For backflush items, there will not 

be a material variance unless the default backflush quantity was changed before 

the transaction was accepted.  

 

Shop order labor variances may indicate that the standard setup and run rates are 
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incorrect and need to be adjusted in the Product Configuration Master. The 

variance could also be the result of machine that needed to run at below normal 

speed or by the learning curve effect of a new operator. The labor variance could 

also be caused by missing or improperly reported labor transactions. 

o   Shop Order Cost Summary Report – a summary report that presents the standard 

and actual costs for material, labor, and overhead for a range of shop orders.  The 

report can be filtered by shop order receipt date range, item number, or product 

family.  The summary report is an efficient way to view variances for multiple 

shop orders in a single report. 

Create / Maintain Schedule Delays 

  

Production schedule delays can be tracked and reported in the system to help 

focus problem solving efforts on frequently occurring or lengthy delays. With the Track 

Schedule Delays feature enabled, production schedule delays are captured by a planner 

or scheduler whenever the finish date on a shop order operation is rescheduled to a later 

date. This allows the planner or scheduler to enter the reasons for a delay at the same time 

the schedule is updated. After rescheduling a delayed operation, the downstream 

operations on the shop order can be automatically rescheduled by clicking the Schedule 

button on the Shop Order Master or by running the Catalyst Scheduler to reschedule 

all shop orders. A production schedule delay can also be added to a shop order separate 

from any scheduling function using the Maintain Schedule Delays screen. This screen 

also allows editing previously entered delays. The sections below provide additional 

details. 

  

Enable Schedule Delay Tracking 

1.      Open the Company Master from the Data Maintenance tab and select the 

Manufacturing page. 

2.      Select the Enable Schedule Delays checkbox. 

3.      Click the Save button. 

  

Enter Schedule Delay 

1.      Open the Shop Order Master from the Production tab and select the shop order 

that incurred the delay. 

2.      In the Operations section, change the scheduled finish date of the delayed 

operation to a later date and/or time. The Schedule Delay Entry screen opens and 

displays the total delay hours and shop order operation details. 

3.      On the Schedule Delay Entry screen, modify the delay hours if required and 

enter the delay reason code and any comments. Enter any additional information 

about the delay in the Comments field.  

•         To split the delay hours into multiple delay codes, add a new line in the 

Schedule Delay Details section and update the delay hours for each delay 

line so that the sum of the delay hours for all reason code equals the total 

delay time. 
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•         To add a new delay code or revise an existing one, open the Schedule 

Delay Codes screen. 

  

Maintain Schedule Delays 

1.      Open the Maintain Schedule Delays screen from the Production tab. 

2.      Select a shop order from the drop-down list or search for the shop order using the 

adjacent search button. 

•         To edit a previously entered delay, select the desired record and modify 

the delay hours, reason code, and comments as required. 

•         To add a new delay, click the Add button, select the shop order operation 

from the Seq. field and enter the delay hours, reason code and comments 

for the delay. 

•         To split a delay, select the desired delay, click the Copy button and 

modify the delay hours, reason code and comments of the new and copied 

delay as required. 

•         To delete a previously entered delay, select the desired delay record and 

click the Delete button. 

3.      To print the schedule delays for the shop order, click the Print button. 

  

Review Schedule Delays 

1.      A detailed and summarized list of production schedule delays can be viewed by 

selecting Schedule Delays Report from the Reports menu on the Production 

tab. This report can be filtered by work center, reason code and date range to 

display all schedule delays over a specified time period. 

2.      The Operation Lateness Report identifies shop order operations that are past 

their scheduled finish date. This report can also be found in the Reports menu on 

the Production tab and includes work center and scheduled date range filters. 

  

Create / Maintain Schedule Delay Codes 

The Schedule Delay Codes can be opened from the Production tab and are used 

to assign a reason code when tracking schedule delays. To edit an existing code, select it 

from the drop-down list, modify the description and click the Save button. To add a new 

code, click the New button, add a delay code description, and click the Save button. 

            To maintain the schedule delay codes in datasheet view, click the table image 

 button. In datasheet view, you can scroll down the list of existing records and add, 

delete, or edit without the use of command buttons. To return to form view, double-click 

the gray bar to the left of the datasheet or right-click anywhere in the datasheet and select 

the View Form option from the shortcut menu. 
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Close Shop Orders 

  

The Close Shop Orders screen provides a utility to select shop orders that have been 

completed, review the material and labor variances, and close all of the selected shop 

orders. The shop order close process can be conducted on a periodic basis by production 

management to remove shop orders from active status that no longer require production 

resources. The Completion % filter allows managers or supervisors to select shop orders 

that have been completed up to a specified percentage point. For example, if a supervisor 

wanted to see all shop orders that were 95% complete or above, he/she could set the 

Completion % field accordingly and only those shop orders would be displayed in the 

list of Current Open Shop Orders. The steps for closing shop orders using this method 

are: 

  

1.     Select Close Shop Orders from the Production tab.  

  

2.     On the Close Shop Orders screen, revise the default Review Date if required. 

The list of Current Open Shop Orders is limited to those with due dates prior to 

the stated Review Date. The Quote flag can be used to display shop orders based 

on quote lines in the Current Open Shop Orders list. 

  

3.     Adjust the Completion % to filter the list of Current Open Shop Orders to 

include only those greater than or equal to the specified completion percentage. 

Only those shop orders meeting both the Review Date and Completion % 

criteria will be displayed in the Current Open Shop Orders list. 

  

4.     Review the shop order variance for shop orders in the Current Open Shop 

Orders list by highlighting the order and pressing the F11 key. The Shop Order 

Variance Report displays indicating the labor and material variances for the shop 

order. This report can be used to determine if all shop order transactions have 

been entered against the shop order. Note: You should not close any shop orders 

that have outstanding labor or inventory transactions.  

  

5.     Double-click highlighted orders or use the directional arrows between the lists to 

move shop orders from the Current Open Shop Orders list to the Selected Shop 

Orders To Be Closed list. 

  

6.     After all selections have been finalized, click the Update button to change the 

status of all selected shop orders to “Closed”. 

  

You will not be able to enter labor or inventory transactions against a closed shop 

order. The shop order must be changed back to an active status before additional 

transactions can be entered. To change the shop order status of a closed shop order, click 

the search button  on the Shop Order Master and select the shop order from the 

Advanced Search screen. The shop order status can be revised after it is selected in the 

Shop Order Master. 
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Create / Maintain Tooling 

  

The Tooling Master is opened from the Production tab and is used to create and 

maintain tooling used on product routes. The product configuration routes where tooling 

is used can be viewed by selecting the Where Used button. A list of the scheduled 

operations that use tooling can be viewed by selecting the Tool Schedule button. The 

tooling also appears on the Shop Order Traveler. To view a summary of the run hours 

and quantity reported for a particular tool, select the Tool Usage button. To create a new 

tool, click the New button and populate the fields as defined below. 

 

Tool No.: the tool number designation. 

 

Name: the tool name. 

 

Description: the tool description. 

 

Usage U/M: the tool usage unit of measure.  

 

Manufacturer: the tooling manufacturer. The manufacturer list is populated from the 

Vendor Master. 

 

Notes: a field to maintain general notes or specifications for the tooling. 

 

Tool Maintenance: a reference of the maintenance required for the tool as follows: 

 

•        Maintenance frequency: the usage allowed on a tool before maintenance or 

replacement. 

 

•        Last maintenance date: the last date the tooling has been maintained or replaced. 

 

•        Last maintained by: the employee who last maintained or replaced the tooling. 

 

Max Usage: the maximum use of the tool in the usage unit of measure before the tool 

needs to either be replaced or maintained. 

 

Inactive?: indicates whether or not the tooling is currently active. 

 

Create / Maintain Standard Operations 

             

The Operation Master is opened from the Production tab and is used to create 

and maintain the standard operations used in the product configuration and shop order 

routes. The standard operations are to the route as items are to the bill-of-material – both 

are used to create a product structure. An operation can be selected for editing or review 
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by selecting an operation from the Operation drop-down list. Other tasks that can be 

performed in the Operation Master include: 

  

Create New Operation 

To create a new standard operation, click the New button and enter the required 

information. The operation description, work center, run rate, and run units are required 

fields. The run units can be entered as Units/Hr, Hrs/Unit, or Hrs/Batch. The hours per 

batch setting allows entering a fixed run time that applies to the batch parent quantity on 

the product configuration. When using units per hour or hours per unit, the total operation 

run hours is divided by the parent quantity to determine the required hours per unit.  

  

Delete Operation 

An operation can be deleted by clicking the Delete button. However, operations 

that are still included on an existing route cannot be deleted until they are removed from 

the route. 

  

Mass Update 

To update the existing product configuration routes with revised values for a 

standard operation, click the Mass Update button. A mass update will change or delete 

all matching standard operations listed on an existing product route. To view the product 

configurations affected by the update before the change, select the Where Used button. 

To replace, remove, or append operations on existing shop orders, use the Mass Update 

BOM/Route option in the Data Maintenance menu. To update standard times on existing 

shop orders, it may also be necessary to perform the changes on the Shop Order Master. 

  

Enter Operation Time Scale 

If the operation run hours vary non-linearly to the production quantity, the time 

function can be entered into Catalyst by clicking the Operation Times button at the 

bottom of the screen. When a standard operation is selected on a route in the Product 

Configuration Master, the operation hours that match the product configuration quantity 

is loaded into the run hours for the operation. For quantities that fall between time scale 

increments, the operation hours are interpolated to arrive at the operation hours between 

the two points. If the function becomes linear at a certain quantity, the Linear flag 

indicates that the calculated operation hours should equal the Hours Rqrd value from the 

previous record plus the Hours Rqrd value of the linear record multiplied by the 

operation quantity. For example, using the operation time scale from the figure below, 

when adding the Cut Handle operation to a product configuration route, if the parent 

quantity is equal to 30 units, then the run hours for the operation will equal 2.4 hours. 

However, when the parent quantity equals 40 units the run hours for the operation equals 

2.4 hours + 10(.03) or 2.7 hours. The function becomes linear after 30 units so the hours 

required is determined by the incremental units above the quantity of the last record. 
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Field Definitions 

Operation: the operation identification number. 

Description: the operation description. 

Work Center: the work center number. 

Setup Hours: the setup hours required for the operation. The setup hours are added to the 

fixed lead time for an item. 

Run Rate: the production rate during run time for the operation. The run rate can be 

expressed in either hours per unit or units per hour. The run hours are added to the 

variable lead time for an item. 

Run Units: the units for the production run rate expressed in Hrs/Unit, Units/Hr or 

Hrs/Batch. The hours per batch setting allows entering a fixed run time that applies to the 

batch parent quantity on the product configuration. When using units per hour or hours 

per unit, the total operation run hours is divided by the parent quantity to determine the 

required hours per unit. 

Queue Time (hrs): the queue time expressed in hours for an operation. The queue time 

occurs before an operation starts and represents the time spent waiting before the 

operation can enter the work center resource. The queue time represents a component of 

fixed lead time for an item. The queue time is also used by the finite capacity scheduler to 

offset the scheduled start time for an operation. 

Move Time (hrs): the move time expressed in hours for an operation. The move time 

occurs after the operation is completed and represents the time spent in-transit to the next 

operation. The move time represents a component of fixed lead time for an item. The 
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move time is also used by the finite capacity scheduler to offset the scheduled start time 

for the next operation. 

Min Move Percent: the minimum percentage completion of the current operation before 

it can proceed to the next downstream operation for processing. The default percentage of 

100% means that the operation must complete all units before the next operation can 

start. A lower minimum move percentage reduces the cycle time for an item and results 

in a more compressed schedule. 

No. Operators: the number of operators needed to perform the operation on a standard 

work center resource. 

Backflush Labor?: a flag used to indicate whether or not the setup and run hours for the 

operation will be backflushed at their standard quantities when the shop order is received. 

Use Campaign?: a flag used to indicate whether or not to apply campaign rules to the 

operation when generating a finite capacity schedule. If campaign rules are used, the 

setup hours for the operation will be reduced or eliminated when the operation is 

sequenced after the same item or product family. 

Notes: a memo field to store operation-specific notes. The notes are copied to the product 

configuration route when the operation is added to a route. These notes are then copied to 

the shop order route when the shop order is created. 

 

Create / Maintain Work Centers 

  

The Work Center Master is opened from the Production tab and is used to 

establish the capacity and cost defaults for work centers in a production area. The work 

center is used by the planning and scheduling functions to evaluate capacity availability 

in the Capacity Load Profile and adjust the schedule on the Production Schedule Board. 

The shifts and resources added to a work center are used to populate the Shop Calendar 

which, in turn, determines planned capacity for the finite capacity scheduling engine. The 

work center is a required field for operations added to either a product configuration or 

shop order route.  

  

On the Work Center Master, an existing work center can be viewed by selecting 

it from the Work Center drop-down list. To add a new work center, click the New 

button at the bottom of the screen. To copy an existing work center, click the Copy 

button at the bottom of the screen. Additional information can be entered for the work 

center in the header, capacity, resources, alternates, and cost sections as described below. 

To view the items a work center appears in the product route, click the Where-Used 

button.  
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Header 

  

Work Center: the work center number or reference that will be used to identify 

the work center. 

  

Name: the name of the work center. 

  

Description: the description of the work center. 

  

Department: the department the work center has been assigned. The department 

can be used to identify the supervisor, employees available for staffing the work 

center, and as a basis for organizing the distribution of work center schedules. 

  

Default Whse: the default warehouse for the work center used for reporting 

material issue and shop order receipt inventory transactions. 

  

Default Location: the default location for the work center used for reporting 

material issue and shop order receipt inventory transactions. 

   

Capacity 

The capacity of the work center is determined by the number of shifts, shift 

duration, number of work days, and number of resources per shift. The work center 

schedule can be populated from the default schedule maintained in the Company Master 

or individually if there are differences in any of the schedule parameters. To copy the 

default schedule from the Company Master, select the Use Default Schedule? checkbox. 

Alternatively, shifts can be added to the work center schedule by adding shift records to 

the capacity screen. Shifts can be removed by selecting a shift record and hitting the 

Delete key. The work center capacity fields are described in more detail below.   

  

Shift: the work shift with values from 1 to 3. 

  

Start: the start time for the applicable shift. 

  

End: the end time for the applicable shift. 

  

Shift Hours: the calculated hours between the shifts start and end times including 

breaks and other planned downtime. 

  

Work Days: the number of days per week the work center operates. Currently, 

this field supports work weeks of between 4 and 7 seven days. 

  

No. Resources: the number of resources is a calculated field based on the 

resources added to the shift record. To add resources to a shift, click the Add 

Resources button and select the resources from the drop down list. The resource 

list for the work center is populated on the Resources page. 
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No. Operators: the number of operators assigned to the work center by shift. The 

number of operators is used to determine the work center staffing requirements 

based on the scheduled hours for the work center. The work center staff 

requirements are summarized on the Work Center Staffing Report in the 

Production menu. 

  

The Load Factor refers to the percentage of time that the work center is 

productive based on historical efficiency and utilization factors. The load factor can be 

used to account for both planned downtime such as breaks, startup, and cleanup and 

unexpected downtime based on past performance. The Planned Capacity is determined 

by multiplying the load factor with the available work center hours. The planned capacity 

is stated in hours per week and represents the available capacity for the work center in a 

normal week.  

The Critical Work Center? flag is used to indicate whether or not the work 

center should receive special focus and attention as a potential bottleneck resource. The 

field is used as a filter option when reviewing the work center dispatch reports so that a 

schedule can be maintained and printed for critical work centers only.  

The Display Work Center? flag determines whether the work center is displayed 

on the Production Schedule Board and Work Center Dispatch Report. 

The Use Campaign Settings? flag is used to indicate whether or not to apply 

campaign rules to the operation when generating a finite capacity schedule. The default 

setting is applied when adding a work center to an operation. If campaign rules are used, 

the setup hours for the operation will be reduced or eliminated when the operation is 

sequenced after the same item or product family. 

To inactivate a work center, check the Inactive? flag. Inactivating a work center 

removes it from all active work center lists. 

To update the Shop Calendar with the current work center schedule, click the 

Update Calendar button at the bottom of the screen and enter a date range for the 

specified work center(s). For more details on the update process, please refer to the 

Update Shop Calendar section. The Shop Calendar can be viewed by clicking the View 

Calendar button. For more details on the shop calendar, please refer to the Shop 

Calendar section. 

   

Resources 

The Resources page contains the resource list for the work center. To create a 

resource, add a Resource Name, Description, and Priority to the list. The priority 

assigned to a resource is used during finite scheduling to assign available resources to an 

operation with available resources assigned in ascending priority order. Resources can be 

inactivated using the Inactive checkbox or removed by selecting a resource record and 

pressing the Delete key.  
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A resource will not affect capacity until it is added to a shift. A resource can be 

added to a work center shift by selecting a shift on the Capacity page and clicking the 

Add Resources button. When adding a resource to more than one shift, use the 

navigation buttons to move between shifts. 

   

Alternates 

The Alternates page contains the list of alternate work centers. The alternate work 

centers are used when rescheduling a work center on a product configuration or shop 

order route. When you right-click the work center field on a route, a list of alternate work 

centers will be displayed to make an appropriate substitution. Please refer to the Product 

Configuration Master and Shop Order Master sections for more details. 

   

Cost 

The Cost page contains the information to apply setup, direct labor, and overhead 

costs to product configuration and shop order routes. The overhead cost can be applied 

based on either an hourly rate or percentage of direct labor hours as defined below. 

  

Setup Rate: the setup labor rate expressed in cost per hour for the work center. 

This rate is used to calculate the setup cost for operations. If more than one 

operator is required to setup an operation, the setup labor rate should reflect the 

total for all setup operators.  

  

Machine Rate: the machine rate expressed in cost per hour for the work center. 

The machine rate is multiplied by the run hours to determine the total machine 

cost for the work center operation. The number of operators required for the 

operation is not applied to the machine rate. 

  

Operator Rate: the operator labor rate expressed in cost per hour for the work 

center. The operator rate is multiplied by the operation hours and number of 

operators to determine the total operator cost for the work center operation. The 

number of operators required for the operation is applied to the run hours. The 

machine cost and operator cost are used to calculate the total direct labor cost for 

the operation and product route. 

  

Overhead Hourly Rate: the hourly rate for overhead expressed in cost per hour 

for the work center. This rate is used to calculate the overhead cost by multiplying 

the rate by the setup and run hours required for operations on product 

configurations and shop orders. 

  

Overhead Percent: the percentage of direct labor cost to apply to overhead for 

the work center. 

  

Backflush Labor?: indicates whether labor should be backflushed when 

reporting production against a shop order. For more information, please refer to 

the Labor Backflush section. 
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Create / Maintain Shop Calendar 

The Shop Calendar is opened from the Production tab and is used to view and 

modify work center resource availability by calendar date. To display work center 

resource availability for any given day, click on a date in the calendar section. Use the 

arrows adjacent to the month and year heading to navigate through the calendar. The 

shop calendar can be updated for all work centers or a selected work center to create a 

shop calendar that accurately reflects available capacity. Any shop calendar changes are 

reflected in the schedule for unfrozen operations the next time the Finite Scheduler runs. 

The shop calendar can be updated over an extended date range by clicking the Update 

Calendar button at the bottom of the screen. Alternatively, the shop calendar can be 

adjusted and fine-tuned by selected calendar date to meet specific requirements as 

defined below. 

Add Overtime Hours 

To reflect overtime hours in the Shop Calendar, adjust the End time for a work 

center in the Shop Schedule frame or update the shop calendar over a range of days 

using the Update Calendar button. The method used depends on the number of days and 

work centers the change will apply. When using the Update Calendar method, the shift 

start and end times on the Work Center Master must be changed to reflect the extended 

shift hours. 

  

Add Shifts or Weekends 

To add a shift or weekend days to the shop calendar, select the desired calendar 

date and click the Add button. A new line is inserted to add the work center, start and end 

times, and resource for the additional shift. A new shift record must be created for each 

required resource. Alternatively, extra shifts or weekend days can be added by clicking 

the Update Calendar button and specifying the appropriate Shift/Weekday Options. 

  

Add Scheduled Downtime 

Scheduled downtime can be reserved for a work center by either adjusting the 

start and end times or removing a work center shift from the shop calendar altogether. To 

remove a single shift from the Shop Schedule frame, select the row and click the Delete 

button. Planned maintenance can also be scheduled by creating a shop order for the work 

to be performed so that it occupies a portion of the schedule. 

  

Schedule Holidays 

Holidays can be entered on the shop calendar to prevent Catalyst from scheduling 

shop orders or cycle counts on company holidays. A holiday may be added to the shop 

calendar as follows: 

1.      Right-click over a calendar date and select the Enter Holiday shortcut 

option. A dialog box opens with the selected date and a field to enter a 

holiday description. 
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2.      In the Holiday Notes screen, enter a holiday description and click the 

Save button. 

3.      To delete any work center shifts already scheduled on a holiday, click the 

Delete All button.  

  

Schedule Partial Work Week 

To schedule a work center for less than a full work week, click the Update 

Calendar and select the desired Shift/Weekday Options. A partial work week can be 

specified by selecting the applicable shifts and work days in the Shift/Weekday Options 

group and the ‘Add available hours’ Update Option. 

             

Enter Shop Calendar Notes 

On occasion, it may be helpful to enter shop calendar notes for work centers to 

capture reasons for overtime, downtime, etc. Shop calendar notes for a work center can 

be entered by double-clicking the calendar date and entering comments in the Notes 

section. The shop calendar notes can also be opened from the shortcut menu displayed by 

right-clicking a calendar date. 

 

Create / Maintain Operator Calendar 

The Operator Calendar is opened from the Production tab and is used to view 

and modify operator availability by calendar date. To display operator availability for any 

given day, click on a date in the calendar section. Use the arrows adjacent to the month 

and year heading to navigate through the calendar. The operator calendar can be updated 

for all operators or a selected operator to create a calendar that accurately reflects 

available capacity. Any operator calendar changes are reflected in the schedule for 

unfrozen operations the next time the Finite Scheduler runs. The operator calendar can be 

updated over an extended date range by clicking the Update Calendar button at the 

bottom of the screen. Alternatively, the operator calendar can be adjusted and fine-tuned 

by selected calendar date to meet specific requirements as defined below. 

Add Overtime Hours 

To increase the Shift Hrs for an operator on a specific day, select the calendar 

date on the Operator Calendar and edit the shift hours for the desired operator in the left-

hand frame. To add overtime hours over an extended date range for all operators assigned 

to a shift, edit the Shift End time in the Default Shop Schedule frame on the 

Manufacturing page of the Company Master. Next, click the Update Calendar button 

on the Operator Calendar and select the desired shift and date range to apply the extended 

work hours. 

  

Add Shifts or Weekends 

To add a shift or weekend days to the operator calendar, select the desired 

calendar date and click the Add button. A new line is inserted to add an operator and 

shift. Alternatively, extra shifts or weekend days can be added by clicking the Update 

Calendar button and specifying the appropriate Shift/Weekday Options. The shift hours 
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are applied using the information from the Default Shop Schedule on the 

Manufacturing page of the Company Master 

   

Schedule Holidays 

Holidays can be entered on either the Operator Calendar or the Shop Calendar – 

the holidays entered on one calendar apply to both. To add a holiday using the Operator 

Calendar, follow the steps below. 

1.      Right-click over a calendar date and select the Enter Holiday shortcut 

option. A dialog box opens with the selected date and a field to enter a 

holiday description. 

2.      In the Holiday Notes screen, enter a holiday description and click the 

Save button. 

3.      To delete any operators already scheduled on a holiday, click the Delete 

All button.  

  

Schedule Partial Work Week 

To schedule an operator for less than a full work week, click the Update 

Calendar and select the desired Shift/Weekday Options. A partial work week can be 

specified by selecting the applicable shifts and work days in the Shift/Weekday Options 

group and the ‘Add available hours’ Update Option. 

             

Enter Operator Notes 

On occasion, it may be helpful to enter operator notes to capture reasons for 

overtime, absences, etc. Operator notes can be entered by double-clicking the calendar 

date and entering comments in the Notes section. The operator notes can also be opened 

from the shortcut menu displayed by right-clicking a calendar date. 

 

Create / Maintain Operator Schedule 

 

The Operator Schedule Reports screen provides for the manual assignment of 

operators to shop order operations and output to several report options including a 

variation of the Work Center Dispatch Report listing the operators assigned to a shop 

order route, an Operator Dispatch List, and Operator Shortages report. The Work 

Center Filter and Shop Order Filter groups can be used to limit the operations 

displayed in the Scheduled Operations section and output reports. Any of the shop order 

operation fields that are not grayed out can be modified including the schedule start and 

finish, operation description, work center resource, number of required operators, setup 

hours, run hours, shop order due date, and shop order priority. To modify a date field, 

double-click the field and select a date/time from the calendar. To navigate between shop 

order operations, use the record selectors at the bottom of the Scheduled Operations 

frame. 

  

The operators are assigned to shop order operations automatically using the 

Catalyst Finite Scheduling engine. To edit the generated schedule or manually assign 

operators to Scheduled Operations, select an operator from the Operator drop-down 



Catalyst Manufacturing User Manual

 

141 

list, enter a schedule date, shift number, and scheduled hours for the operator during the 

scheduled start and finish times for the operation. Only active operators assigned to the 

work center department are displayed in the Operator drop-down list. The Shift Hrs 

field is based on the operator calendar. If the Shift Hrs is zero, click the Operator 

Calendar button to add the operator for the selected date and shift. To delete an operator 

from an operation, select the operator record and press the Delete key. Select the Save 

button to save changes in the Scheduled Operations frame. 

  

  To view the operator schedule, select a Report Type from the top of the screen 

and select the Print Preview button. The Work Center Dispatch List displays operators 

assigned to a shop order route below each scheduled operation. The Operator Dispatch 

List displays operators by work center resource assigned to shop order operations. The 

Operator Shortages report displays the shop order routes that do not have sufficient 

operator coverage based on the work hours and number of operators required for the job. 

 

Create / Maintain Setup Matrix 

  

The Catalyst Scheduler uses the setup hours in the product family setup matrix to 

apply campaign scheduling rules. The setup hours applied to an operation when using 

product families depends on the predecessor/successor relationship established in the 

setup matrix. For example, if an operation producing an item in product family B is 

preceded by an operation producing an item in product family A, the setup hours that will 

be applied to the second operation is based on the product family A to B 

predecessor/successor relationship. 

 

To populate the setup matrix, select Product Family Setup from the Production 

tab. To apply the setup hours from the setup matrix, you will need to mark the Campaign 

flag on the affected shop order operations and select the ‘Use product family setup 

matrix’ option on the Catalyst Scheduler. Please refer to the Catalyst Scheduler help topic 

for more information. 

 

Create / Maintain Labor Reason Codes 

  

The reason code allows the underlying cause for an inventory or labor transaction 

to be captured at the time the transaction is reported. The transactions may then be 

reviewed as part of a corrective and preventive action process. The Labor Reason Codes 

are located in the Production Data Setup group on the Production tab.   

  

The Transaction History screen can be used to identify the inventory and labor 

transactions by specified filter. For instance, inventory reporting reason codes are helpful 

in determining the root cause of scrap adjustments, obsolescence write-offs, cycle count 

adjustments and other forms of inventory variance and shrinkage. The labor reporting 

reason codes can be used to track machine downtime or production disruptions due to 

material shortages or operator availability. 
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To maintain the reason codes in datasheet view, click the table image  button. 

In datasheet view, you can scroll down the list of existing records and add, delete, or edit 

without the use of command buttons. To return to form view, double-click the gray bar to 

the left of the datasheet or right-click anywhere in the datasheet and select the View 

Form option from the shortcut menu.  
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Inventory 

The Inventory tab contains options to report inventory transactions, maintain and view 

inventory data, and conduct cycle counts. The tab options are listed below.  

Enter Shop Order Receipts 

Mass Issue Materials 

Transfer Inventory 

Adjust Inventory 

 

Single-Issue Materials 

Material Code Change 

 

Inventory By Location 

Transaction History 

Inventory Batch Summary 

 

Conduct Cycle Counts 

Create Barcode Labels 

 

Warehouse Master 

Location Master 

Inventory Reason Codes 
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Enter Shop Order Receipts 

  

To enter a shop order receipt, select Enter Shop Order Receipts on the 

Inventory tab. The instructions for entering a shop order receipt are as follows: 

  

1.     On the Inventory Transaction Reporting screen, select a shop order from 

the Shop Order drop-down list. To select shop orders that have already been 

completed, click the search  button and perform an advanced search. If the 

shop order has already been closed, it must be changed to an open, released, 

or complete status using the Shop Order Master before continuing. 

  

2.     After a shop order is selected, the parent item, lot number, QA Status, default 

warehouse, default location, and current shop order balances are automatically 

displayed on the screen. The QA Status is based on the QA Release Required 

field from the Item Master. The default warehouse and location are based on 

the Item Master for the parent item, but can be changed if needed. When the 

shop order receipt is saved, the inventory of the parent item in the warehouse 

location will be increased by the receipt quantity. 

  

3.     Enter the shop order receipt quantity for the parent item on the shop order in 

the Quantity field on the Primary page. To reverse or reduce the quantity of 

a previous receipt transaction, enter a negative shop order receipt quantity. If 

the parent item has a by-product referenced on the Item Master, a by-product 

receipt quantity can be entered on the By-product page. The sum of the 

primary and by-product quantities are used to update the quantity received 

against the shop order and calculate the backflush quantities, if applicable. 

   

4.     Verify the transaction and click the Save button. The receipt transaction 

increases the inventory of the parent item in the specified warehouse location 

and updates the shop order quantity received. 

  

For shop orders linked to a customer order, the receipt quantity is automatically 

allocated to the customer order at the time of receipt. Any receipt quantity greater than 

the customer order quantity remains unallocated and available for use on other orders. 

  

If the shop order contains any backflush materials on the bill-of-material or 

backflush labor operations on the product route, the Backflush Confiirmation screen will 

display after clicking the Save button. The default backflush quantities are based on the 

shop order receipt quantity and may be modified if required. Clicking the Accept button 

on the Backflush Confirmation screen will create a material issue transaction for each 

of the backflush components and a labor transaction for each of the backflush operations. 

When backflushing lot-controlled items, the backflush consumes inventory on a FEFO 

(first expiry, first out) basis using an ascending sort on the expiration date and lot 

number. The Cancel button will cancel all pending backflush transactions, but not the 

original shop order receipt transaction. To process backflush transactions without 
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entering a receipt, click the Backflush Shop Order button instead of the Save button in 

step 4. 

  

The Notes field can be used to enter comments or additional information 

regarding the reason for a transaction. The fields in the Session Totals section are 

incremented for the saved transaction. The Total Entries field will be incremented by 

one to reflect the number of saved transactions and the Cum. Quantity field will be 

incremented by the receipt quantity to reflect the sum of all transaction quantities entered 

in the current session. The backflush transactions are not included in the session totals. 

Mass Issue Materials 

  

A material issue transaction removes inventory from a stock location to report 

consumption against a specific shop order. Whereas a single-issue material transaction 

involves only one bill-of-material component for each transaction, a mass issue material 

transaction involves reporting the usage of multiple components on a shop order 

simultaneously. If materials have already been allocated to the shop order, the allocations 

can be pre-loaded into the issue quantity fields using the Load Allocations button at the 

bottom of the screen. The pre-loaded quantities can then be reviewed and edited prior to 

saving. The instructions below describe how to enter a mass issue transaction without 

material allocations. 

  

1.     Select Mass Issue Materials from the Inventory tab. 

2.     On the Inventory Transaction Reporting screen, select a shop order from 

the Shop Order drop-down list. To select a shop order based on a quote, click 

the Quote check box and select from the revised list. To select shop orders 

that have already been completed, click the search  button and perform an 

advanced search. If the shop order has already been closed, it must be changed 

to an open, released, or complete status using the Shop Order Master before 

continuing. 

3.     When a shop order is selected, all non-backflush bill-of-material components 

for the shop order are listed in the Bill-of-Material Components section. The 

available inventory for each component is listed in the Available Inventory 

section for the currently selected bill-of-material item. To issue material for a 

different material, select the desired item record in the Bill-of-Material 

Components section. The Issue Location option can be used to filter the 

available inventory to a specific warehouse or location. If there are no records 

listed in the Available Inventory section, then no inventory exists for the 

item in the selected issue location(s) or the inventory may reside in a non-

nettable inventory location. To issue material from a non-nettable inventory 

location, the material must first be transferred to a nettable location using an 

Inventory Transfer.. 
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4.     To report the quantity issued for a bill-of-material item, select the Issue flag 

on the matching inventory record. The Quantity field is automatically 

populated based on the quantity remaining (Qty Rem) for the bill-of-material 

item. If necessary, edit the default quantity and continue to select the Issue 

flag on additional inventory records until the total issue quantity equals the 

actual quantity consumed in the process. If the issue quantity entered for any 

given inventory record exceeds the available inventory, a warning message 

appears advising that the issue quantity will result in a negative inventory 

condition.  

5.     Repeat the previous step for each bill-of-material component used on the shop 

order. The issue transactions can be saved by clicking the Save button either 

before moving to another bill-of-material component or after entering issue 

amounts for all bill-of-material items. When saving, the inventory records are 

deducted by their corresponding issue quantities and the Issue Qty field for 

each bill-of-material item is updated accordingly. 

  

6.     After saving a material issue, the unused quantity that remains in the work 

center location can be transferred back to the stockroom or other location by 

clicking the Return To Stock button at the bottom of the screen. The 

Inventory Transfers screen is populated with the item, lot number, and from 

location information based on the current issue location. 

   

Note: To reverse an issue quantity, enter a negative amount in the Quantity field. 

A negative issue amount adds inventory back to the stock location and decreases the issue 

quantity for the bill-of-material item. If the inventory record has already been completely 

depleted, it will be necessary to use a single-issue transaction to add back the consumed 

inventory. To issue an item that is not on the shop order bill-of-material, use the single-

issue transaction. 

 

Transfer Inventory 

  

The Inventory Transfers screen is opened by selecting Transfer Inventory 

from the Inventory tab and is used to capture the movement of goods from one inventory 

location area to another. To enter a set of inventory transfer transactions, select a From 

Warehouse and To Warehouse at the top of the screen. You can then begin entering the 

transfer lines in the lower screen. After each transfer line you will be notified of any 

missing information. The lot number and serial number range may be required if so 

indicated for the item on the Item Master. After entering the transfer data, click the Save 

button to create the inventory transfer transactions. The Total Quantity and Total Lines 

amounts at the top of the screen are updated after each save to track the total quantity 

transferred and number of transfer lines entered during a given session. The definitions 

for the transfer line fields are provided below:  
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Item No.: the transferred item 

  

Description: the description of the transferred item. 

Lot No.: the lot number for the transfer item. This field will be enabled for lot controlled 

items. 

From Location: the location the goods were transferred from within the From 

Warehouse 

  

To Location: the location the goods were transferred to within the To Warehouse 

  

Quantity: the quantity transferred between locations 

  

U/M: the stock unit of measure for the item. 

  

Dimension/Revision No.: the dimension code for the item if the item is identified as 

dimensional in the Item Master or the revision number if the item is identified as revision 

controlled in the Item Master. The item attribute setting on the Inventory page of the 

Company Master determines whether an item can be setup with dimensional inventory or 

revision control.   

 

Adjust Inventory 

  

To enter an inventory adjustment for an item, select Adjust Inventory from the 

Inventory tab. There are two basic inventory adjustment Transaction Types. To create a 

new inventory record, use the Opening Balance transaction. To change the quantity of 

an existing inventory record, use the Inventory Adjustment type. The instructions below 

apply to both transaction types. 

  

1.      Enter the Lot No., Item No., and QA Status into the respective fields. If an 

inventory batch record already exists, the selection of one of these fields 

automatically filters the list options in the other two.  

2.      Select the Warehouse and Location of the adjustment transaction. The 

Current Qty is populated with the on-hand quantity in the specified 

warehouse location. 

3.      Modify the default Reason Code as required. To add a new reason code or 

change a non-system reason code, click the adjacent pencil edit button  to 

open the Reason Code Master. The Notes field can be used to enter comments 

or additional information regarding the reason for a transaction. 

4.      Enter either a positive or negative inventory adjustment quantity in the Adj. 

Quantity field. The Post Adj. Qty field is updated accordingly. 
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5.      Click the Save button to process the transaction. If you need to verify the 

transaction, use either the View Inventory By Location or Transaction History 

screens. 

 

Single-Issue Materials 

  

The material issue transaction decreases the inventory on-hand of the component 

in the specified warehouse location and increases the issue quantity of the component on 

the shop order. A single-issue material transaction involves only one bill-of-material 

component for each transaction whereas a mass issue material transaction involves 

reporting the usage of multiple components on a shop order simultaneously. The 

instructions for entering a single-issue transaction are as follows: 

  

1.     Select Single Issue Materials from the Inventory tab. 

  

2.     On the Inventory Transaction Reporting screen, select a shop order from 

the Shop Order drop-down list. To select shop orders that have already been 

completed, click the search  button and perform an advanced search. If the 

shop order has already been closed, it must be changed to an open, released, 

or complete status using the Shop Order Master before continuing. 

  

3.     After a shop order is selected, the Item No. field is automatically populated 

with the shop order bill-of-material components. Select the appropriate 

component from the Item No. drop-down list. To issue an item that is not on 

the shop order bill-of-material, type the item number directly into the field and 

select the new item from the revised list. 

  

• If the component is a dimensional inventory item, the dimension 

code is referenced in the drop-down list and can be modified after 

selection using the Dimension field.  

• If the component is a revision control item, the revision number is 

referenced in the drop-down list and can be modified after 

selection using the Revision No. field.  

 

4.     The Warehouse and Location fields will default to the values entered for the 

item on the Inventory page of the Item Master. If default values are not 

populated or the adjustment needs to be entered for a different warehouse 

location, edit the default values as required. 

  

5.     Enter the material issue quantity in the Quantity field. This quantity should 

be the quantity actually consumed as part of the shop order process. To 

reverse an issue quantity, enter a negative amount in the Quantity field. A 

negative single-issue transaction adds inventory back to the stock location and 

decreases the issue quantity for the bill-of-material item. 
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6.     If the bill-of-material item is lot controlled, then enter a Lot No. for the 

transaction. Select the QA Status from the drop-down list as indicated from 

the physical label attached to the component lot issued to the parent batch. 

  

7.     Verify the transaction and click the Save button. The material issue 

transaction decreases the inventory in the warehouse location and increases 

the issue quantity of the shop order component. 

  

The Notes field can be used to enter comments or additional information 

regarding the reason for a transaction. The fields in the Session Totals section are 

incremented for the saved transaction. The Total Entries field will be incremented by 

one to reflect the number of saved transactions and the Cum. Quantity field will be 

incremented by the material issue quantity to reflect the sum of all transaction quantities 

entered in the current session. 

 

Change Material Code 

 The Material Code Change screen, opened from the Inventory tab, provides a 

mechanism to change the item number for inventory records on a batch. This function 

can be used instead of an inventory adjustment to support the recoding of product to a 

different item number in a single step. The code change function essentially creates a 

shop order for the new item number (To Item No.), issues the current item number 

(From Item No.) to the shop order to remove it from inventory, and then enters a shop 

order receipt to add the inventory back under the new item number. For this to occur, an 

alternate configuration must be created prior to running the utility with the To Item No. 

as the parent and the From Item No. as a child component on the bill-of-material. The 

engineering ID for this product configuration must be ‘2’. 

           On the Material Code Change screen, enter the Lot No., From Item No., and To 

Item No. to process a material code change. After entering the From Item No., the 

inventory records for the selected lot and item are listed in the lower screen. When 

clicking the Save button, a material code change is executed by applying issue and 

receipt transactions to each inventory record in the lower screen using the shop order 

number created during the process. 

View Inventory By Location 

  

The Inventory By Location screen displays the inventory quantity by location 

for an item. The inventory locations can be filtered by warehouse, location, lot number, 

and QA Status. In addition, the inventory basis can be alternated between the stock unit 

of measure, purchase unit of measure, and alternate unit of measure based on the 

respective unit of measure conversion value maintained either on the Item Master or Unit 

of Measure Master. The inventory basis does not change the manner in which inventory 
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transactions are entered for the item. The stock unit of measure remains the default unit 

of measure for inventory, planning, and costing purposes.  

  

The Inventory By Location section displays the inventory records for the 

currently selected filter options. Each inventory location record includes an On-Hand 

quantity and Available quantity. The available inventory is calculated as the on-hand 

quantity less the allocated quantity in a specific location (Available Quantity = On-Hand 

– Allocated Quantity). For inventory transaction details, please refer to the Transaction 

History screen. 

 

To transfer selected inventory records to another location, highlight the record 

selector to the left of the record and click the Transfer button. To select all filtered 

inventory records, click the Select All button. The Transfer button will open the 

Inventory Transfers screen and populate the from locations and quantities for the 

highlighted inventory records. To complete the transfer, enter the transfer to locations and 

click the Save button. 

  

View Transaction History 

The Transaction History screen, opened from the Inventory tab, displays 

inventory and labor transactions entered over the filtered date range. The list of 

transactions can also be filtered by transaction type, reason code, item number, lot 

number, shop order, purchase order, location, or user name. When changing the filter 

options and date range, select the Apply Filters button to update the transaction list. 

For inventory transactions, the transaction detail provides information on the 

transaction date/time, transaction type, order reference number, item number, item 

description, transaction quantity, warehouse, location, lot number, reason code, and user 

name. For labor transactions, the transaction detail provides information on the 

transaction date/time, transaction type, shop order number, sequence number, operation 

description, labor hours reported, good quantity, scrap quantity, parent item number, 

parent item description, reason code, and user name. 

The inventory and labor transactions can be printed by clicking the Print Preview 

button at the bottom of the screen. For a more detailed report of transactions specific to a 

shop order, refer to the Shop Order Transaction Detail report which can be opened by 

selecting Transaction Detail from the Production tab. 

 

Inventory Batch Record Summary 

 

The Inventory Batch Record Summary screen, opened by selecting Inventory 

Batch Summary from the Inventory tab, displays a summarized list of receipt, issue, 

and adjustment transactions for inventory batch records. To display a single inventory 

batch record, select the Item No. and Lot No. from the Record Filter section and click 
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the Print Preview button. The Inventory Batch Record Summary report provides a 

history of the inventory batch record from initial receipt to final close-out transaction.  

  

To view multiple inventory batch records as part of a reconciliation process, 

select the ‘Perform inventory record reconciliation’ check box and select the option to 

view all inventory records that reached a zero balance or that currently have a balance 

based on a percentage of the quantity received. The final inventory transaction date may 

be specified with either option. 

 

Conduct Cycle Counts 

             

A cycle count program is part of a continuous improvement process to ensure that 

the inventory asset is managed and controlled properly. Cycle counting is the systematic 

counting of parts over a period of time with the purpose of: 

  

▪       verifying inventory control procedures, 

▪       eliminating root causes, 

▪       correcting errors to maintain record accuracy, and 

▪       eliminating the physical inventory.  

  

The four main methods of cycle counting are control group, random sample, 

ABC, and process control. It is beyond the scope of this manual to review these methods 

in detail; however, the primary difference between the methods is in how the cycle count 

sample is chosen. Catalyst supports each of these methods and provides a format to 

manage and execute the cycle count process. In this section we will review Control 

Group, Random Sample, ABC Method, and Process Control cycle count methods and 

how they would be implemented using Catalyst. 

  

Control Group 

Control group cycle counting is generally used at the outset of an inventory 

control program to verify the design of the process and procedures. With control group 

cycle counting, a sample of items that reflect the general population is selected and the 

same sample is cycle counted repeatedly over a short period of time. By counting the 

same items repeatedly in a short time frame, inventory errors can be found more easily. 

The corrective actions for the errors that occur to the control group can then be applied to 

the inventory control process to improve the accuracy for the general population.   

  

            To conduct a control group cycle count using Catalyst, follow the steps as 

outlined below: 

  

1.      Create a control group by setting the control group flag for each desired 

item. You can change the cycle count properties for an item by selecting 

Setup Cycle Count Items under the Conduct Cycle Counts button on 

the Inventory tab. 
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2.      Open the Cycle Count Control Board located on the Inventory tab under 

the Conduct Cycle Counts button. In step 1 of the control board, choose 

the Control Group method to load control group items into the current 

cycle count list. 

3.      Follow the remainder of the steps on the Cycle Count Control Board to 

complete the control group cycle count. 

  

Since the sample is not drawn randomly from the general population, control 

group cycle counting cannot be used to report inventory accuracy. For this reason, other 

cycle counting methods are usually employed in combination with the control group. 

   

Random Sample 

Random cycle counting is a method in which the cycle count items are selected 

randomly from the overall population of item numbers. With random cycle counting, 

each item has an equal chance of being included in the sample. This method ensures no 

bias is built into the selection process.    

  

            To conduct a random sample cycle count using Catalyst, follow the steps as 

outlined below: 

  

1.      Open the Cycle Count Control Board located on the Inventory tab under 

the Conduct Cycle Counts button.  

2.   In step 1 of the control board, choose the Random method to randomly 

select items from each ABC classification and insert them into the current 

cycle count list. 

3.      Follow the remainder of the steps on the Cycle Count Control Board to 

complete the random sample cycle count. 

  

ABC Method 

           With ABC cycle counting, items are counted based on their dollar volume or 

usage according to the Pareto Principle. Applied to inventory, the Pareto Principle states 

that a minority of the items account for a majority of the volume and therefore most of 

the inventory transactions. Since the higher usage items have more opportunity for error, 

it is natural that they will need to be counted more frequently than the slower moving B 

and C items. To conduct a cycle count based on the ABC method, follow the steps as 

outlined below: 

  

1.      Review the Annual Expense per Item report located under the Reports 

button on the Inventory tab to determine the assignment of A, B, and C 

items based on usage. The items are listed in descending order of annual 

expense with a reference to the cumulative percentage. 
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2.      Assign an ABC category to each cycle count item by selecting Setup 

Cycle Count Items under the Conduct Cycle Counts button on the 

Inventory tab. 

  

3.      If you have not done so already, specify the parameters for your cycle 

count program by selecting Setup Cycle Count Program under the 

Conduct Cycle Counts button on the Inventory tab. For more 

instructions, please refer to the Cycle Count Program Setup topic. 

4.      Create a cycle count schedule based on your program setup to indicate the 

calendar days you will cycle count each item. The cycle count schedule is 

created for you automatically by selecting Generate Cycle Count 

Schedule under the Conduct Cycle Counts button on the Inventory tab. 

The cycle count schedule can be reviewed and maintained by selecting 

Maintain Cycle Count Calendar under the Conduct Cycle Counts 

button on the Inventory tab. For more instructions, please refer to the 

Cycle Count Schedule and Cycle Count Calendar topics. 

  

5.      Open the Cycle Count Control Board located on the Inventory tab under 

the Conduct Cycle Counts button. In step 1 of the control board, choose 

the Cycle Count Schedule method to load the cycle count items from the 

cycle count schedule into the current cycle count list. 

6.      Follow the remainder of the steps on the Cycle Count Control Board to 

complete the ABC cycle count. 

   

Process Control 

In process control cycle counting, the cycle count sample is determined by three 

factors: location, ease of counting, and obvious errors. In this method, the cycle count 

begins with all items and locations in a particular area. However, only those items that 

are easy to count or have obvious errors are actually included in the cycle count. Process 

control cycle counting is an effective way to “clean-up” the inventory in a work center 

location or other high-activity inventory area. The steps involved in a process control 

cycle count are as follows: 

  

1.      Open the Cycle Count Control Board located on the Inventory tab under 

the Conduct Cycle Counts button. 

2.   In step 1 of the control board, choose the Process Control method and 

select either all locations or a specific warehouse location to load the cycle 

count items into the current cycle count list. 

3.   Print the cycle count sheets for the cycle count team using the button in 

step 2 on the Cycle Count Control Board. Alternatively, the cycle count 

sheets can be printed from the Inventory Inquiry Reports using the 

warehouse or location filter option. For a process control cycle count, the 
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cycle count sheet includes the quantity on hand so the cycle counters can 

identify the item locations with obvious errors. 

4.      Follow the remainder of the steps on the Cycle Count Control Board to 

complete the process control cycle count. 

  

Cycle Count Control Board 

             

The Cycle Count Control Board helps manage the operational aspects of conducting 

a cycle count and provides multiple options for populating a list of cycle count items. The 

Cycle Count Control Board is located on the Inventory tab under the Conduct Cycle 

Counts button. After specifying a cycle count number, warehouse and date, proceed 

through each step of the cycle count process using the steps provided below. 

  

1.     Load cycle count items into current list 

▪ The first step creates a list of cycle count items based on one of the 

following options: 

• Cycle Count Schedule: 

o       Loads the cycle count items directly from the Cycle Count 

Calendar 

• Random 

o       Generates a random sample for each ABC classification 

• Control Group 

      o       Loads the control group items as indicated by the cycle count 

item properties 

• Process Control 

o       Loads the cycle count items based on specified warehouse 

location(s) 

The cycle count items can be filtered to include zero balances, exclude zero 

balances, exclude balances less than or equal to zero, or include negative 

balances. Please refer to the section on Implementing a Cycle Count Program 

for more details about the different methods for generating a cycle count 

sample. 

  

2.     Print cycle count sheets 

▪       This step prints the cycle count sheets used by the auditors to capture the 

physical quantity of the cycle count items ina particular location. The 

group increment on the cycle count sheet report defaults to 10 records, but 

can be modified based on the number of participating cycle counters. 

  

3.     Post cycle count results 

▪       The Cycle Count Entry screen allows the cycle count team to enter the 

results of the cycle count and immediately see the number of hits and 

misses and resulting accuracy value. The cycle count can be customized to 
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include or exclude inventory records by adding, deleting, or editing the 

records generated from the automated process. 

  

4.     View cycle count accuracy report 

▪       The results of the current cycle count can be summarized and printed in 

the Cycle Count Accuracy Report. 

  

5.     Process inventory adjustment transactions 

▪       In the final step, the cycle count records are posted to a results table and 

any necessary inventory adjustment transactions are processed based on 

the actual cycle count quantity. The inventory transaction reason code is 

based on the reason code selected for each cycle count record. 

 

 

Post Cycle Count Results 

The Cycle Count Entry screen allows the cycle count team to enter the results of 

the cycle count and immediately see the number of hits, misses, and overall 

accuracy.  The Cycle Count Entry screen can be opened from the Cycle Count Control 

Board or directly by selecting Post Cycle Count Results under the Conduct Cycle 

Counts button on the Inventory tab.  

The Clear Counts button at the bottom of the screen is used to clear any cycle 

count entries and resequence the record numbers. After finalizing the cycle count list, 

click the Print Sheets button at the bottom of the screen to distribute the cycle count 

sheets to the cycle count team. The Refresh button can be used to update the on-hand 

quantities of items in the cycle count list. The steps for posting cycle count results to the 

Cycle Count Entry screen are listed below followed by field definitions.  

1.     Select a warehouse from the drop-down list in the Warehouse field at the top 

of the screen. 

  

2.     If you need to add or edit to the existing cycle count list, you can make entries 

as required in the main section of the form. Use the Include All button to add 

all item locations for the current record to the cycle count list. The Copy 

button creates a copy of the current record. The Delete All button deletes all 

cycle count records in the list. The Reset button on the main form is used to 

clear any cycle count entries and resequence the record numbers. After 

finalizing the cycle count list, click the Print Sheets button at the bottom of 

the screen to distribute the cycle count sheets to the cycle count team. 

  

3.      As the cycle count results are submitted, post the actual quantity for each 

cycle count record in the Count Quantity field. The Miss field is calculated 

for you automatically based on the quantity on-hand (QOH) and tolerance for 

the item.  
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4.      The Accuracy is displayed at the top of the screen and is calculated by 

dividing the number of hits by the total number of hits and misses for the 

cycle count. The results of the cycle count can also be reviewed by clicking 

the View Report button at the bottom of the screen.  

5.      After verifying the cycle count results, click the Process Adj. button at the 

bottom of the screen to post the cycle count records to a results table and 

perform any necessary inventory adjustment transactions based on the actual 

cycle count quantity. The inventory transaction reason code is based on the 

reason code selected for each cycle count record. 

The header fields on the Cycle Count Entry screen include: 

Auditor: the current system user. 

Beg. Record: the beginning cycle count record 

End Record:  the ending cycle count record.  The cycle count records that appear in the 

subform can be controlled by clicking the Filter button to display cycle count records 

according to the beginning and ending record numbers specified in these two fields. 

Warehouse: the warehouse the cycle count is being conducted.  A cycle count can be 

conducted in only one warehouse per client session. 

Count Date: the date the cycle count was conducted 

Accuracy: the calculated cycle count accuracy based on the number of hits and misses in 

the cycle count records. A recalculation button can be clicked that the value reflects the 

latest records updated. 

The cycle count records in the subform include the following fields: 

Record No.: the cycle count record number which is automatically generated.  If the 

record number is entered manually it cannot be a duplicate of an existing record. 

Item No.: the item number to be cycle counted 

Description: a description of the cycle count item 

QA Status: the release or disposition status of the inventory batch record 

Lot No.: the lot number for the cycle count item. This field is required for lot-controlled 

items. 

Location: the location of the cycle count item.  The locations appearing in the drop-down 

box are locations in the warehouse selected at the top of the form. 
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Current Quantity: the system quantity on-hand of an item for the specified location and 

lot number if required 

Count Quantity: the actual cycle count quantity of an item for the specified location and 

lot number if required 

U/M: the stock unit of measure of the item 

% Tol.: the tolerance percentage for the item.  This percentage allows the cycle count 

quantity to differ from the QOH Record up to the tolerance level and still not be scored as 

a Miss.  The tolerance percent is applied as both a lower and upper limit so the cycle 

count is not counted as a Miss unless the quantity is below the lower limit or above the 

upper limit.  In general, higher tolerances are established for lower cost, higher volume 

items. 

Miss: a checkmark indicates if the cycle count quantity falls outside of the tolerance 

range for the item. 

Reason Code: the reason code for the cycle count record that will be used if an inventory 

adjustment transaction is required. 

Dimension/Revision No.: the dimension code for the item if the item is identified as 

dimensional in the Item Master or the revision number if the item is identified as revision 

controlled in the Item Master. The item attribute setting on the Inventory page of the 

Company Master determines whether an item can be setup with dimensional inventory or 

revision control. 

 

Generate Cycle Count Schedule 

             

The cycle count schedule is generated by selecting Generate Cycle Count 

Schedule under the Conduct Cycle Counts button on the Inventory tab. The cycle 

count schedule loads cycle count items into the cycle count calendar based on the cycle 

count program settings for a specified warehouse. To generate a schedule, follow the 

steps provided below. 

  

1.      On the Generate Cycle Count Schedule screen, enter a warehouse to 

generate a cycle schedule. The program settings for that warehouse will be 

used to generate the schedule. 

2.      Enter a beginning and ending date range to generate the cycle count 

schedule. 

3.      Modify the Cycle Count Options as required to include items with zero 

or negative inventory balances. 
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A schedule is not generated for any company holidays entered in the Shop 

Calendar. The cycle count schedule can be viewed by calendar day using the Cycle Count 

Calendar or by item using the Cycle Count Item Setup. The cycle count schedule is 

loaded into the current cycle count item list using the Cycle Count Control Board. The 

cycle count schedule can be printed using the Cycle Count Items by Date Report. 

 

Maintain Cycle Count Calendar 

 

The Cycle Count Calendar displays the cycle count schedule in a calendar 

format. The calendar is opened by selecting Maintain Cycle Count Calendar under the 

Conduct Cycle Counts button on the Inventory tab. To display the cycle count schedule 

for a particular day, select the date on the monthly calendar. The cycle count schedule for 

the day appears to the left of the calendar. The calendar includes the holidays as 

maintained on the Shop Calendar. 

  

            The steps below indicate how to add a cycle count item to the schedule for a 

specified day. 

  

1.      Select a date by left-clicking a day on the monthly calendar. 

2.      Click the Add button underneath the current cycle count schedule to 

change the schedule to edit mode. 

3.      Select a warehouse and item from the drop-down lists. The Scheduled 

Count Date defaults to the currently selected day. The Last Count Date 

is a calculated field and refers to the last scheduled count date for the item, 

if one exists. The ABC Code for the item is provided for reference only.  

  

4.      Add additional items as required. 

  

Cycle count schedule items can be removed by clicking the Delete button to 

delete a single record or Delete All to delete all cycle count schedule items on the 

selected date. To enter cycle count calendar notes, double-click the cycle count date on 

the monthly calendar. A screen appears listing the cycle count items scheduled for that 

particular day. In the Notes field, enter cycle count notes such as explanations for cycle 

count variances and other comments. To update the cycle count schedule over a date 

range, click the Update button to open the Generate Cycle Count Schedule screen. 

 

Cycle Count Program Setup 

 

The cycle count program is established and maintained at a warehouse level using 

the Cycle Count Program Setup screen. The setup screen is opened by selecting Setup 

Cycle Count Program under the Conduct Cycle Counts button on the Inventory tab. 

To setup a cycle count program for a warehouse, select a warehouse from the drop-down 

list, specify program settings as described below, and click the Save button. The cycle 
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count program settings are used to create a cycle count schedule for the warehouse. The 

Cycle Count Program Setup screen also contains links to perform other system functions 

related to the cycle count program such as updating item tolerances, viewing the cycle 

count calendar, and printing a daily schedule. The program settings and functions are 

described in more detail below. 

  

The Cycle Count Frequency can be specified on either a daily or monthly basis. 

When selecting Daily, you will also enter the days of the week a cycle count will be 

conducted. For less frequent cycle counts, you can select the Monthly basis and indicate 

whether you want to conduct a cycle count semimonthly or at the end of the month. The 

semimonthly days are preset as the 2nd and 4th Friday of the month. The cycle count 

frequency settings are used to calculate the number of cycle count days and generate a 

cycle count schedule. 

  

The other settings required to establish a cycle count program include the 

tolerance and counts per year for each ABC classification. The Tolerance is a specified 

percentage variance allowance used to calculate hits and misses for cycle count records. 

The tolerance percentage is multiplied by the quantity on-hand for a cycle count record to 

determine the absolute variance allowed on a cycle count record. You can click the 

Update Item Tolerances button to update all cycle count items with the default 

tolerances from the program setup.  

  

The Counts / Year specifies how many times per year you would like to count all 

the items in a warehouse for a particular ABC classification. The No. Items reflects the 

total number of items that have been assigned a particular ABC classification. The ABC 

code is assigned to an item’s cycle count properties in the Cycle Count Item Setup screen. 

The Annual Counts refers to the number of cycle counts to be conducted in a year based 

on the Counts/Year and No. Items. Finally, the Items/Count is the number of items in 

each classification that need to be included in a cycle count to meet the required number 

of Counts/Year. The Items/Count is determined by dividing the Annual Counts by the 

number of annual cycle counts days. 

  

            The Create Schedule button opens a separate form to create a Cycle Count 

Schedule based on the cycle count program settings. The View Calendar button opens 

the Cycle Count Calendar to display the cycle count schedule by calendar day. 

 

Cycle Count Item Setup 

 

The cycle count properties for an item are maintained in the Cycle Count Item 

Setup screen. The screen can be opened by selecting Setup Cycle Count Items under 

the Conduct Cycle Counts button on the Inventory tab. To edit the cycle count 

properties for an item, select an item from the drop-down list and update the populated 

fields as required. The cycle count properties for the item include:  
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ABC Code: the ABC classification of the item typically based on annual usage by 

applying the Pareto principle. The ABC Code is used to determine which items to load in 

to the cycle count schedule. 

  

Tolerance: the percentage tolerance allowed during inventory cycle counts for the item. 

The tolerance will vary by item based on usage, value, lead time, criticality, bill-of-

material level, or a combination of these factors. For example, the tolerance for a bolt 

may have a tolerance of 5% whereas the tolerance on a printed circuit board may have a 

zero tolerance. 

  

Control Group: a flag to indicate whether or not the item should be included in the 

control group. Control group items should be representative of the general population so 

that inferences can be drawn and corrective action taken to benefit the overall process. 

  

Last Cycle Count Date: a calculated date field indicating the last date that the item was 

included in a cycle count. 

  

Next Cycle Count Date: a calculated date field indicating the next scheduled cycle count 

date for the item 

  

Cycle Count Dates: a list of cycle count schedule dates for the item. The dates can be 

sorted by Scheduled Date or Actual Date by double-clicking the labels above the 

respective fields. The Scheduled Date can be edited directly or by double-clicking the 

date to open a pop-up calendar. 

  

The cycle count schedule for all items can be reviewed and maintained by opening the 

Cycle Count Calendar. 

 

Create Barcode Labels 

  

Catalyst Manufacturing accepts the input of one-dimensional (1D) barcode data 

into any field that accepts manual data entry. A barcode scanner that supports a keyboard 

wedge interface for USB or PS/2 can be used for this purpose. Please refer to the barcode 

scanner instructions to setup the carriage return default to automatically tab to the next 

field following barcode entry. 

  

Barcodes are already included on numerous standard reports in Catalyst such as 

shop order travelers, pick lists, and inventory reports. The barcode font and other 

properties can be changed by modifying the properties of the barcode activex control.[1] 

The barcode activex control can be used to quickly and easily insert new barcodes into 

existing or new reports. The barcode control supports barcode fonts Interleaved 2 of 5, 

Industrial, Code 39, Code 39 Extended, Code 11, Codabar, MSI, Code 128 (Auto, Set A, 

Set B, Set C), EAN Addon-2, EAN Addon-5, EAN-8, EAN-13, EAN-14, UPC-A, UPC-

E, UCC/EAN 128, SSCC-18, PostNet, PlaNet, Code 93, Code 93 Extended, and ITF 14. 

To add barcodes to an existing report, refer to the instructions below. 
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•        Open existing report in design mode. 

•        Select the report section to add a new barcode. 

•        Select Insert > ActiveX Control from the Access menu. On the Insert 

ActiveX Control screen, select the ABarCode ActiveX from the displayed 

list. 

•        Select the barcode control and display the barcode properties. On the 

Properties screen, select the Data page and specify a control source for the 

barcode. Modify other barcode properties including the font type, size, 

alignment, etc. as required. Note: Most barcode symbology specifications 

require that the ShowQuietZones property remain enabled. 

•        The following special requirements may also apply: 

➢      Insert application identifiers (AI) into UCC/EAN128 barcode types 

➢      Remove leading zero from Code128C barcode 

  

Barcode labels can be designed using third-party label software to create and print 

barcode labels for employee badges, warehouse location or bin labels, and case labels for 

inventory, receiving, and shipping cartons. The barcodes can be printed on direct thermal 

and thermal transfer printers using the label design software. To export and print label 

data, refer to the instructions below. 

  

1. Select Create Barcode Labels from the Inventory tab. In the drop-down 

menu, select one of the following options: 

➢      Employee Badges 

▪       Exports employee name, employee number, title, and job code 

from the Employee Master to create employee badges.  

▪       The label data can be filtered by operator and employee. 

▪       Exported data is stored in the tblBarcodeLabels_Employee 

table in the Catalyst Local.accdb file located in the Catalyst 

installation directory. 

➢      Inventory Cartons 

▪       Exports item number, description, lot number, and quantity per 

case to create case labels for existing inventory.  

▪       The label data can be filtered by warehouse, location, shop 

order, item number, and lot number. 

▪       Exported data is stored in the tblBarcodeLabels_Inventory 

table in the Catalyst Local.accdb file located in the Catalyst 

installation directory. 

➢      Receiver Cartons 

▪  Exports receiver number, item number, description, lot number, 

quantity per case, case or package number, number of 

containers, and receipt date for received goods.  

▪  The label data can be filtered by receiver number, receipt date 

range, and purchase order line number. 

▪  Exported data is stored in the tblBarcodeLabels_Recvr table in 

the Catalyst Local.accdb file located in the Catalyst installation 

directory. 

http://www.barcodetools.com/barcode/barcode-activex/properties.html
http://www.barcodetools.com/faq/faq/linear-barcodes-faq.html#aifnc1
http://www.barcodetools.com/faq/faq/linear-barcodes-faq.html#leadingzero
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➢      Shipping Cartons 

▪  Exports shipper number, customer purchase order number, 

shipping address fields, item number, description, lot number, 

customer part number, case quantity, case or package number, 

number of containers, and ship date for customer shipments.  

▪  The label data can be filtered by shipper number and ship date 

range. 

▪  Exported data is stored in the tblBarcodeLabels_Shipping table 

in the Catalyst Local.accdb file located in the Catalyst 

installation directory. 

➢      Warehouse Locations 

▪       Exports warehouse and location names for warehouse location 

or bin labels.  

▪       The label data can be filtered by warehouse and location. 

▪       Exported data is stored in the tblBarcodeLabels_WhseLoc table 

in the Catalyst Local.accdb file located in the Catalyst 

installation directory. 

2. On the Create…Labels screen, select a filter from the Label Filter section 

and click the Append Data button. The filtered data will be displayed in the 

Label Data section. To clear the label data and add new records, select the 

Delete Data button, modify the filter selection, and click the Append Data 

button. The Label Data records can be edited manually if desired.   

3. Select the Open Labeler button to open the default barcode label design 

software and print the exported label data.  

  

WaspLabeler, sold separately by Wasp Barcode Technologies, is the default 

barcode label software for Catalyst due to its ability to easily connect to an Access data 

source.  To use a different barcode label application, open the Application Path Manager, 

select Barcode Label Software, and specify the application path for your installed label 

software. 

 

If using the WaspLabeler software, a pre-built label template for each label type 

has been provided in the Catalyst installation directory under the Labeler subfolder. After 

selecting a barcode label template and connecting to the data source as described above, 

the barcode labels can be sent to any barcode printer. 

  

 

 

 

 

  
1 Barcode ActiveX Control Copyright © RKD Software 1999-2005. All Rights Reserved.  Note: 

Existing reports can only be modified in Full Editions of Catalyst Manufacturing. 

 

  

http://www.waspbarcode.com/software/labeler.asp
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Create / Maintain Warehouses 

  

The Warehouse Master is located in the Inventory Data Setup group on the 

Inventory tab and is used to create and maintain warehouses. Each warehouse can be 

assigned multiple locations. The warehouse is used for planning purposes and grouping 

inventory locations. Each warehouse record includes a name and description field.  

  

To maintain the warehouses in datasheet view, click the table image  button. 

In datasheet view, you can scroll down the list of existing records and add, delete, or edit 

without the use of command buttons. To return to form view, double-click the gray bar to 

the left of the datasheet or right-click anywhere in the datasheet and select the View 

Form option from the shortcut menu. 

  

Warehouse and locations together define inventory storage locations. A single 

warehouse can be used to define all locations within the company or, alternatively, 

multiple warehouses can be used to represent physical structures or buildings. The 

inventory can be summarized by warehouse designation on the Inventory Inquiry screen.  

 

Create / Maintain Locations 

             

The Location Master is located in the Inventory Data Setup group on the 

Inventory and is used to create and maintain inventory location records within a selected 

warehouse.  To add a new location, select a warehouse and enter a new record in the 

location list.  To edit a location, locate the record in the list and edit the required 

fields.  To find a specific location record, place the cursor in a Location Code field and 

press Ctrl-F to open the Find dialog box.  

  

Alternatively, you can add locations in datasheet view by clicking the table image 

  button.  In datasheet view, the warehouse records are displayed in the main datasheet 

and the location records are displayed in a subdatasheet below each warehouse.  To 

expand a subdatasheet and add, delete, or edit inventory locations, click the plus symbol 

in the expansion column to the left of the warehouse. 

  

The inventory location fields are defined as follows: 

  

Location Code: the inventory location code.  

  

Description: the inventory location description. 

  

Nettable?: indicates whether the location is nettable.  Inventory stored in nettable 

locations is considered available for planning purposes.  Inventory in non-nettable 

inventory locations is ignored by MRP.  Non-nettable locations provide a means to 

exclude material from MRP netting without placing the material in a blocked or reject 

status.  
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Pickable?: indicates whether to include the location on the customer order pick ticket. 

  

Usage?: if the location is marked as a usage location, inventory transfers are not allowed 

to the location unless the material is released.  This is designed to reinforce physical 

controls to prevent unreleased material from being transferred to a location where it could 

be issued to production or shipped to a customer or vendor.  For locations where material 

can be received, the receipt may create quarantine material in a usage location, but the 

material cannot be issued or shipped unless it’s released and it can only be transferred to 

non-usage locations. 

  

Inactive?: indicates whether the location is active.  A location cannot be inactivated if it 

has a non-zero inventory balance or is specified as the:  

•         default location for an active or discontinued item 

•         default location for an active work center 

•         receipt location on an open purchase order line 

•         default company shipping location.  

  

The Where-Used button can be used to identify where a location is specified so it can be 

reassigned prior to inactivating the location record. 

  

Create / Maintain Inventory Reason Codes 

  

The reason code allows the underlying cause for an inventory or labor transaction 

to be captured at the time the transaction is reported. The transactions may then be 

reviewed as part of a corrective and preventive action process. The Inventory Reason 

Codes are located in the Inventory Data Setup group on the Inventory tab.    

  

The Transaction History screen can be used to identify the inventory and labor 

transactions by specified filter. For instance, inventory reporting reason codes are helpful 

in determining the root cause of scrap adjustments, obsolescence write-offs, cycle count 

adjustments and other forms of inventory variance and shrinkage. The labor reporting 

reason codes can be used to track machine downtime or production disruptions due to 

material shortages or operator availability. 

  

To maintain the reason codes in datasheet view, click the table image  button. 

In datasheet view, you can scroll down the list of existing records and add, delete, or edit 

without the use of command buttons. To return to form view, double-click the gray bar to 

the left of the datasheet or right-click anywhere in the datasheet and select the View 

Form option from the shortcut menu. 
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Lot Tracking Reports 

  

The Lot Tracking report, opened by selecting Lot Tracking Report from the 

Reports button on the Inventory tab, indicate how a lot is made or where it used by 

displaying all of the issue transactions associated with the lot from the time it is received 

until final consumption. To identify the materials required to produce a lot of material, 

select the How Made report type. The How Made report can be used to investigate 

customer complaints to determine the items and lots that went into the final product. For 

information on how a particular lot was used, select the Where Used report type. The 

where-used report is useful for identifying the end items a lot was used in the event of a 

product recall or safety notice.  

  

The Lot Tracking Report traces usage by lot number through each level in the 

bill-of-material as long as each level in the bill-of-material includes a lot controlled item. 

The lot traceability will be interrupted if there is not a lot number to join each level in the 

bill-of-material. To view only the how made or where-used at the next level, select the 

‘Single-level’ Report Level option.  
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Quality 

  

The Quality tab contains functionality to manage the testing, review, and disposition of 

material and includes the options listed below. 

Batch Tracking Log 

Review/Update QA Status 

  

Batch Record Type Master 

Reviewer Master 

Quality Event Master  

Correction Type Master 
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Batch Tracking Log 

  

The Batch Tracking Log, opened from the Quality tab, stores information to 

support the review and release of batches including key dates, quality events, test results, 

dispositions, and documents.  The Batch Tracking Log provides a useful reference to 

both the current status and history of a batch.  It is also used to update the inventory 

record with changes in the retest date, expiration date, and disposition status.   

  

Add New Batch Record 

            To add a new batch to the Batch Tracking Log, click the New button at the 

bottom of the screen and enter the Lot No. and Item No.  After the batch and item have 

been entered, the other fields in the header section can be completed.  Press the Save 

button to save the record.  If after saving, the lot number needs to be changed, click the 

pencil edit button located next to the search button.  This places the Lot No. field in edit 

mode and allows the lot number to be changed. 

  

Find Existing Batch Record 

            To open an existing batch record, either enter the lot number in the Lot No. drop-

down list or click the adjacent search button  to open the search dialog. The Batch 

Tracking Log Search screen allows you to filter the batch records by item number, lot 

number, batch record reviewer, QA type, batch status, and disposition date range. 

  

Header 

            The header section is used to specify the lot number and item number for new 

batch records and navigate to different batch records.  It identifies the item number, 

description, and other general information related to the batch such as: 

• Quantity: the total quantity of the batch.  The quantity defaults to the on-hand 

quantity of the batch when a new batch record is created.  The quantity on the 

batch record header typically refers to the original receipt quantity of the 

batch.  The disposition quantity may differ. 

• Type: the type of batch record e.g. commercial, experimental, etc.  This list is 

maintained in the Batch Record Type Master. 

• Status: the batch record status – open, closed or cancelled. 

• Protocol: for validation batches or batches with an associated protocol, the 

protocol or document number issued to the batch. 

• Vendor: for purchased items, the vendor from whom the batch was received. 

• Vendor Lot No.: for purchased items, the supplier lot number for the batch.  
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Date Log 

            The Date Log page consists of three date sections – Batch Record Dates, Batch 

Review Dates, and Test Dates.  The fields in these sections are described in more detail 

below. 

 

            Batch Record Dates 

• Goods Receipt: the date the batch was received.  This date is populated 

by the system using either the PO receipt or shop order receipt date. 

• Mfg. Complete: the date manufacturing completes production of the 

batch. 

• Active Added: the date active pharmaceutical ingredient (API) was added 

to the batch.  The Contains API checkbox references the setting for the 

item on the Product page of the Item Master.  

• Mfg. Date: the date of manufacture of the batch. 

• Expiration Date: the expiration date of the batch.  For purchased items, 

the expiration date is determined by either the supplier’s CofA or internal 

procedures.  For manufactured items, the expiration date is based on either 

the manufacturing date or the active added date.  The default expiration 

date is calculated by offsetting the manufacture date or active added date 

by the Expiry Date Offset period specified on the Product page of the 

Item Master. The expiration date on the inventory record is updated with 

any changes made to the expiration date on the Batch Tracking Log. 

  

            Batch Review Dates 

• Record Received: the date the batch record is received into the QA 

department from the Manufacturing department. 

• Results Received: the date test results are received for batch record 

review. 

• 1st Review Date: the date the first review of the batch record occurs. 

• 1st Review By: the reviewer performing the initial review of the batch 

record. 

• 2nd Review Date: the date the second review or check of the batch record 

occurs, if applicable. 

• 2nd Review By: the reviewer performing a second review or check of the 

batch record, if applicable. 

• Schedule Date: the date the batch record is scheduled for initial review. 

• Actual Completion: the date the initial review of the batch record occurs. 

  

Test Dates 

• Initial Test Date: the initial test date of the batch sample. 

• Retest Date: the date the batch needs to be retested.  The default retest 

date is calculated by offsetting the initial test date by the Retest Date 

Offset period specified on the Product page of the Item Master. The retest 

date on the inventory record is updated with any changes made to the 

retest date on the Batch Tracking Log. 

  



Catalyst Manufacturing User Manual

 

169 

A Comments field is also available to enter general comments regarding the 

batch. 

  

Quality Events 

A quality event, as defined by the Quality Event Master, refers to any event that 

impacts the quality or disposition of a batch.  To create a quality event record, select a 

new record on the Quality Events page and populate the following fields: 

• Event Type: a batch record correction, lab investigation, 

nonconformance, unplanned deviation, planned deviation, corrective or 

preventive action (CAPA), validation, incident, or other event impacting 

the quality or disposition of a batch. 

• Reference No.: a standard procedure, protocol, or other document that 

serves as a basis for or reference to the quality event. 

• Department: the department responsible for the completion of the quality 

event.  The department list is populated from the Department Master. 

• Assigned To: the person assigned to the investigation and/or completion 

of the quality event.  This list is populated from the Employee Master.  

• Event Open: the date the quality event was opened. 

• Event Close: the date the quality event was closed, completed, or made 

effective. 

• Description: a brief description, notes or comments related to the quality 

event. 

  

For batch record corrections, the following fields are also available:  

• Correction Type: the type of batch record correction.  The default types 

include cGMP & Misc., Incorrect Information, Missing Information, and 

Justification & Clarification.  This list is maintained in the Correction 

Type Master. 

• # of Corrections: the number of corrections required for the specified 

quality event. 

• Page(s) / Form#: the page(s) or form number the batch record 

correction(s) need to be made. 

  

Test Results 

            The tests required for an item, as specified on the Specifications page of the Item 

Master, are automatically loaded onto to the Test Results page of the Batch Tracking 

Log when a new batch record is created.  If the test specifications are not populated for 

the batch, enter the required tests on the Specifications page of the Item Master and then 

click the Import button at the bottom of the Test Results page.  The test results are 

incorporated into the Certificate of Analysis (CofA) report that can be generated for the 

batch using the CofA button at the bottom of the screen.  To populate the test results for a 

batch, refer to the steps below. 

  

1.      On the Test Results page, move to different Test Category using the 

navigation buttons .   
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2.      Enter the Result for each test, add Notes if needed, and check the Complies 

checkbox if the result is within specification. 

  

3.      Enter the results for each test in the selected category. 

  

4.      Repeat the steps above until all results have been entered for each category. 

  

Dispositions 

After the batch record has been reviewed, a disposition status can be assigned to 

the batch on the Dispositions page of the Batch Tracking Log.  After entering a 

disposition, a report with the batch and disposition information can be printed using the 

Print Dispositions button at the bottom of the Dispositions page.  To enter a batch 

disposition, select a new record on the Dispositions page and populate the fields below. 

• Disposition: the disposition status can have one of the following values: 

o Quarantine: the batch is restricted from use.  If an item requires 

release (as specified on the Product page of the Item Master), the 

batch is assigned a quarantine status at the time of receipt.  A batch in 

quarantine status can be allocated, but cannot be transferred to a usage 

location, issued to a shop order, or shipped.  

o Approved: the batch has been released for commercial use without 

restriction. 

o Conditional Release: the batch has been released with certain 

conditions.  

o Blocked: the batch is blocked from further use pending investigation.  

A batch in blocked status cannot be allocated, transferred to a usage 

location, issued to a shop order, or shipped. 

o Reject: the batch has been rejected and is pending destruction.  A 

batch in rejected status cannot be allocated, transferred to a usage 

location, issued to a shop order, or shipped. 

• Quantity: the batch quantity subject to the disposition status.  This quantity 

can be different from the original receipt quantity of the batch entered in the 

header section. 

• Disposition Date: the date the disposition of the batch is entered. 

• Disposition Comments: comments and notes related to the disposition. 

•         Condition: the condition under which the batch may be used.  The condition 

is a required field for conditionally released batches. 

• Condition Date: the date the condition is effective.  This date has no impact 

on the when the conditional release becomes effective.  The update of the 

inventory status is the actual effective date. 

• Condition Comments: comments and notes related to the conditions for 

release. 
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Documents 

The Documents page stores the file path for documents associated with a batch 

such as receiving documents, supplier CoAs, or other executed documents.  The 

document path can be added by clicking the Browse button on a blank File Path line and 

browsing to a pdf or other file stored in a shared folder.  Once the document path is 

stored, it can be opened by either double-clicking the file path or clicking the open file 

button. 

 

Audit Notes 

            All additions, changes, or deletions of data on the Batch Tracking Log are tracked 

and stored in an audit trail that can be reviewed by selecting the Audit Notes page. 

 

Review QA Status 

To open the QA Status Review screen, select Review/Update QA Status on the 

Quality tab. The QA Status Review screen displays the inventory records for a batch. In 

addition to the quantity and location information typically associated with an inventory 

record, the inventory record also displays the status, release date, retest date, and 

expiration date associated with a batch. To display an inventory record, select the Item 

No., Lot No., or Status from the Filter Options section. The inventory records that 

match the selected filters will be displayed in the Inventory Records section. To change 

the sort order of the displayed inventory records, change the Sort Options to sort by 

either ascending lot number or item number. 

            To update the status for an inventory record, select the inventory record and then 

click the Update Status button.  The status, release date, retest date, and expiration date 

can be changed for the selected inventory record(s) as indicated in the QA Status Update 

help topic.  To update the status for multiple locations a batch resides, hold down the Ctrl 

key and left-click each inventory record. When selecting multiple inventory records in 

this manner, the lot number, item number, and status must be the same.  

            To adjust the quantity for a selected inventory record, click the Adjust Quantity 

button.  The inventory quantity can be adjusted for the item as described in the Inventory 

Adjustment help topic.  An inventory adjustment can only be entered for one inventory 

record at a time.  

The View Date Violations button opens a dialog box to run the Batch Retest / 

Expiration Date Report to identify batch records that may be approaching their retest or 

expiration date. The report can also be opened by selecting Batch Retest / Expiration 

Date Report from the Reports drop-down list on the Quality tab. 

The Audit Notes button opens a form summarizing the change history for an 

inventory record including changes to the status, release date, retest date, expiration 

date, quantity, and location.  This audit trail is in addition to inventory Transaction 
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History which displays inventory updates on a transactional basis e.g. receipts, issues, 

adjustments, etc.  

Update QA Status 

The QA Status Update screen provides a mechanism to change the status, release 

date, retest date, and expiration date associated with an inventory batch record. Although 

these changes are made concurrently with updates made in the Batch Tracking Log, the 

inventory record can also be updated by authorized users directly through the inventory 

record.  

To update an inventory record, select Review/Update QA Status from the 

Quality tab. On the QA Status Review screen, use the Filter Options to display the 

desired inventory batch record(s) in the Inventory Records section. To change the status, 

release date, retest date, and/or expiration date for an inventory record, follow the steps 

below: 

1.      Select the inventory record(s) you would like to change by using the left 

button on your mouse. To update the status for all locations a batch resides, 

hold down the Ctrl key and left-click each inventory record. When selecting 

multiple inventory records in this manner, the lot number, item number, and 

status must be the same. For more information on selecting inventory records, 

please refer to the Review QA Status help topic. 

2.      Click the Update Status button to open the QA Status Update screen. The 

Current Status of the selected inventory record(s) is displayed in the upper 

portion of the screen with the total quantity from all locations. 

3.      In the Updated Status section, revise the Status, to reflect one of the 

following: 

-          Quarantine: the batch is restricted from use.  If an item requires 

release (as specified on the Product page of the Item Master), the 

batch is assigned a quarantine status at the time of receipt.  A batch in 

quarantine status can be allocated, but cannot be transferred to a usage 

location, issued to a shop order, or shipped.  

-          Approved: the batch has been released for commercial use without 

restriction. 

-          Conditional Release: the batch has been released with certain 

conditions.  

-          Blocked: the batch is blocked from further use pending 

investigation.  A batch in blocked status cannot be allocated, 

transferred to a usage location, issued to a shop order, or shipped. 



Catalyst Manufacturing User Manual

 

173 

-          Reject: the batch has been rejected and is pending destruction.  A 

batch in rejected status cannot be allocated, transferred to a usage 

location, issued to a shop order, or shipped. 

4.      The Release Date is updated for Approved and Conditional Release 

updates.  The Retest Date and Exp. Date can also be updated from this screen 

if required. The Test Date and Mfg. Date values can be used as a reference to 

calculate the retest date and expiration date for the item, but changes to these 

fields are not saved.  Any changes to the Test Date and Mfg. Date must be 

made directly on the Batch Tracking Log. 

5.      Click the Save button to process the changes and return to the QA Status 

Review screen. The updates made to the inventory record are reflected in the 

Inventory Records section. 

When updating multiple locations, the update Quantity must match the total 

quantity in the Current Status section. To change the Status for a partial quantity in a 

location, select only one inventory record at a time. 

Create / Maintain Batch Record Types 

The Batch Record Type Master, opened from the Quality tab, stores batch 

record types used on the Batch Tracking Log to categorize batch records. The Batch 

Record Type is assigned to a batch record using the Type field on the Batch Tracking 

Log. 

To maintain the reviewers in datasheet view, click the table image  button. In 

datasheet view, you can scroll down the list of existing records and add, delete, or edit 

without the use of command buttons. To return to form view, double-click the gray bar to 

the left of the datasheet or right-click anywhere in the datasheet and select the View 

Form option from the shortcut menu. 

Create / Maintain Reviewers 

The Reviewer Master, opened from the Quality tab, stores a list of QA 

reviewers assigned to review batch records. A reviewer is assigned to the 1st Reviewer 

and 2nd Reviewer fields on the Date Log page of the Batch Tracking Log.  When creating 

a new reviewer record, specify a User Name that is an easily recognizable abbreviation 

of the reviewer’s first and last name. The Reviewer checkbox indicates whether the 

reviewer currently serves in the reviewer role.  The Inactive field is used to indicate 

whether the reviewer is currently active.  The Reviewer checkbox must be checked and 

the Inactive checkbox must be unchecked to add a reviewer to the Batch Tracking 

Log.  Although these fields are redundant, they can be used to extend the reviewer list to 
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other areas of the application and assign the reviewer privilege to only selected users 

within the list.  

            To maintain the reviewers in datasheet view, click the table image  button. In 

datasheet view, you can scroll down the list of existing records and add, delete, or edit 

without the use of command buttons. To return to form view, double-click the gray bar to 

the left of the datasheet or right-click anywhere in the datasheet and select the View 

Form option from the shortcut menu. 

Create / Maintain Quality Events 

The Quality Event Master, opened from the Quality tab, maintains the quality 

events logged against a batch on the Batch Tracking Log.  The standard quality events 

provided by the system are batch record correction, lab investigation, nonconformance, 

unplanned deviation, planned deviation, corrective or preventive action (CAPA), 

validation, and incident.  The batch record correction event is reserved by the system and 

cannot be changed or deleted.  The other quality events can be changed or deleted if they 

have not already been added to a batch record.   

To add a new quality event, press the New button, populate the Event Name and 

Description fields, and press the Save button.  To edit a quality event, select the Event 

Name from the drop-down list, change the Description field as required, and press the 

Save button.  If the Event Name needs to be revised, the field needs to be placed in edit 

mode by selecting the field and pressing the F2 key.  As noted above, reserved events or 

events that have already been used cannot be changed or deleted. 

            To maintain the quality events in datasheet view, click the table image  button. 

In datasheet view, you can scroll down the list of existing records and add, delete, or edit 

without the use of command buttons. To return to form view, double-click the gray bar to 

the left of the datasheet or right-click the gray bar and select View Form from the 

shortcut menu. 

Create / Maintain Correction Types 

The Correction Type Master, opened from the Quality tab, stores a list of 

possible correction types assigned to a batch record correction.  A batch record correction 

is created as a quality event on the Batch Tracking Log.  The Correction Type is 

assigned to the batch record correction to categorize the type of correction required.  The 

corrections can be reviewed by type using the Batch Correction Summary Report 

located in the Reports menu on the Quality tab. 

            To maintain the correction types in datasheet view, click the table image 

 button. In datasheet view, you can scroll down the list of existing records and add, 

delete, or edit without the use of command buttons. To return to form view, double-click 



Catalyst Manufacturing User Manual

 

175 

the gray bar to the left of the datasheet or right-click anywhere in the datasheet and select 

the View Form option from the shortcut menu. 
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Purchasing 

  

The Purchasing tab contains options to enter and maintain purchase orders throughout the 

purchase order process cycle. The tab options are listed below. 

Purchase Order Entry 

Email Purchase Orders 

 

Purchase Order Receipts 

P.O. Receipt Edit 

 

Vendor Invoice Entry 

Vendor Invoice Edit 

 

Shipping Document Entry 

Ship Confirmation 

 

Vendor Master 

Contact Management 

 

Vendor Type Master 

Purchase Price Quantity Breaks 
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Create / Maintain Purchase Orders 

  

The Purchase Order Entry screen is used to create and maintain vendor 

purchase orders. To open the screen, select Purchase Order Entry from the Purchasing 

tab.  The Purchase Order Entry screen is also opened when creating a new purchase order 

from the Material Planning and Purchase Order Consolidation screens. On the Purchase 

Order Entry screen, open an existing purchase order by selecting it from the P.O. 

Number drop-down list or click the adjacent search  button to perform a more 

advanced search. The search screen is required to open complete, closed, cancelled, or 

quote orders. On the search screen, enter filter values to locate the desired order and press 

the Select button to display the selected order on the Purchase Order Entry screen.  

  

The Purchase Order Entry screen consists of a purchase order header, order 

details, and order footer sections. When entering a new purchase order, proceed through 

each of these sections from the top of the screen to the bottom. In addition, more detailed 

instructions are provided for the following topics: 

 

• Create Purchase Order 

• Copy Purchase Order 

• Request for Quotation 

• Blanket Purchase Orders 

• Non-Inventory Items 

• Outside Process Contracting 

• Allocate Receipt Quantity 

• Setup Drop Shipments 

• Maintain Revision Notes 

• Attach Documents 

  

Purchase Order Header 

To open an existing purchase order, enter the purchase order number directly into 

the P.O. Number field or select it from the drop-down list. To perform an advanced 

search for a purchase order, click the  button located adjacent to the P.O. Number 

field. In addition to other search criteria, the Advanced Purchase Order Search screen 

allows searching for complete, closed, or cancelled purchase orders not found in the 

drop-down list. The search results are displayed in the lower screen and can be loaded 

into the Purchase Order Entry screen by selecting a list record and clicking the Select 

button or double-clicking the P.O. No. field on the desired record. 

  

The Status, Vendor, Order Date, and Due Date are all required fields. The 

Receipt Date is updated when a purchase order receipt is posted against the purchase 

order. The purchase order status is automatically updated to ‘Complete’ when all 

purchase order lines have been received and updated to a ‘Complete’ status. When 

selecting a vendor from the drop-down list, the buyer, ship via, freight terms, FOB point, 

payment terms, ship-to location, and currency code from the Vendor Master are loaded as 

defaults onto the purchase order. If a default ship-to location is not specified for the 
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vendor, the ship-to location is populated from the default Ship-To Location selected on 

the Shipping page of the Company Master. The edit button  located adjacent to the 

vendor field opens the Vendor Master so that changes and/or additions can be made 

during the purchase order entry process 

   

Purchase Order Details 

The purchase order line items are entered into the detail section by selecting an 

Item No. from the drop-down list. If the vendor cross-reference table has been populated 

in the Item Master, the Filter toggle switch below the order lines is automatically toggled 

on to include only those items that have been assigned to the selected vendor. If DEA 

registration is required for an item, the DEA registration number and license expiration 

date for the vendor are verified before adding the line item. After selecting an item, the 

following fields are populated on the order line: 

  

•       Item Description: defaults from the short description field in the Item Master. 

The description can be modified on the purchase order line if necessary 

•       Unit Price: based on the Default Purchase Price field in the Item Master. 

•       U/M: defaults from the purchase unit of measure field in the Item Master 

•       Receipt Warehouse: defaults from the default warehouse field in the Item 

Master 

•       Receipt Location: defaults from the default location field in the Item Master 

  

To perform an advanced search for a purchased or outside process item, select the 

Search button located below the order lines. On the Purchase Order Item Search 

screen, search for an item by description, vendor, vendor part number, or product code 

and add it to the order by selecting the desired item and clicking the Select button. An 

item can also be added to the order by double-clicking the desired Item No. from the 

filtered list.  

  

To copy an existing order line, select the order line to copy and press the Copy 

button located below the order lines. Note: The Copy button below the order lines copies 

order lines and the Copy button at the bottom of the screen copies the entire order. 

  

To view several other order-entry functions, right-click on the order line to open 

the shortcut menu and select from one of the following available options: 

•        Edit Item 

o       To view or edit the Item Master for the selected item, select the Edit 

Item option from the shortcut menu. If user-level security is enabled, 

the ability to open or edit the Item Master may be limited depending 

on the user’s permission level. 

•        Search Item 

o       To search for purchased or outside process items, select the Search 

Item option from the shortcut menu. The search screen contains fields 

to search for items based on description, vendor, vendor part number, 

or product code. To add a search item to the current purchase order, 
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select the desired record and click the Select button or double-click the 

desired Item No. from the filtered list. 

•        Open drawing file 

o       If applicable, opens the drawing or specification file for the item. 

  

If the Filter toggle button is on, the vendor part number, manufacturer, and 

manufacturer part number are added to the PO line. The Manufacturer can be changed 

on the PO line by selecting an approved manufacturer from the drop-down list. The Unit 

Price is stated in terms of the purchase unit of measure and vendor currency. If the 

purchase unit of measure differs from the stock unit of measure, the default unit price is 

converted to the stock unit of measure. When the P.O. Receipt is entered, the purchase 

order receipt quantity will be converted to a stock quantity using the appropriate 

conversion value. Similarly, the default unit price is converted to the vendor currency 

when required. 

  

If the purchase order line is a dimensional inventory item, the Dimension field is 

required. If the purchase order line is a revision controlled item, the Revision No. field is 

required. 

  

The receipt warehouse and location fields allow the item to be received directly to 

the point of use for just-in-time operations. The total receipt quantity against the line item 

and last receipt date are maintained for each PO line. The completion status is 

automatically updated when the percentage of the order quantity received meets the 

completion percentage for the item (as defined on the Supply page of the Item Master). 

The Complete status can also be updated manually to indicate no additional receipts will 

be entered against the PO line. To filter the complete order lines from view, select the 

Hide Complete toggle button. To view all order lines again, select the Show All toggle 

button. 

   

Purchase Order Footer 

The purchase order footer section contains the Expedite P.O.?, Buyer, Ship Via, 

Freight Terms, FOB Point, Payment Terms, and Ship-To Location fields. The 

Expedite P.O.? field is used to provide email notification when the goods are received to 

those on the Event Notification distribution list. 

  

The order summary and tax fields are located in the rightmost columns and 

include the Order Subtotal, Freight Charge, Sales Tax Rate, Sales Tax Amount, 

VAT Rate, VAT Amount, Order Total, and currency code. The Sales Tax Rate and 

VAT Rate are based on the tax codes maintained in the Tax Code Master. The Sales Tax 

Rate applies to the state, local or provincial sales tax as applicable. The VAT Rate applies 

to either the Goods and Services Tax for Canadian-based companies or the Value Added 

Tax for companies doing business in the European Union. The Sales Tax Amount is 

based on the sales tax rate and the line totals from the taxable line items. The VAT Rate 

is applied to the order subtotal and freight charge amounts. 
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The currency code defaults from the Vendor Master and serves as the currency 

basis for the purchase order. The prices and line totals are expressed in terms of the 

currency referenced on the order. If the currency code is changed on the order, the user is 

prompted to convert the unit prices in the order detail section. The currency conversion 

values are determined from the exchange rates maintained in the Currency Master.   

  

The purchase order can be emailed directly to a vendor contact by clicking the 

Email PO button. The Email Purchase Order screen opens with the vendor contacts and 

email addresses for the current purchase order vendor. To email a copy of the P.O., select 

a vendor from the list, verify the email address, and click the send email button on the 

dialog box. 

     

Create Purchase Order 

To enter a new purchase order, click the New button at the bottom of the screen 

and begin entering data from the header section down to the footer section. The screen 

reverts to add mode and cannot be used to edit other purchase orders until the order is 

saved. The required fields to save a purchase order are the vendor, order due date, and 

ship-to location. Purchase order notes can be entered by clicking the P.O. Notes button at 

the bottom of the screen. To add notes and comments to purchase order lines, click the 

P.O. Line Notes button. The notes appear on the Purchase Order report which can be 

displayed by either selecting the Print button or Purchase Order Report under Reports 

on the Purchasing tab. 

   

Copy Purchase Order 

To copy a purchase order, select an existing order and press the Copy button. On 

the Copy Purchase Order screen, enter a Due Date for the new order and press the OK 

button. 

   

Request for Quotation 

A Request for Quotation can be generated for a vendor by creating a new 

purchase order with a ‘Quote’ status and selecting the Print button. To request pricing 

for different quantity levels, add multiple PO lines for the item. For quote requests, the 

Due Date field specifies when the RFQ should be returned by the vendor. When the RFQ 

is returned from the vendor, the quote order may be converted to an actual order by 

changing the Status to ‘Open’ and assigning the applicable purchase price to the order 

lines.  

   

Blanket Purchase Orders 

A blanket purchase order represents a long-term commitment to a supplier for 

material against which short-term releases are made to satisfy demand requirements. 

Usually the blanket purchase order is for a single item with pre-set delivery dates. To 

create a blanket purchase order in Catalyst, create a new purchase order as described 

above, and add an order line for each pre-determined delivery or release date. Enter the 

release quantity in the Order Quantity field and the release date in the Due Date field. 

The Due Date for the purchase order should be the release date for the last order line. 
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Non-inventory Items 

A non-inventory item as designated in the Item Master can be ordered in the same 

manner as inventory items by selecting an item from the drop-down list. Examples of 

non-inventory items include packaging tape, labels, and office and cleaning supplies. 

Another category of non-inventory items may be the MRO (Maintenance, Repair, and 

Operating) items like machine part replacements and supplies that are not maintained in 

the company’s inventory system. 

  

For these item types, a generic item number can be created in the Item Master to 

represent the non-inventory category. The Description field on the purchase order line 

can then be edited for non-inventory line items to provide a more accurate product 

description and/or vendor part number if applicable. A purchase order receipt is entered 

for non-inventory items in the same manner as inventory items; the only difference is that 

an inventory transaction is not created and the on-hand balance is not updated in the Item 

Master. 

  

A purchase order can be created for services in the same manner as non-inventory 

items. An example of a service item may be legal services, artwork, lawn maintenance, 

janitorial services, or any other contractual arrangement with an outside party that does 

not affect inventory. Another category of services relates to the outside processing of 

inventory items.  

  

Outside Process Contracting 

An outside process item refers to an inventory item that receives some value-

added operation at another company. The outside operation serves as an extension of 

your internal operations. In many instances, the outside operation requires materials or 

sub-assemblies to be transferred to the vendor for the work to be performed. A shop order 

attached to the purchase order can be used to track the materials sent to the vendor and 

receive the converted item into inventory. The linked shop order can also be used for 

capacity planning in the outside process work center if desired. 

  

To create a shop order attached to a purchase order, the item needs to be defined 

as an Outside Process product type in the Item Master. A shop order can be linked to a 

purchase order line item either by double-clicking the Outside Process S.O. field or by 

selecting a shop order that has already been created from the drop-down list.  

  

To track the material sent to the outside process operation, the material can either 

be transferred to the vendor and then issued to the shop order or issued to the linked shop 

order at the time it is sent to the vendor. If the material is transferred, then an outside 

process location needs to be established for the vendor. When the vendor completes the 

operation and returns the converted materials, a purchase order receipt is entered which 

automatically updates the shop order quantity received. 

  

A variation of above procedure applies when the shop order materials are 

backflushed. Backflushing is the automatic issue of shop order materials at the standard 

quantity required. The backflush transactions occur at the time of shop order receipt. For 
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shop orders linked to purchase orders, the backflush occurs at the time of purchase order 

receipt. The material is backflushed from the vendor work center location so an inventory 

transfer transaction is required when the materials are sent to the vendor location. 

  

The backflush method reduces the number of inventory transactions required to 

issue materials to the shop order. The disadvantage of backflushing is that the automatic 

issue of materials does not occur until the time the shop order parent item is received into 

inventory, not the time the materials were actually issued from inventory. Backflushing 

requires that the bill-of-material quantities be accurate and that yield and scrap losses are 

low. Otherwise the backflush at standard quantity will cause the inventory records to be 

incorrect. Nonetheless, the backflush transaction is quite effective when lead times are 

short and material variances are negligible. 

  

 In addition, the transfer of material provides some level of visibility and 

accountability of inventory at the vendor location. The inventory in the vendor location 

can be summarized on inventory reports in the same manner as internal locations. An in-

transit location provides a further degree of control and accountability allowing an 

inventory comparison between the inventory sent from your location and received by the 

vendor. The following tables summarize the outside process procedures both with and 

without backflush. A few preliminary steps are required, however, before getting started. 

  

Preliminary Steps 

  

Step Action Catalyst Module 

1 Setup vendor warehouse and work center location Warehouse Master/ 

Location Master 

2 Setup vendor work center and specify vendor 

warehouse and location as default warehouse and 

location 

Work Center Master 

3 Setup outside process item as Outside Process 

product type 

Item Master 

4 Create product configuration for outside process 

item using the vendor work center in the route 

Product Configuration 

Master 

  

Outside Process without Backflush 

  

Step Action Catalyst Module 

1 Create purchase order and linked shop order for 

outside process line item 

Purchase Order Entry 

2 Transfer materials required on linked shop order 

from company location to vendor location 

Inventory Transfers 

3 Single-issue materials to shop order based on 

advance ship notice from vendor 

Material Issues 
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Step Action Catalyst Module 

4 Enter purchase order receipt when goods are 

received from vendor 

Purchase Order 

Receipts 

  

  

The materials could also be issued to the shop order instead of transferred 

replacing step 2 from above. This method would not give you visibility of 

inventory at the vendor location and would result in the highest work-in-process. 

Another variation would be to single-issue the materials when the goods are 

received from the vendor. This can be accomplished automatically using the 

backflush method as described below. 

  

Outside Process with Backflush 

  

Step Action Catalyst Module 

1 Create purchase order and linked shop order for 

outside process line item 

Purchase Order Entry 

2 Transfer materials required on linked shop order 

from company location to vendor location 

Inventory Transfers 

3 Enter purchase order receipt when goods are 

received from vendor 

Purchase Order 

Receipts 

  

             

The shop order materials would need to have the Backflush flag set for 

the issue transaction to occur automatically. The Backflush flag can be set either 

in the Product Configuration Master or the Shop Order Master. Unlike Shop 

Order Receipts, the Purchase Order Receipt screen will not display a backflush 

confirmation before the issue transactions are processed. 

 

Allocate Receipt Quantity 

            To allocate the purchase order receipt quantity to a shop order when the line item 

is received, select a shop order from the Allocation S.O. drop-down list. This assignment 

can be used in situations where the line item is being ordered to support the requirements 

on a specific shop order. 

  

Setup Drop Shipments 

In instances where a contract manufacturer produces an item that is directly 

shipped to a customer, a customer invoice can be generated from the PO receipt by 

setting up a drop shipment for the item. To setup a drop shipment, add the item to a PO 

line and select the Drop Ship button at the bottom of the screen. On the Drop Shipment 

Setup screen, select a customer from the Ship To drop-down box. Only line items that 

are ‘Saleable’ are displayed in the drop shipment list. In the Customer PO drop-down 

box, select a customer order line to link the purchase order line. Select the Save button to 

save changes and the Close button to return to the Purchase Order Entry screen. When a 



Catalyst Manufacturing User Manual

 

184 

PO receipt is entered against a line item with a linked customer order, the item is received 

into the receipt location and immediately shipped to the customer ship-to address 

specified on the customer order.  The customer invoice can then be printed, sent to the 

customer, and, if applicable, exported to QuickBooks®. For more details on the drop 

shipment process, please refer to the Drop Shipments help topic.  

 

Maintain Revision Notes 

To track the changes made to a purchase order, revision notes can be entered by 

selecting the Admin tab and adding a new record in the Revisions section. The revision 

history can be used to document changes made to the due date, price, quantity, or other 

changes on the order. The revision notes print on the purchase order and request for 

quotation reports to serve as a reference of changes agreed to with the supplier.  

  

The Comments section on the Admin tab can be used to maintain internal notes 

related to the order. Comments are intended for internal use only – they are not included 

on any purchase order reports.  

  

Attach Documents 

The file path to item specifications, drawings and other documents can be 

maintained at either order level or line item level. To link a document to the purchase 

order, click the Order Doc button at the bottom of the screen. The order document can be 

used to store the file path to a quote or signed copy of the purchase order for instance. To 

link a document to an order line, click the Line Docs button. The line documents can be 

used to store a drawing or specification file for each order line. If an order line item is 

added when the Filter button is toggled on and a document path has already been stored 

for the vendor item using either the Item Master or Vendor Master, the document will 

automatically be linked to the order line when the item is added to the purchase order.  

 

Audit Notes 

The Audit Notes page displays an audit trail of any changes or additions made to 

the purchase order header, footer, or order lines.  Information regarding the user name 

and time the purchase order was created and last modified is listed on the Admin page as 

well as whether or not the purchase order has been printed or emailed. 

 

Email Purchase Order 

  

The Email Purchase Order screen can be opened from the Purchasing tab or by 

clicking the Email P.O. button on the Purchase Order Entry screen. The Email Purchase 

Order screen allows you to send an email attachment of the purchase order to the vendor. 

The vendor contacts listed for the order are populated from the contacts entered on the 

Contacts page of the Vendor Master. To email a purchase order, refer to the steps below. 

  

1.     On the Email Purchase Order screen, select a P.O. Number from the 

drop-down list.  
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2.     Select the recipients using the Email checkbox in the Contacts list. If a 

contact email address is missing or incorrect, it can be added or edited 

directly on the screen.  

3.   Optionally, enter your name in the PO Signature field to electronically 

sign the purchase order.  Enter a message in the Email Text section to 

include text in the email body.  The email text defaults to the notes entered 

for the order. 

4.      Optionally, check the ‘Include PO line documents as attachments?’ 

checkbox to include attachments of any line documents referenced on the 

PO lines. 

5.      Click the  button to send the email message. The purchase order will 

either be sent immediately using preconfigured email settings or displayed 

in draft mode in Outlook. If you are using Outlook, you may need to 

respond to a security prompt depending on your security settings. 

  

Enter P.O. Receipts 

  

The Purchase Order Receipts screen can be opened from the Purchasing tab 

and is used to process receipt transactions for goods shipped from vendors. The purchase 

order receipt transaction updates the purchase order with the receipt date and quantity 

received for each line item. The purchase order status is also updated to either “Partial” or 

“Complete” depending on the quantity received and quantity ordered for each order line. 

The purchase order receipt increases the inventory for the received line items by the 

receipt quantity for inventory items. 

  

The Purchase Order Receipts screen includes the Order Status, Order Date, and 

Due Date fields from the purchase order for reference. The purchase order status can be 

updated directly from the Purchase Order Receipts screen. The purchase order receipt 

lines in the lower screen are the same as the purchase order lines except with additional 

fields to enter the receipt amounts. 

  

The Shipment and Vendor information is contained in the tabbed pages on the upper 

right-hand portion of the screen. The Shipment page contains fields to store the packing 

list number, the receipt date, and the carrier for the shipped goods. The Receipt 

Quantity, Defect Quantity, and No. Containers fields summarize the total non-

defective quantity received, total defect quantity, and total number of containers entered 

for the purchase order lines. The Vendor page displays the vendor name, address, and 

contact information. For more information on specific purchasing tasks, please refer to 

the topics listed below. 

  

• Enter Purchase Order Receipts 

• Purchase Unit of Measure Conversions 

• Receive Defective Units 

• Receive Quarantine Materials 

• Receive Containers 
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• Allocate Landed Cost 

• Process Drop Shipments 

  

Enter Purchase Order Receipts 

           To enter a purchase order receipt transaction, select a purchase order from the 

P.O. Number drop-down list or enter the number directly into the field. The search 

button  can also be used to select purchase orders that have already been completed. 

Receipt transactions are not permitted on closed or cancelled purchase orders. 

  

The required fields to process a P.O. receipt transaction are the Packing List No. 

and the Receipt Quantity, Warehouse, and Location for each line item received. The 

receipt warehouse and location default from the Inventory page on the Item Master. The 

Receipt Quantity is converted to the stock unit of measure, if required, and used to 

update the inventory on-hand for the line item when the receipt transaction is saved. The 

Defect Quantity updates the quantity received for the line item, but does not update 

inventory. Please refer to the Receive Defective Units section below for more 

information on this subject. The No. Containers field reflects the number of containers 

entered on the Containers page. If the containers have not been entered, the field can be 

used to store the number of cartons or shipping containers received for the line item.  

  

On the next line, the Vendor Part No. and Due Date for the line item are 

provided for reference. The Supplier Lot No. is entered based on the information 

provided on the shipment’s packing list. The Lot No. is required for lot-controlled items. 

To have the system generate a default lot number, specify a lot number default for PO 

Receipts on the Profile page of the Company Master. The Date of Mfg captures the date 

of manufacturing and is a required field if a CoA has been provided and the item requires 

release prior to use. The Warehouse and Location specify the receipt warehouse 

location for the line item. The DEA 222 # is provided for controlled-substance material. 

The Linked S.O. field indicates the shop order linked to the PO line for outside process 

items. The C of A? flag indicates whether or not a Certificate of Analysis or Certificate 

of Conformance was received for the line item. 

    

Purchase Unit of Measure Conversions 

           When the purchase unit of measure for a line item is different than the stock unit 

of measure, the receipt quantity is converted from the purchase units to the stock units 

using a conversion value from one of the following sources: 

•        Item Master 

•        Unit of Measure Master 

  

If the stock and purchase units of measure are different and a conversion value 

does not exist, the purchase order receipt transaction is aborted and the user must enter a 

conversion value in either the Item Master or Unit of Measure Master before attempting 

to save the receipt transaction again. If a conversion value is maintained in both sources, 

the conversion value stored in the Item Master has precedence over the global Unit of 

Master conversion values. 
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Receive Defective Items 

           For purchased goods received damaged or defective, the nonconforming units can 

be entered in the Defect Quantity field for the line item. The defect quantity does not 

update the inventory on-hand or Quantity Received for the line item. As such, it will not 

be considered received for accounts payable purposes. A summary of the total defects 

received for the line item is maintained in the Defect Received field. For linked shop 

orders, the defect quantity is included in the calculation of the issue quantity for 

backflush components on the shop order bill-of-material. 

   

Receive Quarantine Materials 

Materials that require inspection before being considered available for use can be 

received into a non-nettable inventory location. Inventory residing in non-nettable 

inventory locations will not be considered available for MRP planning purposes. To 

receive material into a quarantine location, select the non-nettable location from the 

Location drop-down list. A separate transaction must be entered for each receipt 

warehouse and location. 

  

After the material has been inspected or reworked and is available for use, the 

material can be transferred to a nettable inventory location using the Inventory Transfers 

screen. Inventory that is returned to the vendor can be adjusted out of inventory by 

Entering an Inventory Adjustment transaction.  

   

Receive Containers 

           To receive container records for a line item, select the line item record on the 

Items page and then click the Containers tab. The matching line item appears on the 

Containers page. The Containers page can be populated either manually or by scanning 

barcode labels on the received containers.  

  

If entering containers manually, uncheck the ‘Check?’ checkboxes above the item 

number and lot number and enter the number of containers and quantity per container. 

For multiple containers received of the same quantity, you only need to enter one line 

unless you want to capture the individual container numbers.  

  

If scanning in container barcode labels, the item number and lot number, if 

applicable, can be verified by selecting the ‘Check?’ checkboxes above those fields. The 

scanned entries are verified against the item number and lot number of the currently 

selected line item. For lot-controlled items, the lot number must be entered on the Items 

page prior to scanning in containers on the Containers page if performing a check on that 

field.  

  

The receipt quantity should always be entered in the purchase unit of measure. 

The Receiving Report includes the number of containers, container quantity, and lot 

number for each line item. 
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Receive Items from Outside Processes 

            For outside process items with linked shop orders, the purchase order receipt 

transaction also updates the quantity received on the shop order. The materials transferred 

to and consumed by the outside process operation, including backflush components, must 

be issued to the shop order using either a single-issue or mass issue transaction. Shop 

orders can be added or changed using the Linked S.O. drop-down list for each line item. 

   

Allocate Landed Cost 

            The Landed Cost field is used to enter import costs (e.g. broker fees, custom 

fees, import duties, etc.) and allocate them to the purchase order receipt lines as part of 

the receipt process. When a landed cost is entered, Catalyst updates the unit shipping cost 

for the item using a weighted average unit landed cost. The receipt transaction then 

includes the landed cost as part of the unit cost for the imported item. 

   

Process Drop Shipments 

           In instances where a contract manufacturer produces an item that is directly 

shipped to a customer, a customer invoice can be generated from the PO receipt by 

setting up a drop shipment for the item. To setup a drop shipment, select the Drop Ship 

button at the bottom of the screen. On the Drop Shipment Setup screen, select a 

customer from the Ship To drop-down box. Only line items that are ‘Saleable’ are 

displayed in the drop shipment list. In the Customer PO drop-down box, select a 

customer order line to link the purchase order line. Select the Save button to save changes 

and the Close button to return to the Purchase Order Receipts screen. When a PO receipt 

is entered against a line item with a linked customer order, the item is received into the 

receipt location and immediately shipped to the customer ship-to address specified on the 

customer order.  The customer invoice can then be printed, sent to the customer, and, if 

applicable, exported to QuickBooks®. For more details on the drop shipment process, 

please refer to the Drop Shipments help topic. 

 

Edit P.O. Receipts 

The P.O. Receipt Edit screen is used to edit or rollback previously entered 

purchase order receipt transactions. For edit transactions, a change to the receipt quantity 

updates the quantity received on the purchase order and posts a corresponding adjustment 

to inventory. A rollback transaction deletes the original receipt entirely. If the purchase 

order line includes a linked shop order, the shop order record is also updated, including 

the material issue transactions for any backflush components. If the PO line was drop 

shipped to a customer, the customer shipment record is also updated.  

If the receipt needs to be changed after it has already been exported to 

QuickBooks, the receipt should be rolled back in Catalyst with the QuickBooks company 

open to ensure the receipt is deleted in QuickBooks. The receipt can then be re-entered 

with the correct information and re-exported to QuickBooks. If for some reason the 

receipt in QuickBooks is not deleted at the time of rollback, it will need to be manually 
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deleted in QuickBooks. In general, if the receipt has already been applied to a vendor bill, 

the receipt should not be edited or deleted in Catalyst.  

Although not recommended, a non-quantity related change to a receipt can be 

accomplished by unchecking the Exported flag, making the non-quantity change to the 

receipt, and then re-checking the Exported flag. The change would then need to be 

manually replicated to the item receipt in QuickBooks. If the Exported flag is not 

rechecked after making the change in Catalyst, it could be re-exported to QuickBooks 

resulting in a duplicate receipt. 

To process an edit or rollback transaction, refer to the steps below. 

Edit Receipt Fields 

  

1.     Select a Receiver No. from the drop-down list or enter search criteria by 

pressing the adjacent search  button. 

  

2.     Click the Edit Receipt Fields option under Transaction Type. 

  

3.      Edit the receiver field(s) as required. The packing list number, receipt date, 

ship via, landed cost, number of containers, container quantity, defect 

quantity, supplier lot number, lot number, DEA 222#, and CofA fields are 

editable.  

4.   (Optional) Press the Notes button at the bottom of the screen to add receiving 

line notes for display on the Receiving Report. Press the Receiver Documents 

button to attach scanned documents, such as quality or inspection records, to 

any of the received line items. 

5.      Click the Save button after making all necessary changes. 

6.      Click the Print Receiver button to reprint the Receiving Report. 

  

Rollback Entire Receipt 

  

1. Select a Receiver No. from the drop-down list or enter search criteria by 

pressing the adjacent search  button. 

 

2. Click the Rollback Entire Receipt option under Transaction Type. 

 

3. Click the Save button to delete the transaction. 

 

Enter Vendor Invoices 

The Vendor Invoice Entry screen is used to process vendor invoices. The 

accounts payable invoice transactions can be exported to QuickBooks® as a vendor bill if 



Catalyst Manufacturing User Manual

 

190 

applicable. Vendor invoice receipts can only be entered against existing purchase orders. 

To write a check or make a payment not associated with a purchase order, enter a vendor 

bill directly into QuickBooks®. 

Enter Vendor Invoice Receipt 

To process a vendor invoice, enter the purchase order in the P.O. Number field 

or use the search button  to perform an advanced search. After selecting a purchase 

order, perform the following steps: 

1.      On the Invoice page, enter the invoice number, invoice date, due date, 

payment terms and other information from the vendor invoice. 

2.      Compare the prices and quantities on the invoice with the purchase order 

price and receipt quantities. If item receipts have already been exported to 

QuickBooks, apply them to the invoice on the Receipts tab. This converts the 

item receipt to a vendor bill when the invoice is exported to QuickBooks.  

3.      Enter the invoice quantity in purchasing units in the Invoice Qty field. The 

Invoice Price defaults with the P.O. Price for the line item.  The Invoice 

Amount field is calculated automatically after entering invoice quantity and 

invoice price information.  If the invoice price differs from the purchase order 

price, the user is presented with the following options: 

  

The options determine which price to use on the invoice.  If the invoice price 

is correct, the purchase order price can be updated to match the invoice price 

by selecting the last option.  

4.      If applicable, revise the Freight Charge, Sales Tax Rate, and Sales Tax 

Amount fields in the lower portion and click the Save button to process the 

transaction.  

  

The Discount Date and Discount Amount fields are recalculated whenever the 

Invoice Date or Payment Terms fields are updated. The Discount Date and Discount 

Amount fields can also be recalculated using the Refresh button.  The Invoice Subtotal 

is updated as entries are made for the invoice lines. The invoice total and all price and 

amount fields are stated in terms of the currency on the applicable purchase order. 
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Enter Vendor Invoice Credit 

            To enter an invoice credit from a vendor, enter the vendor invoice receipt and 

mark the Invoice Credit? field on the Invoice page. The invoice transaction will be 

processed as a negative invoice receipt when you click the Save button. 

  

Edit Vendor Invoice Receipt 

           Vendor invoice transactions can be edited in Catalyst if they have not already been 

exported to QuickBooks®. Please refer to the Vendor Invoice Edit section for details.  

Field Definitions 

P.O. Number: the purchase order number. 

Order Status: the status of the purchase order. 

Order Date: the purchase order date. 

Due Date: the purchase order due date. 

 

The upper right portion of the screen contains three tabbed pages for Invoice, Vendor, 

and Shipping information. The Invoice page includes fields for: 

Invoice No.: the invoice number stated on the vendor invoice. 

Invoice Date: the invoice date. 

Inv. Due Date: the invoice due date. 

Invoice Credit?: a flag to indicate the invoice being processed is a credit from the 

vendor. 

Payment Terms: the invoice payment terms. 

Discount Date: the date through which discount terms apply if a discount rate is included 

in the payment terms. 

Discount Amount: the discount amount calculated as the discount rate from the payment 

terms multiplied by the invoice amount. 

Waiting on Bill?:  a flag indicating that the invoice receipt was entered from the packing 

list and should not be processed for payment until the vendor invoice is received.  

 

The Vendor page contains address and vendor information.  The Shipping page contains 
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information on the ship-to location and shipping information for the purchase order. 

Below these tabbed pages, a detail section contains the purchase order line items with 

fields to enter the line items of the vendor invoice. The fields in the detail section: 

Line No.: the purchase order line number. 

Item No.: the purchase order line item. 

Description: the description of the line item. 

Quantity Invoiced: the quantity previously invoiced against the line item. 

Invoice Qty: the invoice quantity for the line item from the current invoice. 

U/M: the quantity and price unit of measure. 

Invoice Price: the invoice unit price for the line item. 

Invoice Amount: the invoice amount for the line item based on the invoice unit price and 

invoice quantity. 

Curr.: the invoice currency. 

Vendor Part No.: the vendor part number for the line item. 

Dimension: the dimension description if the line item is dimensional. 

P.O. Quantity: the purchase order quantity for the line item. 

Qty Received: the total quantity received against the line item. 

Defect Received: the total defect quantity received against the line item. 

P.O. Price: the purchase order price for the line item. 

Inventory Account: the general ledger inventory account for the item as defined by the 

item’s product classification. 

 

The lower section of the Vendor Invoice Entry screen includes the following fields: 

Invoice Subtotal: the total of the invoice amounts from the detail section. 

Freight Charge: freight charge from the vendor invoice. 

Sales Tax Rate: the sales tax rate for the purchased items. 
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Sales Tax Amount: the sales tax amount is calculated by multiplying the sales tax rate 

by the taxable portion of the invoice subtotal. 

VAT Rate: the Goods and Services Tax (Canada) or Value-Added Tax (European 

Union) rate for the purchased items. 

VAT Amount: the value-added tax amount is calculated by multiplying the invoice 

subtotal and freight charge by the VAT Rate. The VAT Amount can be edited to adjust 

for non-taxable purchase order line items. 

Invoice Total: the total invoice amount including the invoice amounts for all invoice line 

items, freight, sales tax, and value-added tax amounts. 

Edit Vendor Invoices 

The Vendor Invoice Edit screen is used to edit previously entered vendor 

invoices. To edit a vendor invoice already exported to QuickBooks®, use the  search 

button to locate and open the invoice. If any changes are saved to a previously exported 

invoice, the changes will need to be either replicated or re-exported to QuickBooks®. To 

re-export, uncheck the Exported flag on the Invoice page and manually delete the 

previously exported vendor bill from QuickBooks®.  

The Vendor Invoice Edit screen allows two types of edit transactions – direct 

edits to correct a data-entry error or a rollback of the entire transaction. When an edit 

transaction is saved, the modified invoice fields are updated accordingly. A rollback 

transaction deletes the vendor invoice from Catalyst. After performing a rollback, the 

vendor invoice must be re-entered using the Vendor Invoice Entry screen to place a 

record of the invoice back into the system.  

Edit Transaction 

  

1.     Select a vendor invoice from the Bill No. field. 

  

2.     Click the Edit Transaction option under Transaction Type. 

  

3.     Edit the field(s) that need to be corrected.  

  

4.     Click the Save button after making all required changes. 

  

Rollback Entire Transaction 

  

1.     Select a vendor invoice from the Bill No. field. 

  

2.     Click the Rollback Entire Transaction option under Transaction Type. 
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3.     Click the Save button to delete the transaction. 

 

Field Definitions 

Bill No.: the vendor invoice number 

P.O. Number: the purchase order number 

Vendor: the vendor name 

Order Status: the status of the purchase order 

  

The upper right portion of the form contains three tabbed pages for Invoice, Shipping, 

and Receipts information. The Invoice page includes fields for: 

Invoice No.: the invoice number stated on the vendor invoice 

Invoice Date: the invoice date 

Inv. Due Date: the invoice due date 

Invoice Credit?: a flag to indicate the invoice being processed is a credit from the 

vendor. 

Payment Terms: the invoice payment terms. 

Discount Date: the date through which discount terms apply if a discount rate is included 

in the payment terms. 

Discount Amount: the discount amount calculated as the discount rate from the payment 

terms multiplied by the invoice amount. 

Waiting on Bill?:  a flag indicating that the invoice receipt was entered from the packing 

list and should not be processed for payment until the vendor invoice is received. 

  

The Shipping page contains information on the ship-to location and shipping information 

for the purchase order.   

The Receipts page lists the PO receipts applied to the vendor invoice. 
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Below these tabbed pages, a detail section contains the purchase order line items with 

fields to enter the line items of the vendor invoice. The fields in the detail section: 

Line No.: the purchase order line number 

Item No.: the purchase order line item 

Description: the description of the line item 

Invoice Quantity: the invoice quantity for the line item 

U/M: the quantity and price unit of measure 

Invoice Price: the invoice unit price for the line item 

Invoice Amount: the invoice amount for the line item based on the invoice unit price and 

invoice quantity 

Curr.: the invoice currency 

Inventory Account: the general ledger inventory account for the item as defined by the 

item’s product classification 

Dimension: the dimension description if the line item is dimensional 

  

The lower section of the Vendor Invoice Edit screen includes the following fields: 

Invoice Subtotal: the total of the invoice amounts from the detail section 

Freight Charge: freight charge from the vendor invoice 

Sales Tax Rate: the sales tax rate for the purchased items 

Sales Tax Amount: the sales tax amount is calculated by multiplying the sales tax rate 

by the taxable portion of the invoice subtotal.  

VAT Rate: the Goods and Services Tax (Canada) or Value-Added Tax (European 

Union) rate for the purchased items 

VAT Amount: the value-added tax amount is calculated by multiplying the invoice 

subtotal and freight charge by the VAT Rate. The VAT Amount can be edited to adjust 

for non-taxable purchase order line items 

Invoice Total: the total invoice amount including the invoice amounts for all invoice line 

items, freight, sales tax, and value-added tax amounts 
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Create Vendor Shipping Documents 

  

 A vendor shipment can be created to return defective goods or transfer raw 

materials to vendors using the Vendor Shipping Document Entry screen. The vendor 

shipment record is used to print the packing list, bill of lading, and pick list documents 

and process the vendor shipment confirmation. To create the shipping document record 

for the vendor shipment, refer to the steps provided below. 

  

Add Shipping Record 

  

1. Open the Vendor Shipping Document Entry screen by selecting Shipping 

Document Entry from the Purchasing tab. 

2. Click the New button at the bottom of the screen. 

3. Select a vendor from the Deliver To drop-down list and enter a Packing List No., 

Freight Terms, and Ship Via information. Edit the Attention field and add 

Notes as required by selecting the Notes button at the bottom of the screen. 

Optionally, the Ship From location can be selected to specify a different ship-

from address on the packing list than the present company address. Click the Save 

button to create the shipping document.  

4. To add shipment lines, select an Item No. from the drop-down list and continue to 

enter the No. Packages, Weight, Class or Rate, and Ship Quantity for the line 

item. If the purchase order includes outside process items with a linked shop 

order, you can add all of the shop order components to the shipment by entering a 

P.O. Number and clicking the Load BOM Items button. If the item is lot or 

serial number controlled, the lot number and/or serial number range will need to 

be entered for the line item. The Description, No. Packages, Weight, and Class 

are based on the default values maintained for the item in the Item Master.  

5. To include the total number of pallets and shipment weight on the Bill of Lading, 

click the  button adjacent to the No. Pallets field.  This button will calculate 

the total number of pallets and gross weight of the shipment based on the pallet 

quantity, pallet load weight and pallet weight of each item on the shipment.  Note, 

the standard pallet quantities and weights for each item are maintained on the 

Shipping page of the Item Master. 

6. To print the packing list, bill of lading and pick list, click the Print button at the 

bottom of the screen. The shipment confirmation can be entered directly from the 

current screen by clicking the Enter Shipment button. 
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Edit Shipping Record 

  

1.      To edit an existing shipping document prior to shipment, open the Vendor 

Shipping Document Entry screen by selecting Shipping Document Entry from 

the Purchasing tab. 

2.      Select an existing Shipper No. from the drop-down list. To view shipping 

documents for shipments already entered, click the search button  located 

adjacent to the field. 

3.      Modify the header and shipment line fields as required. The packing list, bill of 

lading, and pick list reports can be reprinted by clicking the Print button at the 

bottom of the screen.  

 

Enter Vendor Shipment Confirmation 

  

The Vendor Shipment Confirmation screen can be opened from the Purchasing 

tab and is used to return defective goods or transfer raw materials to vendors. The vendor 

shipment confirmation transaction is based on the vendor shipping document record 

created to print the packing list and bill of lading reports. Depending on the selected 

Shipment Type, the shipment transaction will either remove defective goods from 

inventory or transfer the shipped line items to a specified vendor location.  

 

            To confirm a vendor shipment, select the Shipper No. from the drop-down list. 

Alternatively, you can enter search criteria to perform a lookup of shipping documents by 

clicking the adjacent search  button. After selecting a shipping document, the document 

information is loaded into the Vendor Shipment Confirmation screen. The shipment 

information can be revised prior to shipment; however, it may be necessary to reprint the 

shipping documents to reflect the changes made. Click the Save button to process the 

shipment transaction. 

 

            When the shipment transaction is saved, the inventory for the shipped line items is 

either deducted or transferred from the warehouse location indicated in the From 

Warehouse and From Location fields. When returning defective goods, an inventory 

adjustment transaction is entered using the specified reason code. For a shipment of raw 

materials to an outside processor, the inventory is transferred from the shipping 

warehouse location to the specified vendor location. A Purchase Order Receipt is entered 

when the processed goods are returned. The raw materials in the vendor location are 

consumed by either a backflush transaction at the time of P.O. receipt or a single-issue 

transaction based on notification from the vendor. A more detailed description of outside 

processing activities is provided in the Purchase Order Entry section. 
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Email Vendor Advance Ship Notice 

  

 The Email Vendor Advance Ship Notice screen can be opened by clicking the 

Email ASN button on the Vendor Shipment Confirmation screen. The Email Vendor 

Advance Ship Notice screen allows you to send an email notifying the vendor of a 

shipment. The list of vendor contacts is populated from the contacts maintained in the 

Vendor Master. To email an advance ship notice to a vendor, refer to the steps below.  

  

1.     On the Email Vendor Advance Ship Notice screen, select a Shipper No. 

from the drop-down list. 

2.     Select the recipients using the Email checkbox in the Contacts list. If a 

contact email address is missing or incorrect, it can be added or edited 

directly on the screen.  

3.     Click the  button to send the email message. The shipment notice will 

either be sent immediately using preconfigured email settings or displayed 

in draft mode in Outlook. If you are using Outlook, you may need to 

respond to a security prompt depending on your security settings.  

  

Create / Maintain Vendors 

  

The Vendor Master consists of tabbed pages for Address, Contacts, Items, 

Orders, Shipping, Invoice, and Profile information. A vendor can be displayed by 

selecting a record from the Vendor No. drop-down list, browsing the list using the 

navigation buttons on the bottom of the screen, or by using defined search criteria to filter 

from a list. To search for a vendor, click on the search  button adjacent to the Vendor 

No. field. On the Advanced Vendor Search screen, you can enter filter criteria for the 

vendor name, remit city, remit state, buyer, vendor type, or vendor status. The search 

screen can be used to open inactive vendors that no longer appear in the active Vendor 

No. drop-down list.  

  

Add New Vendor 

A new vendor can be added by clicking the New button at the bottom of the 

screen and entering the required information into each section. The vendor number, 

vendor name, and payment terms are required fields. The vendor number defaults to an 

auto-increment number, but can be changed to any other unique vendor number. 

  

Copy Vendor 

To create a new vendor based on an existing record, open the vendor in the 

Vendor Master and select the Copy button. In the Copy Vendor dialog box, enter the 

New Vendor name and click the OK button. It will be necessary to enter new contacts 

and items for the new vendor record and modify other fields as required to reflect 

differences. 
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Address 

The Address page shown below contains fields for entering the remit and physical 

street address for a vendor. The Use Remit Address? flag can be used to copy the remit 

address fields to the street address fields. The buttons beside the Web Address and 

Email Address fields are used to open the default internet browser or email client with 

the contents in the respective fields. 

   

Contacts 

The Contacts page is used to enter vendor contact information. Each contact 

record includes fields for first name, last name, title, phone number, extension, fax, email, 

mobile, location, address, city, state, zip code, and comments. Contact events can be 

created and maintained using Vendor Contact Management, opened by double-clicking 

on a contact’s first name. 

  

Items 

The Items page contains an Item Cross Reference section for items purchased 

from the vendor. The Item Cross Reference section allows the entry of a vendor-specific 

part number, default price, NDC number, audit rating, and primary manufacturer for the 

vendor item. The default price is stated in terms of the purchase unit of measure and 

vendor currency. The Item Cross Reference section includes three buttons with the 

following actions: 

• Print: opens the Items By Vendor Report for the currently selected vendor. 

• Documents: opens a window to assign a document, such as an item 

specification or routing, to the vendor item. The vendor document is assigned 

to a PO line when the vendor item is added to the purchase order. 

• Purchase: creates a purchase order for the currently selected vendor item. 

This button gives the buyer a mechanism to place an immediate order for a 

specific vendor item instead of using the PO Consolidation or Purchase Order 

Entry screens. 

  

The active vendor items are displayed in the item number drop-down list on the 

Purchase Order Entry screen when the Filter button is toggled to the on position. The 

vendor items may also maintained in the Vendor Items section on the Supply page of the 

Item Master.  

   

Orders 

The Orders page contains the default Buyer, Sales Tax Code, and VAT Code 

that populate a purchase order when the vendor is selected. The Orders page also contains 

an ‘Open Orders’ list for the vendor. The open orders list can be changed to display a list 

of previous orders by clicking the ‘Order History’ button. For both lists, any of the orders 

can be opened by double-clicking the P.O. No field.  

  

The Buyer referenced on the Orders page refers to the default buyer for the 

vendor. It is separate and distinct from the Planner/Buyer code on the Item Master that is 

used for material planning purposes although conceivably the line items on a purchase 

order for a particular buyer may also have been planned by the same buyer. 
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Shipping 

The Shipping page contains fields to store the default FOB point, freight terms, 

preferred carrier, and ship-to location on a purchase order. The FOB Point field 

designates where legal liability, and typically shipping costs, transfers from the shipper to 

the receiver. The Freight Terms field indicates which party will pay shipping costs. The 

Ship Via field specifies the preferred package or common carrier to use for shipping. The 

Ship-To Location indicates the preferred ship-to location on purchase orders placed with 

the vendor. If not specified, the purchase order ship-to location defaults to the Ship-To 

Locations default specified on the Shipping page of the Company Master. 

   

Invoice 

The Invoice page contains financial and accounting fields related to vendor 

invoicing. The standard field definitions are as follows: 

  

Payment Terms: used to determine the discount amount and payment date for vendor 

invoices.  

  

Expense Account: the general ledger account to track expenses for purchased items and 

services from the vendor. The QuickBooks® Link uses the expense account assigned to 

the product class for the item so the expense account assigned to the vendor is for 

reference only. 

  

Currency Code: used as the default currency for purchase order and vendor invoice line 

items.  

  

Language: if translations are maintained for the report labels in the Translation Manager, 

the language default on the Vendor Master indicates the language to print the purchase 

order and other reports sent to the vendor. 

  

Accounting ID: When using the QuickBooks® Link, the Accounting ID displays the list 

reference for the vendor maintained in the accounting package. 

   

Profile 

The Profile page contains fields to store general information about the vendor 

such as vendor type, account number, vendor class, active status, and vendor notes. The 

Vendor Type field is used to classify the vendor according to an established supplier 

certification program or other defined category. The Account No. refers to the vendor’s 

account number for the company. The Vendor Class is provided for ranking purposes. 

The Inactive flag indicates a vendor’s status and can be used to retain vendor records, but 

exclude them from appearing on vendor drop-down lists. The DEA registration number 

and license expiration date for the vendor are verified when an item requiring DEA 

registration is entered on a purchase order. The Notes field is used to store vendor-

specific notes and comments. 
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Admin 

The Admin page displays information on the user who created and changed the 

vendor record and the date and time the change was made. The change information 

includes changes made to vendor contacts and vendor items. 

Audit Notes 

The Audit Notes page displays an audit trail of any changes or additions made to 

the vendor or vendor items on the Items page. 

 

Vendor Contact Management 

  

The Vendor Contact Management screen can be used to enter and track contact 

events for vendor contacts maintained in the Vendor Master.  To enter a new contact 

event, click the New button and select a vendor and contact from the Vendor and Last 

Name drop-down lists.  After entering the relevant information for the contact event, 

click the Save button.  To view previously entered events for a contact, select the vendor 

contact and click the View Events button. 

The fields on the Vendor Contact Management screen include: 

Vendor: the company name of the vendor contact 

Last Name: the last name of the vendor contact 

First Name: the first name of the vendor contact 

Phone: the phone number for the vendor contact 

Fax: the fax number for the vendor contact 

Email: the email address for the vendor contact 

Order No.: the purchase order number for reference purposes. 

Type: the type of contact such as meeting, phone, fax, email, or page. 

Employee: the employee making the vendor contact. 

Date: the date of the vendor contact. 

Document No.: a document reference field. 

Comments: a comment field for notes and memos. 
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Create / Maintain Vendor Types 

  

The vendor types are used to organize and group vendors for reporting and 

analysis purposes. The Vendor Type Master screen can be opened from the Purchasing 

tab or by clicking the edit  button beside the Vendor Type field on the Profile page of 

the Vendor Master. 

  

To maintain the vendor types in datasheet view, click the table image  button. 

In datasheet view, you can scroll down the list of existing records and add, delete, or edit 

without the use of command buttons. To return to form view, double-click the gray bar to 

the left of the datasheet or right-click anywhere in the datasheet and select the View 

Form option from the shortcut menu. 

 

Enter Purchase Price Quantity Breaks 

  

The Purchase Price Quantity Breaks screen is used to store purchase price 

quantity breaks for vendor items. The Purchase Price Quantity Breaks screen can be 

opened from the Purchasing tab or the Supply page of the Item Master. When adding an 

item to a purchase order line, a price quantity break is applied if ‘vary by quantity’ has 

been selected as the default purchase price option in the Item Master. When entering an 

order line quantity, the price set is identified by comparing the order line due date to the 

effective date and expiration date of the vendor item price sets. The price break is applied 

to order quantities at or above the quantity break. A zero price is returned if a price set or 

break quantity cannot be found for the vendor item. 

  

Multiple price sets consisting of price quantity break information can be 

maintained for each vendor item. The record selectors in the Price Sets frame can be 

used to navigate between different price sets. To create a new price set, click the 

 button. To delete an existing price set, click the  button. Each price set includes 

the following fields: 

  

Effective Date: the effective date of the price set 

Expiration Date: the expiration date of the price set 

Set Description: a description of the price set 

Price Quantity Breaks: the price for each quantity level. The price should be 

based on the purchase unit of measure for the item and stated in terms of the vendor’s 

currency. 
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Shipping 

The Shipping tab contains options to process customer order shipments and returns. The 

tab options are summarized below.  

Review Shipment Capability by Allocation 

Review Shipment Capability by Available Quantity 

 

Shipping Document Entry 

Shipment Export 

Ship Appointments 

Ship Confirmation 

Email Invoice/Shipment Notice 

 

Customer Shipment Edit 

Consignment Invoice Entry 

 

Customer Returns 

Credit Memo Entry 

Customer Receipts 

 

Freight Term Master 

FOB Point Master 

Ship Via Master 

 

  



Catalyst Manufacturing User Manual

 

204 

Review Shipment Capability by Allocation 

The Review Shipment Capability by Allocation screen is used to perform final 

inventory allocations and create pick lists and shipping documents for allocated orders. 

At the top of the screen, a combination of order, order line and allocation filter options 

can be used to narrow down the list of open customer order lines displayed in the Order 

Line Detail section. The order lines are then selected for allocation and shipment as 

described below. A customer order line drops from the list when the entire open order 

quantity has been added to a shipping document. 

To allocate inventory to customer orders and create pick lists and shipment 

documents, refer to the steps below. 

 

1.      Identify order lines that are ready to ship based on available inventory 

o Enter a Due Date in the Order Line Filter option to select order lines up 

to a specified due date. 

o Select the Release check box for desired order lines in the Order Line 

Detail section. Use the Select All and Unselect All buttons located below 

the list to mark and unmark the order line list items. 

o Select the Allocate Inventory button at the bottom of the screen to 

allocate inventory to selected order lines. The Allocation Location option 

can be used to allocate available inventory from a specific warehouse or 

location. The Unallocate Inventory button at the bottom of the screen can 

be used to unallocate inventory from the selected order lines. Note: The 

Customer Order Allocation screen can be used to allocate inventory on a 

single order or order line basis. 

o Change the Allocation Filter to the ‘Only fully allocated order lines’ 

option to identify the order lines that are fully allocated and ready for 

shipment. To filter the list based on a specified allocation percentage, use 

the ‘Order lines allocated less than x%’ or ‘Order lines allocated more 

than x%’ option. 

2.      Generate order pick lists based on the filtered list of order lines 

o       Filter the list of order lines using the filter options at the top of the screen. 

o       Select the Print Pick Tickets button to open order pick tickets for the 

selected released orders. Alternatively, select the Print Allocations button 

to display the released order line allocations in a more condensed format. 

3.      Create and print shipping documents for selected order lines 

o       Using the current filtered list of order lines, select the Select All button or 

manually mark the Allocate check box to select order lines for shipment. 
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o       Select the Create Ship Documents button to open the Create/Print 

Shipping Documents screen. To create shipping documents, select the 

‘Create shipping documents’ option, modify the desired Ship Date if 

required, and select the Run button. To view and print the packing lists 

and bill of lading reports for the shipping document records that have been 

created, select the appropriate Document Option. The shipping document 

records can be opened and modified in the Shipping Document Entry 

screen prior to entering the Customer Shipment Confirmation. 

 

Review Shipment Capability by Available Quantity 

            

The Review Shipment Capability by Available Quantity screen is opened from the 

Shipping tab and facilitates the review of inventory availability for customer order lines 

pending shipment. If inventory is available, the shipping document records can also be 

created from this screen.  

  

The Available list includes all order lines that meet the specified Due Date and 

Customer filter criteria. The Selected list includes all selected order lines.   The Review 

Availability button at the bottom of the screen opens the Shippable Orders Report which 

displays the inventory status of the order lines in the Available list. To select all order 

lines with available inventory, press the Select Avail button on the Review Shipment 

Capability screen.  

  

The order pick tickets and shipping documents can be created for selected order lines 

using the Print Pick Tickets and Create Ship Documents buttons at the bottom of the 

screen. Please refer to the instructions below for a  

  

1.     Select a Due Date to view customer order lines in the Available list with due 

dates prior to the specified date. Select a Customer to apply a customer filter to 

the Available list.  

  

2.     Check the shipment capability for an order by highlighting an order in the 

Available list and pressing F11. A Ship Capability screen opens as shown in the 

figure below depicting the inventory position of the order line items relative to 

the other orders in the Available list. This function can be used to determine if all 

of the line items on an order can ship based on the requirements for all of the 

other orders in the Available list. 
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3.     An order line can be selected and de-selected by double-clicking or by using the 

up and down arrow buttons. The Select Avail and Unselect All buttons beneath 

the Selected list can also be used to move order lines between the two lists. 

  

4.     The capability to ship the orders that have been selected can also be determined 

by highlighting an order in the Selected list and pressing F11. A Ship Capability 

screen opens depicting the inventory position of the order line items relative to 

the other orders in the Selected list. This function can be used to determine if all 

of the line items on an order can ship based on the requirements for all of the 

other orders that have been selected. 

  

5.     After finalizing the list of releasable customer order lines, use the Print Pick 

Tickets button to print the order pick tickets and the Create Ship Documents 

button to create and print shipping documents for the selected order lines. 

 

Create Shipping Documents 

  

           The Shipping Document Entry screen is used to create the packing list and bill of 

lading documents prior to shipment. After the shipping documents have been created, 

they are used as the basis for the Shipment Confirmation transaction. The shipment 

confirmation is also used to generate the customer invoice. To create the packing list and 

bill of lading documents, refer to the steps provided below. 

  

Add Shipping Record 

  

1. Select Shipping Document Entry from the Shipping tab. 

2. On the Shipping Document Entry screen, click the New button. 

3. Select an Sales Order from the drop-down list. To perform a lookup based on 

customer order attributes, click the search button  located adjacent to the field. 

After selecting an order, the shipping document header fields are populated using 
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the customer order information. The Packing List No. defaults to the customer 

order number and a sequence number suffix based on the number of customer 

shipments entered against the order. The Attention, Ship Via, and Notes fields 

default from the customer ship-to location. The Notes can be edited by clicking 

the Notes button at the bottom of the screen. Optionally, the Ship From location 

can be selected to specify a different ship-from address on the packing list than 

the present company address, for example, to support drop shipments directly to 

the consumer. The DEA 222 No. is available for shipping controlled-substance 

materials, if applicable. 

4. To add shipment lines, either click the Load Line Items button to add all order 

lines or enter the line items directly into the shipment line detail. The Copy button 

can be used to copy the currently selected row to a new line item. If the item is lot 

controlled, the lot number will need to be entered for each shipment line. The 

Shipping Description, No. Containers, Container Quantity, Weight, and Class 

will default to the shipping defaults maintained for the item in the Item Master. 

The Line No. will be either sequential or a reference to the customer order line 

number depending on the ‘Shipping Line No.’ preference specified on the 

Shipping page of the Company Master. The Seal No. for the shipment line can be 

entered as required for controlled substance materials. 

5. To add shipment lines for a different order on the same shipment, select a 

different order in the Sales Order field. The line items on that order can then be 

added by either clicking the Load Lines Items button or entering the line items 

directly into the shipment line detail. 

6. To include the total number of pallets and shipment weight on the Bill of Lading, 

click the  button adjacent to the No. Pallets field.  This button will calculate 

the total number of pallets and gross weight of the shipment based on the pallet 

quantity, pallet load weight and pallet weight of each item on the shipment.  Note, 

the standard pallet quantities and weights for each item are maintained on the 

Shipping page of the Item Master. 

7. To print the packing list and bill of lading, click the Print button at the bottom of 

the screen. The shipment confirmation can be entered directly from the current 

screen by clicking the Ship Confirm button. 

  

Edit Shipping Record 

  

1. To edit an existing shipping document, select Shipping Document Entry from 

the Shipping tab. 

2. On the Shipping Document Entry screen, select a Shipper No. from the drop-

down list. To view shipping documents for shipments already entered, click the 

search button  located adjacent to the field. 
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3. Modify the header and order line fields as required. The packing list and bill of 

lading reports can be reprinted by clicking the Print button at the bottom of the 

screen.  

  

Note: Editing a shipping document after the shipment confirmation transaction has 

been entered will result in shipping documentation that does not match the customer 

invoice.  To edit a shipment transaction after the ship confirmation has been entered, 

open the Customer Shipment Edit screen. 
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Export Shipments 

The Shipment Export screen is used to populate customer shipment data in 

Catalyst to import into the UPS WorldShip® application.  UPS WorldShip® is used to 

print shipment labels, request pickups, and process the shipment through UPS Air, 

Freight, or Ground services.  After processing the shipment in UPS WorldShip, enter a 

shipment confirmation in Catalyst to deduct the inventory and create the customer 

invoice. 

Setup Instructions 

1.      In Windows File Explorer, locate the ‘Catalyst MFG Shipment Import.dat’ 

file located in the C:\Program Files\Catalyst\UPS folder and copy it to the 

C:\ProgramData\UPS\WSTD\ImpExp\FreightShipment folder. 

2.      In Catalyst, modify the carrier code descriptions in the Ship Via Master to 

match the UPS service types. When the records are imported to WorldShip, 

the service type for the shipment is based on the carrier code description in 

Catalyst. A list of the common service types are listed below. All of the 

descriptions in the ‘External Field column’ in the table below will map to the 

specified UPS service type. If a different service type is required, add it to the 

Ship Via Master in Catalyst with a carrier code description that matches the 

UPS service type. If the carrier code doesn’t match a UPS service type when 

imported to WorldShip, it will default to Freight LTL and would need to be 

changed to a different service type prior to processing the shipment. 

 

Set UPS WorldShip Preferences 

1.      In UPS WorldShip, select Tools > Shipper Editor. 

2.      On the Shipper Editor window, select the shipper that you want to modify 

under ‘Existing Shipper Numbers’ and click the Modify button. 

3.      On the Modify Shipper window, click the Freight tab and update the number 

of labels to print per handling unit and pallet as required. Verify the 

information on other tabs as needed and click the OK button. 

4.      On the Shipper Editor window, click the Close button. 
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Import Shipments to UPS WorldShip 

1.      In Catalyst, create a shipping document using the Shipping Document Entry 

screen. 

2.      Open the Shipment Export screen from the Shipping tab. 

3.      Select a Shipment Filter using either the ‘Shipper No.’ or ‘Ship Date Range’ 

options and enter the desired criteria. 

4.      Click the Append Data button to add the selected shipments to the Shipment 

Data list.  Use the Delete Data button to clear any previous shipment data 

prior to appending new data. 

5.      Click the Open UPS WorldShip button.  If necessary, modify the default 

‘UPS WorldShip’ application path in the Application Path Manager. 

6.      In UPS WorldShip, select Import-Export > Batch Import. 

7.      On the Batch import data window, select the ‘Catalyst MFG Shipment 

Import’ map and click the Next button. 

 

8.      On the Import/Export Preview dialog box, click the Next button to proceed 

with the import.  The records to be imported were populated in step 4. 
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9.      On the Import/Export Summary dialog box, click the Save button to save 

the imported records. 

 

10.   Process the imported shipment records as described in the next section. 

Process Shipments in UPS WorldShip 

1.      In UPS WorldShip, select the Home tab and click the History button. 

2.      In the left navigation pane, expand the folder of an imported shipment, select 

a shipment (signified with a pallet icon ) and press F7 or click the 

Edit/Reconcile icon in the toolbar to open in edit mode. 

 

3.      In shipment edit mode, the service type, weight, and other data can be 

modified as required, pickups scheduled, labels printed, etc. To save your 
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changes, press the Save button in the lower-right corner.  To process the 

shipment, press F10 or click the Process button in the lower-right corner. 

 

4.      To return to the list of imported shipments, click the History button under the 

Home tab and repeat steps 2-3 for all imported shipments.  
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Create Ship Appointments 

The Ship Appointment Calendar is opened from the Shipping tab and is used to 

schedule shipping and receiving activities for the available dock locations. The ship 

appointment calendar allows shipment appointments to be created, modified and 

reviewed by date for customer shipments and vendor PO receipts. The ship appointment 

calendar can be updated by selecting a date from the calendar and adding, editing, or 

deleting appointments as described below. 

Add Ship Appointment 

To add a ship appointment, select a date from the calendar and click the Add 

button. On the Add Ship Appointment screen, perform the following steps listed below: 

 

1.      From the Source options, select whether the shipment is an outgoing Customer 

shipment or incoming Vendor PO receipt. For customer shipments, select a 

shipping document from the drop-down list.  For vendor PO receipts, select a 

purchase order from the drop-down list. Use the adjacent search button to search 

using other search criteria. After making a selection, either the customer name 

and ship-to address are displayed for customer shipments or the vendor name and 

default company ship-to location for vendor receipts. 

2.      Select the Dock to be used for the outgoing or incoming shipment. The drop-

down list displays three numbered dock locations. A different dock designation 

can be entered if applicable. 

3.      The Appt. Date defaults to the currently selected calendar date, but can be 

changed prior to adding the new appointment. 
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4.      Enter an Appt. Time for the carrier to arrive for the shipment and start loading 

or unloading activities. The Finish Time will default to 30 minutes after the start 

time and can be adjusted to reflect the necessary loading or unloading time. 

5.      The # Pallets can be used as a reference to estimate the loading or unloading 

time. A default pallet quantity is calculated based on the pallet quantity specified 

on the Shipping page of the Item Master for each item on the shipment. 

  

6.      The Carrier defaults from either the customer shipping document or vendor 

purchase order, depending on the shipment source. Selecting a different carrier 

than specified on the source document will generate a prompt to update the 

source document. 

  

Edit Ship Appointment 

            To edit a ship appointment, select a date from the calendar display and either 

double-click one of the ship appointment records or select an appointment record and 

click the Edit button. On the Ship Appointment Details screen, additional details related 

to the appointment can be added such as whether confirmation has been received, 

shipment routing number, and a notes field to capture contact information or other 

comments regarding the appointment. 
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Delete Ship Appointment 

           To delete a ship appointment, select a date from the calendar display, select an 

appointment record from the ship appointment list and click the Delete button. The user 

receives a warning message if the ship appointment has already been confirmed. 

   

Enter Ship Appointment Notes 

In addition to adding notes to an individual appointment in edit view, appointment 

notes can also be added to multiple ship appointments on the same calendar day by 

double-clicking the calendar date to open the Ship Calendar Notes screen.  

 

Enter Shipment Confirmation 

The Customer Shipment Confirmation screen is used to process customer 

shipments and create the customer invoice. In addition, the goods can be transferred to a 

customer consignment location for invoicing at the time of the consignment sale. The 

shipment confirmation transaction is based on the shipping document created to print the 

packing list and bill of lading reports. In general, the shipment transaction deducts the 

inventory from either a specified shipment location or the allocation locations. In the case 

of a consignment sale, the shipment is transferred from the shipment location to the 

specified customer location.  

General Instructions 

1.      Select Ship Confirmation from the Shipping tab. The Customer Shipment 

Confirmation screen can also be opened directly from the Shipping 

Document Entry screen by selecting the Ship Confirm button. 

2.      On the Customer Shipment Confirmation screen, select the Shipper No. 

from the drop-down list. Alternatively, use the adjacent search  button to 

lookup the shipping document using various search criteria. 

3.      On the Ship Options page, select either the ‘Allocation location’ or 

‘Specified location’ option in the Ship From field. The ‘Allocation location’ 

option deducts inventory from the allocation locations and the ‘Specified 

location’ option deducts inventory from a single shipment staged goods 

location. In addition, verify the Ship To location, especially if shipping to a 

customer consignment location. The default ship-to address is based on the 

customer shipping location. 

4.      Verify the Ship Date, Ship Via, Freight Charge and ship line information. 

Note: When shipping from allocated locations, if the allocation quantity for a 

shipment line is less than the stated Ship Quantity, either the shipment 

quantity or allocation must be adjusted before the shipment can be saved.  

5.      To process a shipment to relieve inventory and create the customer invoice, 

select the Ship Goods button. To transfer the ship lines to the specified 

consignment location, select the Consign Goods button. When consigned 
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goods are consumed by the customer, the customer invoice can be created 

using the Consignment Invoice Entry screen. 

  

When the shipment transaction is processed, the inventory is deducted from the 

Ship From location(s). When using a specified Ship From location, the default 

warehouse and location are based on the values specified on the Shipping page of the 

Company Master. 

     

Enter Multiple Ship-To Destinations 

The ship-to destination can be changed at the time of shipment confirmation by 

selecting a different customer ship-to location from the drop-down list on the Ship To 

page. However, to maintain an accurate record of the shipping documentation, it is 

recommended that a separate shipping document record be created as indicated in the 

Shipping Document Entry help topic.  

  

Process Customer Return 

            To process a customer return, it is necessary to process a Return Material 

Authorization as described in the Process Customer Returns help topic. 

  

Edit Customer Shipment 

           A shipment can be edited if the customer invoice has not already been exported to 

QuickBooks®. Please refer to the Customer Shipment Edit help topic for details. 

 

Process Credit Items 

            A credit item is an item, typically a non-inventory item, added to the sales order 

with a negative price.  Credit items must be processed on the shipment to be included on 

the customer invoice.  

  

Email Invoice/Shipment Notice 

  

The Email Invoice/Shipment Notice screen can be opened from the Shipping 

tab or by clicking the Email ASN button on the Customer Shipment Confirmation screen. 

The Email Invoice/Shipment Notice screen allows you to send an email with either an 

invoice attachment or shipment notification to the customer after an order has shipped. 

The list of customer contacts is populated from the contacts maintained in the Customer 

Master. To email an invoice or shipment notification to a customer, refer to the steps 

below.  

  

1.     On the Email Invoice/Shipment Notice screen, select the desired 

Attachment option to send either a copy of the invoice or a shipment 

notification. 

2.     Select an Invoice No. from the drop-down list or browse for the invoice 

number using the adjacent search  button. 
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3.     Select the recipients using the Email checkbox in the Contacts list. If a 

contact email address is missing or incorrect, it can be added or edited 

directly on the screen.  

4.     Click the  button to send the email message. The invoice or shipment 

notice will either be sent immediately using preconfigured email settings 

or displayed in draft mode in Outlook. If you are using Outlook, you may 

need to respond to a security prompt depending on your security settings. 

 

Edit Customer Shipments 

The Customer Shipment Edit screen is used to edit previously entered customer 

shipments. To edit a customer invoice already exported to QuickBooks®, use the 

 search button to locate and open the invoice. If any changes are saved to a previously 

exported invoice, the changes will need to be either replicated or re-exported to 

QuickBooks®. To re-export the invoice, uncheck the Exported? flag on the Shipment 

page and manually delete the previously exported invoice from QuickBooks®. 

 The Customer Shipment Edit screen allows two types of edit transactions – direct 

edits to correct a data-entry error or a rollback of the entire transaction. If a shipment 

quantity is changed during an edit transaction, the inventory is updated accordingly. The 

rollback transaction deletes the original shipment and associated customer invoice. To 

edit or rollback a shipment transaction, refer to the steps listed below. 

Edit Shipment Fields 

  

1.     Select an Invoice No. from the drop-down list. 

  

2.     Click the Edit Shipment Fields option under Transaction Type. 

  

3.     Edit the shipment field(s) as required. Only fields with a white background 

can be changed. 

  

4.     Click the Save button after making all necessary changes. 

  

Rollback Entire Shipment 

  

1. Select an Invoice No. from the drop-down list. 

  

2. Click the Rollback Entire Shipment option under Transaction Type. 

  

3. Click the Save button to delete the transaction. 
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Create Consignment Invoices 

  

The Consignment Invoice Entry screen displays shipments in customer 

consignment locations with quantities that have not yet been invoiced. The Consignment 

Shipments list is sorted by ship date with details regarding the inventory and the 

customer order they shipped against. To locate a specific consignment shipment, you can 

use the customer, consignment location, and ship date filters provided at the top of the 

screen. When a customer sends notification of a consignment sale, the consignment 

shipments are converted to invoices using the following process. 

1.      Select Consignment Invoice Entry from the Shipping tab. 

2.      On the Consignment Invoice Entry screen, select the Specific customer 

option and enter the customer name. If necessary, adjust the Ship Date 

Filter to display the earliest Consignment Shipments eligible for 

invoicing. Alternatively, if the customer provides consignment sales by 

location or store, use the Specific location filter. 

3.      Select the Invoice? check box in the first Consignment Shipment record 

to populate the Invoice Quantity field with the remaining shipment 

quantity. Edit the Invoice Quantity as necessary to match the 

consignment sale quantity. Proceed in this manner until the Total Invoice 

Quantity equals the total consignment sale quantity from the customer.  

4.      To specify a different invoice date than the current date, edit the Invoice 

Date field as required. If applicable, adjust the Freight amount to include 

on the invoice. To verify all entries, select the Print Preview button. 

5.      Select the Create Invoice button to deduct the invoice quantity from the 

consignment location(s) and create the invoice. The invoice can be printed 

using either the bulk print or reprint options in the Shipping menu.  

Note: Prior to creating an invoice for consigned goods, the consigned ship quantity can 

be changed by editing the Quantity Shipped field. After the invoice has been created, 

the invoice can be edited or rolled back by selecting Customer Shipment Edit from the 

Shipping tab. 

  

Process Customer Returns 

The Return Material Authorization screen is used to process customer returns 

for goods shipped back from the customer after shipment. The RMA generated during the 

process can be used to track the status of a return, update inventory, and issue a credit 

memo if required. As with a customer shipment, the returned goods must reference a 

customer order. To begin processing a customer return, select Customer Returns from 

the Shipping tab. 
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Generate RMA Number 

To process a customer return, you will first need to generate a Return Material 

Authorization (RMA) number. To create an RMA number, click the New button at the 

bottom of the Return Material Authorization screen and follow the steps described below. 

  

1.      On the Create Return Material Authorization screen, select a previous 

customer order from the Sales Order drop-down list. Alternatively, you 

can enter search criteria to perform an advanced search of customer orders 

by clicking the adjacent search  button. An RMA No. is automatically 

generated based on the customer order number. The RMA number can be 

edited as required. To view previous customer invoices, click the preview 

button located adjacent to the Ship Date field. 

2.      To add return lines for items, select an order line item from the Item No. 

drop-down list. The line displays the Unit Price from the customer order 

and the Quantity Shipped against that line item. To create a credit memo 

based on a lower price, change the Credit Price accordingly. To create an 

authorized return quantity for the line item, enter a return quantity in the 

Auth. Return Quantity field. 

3.      After entering the return information for each line item, click the Save 

button. The new RMA record is loaded into the Return Material 

Authorization screen to receive the goods or enter a credit memo as 

described in the following sections.  

  

Process Return Material Authorization 

After the RMA number has been created, it can be selected from the RMA No. 

drop-down list on the Return Material Authorization screen. It is from this screen that the 

goods are actually received back into inventory and/or a credit memo is issued to the 

customer. The inventory receipt and invoice credit occur as separate transactions to allow 

for rework or other return processing steps to occur before a credit memo is created. This 

also permits a credit memo to be created without affecting inventory for situations where 

only the price has changed. To receive goods into inventory and create a credit memo, 

refer to the steps described below. 

  

Receive Goods 

To receive goods back into inventory from a customer return, select an RMA No. 

from the drop-down list and perform the following steps: 

  

1.      Complete the Return section at the top of the page indicating the receipt 

date, receipt warehouse and location, and shipping carrier.  

2.      Based on the customer return, enter the physical quantity of goods 

received in the Actual Return Quantity field. Depending on the lot 

control setting for an item, the return line may also require a lot number. A 

return reason code and comments can also be entered for each line item if 

required. 
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3.      After entering the return information for each line item, click the Receive 

Goods button at the bottom of the screen to add the goods back to 

inventory. The items will initially be located in the receipt warehouse and 

location specified on the Return tab. 

  

Create Credit Memo 

           To create an invoice credit for the customer return, edit the Credit Price if needed 

and click the Create Credit Memo button. The Credit Memo report can be printed by 

selecting Credit Memo Report from Shipping > Reports or opening the Credit Memo 

Entry screen. The invoice credit can also be exported, if applicable, to QuickBooks® for 

further processing. To include freight in the credit total, enter a Freight Credit amount. 

To issue a credit for a price adjustment or correction, revise the Credit Price so that the 

extended amount reflects the credit to be applied. To issue a credit for a freight charge 

only, add a return line with an authorized return quantity and enter a freight credit, but no 

actual return quantity. After processing a credit memo, the RMA record is automatically 

placed in a ‘Closed’ status. To open a closed RMA, select the search  button adjacent 

to the RMA No. field on the Return Material Authorization screen. 

 

Enter Credit Memo 

 

The Credit Memo Entry screen is used to create customer credit memos. The 

credit memo can either be applied to a previously shipped sales order or created for the 

customer without a sales order reference. After the credit memo has been created, it can 

be printed and/or emailed to the customer and exported to QuickBooks® (using the 

optional QuickBooks Link interface). To create a credit memo, refer to the steps provided 

below. 

  

Create Credit Memo 

  

1.      Select Credit Memo Entry from the Shipping tab. 

2.      On the Credit Memo Entry screen, click the New button. 

3.      To enter a credit against a sales order, select a Sales Order from the drop-down 

list or use the adjacent search  button.  To enter a credit for a customer without 

a sales order reference, select a Customer from the drop-down list.  Most of the 

remaining credit memo fields default from either the sales order or customer 

although they can be revised if necessary.  If the credit results from a customer 

return, the RMA number can be added to the credit memo.  Note, the RMA No. is 

automatically added to the credit memo if the credit is created during the RMA 

process.  

4.      The credit memo lines must be selected from sales order lines if a sales order was 

entered.  If only the customer was entered, a credit memo line can be entered for 

any saleable item. 
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5.      Click the Save button to save the credit memo.  The credit memo can be reprinted 

by clicking the Print button at the bottom of the screen. 

   

Edit Credit Memo 

  

1.       To edit an existing credit memo, select Credit Memo Entry from the Shipping 

tab. 

2.       On the Credit Memo Entry screen, select a Credit Memo No. from the drop-

down list or use the adjacent search  button.  

3.       Modify the credit memo or credit memo lines as required.  

4.       Click the Save button.  If the credit memo has already been exported, the changes 

applied to the credit memo will need to be replicated in QuickBooks if 

applicable.  The credit memo can be reprinted by clicking the Print button at the 

bottom of the screen.  

 

Enter Customer Receipts 

 

The Customer Receipts screen is used to process receipt transactions for goods 

shipped from customers. The customer receipt transaction increases inventory for line 

items received from a customer and generates a Receiving Report for the customer 

receipt. The ownership and value of the goods remains with the customer so the receipt 

value does not increase the inventory value in Catalyst. To process a customer receipt, 

select Customer Receipts on the Shipping tab, and refer to the steps listed below. 

  

1. On the Customer Receipts screen, select the New button. The Receipt Date and 

Status fields are populated automatically. The receipt status can be Open, 

Received, Inspected, or Closed to reflect the appropriate stage in the receipt 

process. 

2. In the header section, populate the Packing List No., Ship Via, Customer, and 

Ship From locations. If the customer ship from location is not in the drop down 

list, click the adjacent pencil edit button and enter the location on the Shipping 

page of the Customer Master. 

3. In the detail section, populate the received line items as follows: 

• Item No.: the item number received from the customer. 

• No. Containers: the number of packages or containers received at a 

specified quantity. 

• Container Quantity: the quantity per package or container. 

• Defect Quantity: the quantity of damaged or defective goods received 

from the customer. The defect quantity does not update the inventory on-

hand or quantity received for the line item when the receipt transaction is 

processed. 
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• U/M: the unit of measure for the quantity entered. If the unit of measure 

for the customer receipt is different than the stock unit of measure, the 

quantity will be converted to the stock unit of measure when the receipt 

transaction is processed. 

• Dimension: the item dimensions for a dimensional inventory item. 

• Lot No.: if a lot controlled item, enter the lot number. 

• Warehouse: the warehouse the goods will be received when the receipt 

transaction is processed. 

• Location: the location the goods will be received when the receipt 

transaction is processed. For goods that require inspection before being 

considered available for use, select a non-nettable receipt location. 

  

4. If applicable, enter receipt notes by selecting the Notes button at the bottom of the 

screen. 

5. To verify the entry prior to processing the receipt transaction, open the Receiving 

Report. The container and receipt quantity will appear on the report, but the 

Quantity Received field will be zero until the receipt transaction is processed. 

6. Select the Process Receipt button to enter the receipt transactions for the line 

items on the customer receipt. The customer receipt status will automatically 

update to ‘Received’. To open customer receipt records that are no longer in an 

‘Open’ status, use the search button adjacent to the Receiver No. field. 

7. To reverse the receipt transactions for a customer receipt, select the Rollback 

Receipt button. To delete the remaining receipt record, select the Delete button. 

 

Create / Maintain Freight Terms 

The Freight Term Master is found on the Shipping tab and is used to create and 

maintain standard shipping terms. The freight terms are assigned to customers in the 

Customer Master and are referenced on the customer order and invoice. The freight terms 

are also assigned to vendors in the Vendor Master and are referenced on the purchase 

order and Vendor Invoice Receipts screen. 

To maintain the freight terms in datasheet view, click the table image  button. 

In datasheet view, you can scroll down the list of existing records and add, delete, or edit 

without the use of command buttons. To return to form view, double-click the gray bar to 

the left of the datasheet or right-click anywhere in the datasheet and select the View 

Form option from the shortcut menu. 
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Create / Maintain FOB Points 

  

The FOB Point Master is found on the Shipping tab and is used to create and 

maintain standard FOB (free on board) designations. The FOB point is assigned to 

customers in the Customer Master and referenced on the shipping documents. The FOB 

Point is also assigned to vendors in the Vendor Master and referenced on the purchase 

order and Vendor Invoice Receipts screen. The FOB point designates where legal 

liability, and typically shipping costs, transfers from the shipper to the receiver. 

  

           To maintain FOB points in datasheet view, click the table image  button. In 

datasheet view, you can scroll down the list of existing records and add, delete, or edit 

without the use of command buttons. To return to form view, double-click the gray bar to 

the left of the datasheet or right-click anywhere in the datasheet and select the View 

Form option from the shortcut menu. 

 

Create / Maintain Carriers 

  

The Ship Via Master is found on the Shipping tab in the Shipping Data Setup 

section.  The Ship Via Master is used to create and maintain a list of common carriers, 

freight brokers and package delivery companies. The carrier list is used throughout the 

application to specify a ship via method for incoming and outgoing shipments. If a carrier 

code has been assigned to a customer on the Customer Master, the carrier is populated on 

the customer order when the customer is added to the order.  Similarly, if a carrier code 

has been assigned to a vendor on the Vendor Master, the carrier is populated on the 

purchase order when the vendor is added to the order.  The carrier code transfers from the 

order to shipping documents such as receivers, packing lists, and bills of lading.  The 

carrier code can also be changed on the shipping document prior to shipment to reflect 

changes due to availability or other reasons. 

  

A list of contacts can be maintained on the Ship Via Master for each carrier to 

assist with scheduling ship appointments for incoming and outgoing shipments.  If the 

SCAC (Standard Carrier Alpha Code) for the carrier is populated, the code will be 

referenced on the bill of lading.  The Account No. refers to the company’s account with 

the carrier.  A carrier can be inactivated so they do not appear in active carrier lists using 

the Inactive checkbox. 

  

           To maintain the carriers in datasheet view, click the table image  button. In 

datasheet view, you can scroll down the list of existing records and add, delete, or edit 

without the use of command buttons. To return to form view, double-click the gray bar to 

the left of the datasheet or right-click anywhere in the datasheet and select the View 

Form option from the shortcut menu. 
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Print Customer Invoices 

  

To print customer invoices, select Customer Invoice Report from the Reports 

button on the Shipping tab. Customer invoices can be printed either by ship date range or 

by entering a specific invoice number. When printing by date range, the invoices may 

also be filtered by customer name. When using QuickBooks®, the customer invoice may 

be printed using the QuickBooks invoice template after exporting the invoice. 

  

A customer invoice is created when entering a shipment confirmation on the 

Customer Shipment Confirmation screen. The invoice date defaults to the shipment date. 

To edit the invoice date, open the shipment transaction in the Customer Shipment Edit 

screen and edit the Invoice Date field.   



Catalyst Manufacturing User Manual

 

225 

Financial 

The Financial tab contains all of the accounting and finance options to maintain and 

update cost and financial data in Catalyst.  The QuickBooks® Link interface options are 

also located on the Financial tab for users with that functionality. The Financial tab 

options excluding the QuickBooks® Link are listed below. 

Perform Product Cost Rollup 

Freeze/Unfreeze Standard Costs 

Update Raw Material Standard Costs 

 

Physical Inventory Control Board 

Physical Inventory Ticket Entry 

 

Currency Master 

Tax Code Master 

Payment Terms 
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Perform Product Cost Rollup 

  

A product cost rollup can be initiated by selecting Product Cost Rollup on the 

Financial tab. The rollup calculates the material, labor, and overhead costs for all items 

with a primary product configuration and updates the unfrozen standard item costs in the 

Item Master. The product cost for a manufactured item is the sum of the material, labor, 

and overhead costs for the item’s base configuration adjusted for scrap and yield losses. 

The labor and overhead amounts for an item are derived from the work center labor and 

overhead rates for the operations on the primary route (see Product Route Cost 

Calculations). The material cost is derived from the total product costs of the components 

and raw materials in the item’s bill-of-material using either the standard or average cost 

of the item. The cost rollup calculation considers the effective start and stop dates of the 

bill-of-material components, if applicable. 

  

Although users that are not performing table updates cannot impact the rollup 

procedure, it is advisable to have other users exit the system prior to performing a product 

cost rollup. To verify other users have exited the system, select User Roster from the 

Tools tab. To perform a product cost rollup, follow the steps on the Task List of the 

Product Cost Rollup page as outlined below. 

  

1.      Freeze/unfreeze standard costs 

o       This step provides a mass update method to freeze or unfreeze the 

standard costs for items. The frozen flag can be changed for 

specific items on the Cost page of the Item Master. 

2.      Update raw material standard costs 

o       Prior to performing a cost rollup, the costs of all purchased raw 

materials can be updated using a variety of cost methods and price 

sources. 

3.      Select product configuration(s) 

o       A product rollup can be performed on all primary product 

configurations or a selected product configuration. The cost rollup 

for an individual product configuration can also be performed 

directly on the Product Configuration Master. The individual cost 

rollup can be used to obtain price quotes for newly configured 

items or to determine the effect of route and bill-of-material 

changes on the item’s standard cost.  

4.      Update standard costs with product cost rollup 

o       When selecting the hyperlink on this step, the product cost rollup 

is performed and any unfrozen standard costs are updated based on 

either the average or standard cost of materials. 

5.      Update average costs using rollup cost (optional) 

o       This optional step can be performed to populate the average cost 

for items based on the current standard costs. 

6.      View costed BOM report 
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o       The Indented Costed BOM Reports display an indented bill-of-

material with associated costs for a specific product configuration. 

  

Any changes to the product configuration for an item could have an impact on the 

standard cost for the item. Depending on a company’s standard cost policy, a product cost 

rollup will need to be performed periodically to update the standard item costs with 

product configuration changes. The standard costs are compared with actual material and 

labor costs incurred on a shop order to identify material and labor variances. These 

variances are used to determine whether corrective actions need to be taken to control 

costs or adjust pricing on future orders. 

 

Freeze / Unfreeze Standard Costs 

  

The frozen flag must be removed from an item before its standard cost can be 

updated. To make changes to the standard costs for an individual item, uncheck the 

Frozen Standard Costs? flag on the Cost page of the Item Master and then directly edit 

the standard costs for the item. However, this process can be tedious when trying to make 

bulk updates to a large group of items. To freeze or unfreeze the standard costs for all 

items, select Freeze/Unfreeze Standard Costs from the Financial tab and select the 

appropriate update option. The mass update action can be further refined using the Item 

Type filter. The update utility can be used prior to and following a product cost rollup to 

unfreeze and refreeze the standard costs for a population of items. 

 

Update Raw Material Costs 

  

The standard costs for raw materials can be updated by selecting Update Raw 

Material Standard Costs from the Financial tab. The Update Raw Material Costs 

utility performs a mass update of standard material costs using a variety of different 

update methods.  It can also apply the current standard costs to the average cost of 

purchased and outside process items. 

  

Update Standard Material Cost 

To update the standard material costs for purchased and outside process item, 

select one of the following options from the Method group: 

•         Last Price 

•         Average Price 

•         FIFO Wtd. Average 

  

And one of the following options from the Source group: 

•         Invoice Price 

•         Purchase Orders 

•         Item Master 
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The Method option group determines how the material cost will be 

calculated.  The last price option searches for the last price entered on either the vendor 

invoice or purchase order depending on the selected source.  The average option 

calculates an average price over a specified date range.  The date range extends backward 

from the current date by the number of days specified by the user. The FIFO Weighted 

Average option calculates the weighted average price of current inventory using either 

the vendor invoice price or purchase order price for the most recent receipt transactions. 

FIFO costing assumes inventory is consumed based on a first-in, first-out basis. 

  

The Source option group indicates whether the price will be based on the unit 

price from the vendor invoice, the unit price specified on the purchase order, or the 

default purchase price entered on the Supply page of the Item Master.  

  

To run the mass update, press the Update button located in the “Update standard 

material costs using:” group.  The utility only updates standard costs for items marked as 

unfrozen in the Item Master. To unfreeze standard costs, either update the frozen flag in 

the Item Master for individual items or run the bulk unfreeze operation to update all 

items.  The raw material costs should be updated prior to performing a product cost 

rollup. 

  

Update Average Cost Using Standard Cost 

To update the average cost using the current standard material and shipping costs 

for purchased and outside process item, select one of the following options: 

•         Purchased and outside process items 

•         Purchased items only 

•         Outside process items only 

  

To run the mass update, press the Update button located in the “Update average 

costs using standard cost” group.  Note: this utility overwrites the current average cost 

for the item with the sum of the standard material cost and shipping cost for the 

item.  The change is documented in the audit history of the item but will not be visible in 

the Average Cost History Report that lists updates to average cost based on item receipts. 

  

Conduct Physical Inventory 

  

The Physical Inventory Control Board manages the system process for 

conducting a physical inventory. Even if companies have replaced the periodic or annual 

inventory with a cycle count program, there are still occasions that a complete count of 

all inventory may be required. Catalyst provides the tools to enter and validate the 

transactions for a physical inventory. The process is managed using the Physical 

Inventory Control Board which can be opened by selecting Control Board in the 

Physical Inventory group on the Financial tab. 

  

When conducting a physical inventory, it is recommended that all production and 

material handling functions be discontinued in the areas the physical inventory is 
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conducted to ensure the accuracy of the count and facilitate the analysis of the results. 

The management of the count teams and distribution and control of the tickets are also 

important factors. The primary steps of the physical inventory process can be tracked on 

the Control Board as follows: 

   

1. Enter physical inventory tickets:  As the count tickets are returned to the 

Physical Inventory Control Room, data-entry operators enter the data into the 

Physical Inventory Ticket Entry screen. The saved tickets can be reviewed by 

clicking the View saved ticket entries hyperlink. 

2. Calculate quantity and cost variances: The quantity and cost variances between 

the pre- and post-physical inventory balances are calculated by clicking the 

hyperlink. After the variances have been calculated, the variance reports can be 

opened by selecting the Review physical inventory reports hyperlink. On the 

Physical Inventory Variance Reports screen, select either the Quantity 

Variance option to open the Physical Inventory Quantity Variance report or the 

Cost Variance option to open the Physical Inventory Cost Variance report. For 

the cost variance report option, select either an average cost or standard cost basis. 

The variance reports compare the pre- and post-physical inventory quantities and 

costs so that variances can be analyzed and recounts taken prior to posting the 

physical inventory results 

 

Note: The variance reports can be generated by warehouse using the Warehouse 

filter on the Control Board.  

3. Adjust on-hand to match physical inventory: After verifying the physical 

inventory results, click the hyperlink on this step to process the inventory 

adjustments necessary to change the current inventory levels to match those of the 

physical inventory. To skip adjustments for items that were not counted, select the 

Exclude items not counted option before clicking the hyperlink. The inventory 

adjustments can be limited to a single warehouse using the Warehouse filter on 

the Control Board. When the process completes, all of the physical inventory 

adjustments can be reviewed using the Transaction History screen. 

4. Purge physical inventory tickets: This step is used to delete the physical 

inventory tickets from the server and create an archive copy of the physical 

inventory records. The archived table will be saved as 

“tblPhyInv_yyyymmdd_hhmm” in the Catalyst Local database that resides in the 

Catalyst directory. The inventory ticket purge can be limited to a single 

warehouse using the Warehouse filter on the Control Board. 

5. Archive zero inventory records with zero balance: This optional step will 

archive and delete inventory transaction records for items with a zero inventory 

balance. The archiving of inventory transactions can improve system performance 

in functions that involve an on-hand balance. The inventory transactions also need 

to be archived when the stock unit of measure for an item needs to be changed. 

The archive process can be limited to a single warehouse using the Warehouse 
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field on the Physical Inventory Control Board. The archived inventory 

transactions are saved in a table named “tblInvTransactions_yyyymmdd_hhmm” 

in the Catalyst Local database that resides in the Catalyst directory.  

  

Enter Physical Inventory Tickets 

             

The Physical Inventory Ticket Entry screen can be opened from the Physical 

Inventory Control Board or by selecting Ticket Entry in the Physical Inventory group 

on the Financial tab. The Physical Inventory Ticket Entry screen is used to enter the 

physical inventory count results for an item by inventory location as count tickets are 

turned-in during the physical inventory. 

  

The count results are entered in by operator for a bundle of sequential ticket 

numbers. Typically, these bundles are assigned a control number to more easily track 

errors. To start entering count tickets from a bundle, the operator fills-in the top portion 

of the screen including the control number, beginning and ending ticket number, and 

warehouse. The operator then begins to enter the ticket information into the transaction 

section of the screen. A ticket number is required for each line item. A lot number must 

be entered for lot-controlled items. 

  

The Physical Inventory Ticket Entry screen has built-in validation checks to 

improve the reliability and accuracy of the count process. To identify missing and/or 

duplicate ticket numbers, click the Validate button at the bottom of the screen. The 

physical inventory tickets are saved locally until they are uploaded to the server using the 

Upload button. Once a set of tickets has been validated and uploaded, they can be 

reviewed and analyzed by clicking the View Saved Tickets button which opens the 

Physical Inventory Ticket Listing report. 

 

Import Inventory Data 

Instead of manually entering the information from tickets, the inventory records can be 

imported from a spreadsheet into the Physical Inventory Ticket Entry list using the 

Import button at the bottom of the screen.  The inventory data must be populated on the 

pre-formatted spreadsheet, Physical_Inventory_Sheet.xlsx, located in the Catalyst 

installation directory. 

 

Edit Previously Saved Ticket 

To correct a previously uploaded ticket, enter the ticket number and answer ‘Yes’ when 

prompted to replace the previously saved ticket number. The previously saved ticket will 

load, allowing you to make the necessary corrections and re-upload the ticket.  

Delete Previously Saved Ticket 

To delete a previously uploaded ticket, enter the ticket number and answer ‘Yes’ when 

prompted to replace the previously saved ticket number. The previously saved ticket is 

deleted from the server when it’s loaded into the Ticket Entry screen. To delete the record 

permanently, either reassign the ticket to a new number or delete the ticket by selecting 
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the record and pressing the Delete key. If the ticket is not re-uploaded, it will not be 

replaced on the server. 

 

The field definitions for the Physical Inventory Ticket Entry screen are referenced 

below. 

Operator: the current system user. 

 

Control #: the batch number for the current set of ticket numbers being entered 

 

Warehouse: the warehouse in which the physical count took place 

 

Beg. Ticket: the beginning ticket number in the range 

 

End Ticket: the ending ticket number in the range  

 

 

The count tickets are entered in the detail section which contains the following fields: 

 

Ticket No.: the numeric, serial ticket number on the count ticket. 

 

Item No.: the item number indicated on the count ticket. 

 

Description: the item description. 

 

Lot No.: the lot number for the item (if required). 

 

Quantity: the quantity indicated on the count ticket. 

 

U/M: the stock unit of measure for the item. 

 

Location: the warehouse location indicated on the count ticket. 

 

QA Status: the release or disposition status of the inventory batch record 

 

Mfg. Date: the defined manufacturing date of the batch 

 

Release Date: the release or disposition date of the inventory batch record 

 

Retest Date: the date the batch needs to be retested 

 

Exp. Date: the date the batch expires 

 

Dimension/Revision No.: the dimension code for the physical inventory item if the item 

is identified as dimensional in the Item Master or the revision number if the item is 
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identified as revision controlled in the Item Master. The item attribute setting on the 

Inventory page of the Company Master determines whether an item can be setup with 

dimensional inventory or revision control. 

 

Create / Maintain Currencies 

  

The Currency Master is found on the Financial tab and is used to create and 

maintain foreign currency codes and exchange rates. The currency conversion section is 

used to maintain exchange rate information for the currently selected currency. An 

effective date and expiration date may be specified for each exchange rate conversion. 

The conversion rates can be obtained from an online exchange rate source using the 

Currency Conversion hyperlink. 

To maintain currencies in datasheet view, click the table image  button. In 

datasheet view, the currency records are displayed in the main datasheet and the 

conversion values are displayed in a subdatasheet below each currency. To expand a 

subdatasheet and add, delete, or edit conversion values, click the plus symbol in the 

expansion column to the left of the currency code. 

If you have customers or vendors which request invoicing or payment in a foreign 

currency, you will need to assign a default currency code on the Accounts page of the 

Company Master and on the Invoice page of the Customer Master and Vendor Master. 

You will also need to enter exchange rate information prior to entering shipment 

transactions or vendor invoice receipts for any customers or vendors you deal with in a 

different currency. The method in which Catalyst handles foreign currencies for 

customers and vendors is summarized in the following sections. 

Foreign Currency Customers 

            Setup Requirements 

1.     Create foreign currency code and exchange rate in Currency Master. 

  

2.     Assign currency code to customer on Invoice page of Customer Master. 

   

Order Processing 

  

1.     When creating a new customer order, the currency code defaults from the 

Customer Master when the customer is selected. 

2.     As new line items are added, the sales prices are automatically converted 

to the currency units referenced on the order. 

3.     When the sales order and customer invoice are printed, the currency 

amounts are stated in terms of the foreign currency with a reference to the 

currency code from the order. 
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4.     The customer invoice is exported to QuickBooks® in foreign units and 

displayed on the customer invoice in QuickBooks in both foreign and 

domestic units at the then prevailing exchanging rate. The sales account is 

credited in domestic units and the foreign Accounts Receivable account is 

debited in foreign units.  

5.     When payment is received in QuickBooks®, the foreign Accounts 

Receivable account is credited in foreign units and the bank account (or 

undeposited funds account) is debited in domestic units. 

  

Foreign Currency Vendors 

            Setup Requirements 

1.     Create foreign currency code and exchange rate in Currency Master. 

  

2.     Assign currency code to vendor on Invoice page of Vendor Master. 

   

Order Processing 

  

1.      When creating a new purchase order, the currency code defaults from the 

Vendor Master when the vendor is selected. 

2.      As new line items are added, the prices are automatically converted to the 

currency units referenced on the order. 

   

3.     When the purchase order is printed, the currency amounts are stated in 

terms of the foreign currency with a reference to the currency code from 

the purchase order. 

  

4.      The vendor invoice is entered in Catalyst in foreign currency units. 

5.      The vendor invoice is exported to QuickBooks® in foreign units and 

displayed in QuickBooks on the vendor bill in both foreign and domestic 

units. The foreign Accounts Payable account is credited in foreign units 

and inventory is debited in domestic units at the then prevailing exchange 

rate. Payment is made from your bank account in domestic units and the 

foreign Accounts Payable account is debited in foreign units. 

  

Create / Maintain Tax Codes 

    

The Tax Code Master is located on the Financial tab and is used to create and 

maintain tax codes and authorities for both sales tax and value-added tax types. The Tax 

Code Master can be used to create and maintain tax codes, authorities, and rates for sales 

and value-added taxes that will be applied to customer and vendor invoices.  
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            The tax code can consist of one or more tax items. Each tax item refers to an 

associated tax authority responsible for assessing and collecting the sales and use and/or 

value-added tax for their region. To create a tax code, follow the steps below: 

  

1.      Click the New button and enter a tax code in the Name field and description 

of the tax code in the Description field. A standard sales tax format would 

combine abbreviations for the sales tax authorities. For example, a sales tax 

code for Hall County in the state of Georgia would be entered as GAHALL to 

refer to the Georgia and Hall County sales tax authorities that assess sales tax 

in the region. 

2.      Click the Save button to create the new tax code and allow adding tax 

authorities. 

3.      Select a tax authority from the Available Tax Authorities list and either click 

the up arrow button or double-click the tax authority name to add the authority 

to the Selected Tax Authorities list. 

•         If a tax authority does not appear in the Available Tax Authorities 

list, add a new record to the list by populating the Name, Description, 

Account, and Tax Rate % fields. 

•         To change the name, description or tax rate of an existing tax 

authority, edit the tax authority record directly in the Available Tax 

Authorities list. This will update all existing tax codes using the tax 

authority. 

•         To remove a tax authority from a tax code, select the tax code from 

the Name drop-down at the top of the form, select the tax authority 

from the Selected Tax Authorities list and either click the down 

arrow button or double-click the tax authority name. 

Note: When using the QuickBooks® Link, the sales tax codes and authorities should be 

maintained in QuickBooks and imported into Catalyst to reflect any changes. Any tax 

authorities that have been added to Catalyst but not created in QuickBooks will be 

deleted and overwritten when importing sales tax codes from QuickBooks. 

Create / Maintain Payment Terms 

  

The Payment Terms screen can be opened by selecting Payment Terms from 

the Financial tab. Payment terms are used to process invoices for accounts payable and 

accounts receivable. A payment term can be entered for each customer and vendor in the 

Customer and Vendor Master to serve as a default payment term for customer orders and 

purchase orders.  
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            The Payment Terms window has two option categories for Discount Terms and 

Net Terms. The Discount Terms indicate the discount rate and discount period. The 

discount percentage (Discount %) is the discount rate applied to the invoice amount for 

payment within the discount period. The discount period can be expressed as the number 

of days from the invoice date (Days), a specific day of the month (Day of Month), or the 

end of the month (EOM). The Net Terms indicate when the balance of the payment is 

due and can be stated as the number of days from the invoice date (Days), a specific day 

of the month (Day of Month), or the end of the month (EOM). 

  

            To enter a new payment term, click the New button and enter a payment terms 

description that reflects the discount and net terms. For instance, a payment term for a 1% 

discount to be applied if payment is made within 10 days and the net payment due on the 

20th day of the month would have a description of  “1% 10/Net 20th”. Next, enter the 

discount and net terms into the appropriate option group and click the Save button. 

            A payment term cannot be deleted if it is currently being used as a default for a 

customer or vendor. Changing the discount terms or net terms for a payment term affects 

all customers, vendors, and purchase orders that have been assigned the payment term. 
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System Administration 

The Tools tab provides tools and utilities to manage the database, maintain user-

level security and perform various other functions. The Database Management, External 

Data, and Security Maintenance groups contain functions that are only accessible to users 

in the Admins group. Initially, the only user with this security level is “sysadmin”, the 

default user logon. To add other users to the database and assign permissions, refer to the 

Security Maintenance section. The Tools tab also includes the functionality to manage 

paths to third-party applications, import data, and change logon passwords. 

Database Management 

There are several utilities located on the Tools tab to assist in managing the Catalyst 

Manufacturing® database files, namely: 

Relink Company Database 

Relink Local Database 

 

Backup Data 

Archive Data 

Reset Seed Values 

User Roster 

Relink Company Database 

 

To link to the back-end database or company data file, select Relink Company 

Database from the Tools tab. The Select Company Data File screen is used during 

initial setup and as needed to switch back and forth between companies. The currently 

selected company is referenced in the Current Company field.  The steps to relink to a 

new company data file are provided below. 

 

1.      On the Select Company Data File screen, select a DSN name from the drop-

down list. The Database name should populate automatically based on the 

default database selected when the DSN was created. If it does not, reopen the 32-

bit ODBC Data Source Administrator and use the ‘Configure’ button to assign the 

correct default database. 

2.      If using Windows authentication, keep the Use Trusted Connection field 

checked. If using SQL Server authentication, unselect the Use Trusted 

Connection checkbox and enter the SQL Server login name and password for the 

database.  

3.      Click the Refresh Links button to connect to the selected company database file. 



Catalyst Manufacturing User Manual

 

237 

Relink Local Database 

   

The Catalyst local database contains static reference data and resides on the local 

machine in the Catalyst directory. If the table links to the local database are broken, the 

user is prompted to relink them when the Catalyst application is opened; however, it may 

also be desirable to refresh the local database links on demand. To refresh the local 

database link properties, select Relink Local Database from the Tools tab. On the 

Relink Local Database screen, relink to the local database as follows: 

1.      Click the Browse button to locate the ‘Catalyst Local.accdb’ file located on the 

local machine. Select the file and click the Open button to close the browse 

dialog box. 

2.      Click the Refresh Links button to refresh table link properties to the local 

database file. 

Backup Data 

  

It is imperative that routine backups of your back-end database are performed in 

the event that the database becomes damaged and needs to be restored from the last 

backup copy. For most operations, it is advisable to make backups on at least a daily 

basis. The backup process referred to in this section involves only the data in your back-

end database. The front-end database does not store any data, and therefore does not need 

to be backed up unless it has been modified. It is good practice to store a master copy of 

the front-end database on your server to more easily update the client machines when 

needed. A backup of the data in the back-end database can be accomplished by the 

following steps: 

  

1.     Ensure that all users are logged off the system. To view the users currently 

logged into Catalyst Manufacturing, select User Roster from the Tools tab. 

To perform the backup process, you must have system administrator rights to 

the server and back-end database. 

2.     Open SQL Server Management Studio® and perform a backup of the Catalyst 

database by right-clicking the database and selecting Tasks > Back Up… 

from the shortcut menu. Alternatively, the backup may also be performed by 

selecting Backup Data from the Tools tab within Catalyst. When the backup 

has finished, a message appears advising you of the backup file name. The 

backup file is placed in the same directory as the front-end database on the 

client machine, typically the Catalyst folder, with a “.bak” extension. The 

database backup copy can be restored using SQL Server Management 

Studio®.  

3.     Transfer the backup copy to media and store in a safe location. 
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Archive Data 

  

The Catalyst Archive Wizard will take you through the process of creating an 

archive database in just a few easy steps. The archive process improves the performance 

of your system by removing orders and transactions that are no longer needed and storing 

them in an archive database where they can be referred to when necessary. With the 

archive database, you can print or view data in the same manner as the current database 

by simply relinking to the archive database file using the Select Company option. 

  

During the archive process, the data associated with the archive records listed in 

the table below are deleted from the current database and stored in an archive database. 

The inventory transactions are not deleted from the current database as part of the archive 

process. They must be archived using the physical inventory process. For more details, 

please refer to the Physical Inventory Control Board help topic. 

  

Archive Records 

Vendor Invoices 

Customer Orders 

Labor Transactions 

P.O. Receipts 

Purchase Orders 

Shipping Documents 

Shipments/Invoices 

Shop Calendar 

Shop Orders 

  

The Archive Wizard automatically creates an archive database as part of the 

process. However, it is recommended that you also make a backup copy of the back-end 

database before starting the archive process. If you are using a SQL Server back-end 

database, the backup copy created during the archive process must be restored to a 

database copy before it can be linked to for archival purposes.  

  

Before running the wizard, please ensure all users are logged off the system. To 

view the users currently logged into the system, select the User Roster button in the 

Database Management group on the Tools tab. To perform the archive process, you 

must have system administrator rights to the server and back-end database. To start the 

wizard, select the Archive Data button in the Database Management group on the 

Tools tab. The wizard will walk you through the archive process as follows: 

  

1.      In the first step, the current database is listed for reference and 

verification. Click the Next button to continue. 
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2.      In step 2, select the desired archive records and archive date. Use the 

‘Ctrl’ button and mouse to select multiple records in the Archive Records 

list. After the archive process completes, the current database will only 

include data for the selected records beginning with the archive date. All 

previous data will need to be accessed through the archive database. Click 

the Next button to perform the archive process. 

3.      The final step displays the backup database name created during the 

archive process. Click the Finish button to close the wizard. 

   

 

Reset Seed Values 

  

The Reset Seed Values screen can be used to set the starting number (seed) and 

increment values for reference numbers generated in the tables listed below. 

  

Table Reference No. 

tblCreditMemos Credit Memo No. 

tblLotNoSeq Lot No. 

tblPOReceipts Receiver No. 

tblPurchaseOrders Purchase Order No. 

tblShipments Invoice No. 

tblShopOrders Shop Order No. 

  

This feature enables you to coordinate the numbering scheme with sequence numbers 

currently in use. If the selected table already contains records, the reset seed utility will 

advise and prevent a seed value from being entered that is not greater than the current 

maximum reference number for the selected table. To reset the seed and increment values 

for a table, refer to the steps described below. 

  

1. Select Reset Seed Values from the Tools tab. 

  

2. Select a Table from the drop-down field.  

  

3. Change the Seed value to the number you would like the selected table to begin 

the next reference number. If the seed value is not greater than the current 

maximum reference number in the table, a warning message appears and the seed 

value is changed to reflect the lowest permissible seed value. 

  

4. Change the Increment value to a number you would like each new reference 

number to increment. For instance, if the seed value is 1000 and the increment is 

5, the next reference numbers in the selected table would be 1000, 1005, and 

1010. When using a SQL Server back-end database, the increment value must be 

changed using SQL Server Management Studio®. The reset seed utility supports 

only seed value changes for SQL Server databases. 
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5. Click the Reset button to process the request. 

 

View User Roster 

  

The User Roster displays the user name and computer address of the users 

currently logged into the back-end database. The user roster can be used to determine 

when to run utility programs in Catalyst that require users to be logged off the system. In 

general, all users need to be logged off the system when making back-ups, refreshing data 

using the Upgrade Wizard, or archiving data using the Archive Wizard. It is also 

recommended to have users that edit items or orders log off the system while running the 

finite scheduler and MRP engines. To open the user roster, select User Roster from the 

Database Management group on the Tools tab. 
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Third Party Applications 

The 3rd Party Apps group is located on the Tools tab and provide a means to manage 

application paths to programs called from within Catalyst. 

 

Application Path Manager 

  

The Application Path Manager provides a means to specify application paths 

for programs accessed by Catalyst to open drawings, label templates, spreadsheets, and 

other documents. It can be opened by selecting Application Path Manager from the 3rd 

Party Apps group on the Tools tab. The Application Path Manager stores up to three 

paths for each application, including: 

▪       Primary Path 

o      The default or most common installation path for the 

application. 

▪       Alternate Path 

o      An application path for different versions of the same software. 

▪       Local Path 

o      A unique application path stored on the local machine that 

differs from the primary and alternate paths above. 

  

The file extensions for each application should be entered with a preceding period 

separated by a semicolon. The default applications included with Catalyst are as follows: 

▪       Adobe Acrobat Reader 

o      Free PDF document reader 

▪       Autodesk Design Review 

o      Free viewer for 2D and 3D designs created in Autodesk® 

supporting .dwf, .dwfx, .dwg, and .dxf file types among others 

▪       Autodesk Inventor View 

o      Free viewer for files created in Autodesk Inventor® supporting 

.idw, .iam, and .ipt file types 

▪       Internet Explorer 

o      Internet browser supporting multiple image file types including 

.htm, .html, .bmp, .jpg, .gif, .png, and .tif among others 

▪       Microsoft Excel 

o      Spreadsheet software supporting .xlsx, .xls, .xlw, and .csv file 

types among others 

▪       Microsoft Word 

o      Document software supporting .doc, .docx and .rtf file types 

among others 

▪       WaspLabeler 

o      Barcode label design software that supports .lab and .labx file 

types 
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The default applications can be modified to include additional file extensions, but 

they cannot be deleted. To add a new application, click the New button and populate the 

application name, the desired application paths and associated file extensions. To modify 

the application paths or file extensions for an existing application, select the application 

from the drop-down list, edit the desired fields and click the Save button. 

  

To edit the records in datasheet view, click the table image  button. In 

datasheet view, you can scroll down the list of existing records and add, delete, or edit 

without the use of command buttons. To return to form view, double-click the gray bar to 

the left of the datasheet or right-click anywhere in the datasheet and select the View 

Form option from the shortcut menu.  
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External Data 

The External Data group is located on the Tools tab and provide a means to import or 

link to other databases and consists of the following options:  

Upgrade Wizard  

Linked Table Manager 

Import Data Manager 

 

Upgrade Wizard 

  

The Upgrade Wizard transfers records from one Catalyst back-end database to 

another and can be used to upgrade from a prior version of Catalyst Manufacturing®. The 

back-end database which you are importing from is referred to as the source database. 

The currently selected company data file is the target database. When upgrading to a 

new version, the target database is the empty back-end database provided with each new 

release. The Upgrade Wizard is located in the External Data group on the Tools tab. 

  

Before performing an upgrade, there are some important points to consider: 

1.      If custom modifications have been made in the old version, those changes will 

need to be replicated in the back-end database prior to running the Upgrade 

Wizard. The modifications will also need to be replicated in the front-end 

database, but can be performed after migrating the data for development and 

test purposes. 

2.      During the upgrade, the source database schema is modified to match the new 

version. If the event you need to revert back to the old version, you won’t be 

able to use the back-end database used as the source database for the upgrade. 

You must use the master copy of the back-end database to run the old version. 

You should only use a backup copy of the production database as the source 

database for the Upgrade Wizard. 

3.      After upgrading, you will be able to use the same activation code as the old 

version if you use the same registration information and the back-end database 

resides on the same server machine as the old version. You can import your 

registration information from the old version as part of the upgrade. If you 

need to change the registration information or the back-end database is located 

on a different server, submit a new product registration and request a new 

activation code from Catalyst Support. 

4.      Before performing the upgrade, all users must be logged off both the target 

and source back-end databases.  
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To upgrade to a new version of Catalyst, follow the steps outlined below. 

1.      Make a back-up copy of the old version back-end database using SQL Server 

Management Studio. 

  

2.      On a test client PC, uninstall the old version of Catalyst using the 

Add/Remove Programs option in the Windows® Control Panel. 

3.      Install the new version of Catalyst on the test client PC using the new setup 

package (refer to Installation help topic). 

•         If the old desktop shortcut was modified to include the Catalyst 

workgroup file, the new shortcut will need to be modified in the same 

manner (refer to Modify Desktop Shortcut help topic). 

4.      Prepare the source and target databases for the upgrade: 

•         Move the new version back-end database files to the same server as 

the old version.  

•         Attach the new version SQL Server database file to SQL Server. 

•         Create a DSN connection to the new version using the ODBC Data 

Administrator. 

•         Open Catalyst using the desktop shortcut on the client and relink to 

the new version back-end database using the new DSN connection. If 

not prompted to relink, select Relink Company Database on the 

Tools tab. 

5.      Run the Upgrade Wizard located on the Tools tab to import data from the 

backup copy of the old version back-end database (source database) to the 

new version (target database). When the import process completes, you will 

be able to review an Error Log Report that summarizes any import errors 

encountered. If errors were reported during the upgrade process, perform the 

changes suggested on the Error Log Report manually and rerun the Upgrade 

Wizard.  

6.      Review and test the system to verify the accuracy of the data and confirm the 

functionality of any custom modifications. After verification and testing have 

been completed, schedule an upgrade time with the users and complete the 

following steps: 

•         On a single PC, perform steps 1, 4, and 5 to refresh the back-end 

database. 

•         Repeat steps 2 and 3 to install the new version of Catalyst on the 

remaining client PCs. If the front-end database has been modified, 

copy the modified database from the Catalyst folder on the test PC to 

the Catalyst folder on the client PC. 
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Linked Table Manager 

  

The Linked Table Manager is a Microsoft Access Add-In® utility used to establish 

and maintain table links to another Microsoft Access database. The Linked Table 

Manager is available as a secondary option to link to the Catalyst back-end or local 

Microsoft Access database files. To relink the front-end database to tables in another 

database using the Linked Table Manager, perform the following steps: 

  

1. Open the Linked Table Manager from the External Data group on the Tools 

tab. 

  

 
  

  

2. Click the Select All button to select all links or check the box beside the desired 

linked reference. 

  

3. Click the OK button and browse for the location of the external database. 

  

4. Open the external database. A progress meter in the status bar lets you know that 

the linked tables are being refreshed. 

  

Import Data Manager 

  

To facilitate the population of foundation data in Catalyst, pre-formatted Microsoft 

Excel® spreadsheets have been provided to import items, unit of measures, product 

classes, product codes, customers, vendors, vendor items, warehouses, locations, carriers, 

countries, states, product configurations (routes/BOMs), and work centers. There are two 

spreadsheets provided in the Catalyst folder that can be used to populate either product 

configurations or quote configurations as follows: 
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•        CatalystImport.xls 

-         Used to import foundation data and primary product configurations. The 

spreadsheet can be opened by selecting Import Data > View 

Spreadsheet Data from the External Data group on the Tools tab. After 

populating the spreadsheet, the data can be imported using the Catalyst 

Data Import screen which is opened by selecting Import Data > Import 

Spreadsheet Data on the Tools tab. 

  

•        QuoteConfigImport.xls 

-         Used to import foundation data and quote configurations to support the 

engineer-to-order process. The Catalyst Quote Import screen can be 

opened by selecting the Import Config. button on the Quote page of the 

Customer Order Entry screen. Although other foundation data can be 

entered with this option to support dependent field values, the Catalyst 

Quote Import process is designed to import the quote configuration for 

the currently selected quote line only. 

  

When viewing the spreadsheet, the first row (blue background) of each worksheet 

contains the labels for the equivalent table columns in Catalyst. The required fields are 

indicated with bold text. Each column has data validation rules to ensure that the data 

entered into each cell is the correct data type and length. For columns that depend on data 

from another source, a drop-down box has been provided on the spreadsheet to add 

values from another worksheet range. For example, the Vendor column on the Items 

worksheet references the Vendors worksheet. The vendor names entered on the Items 

page need to either already exist in Catalyst or be included as part of the import. 

Otherwise, the item record that references the vendor will not be imported. These 

dependent relationships are indicated on the various worksheet cells with a drop-down 

combo box that lists the records in the corresponding reference range. 

After loading the required data into the spreadsheet, you can import the records 

directly into Catalyst as described below. 

  

1.      Save and close the CatalystImport.xls or QuoteConfigImport.xls spreadsheet. 

2.      Open either the Catalyst Data Import or Catalyst Quote Import screens as 

described above. 

3.      Select the data you would like to import using the radio button options. 

Specify the Import Path, if required, using the browse button. The selection 

of some data groups will automatically require that you include data from 

related sources even if you have not populated those worksheets. For instance, 

to import item data, you must also import data for product classes, product 

codes, warehouses, locations, unit of measures, and vendors. However, it’s not 

necessary to populate the spreadsheet with data if it already exists in Catalyst. 

For instance, if the location A0023 already exists in Catalyst, it can be added 

to the Items and Work Centers worksheets, but does not need to be added to 

the Locations worksheet.  
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4.      To import the data from the spreadsheet, click the Import Data button. After 

the data has been imported, you can view the imported records for each data 

group by clicking the adjacent edit button . To view an imported quote 

configuration, select the Build Config. button on the Quote page of the 

Customer Order Entry screen. 

  

Since duplicate records are not added during the import process, the spreadsheet can 

be used to load additional records at any time. 
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Security Maintenance 

  

The Security Maintenance group on the Tools tab contains options to create and 

maintain user and group accounts, setup object level security, turn on and off the shift 

bypass option, and hide or unhide the navigation pane. A reference to the help topics in 

this category is provided below. 

  

•        Setup User and Group Accounts 

o       Create New Users 

o       Create New Groups 

o       Assign Users to Groups 

o       Clear User Passwords 

  

•        Setup Object-Level Security 

•        User Maintenance 

•        Turn Shift Bypass Option On/Off 

•        Hide/Unhide Navigation Pane  

  

Important: Before making any changes to user and group accounts or reinstalling 

or upgrading Catalyst to a new version, it is advisable to make a backup copy of the 

Catalyst workgroup file (Catalyst.mdw) to restore from an earlier copy if required.  

   

Enable User-Level Security 

  

Catalyst is distributed with user-level security features disabled. To secure the 

database so that users have access to only what they need, user-level security needs to be 

enabled using the steps provided below. 

1.      Backup the Catalyst workgroup file (Catalyst.mdw) located in the Catalyst local 

directory. 

2.      Move the Catalyst workgroup file (Catalyst.mdw) from a client machine to a 

shared folder on the server with Full Control permissions for the Catalyst network 

user group. 

  

3.      Change the workgroup switch in the program shortcut on the client machine to 

reflect the new workgroup file path on the server. Refer to the Create/Modify 

Program Shortcut section for details on modifying the shortcut properties. Verify 

that the Microsoft Access® path is included in the target path of the shortcut. 

Otherwise, you will not be prompted with a logon screen when opening Catalyst. 

  

4.      Open the Catalyst Manufacturing® database as the system administrator 

(sysadmin user) and add new users and user group accounts as necessary. Assign 

user names to user group accounts to inherit the permissions of the group. Refer 
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to the creating new users help topic for more details. Important: Do not remove 

the Admins group from the sysadmin user. 

  

5.      To manage the permissions granted to a user group, restrict the access level 

granted to user group accounts using object-level security. In this step, assign the 

Users group either Read Only or Deny permissions to all database objects to 

prevent users from unintentionally inheriting permissions from this mandatory 

group. 

  

The user-level security features can be reversed as described in the Disable User-

Level Security section. 

 

Disable User-Level Security 

  

If you do not want to require users to logon to open the database or restrict access to 

the database in any way, you can disable the user-level security features by performing 

the steps below. 

  

1.     Backup the current Catalyst workgroup file (Catalyst.mdw) located on the server. 

  

2.      Open the Catalyst front-end database using the desktop shortcut and logon as the 

“sysadmin” user. 

3.      Select Object-Level Security from the Security Maintenance group on the 

Tools tab and uncheck the ‘Apply Object-Level Security?’ checkbox. Close the 

form.  

  

4.     Exit the database and remove the workgroup switch to the Catalyst workgroup file 

from the desktop shortcut on each client machine. Please refer to the Create / 

Modify Program Shortcut help topic for more details. This step will remove the 

logon prompt when opening the database. 

 

Create New Users 

  

Catalyst is distributed with only one effective user logon, the “sysadmin” user, 

which has administrative permissions over most of the database objects. The “sysadmin” 

user maintains de facto control over all objects in the database unless new users are added 

with administrative permission levels.  

  

Prior to creating new users, ensure that the Catalyst workgroup file is specified in 

the desktop shortcut and that the workgroup file has been moved to the server. For more 

details on these requirements, please refer to the Enable User-Level Security help topic. 

After confirming the workgroup file, refer to the steps below to create new user names.  
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1.      Select User and Group Accounts from the Security Maintenance group on 

the Tools tab. 

2.      Click on the New button in the User pane. Another window opens for you to 

enter the user Name and Personal ID as shown below. 

  

 
  

  

3.      Enter a new user Name and Personal ID. The Personal ID is case sensitive 

and can be up to 20 characters. The Personal ID is required and is used to 

create a permanent security ID for the user. Keep a record of the personal ID 

you enter for each user in case you ever need to recreate the user. 

  

4.      Click OK to create the new user. 

  

The new user’s password will be blank the first time they open the database. A 

password can be established after opening the database by selecting Change Logon 

Password from the Tools tab. 

  

To assign users to a group, refer to the Assign User to Groups help topic. Each 

new user is automatically added to the Users group. The Users group is mandatory i.e. a 

user cannot be removed from the Users group. As part of enabling user-level security, the 

Users group should be assigned read-only or deny access using Object-Level Security. 
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Create New User Groups 

  

A new user group can be added to the Catalyst workgroup file to represent a 

functional group or department within your organization. A user group creates an 

efficient manner to establish user permissions. When a user is assigned to a group, the 

user inherits the permissions of that group. To assign users to the new group, refer to the 

Assign User to Groups help topic. To specify permissions for the group, refer to the 

Object-Level Security help topic.  

  

Prior to creating new user groups, ensure that the Catalyst workgroup file is 

specified in the desktop shortcut and that the workgroup file has been moved to the 

server. For more details on these requirements, please refer to the Enable User-Level 

Security help topic. After confirming the workgroup file, refer to the steps described 

below to create a new group. 

  

1.      Select User and Group Accounts from the Security Maintenance group on 

the Tools tab. 

2.      On the User and Group Accounts screen, select the Groups page and click on 

the New button. Another window opens for you to enter a new group name 

and Personal ID. The personal identifier is required to create a permanent 

security identifier for the group. Keep a record of the personal ID you enter 

for each group in case you ever need to recreate the group. 

  

 
  

3.     Click OK to save the new group.  
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Assign User to Groups 

  

When users are assigned to a group, they inherit the permissions that have been 

established for that group. If a user is a member of more than one group, they inherit the 

highest access level of any group to which they have been assigned. To allow a user to 

perform system administration tasks in the database (clear passwords, add/remove users, 

etc.), assign the user to the Admins group. Refer to the steps below to add a user to a 

group. 

  

1.     Select User and Group Accounts from the Security Maintenance group on 

the Tools tab. 

  

2.     On the Users page, select a user from the user name field. In the Group 

Membership pane, a list of the available groups appears on the left and 

selected groups the user is already a member on the right. 

  

3.     Add or remove groups to the user by selecting a group from one of the lists 

and clicking the Add or Remove button. Note: A user cannot be removed 

from the Users group. 

 

 

Clear User Password 

  

A user that is a member of the Admins group can clear another user’s password so 

that it will be blank the next time the user opens the database. The administrator cannot, 

however, set the password of another user. Only the current user can change her/his own 

password after opening the database. To clear a user’s password, follow the steps below. 

  

1. Select User and Group Accounts from the Security Maintenance group on the 

Tools tab. 

  

2. Select the desired user from the Name field in the User pane of the Users page. 

  

3. Click the Clear Password button.  

  

After clearing a user’s password, it is customary to advise the user they will need to 

use a blank password they next time they open the database. If the Require Password 

flag has been checked in the Company Master, the user will then be prompted to enter a 

non-blank password before proceeding. 
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Setup Object-Level Security 

 

The Object-Level Security option allows you to setup permission levels for 

selected forms, reports, and menu options quickly and easily by specifying access levels 

for each user group. Combined with user name and group accounts, object-level security 

provides a means to limit access to program functionality and control what users can 

view and update.  

  

To open the Object-Level Security utility, select the Object-Level Security 

button in the Security Maintenance group on the Tools tab. As with standard security 

protocols, users inherit the permissions of the groups they have been assigned. If a user is 

a member of more than one group, they inherit the highest permission level of any 

assigned group. 

  

To apply object-level security by functional area or department within your 

company, it will be necessary to first define and create the relevant user groups. To 

establish user groups and assign users to groups, please refer to the Create New User 

Group and Assign User to Groups help topics. After the desired user groups have been 

established, the group permissions can be applied either By object or By group. The By 

object method involves specifying access levels for each form, report, or menu object. To 

apply permissions in this manner, refer to the steps described below. 

  

1.      On the Object-Level Security screen, select the By object page.  

2.      Select the database object type from the Object Type group.  

3.      Select the desired form, report, or menu from the Object drop-down list.  

4.      In the Group Permissions section, assign an Access Level to each group. 

Note: If new user groups have been created, click the Refresh button to add 

the new groups to the list of available groups.  

  

5.   Click the Apply button to apply the assigned access level to the specified 

object. The Apply Object-Level Security check box must be checked for the 

permissions to be applied when a form, report, or menu is opened. 

  

The By group method allows you to specify a user group and access level to 

apply to an entire set of database objects. To apply permissions in this manner, refer to 

the steps described below. 

  

1.      On the Object-Level Security screen, select the By group page.  

2.      Select the user group from the Group name drop-down list. Note: If new 

user groups have been created, click the Refresh button to add the new groups 

to the list of available groups. 
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3.      Select an access level to apply to the group from the Access level drop-down 

list.  

4.   Select the database object type to apply the permissions in the Object Type 

group. 

5.   Click the Apply button to apply the specified access level to the selected 

object type. The Apply Object-Level Security check box must be checked 

for the permissions to be applied when a form, report, or menu is opened. 

The access levels are defined in the table below. Note: To enable the Limited 

permission level, the Enabled property of a desired field or control must be changed to 

‘No’ in form design mode. Form design changes can only be made using the Full Edition 

and will require that any changes be replicated in the front-end database when upgrading 

to a new release. 

Access Level Forms Reports Menus 

Deny Cannot open form Cannot open report Cannot view menu 

Read Only Cannot add, 

change, or delete 

data, but allowed to 

select and view 

form records. 

N/A N/A 

Limited Access is granted to 

form fields and 

controls that have 

not been disabled in 

form design mode. 

N/A N/A 

Full Access is granted to 

all form fields and 

controls 

Report can be 

opened 

Menu is visible 

 

User Maintenance 

  

 The User Maintenance utility allows an administrator to clear a user’s password 

and add and remove user locks for users.  An administrator cannot reset a user’s 

password to a different password, but they can clear a user’s password to allow them to 

reset their password the next time they login to the database. The password can also be 

cleared using the User and Group Accounts menu option. 

  

To prevent a user from accessing the database, an administrator can add a user 

lock to prevent the user from logging in.  This option may be preferable in some 

instances to deleting the user account.  The steps to add and remove a user lock are as 

follows: 
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1.      Log into the database as a user with administrator rights (i.e. member of 

Admins group). 

2.      Select User Maintenance from the Security Maintenance group on the 

Tools tab.  

3.      On the User Maintenance screen, enter the user account name in the User 

Name field. 

4.      Select the Add User Lock button to add a user lock and the Remove User 

Lock button to remove the user lock for the specified user name. 

  

Turn Shift Bypass Option On / Off 

  

The shift bypass option allows users to open the Catalyst database and bypass the 

database startup options. This can be used to open the Catalyst front-end database in the 

Microsoft Access® development environment and modify database objects or perform 

system maintenance. Obviously, this is not a feature you necessarily want everyone to be 

aware of or utilize.  

  

To turn-off the shift bypass option, select Shift Bypass > Off from the Security 

Maintenance group on the Tools tab. After exiting and reopening the database, the 

startup options will execute regardless of whether the user holds down the shift key at 

entry. To turn the shift bypass option on, select Shift Bypass > On from the Security 

Maintenance group on the Tools tab. To prevent users from changing the shift bypass 

option, restrict their access to the Security Maintenance group using Object-Level 

Security. 

 

Hide / Unhide the Navigation Pane 

   

The navigation pane contains a listing of all the database objects (e.g. tables, 

queries, forms, reports, macros, and modules) located in the front-end database. Select 

Navigation Pane > UnHide in the Security Maintenance group of the Tools tab to 

show the navigation pane and Navigation Pane > Hide to close or hide the navigation 

pane. The navigation pane is not available when using the Access Runtime.  

To view a specific table using the navigation pane, select Tables in the navigation 

pane header, locate a table from the displayed list and double-click to open it in datasheet 

view. The records in a table can be reviewed or edited directly in datasheet view; 

however, the entries will not controlled in the same manner as they would if entered 

through the forms opened from the menu. Other database objects (excluding modules) 

can be opened and/or run in the same manner. To prevent the navigation pane from being 

opened by unauthorized users, restrict access to the Security Maintenance menu using 

Object-Level Security. 
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The navigation pane must be visible to perform many routine database management 

functions such as linking tables and importing objects. Linked tables are references to 

tables that reside in another database. The data in a linked table can be viewed, but any 

table maintenance such as adding fields or changing field sizes must be performed in the 

back-end database where they reside. 

  

Change Logon Password 

  

A user can change their own password using the Change Logon button on the 

Tools tab. To change a current password, enter the old password, a new password, and a 

verification of the new password. The password is a case-sensitive character string from 1 

to 14 characters and is subject to the minimum password length specified on the System 

page of the Company Master. If changing from a blank password, leave the Old 

Password field blank and enter only a new password and confirmation password. After 

saving, the new password will be required the next time the user logs into Catalyst. 

  

If the Require Password flag has been set on the System page of the Company 

Master, all users with a blank password will be prompted to enter a new password the 

next time they open the database. Using this flag, a system administrator can clear a 

user’s password and require the user to enter a new one during their next session.  
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Using QuickBooks® Link 

  

The QuickBooks Link allows for the seamless exchange of data between Catalyst 

Manufacturing® and QuickBooks®. The interface allows for enhanced synchronization 

of your manufacturing and financial data through the import of customers, vendors, 

items, sales orders, chart of accounts, payment terms, and other list data and the export of 

customers, vendors, customer invoices, PO receipts and vendor bills to QuickBooks. The 

records can either be updated automatically when changes are saved in Catalyst or in 

batch mode by exporting records at the end of a day or shift.  

  

The interface supports the export of inventory items from Catalyst to QuickBooks 

as a mass update or one at a time. If an item does not already exist in QuickBooks when a 

customer invoice or vendor bill is exported, the item is added to QuickBooks at that time. 

Catalyst serves as the inventory system of record between the two systems for raw 

material, intermediate-level/WIP, sub-assemblies, and finished product inventory; 

however, the inventory balances and values can be exported to QuickBooks with the click 

of a button. This allows QuickBooks to reflect the current quantity and value of the 

different inventory asset accounts at any given time making it easier to report and review 

financials at the end of a period or any time in between.  

  

After the initial import of chart of accounts, sales tax codes, payment terms, 

customers, vendors, and items from QuickBooks, the standard order fulfillment process 

occurs as follows:  

• Create a customer order in Catalyst or import sales orders from QuickBooks. 

During the order creation process, a shop order may be linked to order lines 

for make-to-order items. 

• Review material and capacity availability, order raw materials, schedule 

production of sub-assemblies and perform other activities to support 

production as required. 

• Release shop order to production to build finished product. After reporting 

completion of final product, the end item is placed in inventory for shipping.  

• Prepare shipping documents and enter shipment confirmation to relieve 

inventory. If QuickBooks is open, the customer invoice is created in 

QuickBooks during shipment confirmation. Otherwise, invoices are exported 

to QuickBooks in batch mode at the end of the day or shift.  

• QuickBooks is used to receive payments against the invoice and generate 

financial and accounting journal entries and reports of the business activity.  

• For raw materials, receipts are entered in Catalyst and exported to 

QuickBooks to update liabilities and inventory. When the vendor invoice is 

received, it’s posted in Catalyst and exported to QuickBooks as a vendor bill. 

Alternatively, the bill can be entered directly in QuickBooks. In either case, 

any item receipts are applied when entering the vendor invoice. The vendor 

bill is then used as the basis for processing vendor payments and updating the 

relevant expense and liability accounts. 
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Appendix 

  

The following sections provide supplemental information relevant to previous 

topics. 

 

Calculate Shipping Cost 

 

The Calculate Shipping Cost utility can be opened by clicking the button 

adjacent to the Freight Charge field on the Customer Order Entry, Shipping Document 

Entry and Purchase Order Entry screens. The shipping cost utility can be used to 

determine the cost for shipping packages via FedEx, UPS, or USPS or freight costs for 

less-than-truckload (LTL) shipments via FedEx or UPS. To open the relevant web 

application, click the checkbox adjacent to the desired shipping option. The web page 

will populate the origin and destination zip codes, number of packages, and shipment 

weight for the selected order or shipment. After calculating the shipping cost using the 

web app, enter the resulting freight amount in the shipping cost field and click the Save 

button or close the shipping cost utility and enter the calculated freight charge directly on 

the order or shipment.  

 

Dynamic Lead Times 

  

A well-documented disadvantage of traditional MRP systems is the use of fixed 

lead times in the calculation of release dates for planned orders. This weakness factors 

prominently in the debate between push vs. pull system advocates.  The traditional MRP 

system subtracts the due date of a demand requirement by the standard lead time of the 

item in the Item Master to determine the release date (i.e. when the order needed to start). 

The problem with this approach is that the fixed lead time is at best only an expectation 

or average of the lead time for the item. The actual lead time usually has both fixed and 

variable components; the variable term oftentimes depending on the size of the order. 

  

           The Catalyst MRP engine, however, accounts for both the fixed and variable 

components of an item’s lead time using the dynamic lead times feature. With dynamic 

lead times, the lead time for an item is calculated by adding the fixed lead-time 

components (i.e. setup, move, and queue) with the variable component. The variable 

component is calculated by multiplying the variable lead-time by the order quantity. The 

fixed and variable lead-time components are derived from the operation times in the 

product route of the primary build configuration and can be recalculated from either the 

Planning page of the Item Master or the Mass Update Lead Times option on the Data 

Maintenance tab. The lead times for dynamic lead time items can also be recalculated 

prior to each MRP run by selecting the ‘Update lead times?’ MRP option. 

  

The lead time components are used by MRP to determine release dates for orders. 

The release dates are calculated by subtracting the fixed and variable lead time days from 
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the planned order due date. The safety lead time creates an additional lead time offset to 

reflect internal processing time or to add an extra margin of safety if required. 

 

Costing Methods 

 

Catalyst supports the use of both the average and standard cost method for 

inventory valuation purposes. The standard cost is used in the determination of material 

and labor variances in production, but either cost basis can be selected for the inventory 

cost reports. The average cost for an item is automatically updated when an item is 

received into inventory. The average cost is updated for purchased items at the time of 

purchase order receipt and manufactured items at the time of shop order receipt. The 

update method for both average and standard costing is described in more detail below. 

  

Average Cost Method  

Using the average cost method, a new average unit cost is calculated for each 

receipt – PO receipts for purchased items and shop order receipts for manufactured items. 

The price specified on the purchase order line is used to update the average cost for 

purchased items. For manufactured items, the average cost is updated by performing a 

cost rollup of the shop order route and bill-of-material. The cost rollup is based on either 

standard or actual costs depending on the cost update method specified on the Costing 

page of the Company Master. The table below reflects the manner in which the average 

unit cost would be updated as an item is received and issued (i.e. consumed in production 

or relieved in shipment). 

  

Date Receipts Issues Balance 

January 2 1,000 @ $ 6.00 = $ 

6,000 

  1,000 @ $6.00 = $ 

6,000 

January 8 3,000 @    8.00 

=  24,000 

  4,000 @   7.50 

=  30,000 

        

January 15   2,000 @ $7.50 = 

$15,000 

2,000 @   7.50 

=  15,000 

January 30 2,000 @  10.00 

=  20,000 

  4,000 @   8.75 

=  35,000 

  

   

Standard Cost Method 

The standard costs for an item consists of the standard material, labor, overhead, 

and shipping costs for an item. The standard cost for an item is used to determine cost 

variances for purchased and manufactured items, but can also be used as a basis for 

inventory valuation. The standard costs can be updated either manually or automatically 

as follows: 
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•        Manual 

▪         The standard cost fields for an item can be edited manually on the Cost 

page of the Item Master. 

▪         The standard costs for all unfrozen items can be updated by performing a 

Product Cost Rollup. 

•        Automatic 

▪         The standard cost for an item may be updated automatically based on last 

PO price, average PO price over a specified number of days, or FIFO 

weighted-average. The update method is specified on the Costing page of 

the Company Master.  

 

Product Route Cost Calculations 

 

 The calculations referenced below are applied to each operation in the 

product route. The Costed Route Report in the Financial menu summarizes the cost of 

each operation listed on a product configuration. 

  

The setup cost is calculated as follows: 

  

            SetupCost = SetupHrs/LotSize * SetupRate 

  

The direct labor cost is calculated as follows: 

  

            DirectLaborCost = (RunHrs * Machine Rate / ParentQty) + (RunHrs * Operator 

Rate * NoOperators / ParentQty) 

  

Typically, either a machine rate or operator rate would be applied to a work center so 

only one of the terms would apply. However, it is possible to specify both when the costs 

are cumulative. There is also a yield adjustment applied to the DirectLaborCost if the 

yield on the product configuration is less than 100%. 

  

If overhead is based on an hourly rate, factory overhead is calculated as follows: 

  

            Factory OH = OHRate * (SetupHrs / LotSize + RunHrs / ParentQty) 

  

If overhead is based on a percentage of direct labor, factory overhead is calculated as 

follows: 

  

            Factory OH = OHRate * DirectLaborCost 

  

Where, 

ParentQty: the parent quantity on the product configuration 
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LotSize: for items with a ‘Fixed’ order policy, the lot size is specified on the Item 

Master. For items with other order policies, the lot size is based on the average shop order 

quantity or parent quantity specified on the product configuration. 

SetupHrs: the standard setup hours for the operation. 

RunHrs: the standard runtime hours for the operation. 

NoOperators: the number of operators specified for the operation. 

  

OHRate: either the hourly cost rate or overhead percentage specified on the Work Center 

Master. 

 

Drop Shipments 

 

In instances where a contract manufacturer produces an item that is directly 

shipped to a customer, a customer invoice can be generated from the PO receipt by 

setting up a drop shipment for the item. The drop shipment can be setup from either the 

Purchase Order Entry or Purchase Order Receipts screen by selecting the Drop Ship 

button. To be eligible for drop shipment, an item must be setup in the Item Master as 

‘Saleable’ and either a ‘Purchased’ or ‘Outside Process’ item type. The steps below 

outline how to link a purchase order line item to a customer order line. 

 

1.      On the Drop Shipment Setup screen, select a customer from the Ship To 

drop-down box. This filters the Customer PO drop-down box with open 

order lines for the currently selected customer.  

2.      For the saleable PO lines listed on the purchase order, select a customer 

order line from the Customer PO drop-down box. The Customer PO list 

includes open customer order lines that have not already been assigned to 

another purchase order. 

3.      Select the Save button to save changes and the Close button to return to 

the previous screen. 

 

When a PO receipt is entered against a line item with a linked customer order, the 

item is received into the receipt location and immediately shipped to the customer ship-to 

address specified on the customer order. The customer invoice can then be printed, sent 

to the customer, and, if applicable, exported to QuickBooks®. The purchase order and 

customer order records are updated to reflect the receipt and shipment quantities in the 

same manner as if separate transactions had been entered. If the PO Receipt record is 

edited or deleted in a rollback transaction, the customer shipment associated with the 

receipt is also updated. The customer shipment record can also be edited or deleted in a 

rollback transaction using the Customer Shipment Edit screen. 
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Dimensional Inventory 

Dimensional inventory refers to inventory that is identical in composition and 

function, but varies along one or more dimensions. In this case, it is more efficient to 

stock and process transactions for a single item number with varying dimensions rather 

than attempting to track each dimension as a separate part number. Examples of 

dimensional inventory items include lumber, piping, and sheet stock. 

In Catalyst, each item can have an unlimited number of dimensional records. Each 

dimensional record is defined according to three dimension fields - thickness, width, and 

length. If an item is identified as dimensional on the Item Master, Catalyst requires a 

dimension to be specified whenever the item is used, including all inventory transactions. 

The dimension becomes an inventory attribute that allows the on-hand quantity to be 

maintained for each dimensional record.  

The following steps must be performed to activate dimensional inventory for an 

item: 

1. On the Inventory page of the Company Master, select the ‘Dimensional 

Inventory’ option on the Item Attribute field.  

2. On the Inventory page of the Item Master, select the Dimensional 

checkbox for an item.  

3. Click the edit button adjacent to the Dimensional checkbox and add 

dimensional inventory records to the Dimensional Inventory screen. 

The item attribute setting cannot be changed after inventory transactions have 

been entered for dimensional inventory items. Similarly, the dimensional inventory 

setting at the item level cannot be changed after inventory transactions have been entered 

for the item. Dimensional inventory cannot be applied to saleable end products or by-

products. A new item number must be created in those situations. A new item number is 

also recommended whenever the form, fit, or function of the item changes. 

A Restock flag on the dimensional record is used to indicate whether remnant 

lengths of the dimensional item will be placed back into stock when the item is used in 

production. If the Restock flag is checked, the user is prompted with the Restock 

Dimensional Inventory screen when entering a material issue amount for the dimensional 

item. On the Restock Dimensional Inventory screen, the user specifies the number of 

full lengths consumed, total pieces produced, and restock pieces to place back into 

inventory. For example, if three 2 x 4 x 12 lumber stock were used in the manufacture of 

a certain roof truss and three 3 foot remnants were leftover, the remnant quantities could 

be entered as restock pieces and posted as available inventory for the 2 x 4 x 3 dimension 

at the time the material issue transaction was entered.  
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The restock calculation is based on the length dimension only. The user is 

prompted to restock the dimension when entering single-issue and mass-issue 

transactions by shop order. The restock option is not available for mass-issue by 

component or material backflush transactions. 

Revision Control 

Revision control allows the creation and maintenance of revision numbers to track 

and control usage of different versions of the same item in inventory at the same time. 

When revision control is activated for an item, a revision number must be specified for all 

inventory transactions entered for the item. This creates a different inventory record for 

each revision and allows inventory usage and history to be tracked by revision number. 

Revision control essentially extends the definition of the item to include the 

revision number so that a new item number is not required. The new revision number 

inherits the same properties as the previous revision number at the item number level. 

When an item does not change in form, fit or function, as in the case of minor print or 

artwork changes, a new version number may be more advantageous than creating a new 

item number. Lot traceability extends to the revision number level as it would for a 

different item number.  

The revision control feature extends the functionality of Engineering Change 

Control, which essentially documents the change history for an item. Engineering Change 

Control tracks different revisions through change control and documents the approval 

process around a new revision. Revision control extends that functionality to allow 

inventory control and visibility of the revision in inventory. 

The following steps must be performed to activate revision control for an item: 

1.      On the Inventory page of the Company Master, select the ‘Revision 

Control’ option on the Item Attribute field.  

2.      On the Inventory page of the Item Master, select the Rev. Control 

checkbox for an item.  

3.      Click the edit button adjacent to the Rev. Control checkbox and add a 

revision number record to the Revision Control screen. 

The item attribute setting cannot be changed after inventory transactions have 

been entered for revision control items. Similarly, the revision control setting at the item 

level cannot be changed after inventory transactions have been entered for the item. 

Revision control cannot be applied to by-products. A new item number must be created 

in those situations. A new item number is also recommended whenever the form, fit, or 

function of the item changes. 
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A new revision can be ordered and received into inventory after the revision 

number has been added to Revision Control for an item. To deplete the inventory of an 

old revision, the date the new version will supersede the old version can be specified in 

the effective start date field where the material appears on the Product Configuration 

Master. MRP will create dependent demand for different version numbers according to 

the effective start and stop dates. The revision number for an item appears on all purchase 

order and shop order documentation. 

Material Backflush  

A material backflush refers to a special type of material issue to a shop order. 

Normally, materials are issued to a shop order one item at a time based on actual usage. 

The actual usage can then be compared to the standard quantity required to determine 

material variances. However, single-issue transactions can be time-intensive and may not 

be necessary for low-cost, high-volume items where the variance is negligible. In these 

situations, a backflush transaction can save time, but still capture the usage of material on 

a shop order.  

A material backflush transaction issues material to a shop order automatically 

when a shop order receipt is entered. The issue quantity is based on the component 

quantity required and the ratio of the shop order quantity received to the quantity ordered. 

For instance, if a shop order for 100 printed circuit boards requires 200 transistors, a shop 

order receipt for 50 printed circuit boards would prompt a backflush of 100 transistors 

(50 received/100 ordered * 200 required).  

The backflush location is based on the default location for the operation work 

center. If a default location is not specified for the work center, the backflush location is 

based on the default location of the bill-of-material component. For example, if a 

component is assigned to an operation on the Assembly work center and the default 

Assembly location in the Work Center Master is A001, the default backflush location is 

A001. If a default location is not specified for the Assembly work center, the backflush 

location is based on the component’s default location in the Item Master.  

When the shop order receipt is entered from the Inventory menu, Catalyst allows 

the backflush quantity for backflush items to be modified in the Backflush Confirmation 

screen. The Backflush Confirmation screen can be used to adjust backflush quantities 

based on actual usage and offers a more rapid entry of issue transactions relative to the 

single-issue transaction. The primary disadvantage of backflush transactions involves the 

timing of the transaction. When using the backflush, the issue transaction does not occur 

until the shop order receipt is entered. This means that material will still show as 

available in inventory until the shop order receipt has been entered. For situations where 

cycle times are long or real-time updates are required, the single-issue transaction may be 

the better option.  
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The components on a shop order can be a mix of both backflush and non-

backflush. An item can be designated as backflush on the Item Master, Product 

Configuration Master, and Shop Order Master. The backflush flag in the Item Master 

serves as a default setting when the item is selected as a child item for a product 

configuration. When a shop order is created, the backflush flag from the product 

configuration is copied to the shop order. The backflush flag can be changed for any 

product configuration or shop order. The Backflush Confirmation screen will only 

display bill-of-material items that have the backflush flag set on the shop order regardless 

of the setting on the Item Master or Product Configuration Master. 

Labor Backflush  

A labor backflush can be entered for an operation on a shop order route in the 

same manner that a material backflush is entered for a bill-of-material item. The labor 

backflush occurs in lieu of reporting labor hours for the operation and is entered 

automatically at the time of shop order receipt. Labor backflush is typically appropriate in 

situations where cycle times are short. The ability to modify the backflush labor hours 

during Backflush Confirmation allows labor variances to be properly reported and 

reconciled. 

A labor backflush transaction reports hours completed for a shop order operation 

at the time of shop order receipt. The setup and/or labor hours reported depends on the 

hours required for the shop order operation and the quantity received of the shop order 

parent item. For instance, if a shop order for 100 printed circuit board requires 20 hours at 

the surface mount operation, a shop order receipt for 50 printed circuit boards would 

backflush 10 hours of operation run time for the surface mount operation. If the operation 

required setup, the setup hours would also be backflushed. 

When the shop order receipt is entered from the Inventory menu, Catalyst allows 

the backflush labor hours for backflush operations to be modified in the Backflush 

Confirmation screen. The Backflush Confirmation screen can be used to adjust the setup 

and run labor hours based on actual reported hours. The primary disadvantage of 

backflush transactions involves the timing of the transaction. When using the backflush, 

the labor transaction does not occur until the shop order receipt is entered. This means 

that backflush operations will still show the same hours required for capacity planning 

and finite scheduling purposes until the shop order receipt has been entered. For 

situations where cycle times are long or real-time updates are required, reporting labor by 

operation or shop order may be the better option.  

The operations on a shop order can be a mix of both backflush and non-backflush. 

A work center can be designated as backflush on the Work Center Master, Product 

Configuration Master, and Shop Order Master. The backflush flag in the Work Center 

serves as a default setting when the work center or a standard operation requiring that 

work center is selected for a product configuration. When a shop order is created, the 

backflush labor flag from the product configuration is copied to the shop order. The 
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backflush labor flag can be changed for any product configuration or shop order. The 

Backflush Confirmation screen will only display operations that have the backflush labor 

flag set on the shop order regardless of the setting on the Work Center Master or Product 

Configuration Master.  

Backflush Confirmation 

  

The Backflush Confirmation screen is displayed after entering a shop order 

receipt transaction and either backflush materials or backflush labor operations are 

present on the shop order. The header information on the screen summarizes the shop 

order header information and provides a reference to the shop order receipt quantity that 

was entered on the Inventory Transaction Reporting screen. The two lower sections of the 

screen present the material and labor backflush lines. In the event that backflush materials 

or operations do not exist on the shop order, the respective material or labor section will 

not be displayed. The backflush quantities can be modified in each section before 

clicking the Accept button to process the transactions. The fields for each section are 

reviewed below. 

  

Material Backflush 

The Backflush Quantity field is calculated by dividing the shop order Qty 

Ordered into the Receipt Qty and multiplying the factor by the Qty Required column. 

The scrap percentage is included in the backflush amount. The Backflush Quantity field 

can be edited based on actual results. 

  

The Remaining Quantity field displays the issue quantity remaining for the shop 

order material. The Balance On-Hand field displays the balance on-hand for the line 

item. Both columns are color-coded to highlight over issue and negative inventory 

situations.  

  

Labor Backflush 

The default Backflush Setup Hrs is equal to the remaining setup hours. 

Normally, this results in the full setup hours being charged for the first transaction on a 

shop order. The Backflush Run Hrs are calculated by multiplying the operation run 

hours by the ratio of the shop order quantity ordered and the shop order receipt quantity. 

The Backflush Quantity defaults to the shop order receipt quantity. The default 

backflush amounts for each field can be modified if required to more accurately reflect 

actual amounts. 

 

Backflush By Operation Sequence 

The Seq. No. field at the top right of the screen can be used to filter the backflush 

labor and materials by operation sequence number. This may apply in situations where 

only one operation has been completed so only the labor and materials for that operation 

have been consumed and should be reported in the backflush. 
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Scheduled Task Setup 

The Material Requirements Planning (MRP) and Finite Capacity Scheduling 

(FCS) jobs can be scheduled to run automatically at a specified time by creating a 

Windows scheduled task.  To configure and run the MRP and FCS jobs as scheduled 

tasks, follow the steps outlined below. 

1. Identify a PC or server machine that will not be shut down during the time 

you want to run the MRP and FCS jobs.  

2. If Catalyst has not already been installed on the machine, install Catalyst and 

link to the company back-end database.  Refer to the Installation help topic 

for detailed installation instructions. 

3. Browse to the Program Files\Catalyst folder and locate the front-end 

database.  The front-end database will either have an accdb or accde extension 

and include “Catalyst vx.xx” in the file name (e.g. “Catalyst v5.15.accdb”). 

4. Make a copy of the front-end database and rename the file to include 

“SchedTasks” in the file name (e.g. “Catalyst v5.15 - SchedTasks.accdb”). 

5. Open the “SchedTasks” front-end database from the previous step in shift-

bypass mode by double-clicking the file and holding down the Shift key at the 

same time until the database opens. In shift-bypass mode the Access menu 

and ribbon should display instead of the Catalyst ribbon. Select File > 

Options to open Access Options. Select Current Database from the Access 

Options navigation pane. In the Display Form field, enter 

frmSchedTaskSettings as shown below. Click the OK button and then exit 

Access. 
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6. Open the Windows Control Panel and select the Scheduled Tasks icon or 

link. Select the ‘Add Scheduled Task’ link to open the Scheduled Task 

Wizard. Follow the instructions in the wizard to browse and select the 

Catalyst “SchedTasks” front-end database created in the previous step.  If 

user-level security has been activated (i.e. you are prompted for a user name 

and password when opening Catalyst), you will need to add a command line 

to the scheduled task to open the database with a specified user name and 

password. 

7. To modify the MRP and FCS settings, open the Catalyst “SchedTasks” front-

end database and select the Stop button shown below to stop the 

countdown.  Click the ‘Finite Schedule’ tab to modify the FCS settings as 

described in the Catalyst Scheduler help topic.  Click the ‘MRP” tab to 

modify the MRP settings as described in the MRP help topic. 
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8. After making the desired changes, click the Run button to save the 

configuration settings and run the selected jobs.  After the jobs finish running, 

the database will close.  Click the Cancel button to cancel the configuration 

changes and exit the database. 
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Performance Tips 

 

The following tips and recommendations have been provided to help improve 

application performance and ensure the health and performance of the database. 

  

• Check network routers and switches to ensure sufficient bandwidth between 

the server and client PCs. 

 

• Verify sufficient hard drive capacity exists on both the client and server. 

 

• Minimize open applications and increase RAM and physical memory on the 

client PCs. 

• The front-end database does not change on a daily basis, however, it should be 

compiled and compacted after making any design modifications. Over a 

period of time, the database has a tendency to increase in size with successive 

compilations. To correct this problem and return the database to its minimum 

size, you can decompile the database by using a /decompile switch in the 

database shortcut path. Remember to use the shift key to bypass the startup 

options so you can compile, save, and compact the database after it has been 

opened. Please refer to Microsoft Access Help for more detailed instructions. 

 

• To minimize the number of records maintained in the system, archive orders 

and transactions on a periodic basis. The Catalyst Archive Wizard walks you 

through the process of removing orders and transactions that are no longer 

needed and storing them in an archive database where they can be referred to 

when necessary. Inventory transactions are not included in the archive process 

and should be purged from the system through the Physical Inventory process. 
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Evaluation Version 

 

The evaluation version of Catalyst Manufacturing® can be operated for 90 days up to 

the transaction limit indicated below. The evaluation version can be activated by 

submitting payment for the Basic Edition and registering the product with Manufacturing 

Advisors. Alternatively, the evaluation version can be replaced by a Full Edition upgrade 

that includes the source code in the front-end database and customization capability. The 

Full Edition is downloaded separately following product purchase. The transaction limits 

in the evaluation version are summarized below. 

  

Customer Orders – 50 

Purchase Orders – 50 

Shop Orders – 50 

Items – 50 

Product Configurations - 50 

Customers – 20 

Vendors - 20 
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Software License Agreement 

 

CATALYST MANUFACTURING® SOFTWARE 

IMPORTANT—READ CAREFULLY: This Software License Agreement (“SLA”) is a legal agreement between 

you (either an individual or a single entity) and Manufacturing Advisors, LLC for the Manufacturing Advisors 

software product identified above, which includes computer software, source code, and associated media, 

printed materials, and “online” or electronic documentation (“Product”). An amendment or addendum to this 

SLA may accompany the Product. 

YOU AGREE TO BE BOUND BY THE TERMS OF THIS LICENSE BY CLICKING THE ACCEPT BUTTON 

AND CONTINUING WITH THE PRODUCT INSTALLATION. IF YOU DO NOT AGREE WITH THESE 

TERMS, YOU SHOULD CANCEL THE INSTALLATION PROCESS AND UNINSTALL THE PRODUCT. 

  

The Product is licensed through MANUFACTURING ADVISORS, LLC (“Manufacturing Advisors”), owner of 
the Product for use only under the terms of this SLA and Manufacturing Advisors reserves any rights not 
expressly granted to you. Manufacturing Advisors makes neither representation that it has rights to nor grants 
to you any rights in any software needed to use the Product. It is solely your responsibility to obtain all required 
rights in any software that may be needed to use the Product. The rights granted to you herein are exclusively 
for the Product. 

  
1.     Applicability Of License. Depending on the modules, extensions, and interfaces you have chosen, 

the Product may consist of additional applications with product documentation and sample data 
(each, a “COMPONENT,” and collectively “COMPONENTS,” of the Product. This SLA defines your 
rights to the Product and associated COMPONENTS distributed and sold by Manufacturing 
Advisors. 

2.     General Grant of License. In general, this license grants the right to copy and install the Product 

on a local area network in a file-server or client-server configuration consisting of multiple client 
machines and one server machine per physical location. Specifically,: 

a.     if you are an individual, Manufacturing Advisors grants to you as an individual a personal, 
nonexclusive license to copy and install the Product in accordance with the terms of this 
SLA, provided that you are the only individual using the Product. 

b.     if you are an entity, Manufacturing Advisors grants your employees the right to copy and 
install the Product in accordance with the terms of this SLA. The rights granted shall be 
limited to entity’s licensed location and are not transferable to another entity, affiliate, 
subsidiary or location. 

3.     End Use Limitation. The number of users shall be limited based on the number of concurrent client 
seats licensed by Manufacturing Advisors or an authorized reseller.  

4.     Distribution Restrictions. You may not distribute copies of the Product except as granted herein 
or by separate written agreement with Manufacturing Advisors. You may not assign, sell, distribute, 
lease, rent, sublicense, or transfer the Product in any form including, but not limited to, the 
following: 

a.     You may not distribute copies through any physical storage media such as CD or disk. 
b.     You may not web-enable the Product or sell, distribute, lease, rent, sublicense, or 

otherwise offer access to or use of, the Program via the Internet or via any other network 
available to or accessible by third parties. 

c.     You may not rent or lease the Product through a remote hosting facility or data center. 
5.     Separation and Disassembly. The Product is licensed as a single product. Its source code and 

database objects may not be separated or disassembled for use in other applications without the 
express written consent of Manufacturing Advisors. 

6.     Limitation On Reverse Engineering. You may not reverse engineer the Product, except and only 
to the extent that it is expressly permitted by applicable law notwithstanding this limitation.  

7.     Termination. Without prejudice to any other rights, Manufacturing Advisors may cancel this SLA if 
you do not abide by the terms and conditions of this SLA, in which case you must destroy all copies 
of the Product and all of its component parts.  
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8.     Consent To Use Of Data. You agree that Manufacturing Advisors may collect and use technical 
information you provide as a part of Product registration or separately entered agreement for Support 
Services. Manufacturing Advisors agrees not to sell or transfer this information to non-affiliated 
entities. 

9.     Academic Edition Software. To use Product identified as “Academic Edition” or “AE,” you must be 
a “Qualified Educational User.” For qualification-related questions, please contact Manufacturing 
Advisors directly. 

10.   Export Restrictions.  You acknowledge that the Product is subject to U.S. export jurisdiction.  You 
agree to comply with all applicable international and national laws that apply to the Product, including 
the U.S. Export Administration Regulations, as well as end-user, end-use and destination restrictions 
issued by U.S. and other governments. 

11.   DISCLAIMER OF WARRANTIES. To the maximum extent permitted by applicable law, 
Manufacturing Advisors and its suppliers provide the Product and support services (if any) AS IS 
AND WITH ALL FAULTS, and hereby disclaim all other warranties and conditions, either express, 
implied, or statutory, including, but not limited to, any (if any) implied warranties, duties or conditions 
of merchantability, of fitness for a particular purpose, of accuracy or completeness of responses, of 
results, of workmanlike effort, of lack of viruses, and of lack of negligence, all with regard to the 
Product, and the provision of or failure to provide support services. MANUFACTURING ADVISORS 
MAKES NO REPRESENTATION OR WARRANTY REGARDING THE RESULTS 

OBTAINABLE THROUGH USE OF THE PRODUCT. 

12.   EXCLUSION OF INCIDENTAL, CONSEQUENTIAL, AND CERTAIN OTHER DAMAGES. TO THE 
MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, IN NO EVENT SHALL 
MANUFACTURING ADVISORS OR ITS SUPPLIERS BE LIABLE FOR ANY SPECIAL, 
INCIDENTAL, INDIRECT, OR CONSEQUENTIAL DAMAGES WHATSOEVER (INCLUDING, BUT 
NOT LIMITED TO, DAMAGES FOR LOSS OF PROFITS OR CONFIDENTIAL OR OTHER 
INFORMATION, FOR BUSINESS INTERRUPTION, FOR PERSONAL INJURY, FOR LOSS OF 
PRIVACY, FOR FAILURE TO MEET ANY DUTY INCLUDING OF GOOD FAITH OR OF 
REASONABLE CARE, FOR NEGLIGENCE, AND FOR ANY OTHER PECUNIARY OR OTHER 
LOSS WHATSOEVER) ARISING OUT OF OR IN ANY WAY RELATED TO THE USE OF OR 
INABILITY TO USE THE PRODUCT, THE PROVISION OF OR FAILURE TO PROVIDE SUPPORT 
SERVICES, OR OTHERWISE UNDER OR IN CONNECTION WITH ANY PROVISION OF THIS 
SLA, EVEN IN THE EVENT OF THE FAULT, TORT (INCLUDING NEGLIGENCE), STRICT 
LIABILITY, BREACH OF CONTRACT, OR BREACH OF WARRANTY OF MANUFACTURING 
ADVISORS OR ANY SUPPLIER, AND EVEN IF MANUFACTURING ADVISORS OR ANY 
SUPPLIER HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. THE USER OF 
THE PRODUCT IS EXPECTED TO MAKE THE FINAL EVALUATION OF ITS USEFULNESS IN 
USER’S OWN ENVIRONMENT. 

13.   LIMITATION OF LIABILITY AND REMEDIES. Notwithstanding any damages that you might incur 
for any reason whatsoever (including, without limitation, all damages referenced above and all direct 
or general damages), the entire liability of Manufacturing Advisors and any of its suppliers under any 
provision of this SLA and your exclusive remedy for all of the foregoing (except for any remedy of 
repair or replacement elected by Manufacturing Advisors with respect to any breach of the Limited 
Warranty) shall be limited to the greater of the amount actually paid by you for the Product or 
U.S.$5.00. The foregoing limitations, exclusions, and disclaimers (including Sections 11 and 12 
above and as stated in the Limited Warranty) shall apply to the maximum extent permitted by 
applicable law, even if any remedy fails its essential purpose. 

14.   ENTIRE AGREEMENT. This SLA (including any addendum or amendment to this SLA which is 
included with the Product) are the entire agreement between you and Manufacturing Advisors 
relating to the Product and the Support Services (if any) and they supersede all prior or 
contemporaneous oral or written communications, proposals, and representations with respect to the 
Product or any other subject matter covered by this SLA. To the extent the terms of any 
Manufacturing Advisors policies or programs for Support Services conflict with the terms of this SLA, 
the terms of this SLA shall control. 

15.  COPYRIGHT NOTICE. The Product is protected by copyright and other intellectual property 
laws and treaties. The Product may not be copied, in whole or in part, except as provided 
herein.  Manufacturing Advisors owns the title, copyright, and other intellectual property 
rights in the Product. The Product is licensed, not sold. 
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MISCELLANEOUS 
  
If you acquired this product in the United States, this SLA is governed by the laws of the State of Georgia. If 
this Product was acquired outside the United States, then local law may apply. 
  
Should you have any questions concerning this SLA, or if you desire to contact Manufacturing 
Advisors for any reason, please email sales@catalyst-mfg.com.  

 

mailto:sales@catalyst-mfg.com

